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Copyrights and Trademark Notices
Copyright © 2013 Telestream, Inc. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, 
ScreenFlow, Vantage, Wirecast, GraphicsFactory, MetaFlip, MotionResolve, and Split-
and-Stitch are registered trademarks and Pipeline, Launch, and Videocue are 
trademarks of Telestream, Inc. All other trademarks are the property of their respective 
owners.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
Explorer, SQL Server 2005|2008|Server 2012, and Windows Media Technologies are 
trademarks of Microsoft Corporation.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All right 
reserved.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge 
Corporation.

x.264 LLC. The product is manufactured by Telestream under license from x.264 LLC.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.
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Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.
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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
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Limited Warranty and Disclaimers
Telestream, Inc. (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Software—If software is supplied as part of the product, the Company does not 
warrant that the software will operate uninterrupted or error-free, will meet your 
requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.
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Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, Inc.
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream, Inc. via telephone at (530) 470-1300.

Part number: 110309
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Telestream Contact
Information
To obtain product information, technical support, or provide comments on this guide, 
contact us using our web site, email, or phone number as listed in Table 1.

Table 1. Telestream Contact Information

Resource Contact Information

Telestream Technical 
Support

Web Site: http://www.telestream.net/telestream-support

Vantage Technical 
Support

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Support Web Mail: http://www.telestream.net/
telestream-support/vantage/contact-support.htm

Telestream, Inc. Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream, Inc. 
848 Gold Flat Road
Nevada City, CA. USA 95959

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/overview.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/contact-support.htm
http://www.telestream.net/telestream-support/vantage/contact-support.htm
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
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Domain Management
Overview
Vantage domain management tasks include Vantage installation, configuration, and 
management. The Vantage domain administrator primarily uses the Vantage 
Management Console to configure and manage a Vantage domain.

The following topics introduce Vantage and the Vantage system components that an 
administrator installs and manages:

 Introduction to Vantage

 Vantage Domain Components

 Vantage Domain Configurations

 Vantage Programs

 Vantage Licenses

 Lightspeed Server

 Processing Live and Tape Feeds from Pipeline

 Topics in this Guide

Note: Vantage licenses enable specific features and programs in Vantage, including 
optional transcoding capabilities, Lightspeed server, advanced workflow features and 
system management. 

Vantage licenses allow you to download and install Vantage software at your 
convenience and purchase only those features that you need. If you need additional 
features later, you can purchase the licenses you require at any time.
Features for which you do not have a license may be disabled, or work only in demo 
mode. Topics which describe a feature that requires a license indicate that you need a 
license to use them. 

You manage licenses in the Vantage Management Console. You can also add or 
update licenses directly in Workflow Designer. For a full discussion of licensing in 
Vantage, see the Vantage Management Guide.
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Introduction to Vantage
At the simplest level, Vantage is a collection of customizable software programs that 
automate media processing via workflows. A Vantage workflow is a collection of 
actions, designed by you to process media files in a specific manner.

The actions you can utilize in a workflow are controlled by the Vantage licenses you 
enable. Table 2 lists some typical media processing objectives and the Vantage licenses 
that support them (these are not the only licenses you can use in Vantage—for a 
complete list, contact your Telestream representative).

Table 2. Vantage Media Processing Objectives

Workflow Objective 
(Vantage License) Description

File-to-file (template-
based) transcoding 
(Vantage Transcode or 
Transcode Pro Editions)

Transcoding workflows automate the process of 
converting a video file from one media format to another. 
Vantage can open most video files, regardless of the 
encoding and packaging format, and create one or more 
new video files using one or more selections from an 
extensive list of encoder and packaging formats.

Commercial processing—
local, regional, and 
national

TrafficManager streamlines commercial and content 
handling for TV stations and cable facilities. 
TrafficManager provides a complete solution for 
syndicated and commercial media workflows, from 
ingest, review & approval, transcoding, dub list 
reconciliation, delivery for ad insertion servers or 
broadcast servers, and automation system notification.

Adaptive streaming 
encoding (Vantage 
Multiscreen)

Transcode Multiscreen includes transcoding software 
specifically designed for adaptive bit rate encoding using 
both GPUs and CPUs. It simultaneously produces multiple 
bit-rate variants of H.264 video and containers for 
deployment to HTTP adaptive streaming players from 
Adobe, Apple, Microsoft, and players compatible with 
MPEG DASH.

Automated editing and 
composition of promos

Post Producer automates the repetitive editing of assets 
for distribution, promotion and cross promotion. Post 
producer allows you to automatically re-purpose movies 
and episodic content directly from master format for 
international and domestic distribution.

IPTV VOD Transcoding Vantage Transcode IPTV VOD provides IPTV and Cable 
VOD transcoding with the highest possible quality at the 
lowest bit rates, reducing transmission costs. Additionally, 
Vantage provides sophisticated stream control and can 
automate the entire production process, including ingest, 
transcoding, packaging, delivery, and notification. 
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With the appropriate licenses, Vantage workflows can incorporate some or all of the 
objectives listed in Table 2, as well as other workflow design and management features, 
which include the following:

• Workflow visualization—Vantage offers a highly flexible process design interface, 
with visual components that help you see what the workflow will accomplish

• Notifications—Vantage can send emails or notify external systems when media is 
available

• Intelligent branching—Vantage workflows can be configured to evaluate variables, 
metadata, and the results of other workflow tasks, and select the appropriate work-
flow branch for further processing.

• Workflow monitoring and control—Vantage programs allow you to view the status 
of jobs that have been submitted to a workflow, and you can stop, cancel, and 
restart jobs.

• Operator control—Vantage provides tools for enabling operator management. 
Operators can submit files to workflows, view the results, and submit the results to 
yet another workflow. Operators can also view the status of workflow jobs and, if 
granted permission by a Vantage administrator, stop, cancel or restart jobs.

• Scalability and Redundancy—Vantage scales to thousands of jobs and dozens of 
servers in an enterprise environment, to implement high-volume processing.

Vantage also provides many system management features, allowing you to scale a 
Vantage system to many servers, manage user access, and optimize system 
performance and reliability. The system management features are described in topics 
throughout this guide.

Moving media between 
devices (Vantage 
Transcode Pro Connect)

Media transport workflows use Vantage native 
connections to move media between a wide variety of 
broadcast servers, edit systems, and other professional 
video devices. Using these integrations, Vantage can 
automate the process of receiving media into, or moving 
media between, different devices—ensuring the right file 
format at any of many possible destinations.

Media analysis and 
media-dependent 
processing (Vantage 
Analysis)

Media analysis workflows use Vantage features to analyze 
media, compare the results to configured values, and 
make decisions about how media should be routed or 
processed.

Third-party analysis and 
specialized media 
processing (third-party 
licenses)

Some workflows communicate with third-party products 
(such as MediaMate Screen and Digimetrics Aurora) to 
analyze or process media.

Table 2. Vantage Media Processing Objectives

Workflow Objective 
(Vantage License) Description
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Vantage Domain Components
Each Vantage domain  is a collection of Vantage software components that are linked 
together in an independent entity, as a single Vantage installation. You can install and 
use multiple Vantage domains within a business or other organization. For example, 
you might install a Vantage domain for the sports department and another for the 
news department. Domains do not interact with each other or know of others’ 
existence—each Vantage domain maintains its own database, and automates its own 
workflows, independently of other Vantage domains.

Figure 1. Simplified View of the Basic Vantage Domain Components

The work that you want Vantage to perform is defined in a workflow, which is created 
using the Vantage Workflow Designer program. The workflow is made up of individual 
tasks called actions, which specify what task needs to be performed. A typical workflow 
contains actions to do some or all of the following:

• Discover media that is ready for processing at an input storage location

• Analyze and transcode input media into new media files

• Process metadata

• Register media in a Vantage catalog for further utilization

• Deliver finished media files to an output storage location.

Many other actions are provided in Vantage Workflow Designer. You can create and 
save many different workflows in a Vantage domain, and you can use them over and 
over with different files. Automation features allow you to initiate workflow processing 
whenever a new file appears in a hot folder. For more information on the available 
actions and workflow design, see the Vantage User’s Guide.
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Vantage workflows are stored in the Vantage domain database, which is the control 
center of a Vantage domain. All configuration for the domain is stored in the Vantage 
domain database, as are statistics and status information about the workflows 
processed by the domain. Vantage domain administrators configure Vantage using the 
Management Console.

Working with the Vantage domain database, Vantage services execute workflow 
actions in a Vantage domain. Each service executes specific action types. For example, 
the Transcode Service executes the Flip action, which transcodes an input media file 
into a new file, based on the encoder and codecs you select. 

The input and output storage locations shown in Figure 1 are not Vantage components, 
although they may reside on Vantage servers. Vantage workflow actions which access 
input files or publish output files must have read and write access to these storage 
locations. These locations can be folders that reside on a network server or workstation, 
a Network-Attached Storage (NAS), or a Storage Area Network (SAN). Or, they may be 
FTP or HTTP servers, or other media platforms.

A Vantage store is a specially-designated storage location that stores temporary files 
that are created during workflow processing, and it can also store output files. Typically, 
temporary files are deleted after a job expires or is deleted, however, Vantage controls 
allow you to change this to retain files for a period of time or indefinitely.
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Vantage Domain Configurations
While Vantage supports many different physical configurations, there are only two 
types of domains—a single node All-in-one domain—and a Vantage array, where the 
Vantage services and Vantage database are distributed among two or more servers.

An all-in-one domain is a Vantage domain in which all the basic Vantage components 
shown in Figure 1 are installed on a single server. An all-in-one domain is simpler to 
install and manage, but it has performance limitations which are described in Before 
You Install, in the Vantage Domain Management Guide.

A Vantage array (sometimes referred to as a distributed domain) is one in which the 
basic Vantage components are distributed among multiple servers. For example, you 
might install the Vantage domain database on one server, and install all Vantage 
services on an additional server, and a second Transcode service on the third server. 
This three-server Vantage domain separates database processing from Vantage service 
processing, which increases processing capacity for both the Vantage domain database 
and the Vantage services. 

Having Vantage services on multiple servers also increases capacity and supports load-
balancing, which leads to better throughput, and redundancy, which enables failover 
protection for the Vantage domain.
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Vantage Programs
Vantage programs allow you to manage the components in the Vantage domain. 
Table 3 lists the Vantage programs according to the Vantage management area they 
serve and the type of program. 

Note: Some Vantage programs are available only with particular Vantage product 
licenses. To ensure you get the programs you want, contact Telestream sales for the 
latest bundling and licensing information.

From a management point of view, each Vantage program can be classified as a 
workflow management program or a domain management program. Workflow 
management programs allow you to design workflows, evaluate and forward the 
results of a workflow, and track the status of workflows. Domain management 
programs allow you to configure the Vantage domain, view status and statistics for the 
domain, and control domain operation.

Each Vantage program can also be classified by application type, which is either as a 
client program or a Web application. Client programs run on Microsoft Windows 
servers and workstations. Web applications are hosted by a Microsoft Internet 
Information Services (IIS 7) server and can be accessed from any computer with a 
compatible browser and a network or Internet connection to the IIS 7 server hosting 
the Web applications.

Figure 2 illustrates how the additional Vantage programs not shown in Figure 1 fit into 
a Vantage domain.

Table 3. Vantage Programs

Functional Area

Program Type

Client Applications Web Applications

Workflow Management Vantage Workflow Designer

Vantage Workflow Portal

Vantage Job Status Views

Vantage Workflow Portal

Vantage Web Transcode UI

Transcoding Workflow 
Management

Vantage Workflow Designer Vantage Web Transcode UI

Domain Management Vantage Management 
Console

Vantage Dashboard

TrafficManager Dublist 
Management

Dublist Portal Upload Portal
Vantage Domain Management Guide



Domain Management Overview
Vantage Programs

30
Figure 2. Vantage Domain Showing All Vantage Programs
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The following topics introduce each of the Vantage programs:

 Vantage Management Console

 Vantage Workflow Designer

 Vantage Workflow Portal

 Vantage Workflow Portal Web Application

 Vantage Job Status Views Web Application

 Vantage Dashboard Web Application

 Vantage Web Transcode UI Web Application

 Vantage Dublist Portal

 Vantage Web Upload Portal

Vantage Management Console
The Vantage Management Console (VMC) enables domain administrators to configure 
and manage a Vantage domain, including specifying what features Vantage users can 
access. The following is a partial list of Vantage features that administrators can control 
with VMC:

• Vantage stores

• Vantage users

• Vantage licenses

• Load balancing

• Vantage services

• Action and workflow status

• Import and export of Vantage configuration components

• Domain workflow analytics

• Vantage Job Status Views

• Vantage Workflow Portal

• Dublist Portal

• Report configurations

• Dublist schemes

• Vantage domain database backup and restore

Vantage Management Console also allows you to view some domain status 
information.

For information about using Management Console, see the Vantage Domain 
Management Guide.
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Vantage Workflow Designer
Vantage Workflow Designer enables you to design and automate workflows to meet 
your organization's transcoding and workflow automation requirements. With 
Workflow Designer, you can design workflows that do the following:

• Detect media files and related files that are ready for processing

• Evaluate the contents of media files and set variables that describe their contents

• Create actions that execute different workflow branches based on variable values

• Generate email and other messages in response to workflow events

• Incorporate related metadata files or add metadata to the output

• Transcode media files to multi-screen formats, including package formats such as 
Apple HLS and Adobe HDS

• Transcode media files for use in IPTV/VOD/cable applications

• Perform comprehensive advertisement processing, from catch server to on-air 
server

• Perform file operations—save media output files and delete source files

• Combine any or all of the above features in hundreds of possible workflows.

A typical workflow design session requires that you pick the actions you want to take, 
configure the sequence and settings of those actions, and then activate the workflow. 
When you activate the workflow, the Vantage domain database and Vantage services 
work together to process any source material that is submitted to the workflow. Each 
time source material is submitted, a Vantage job is started. A job represents a single 
instance of a workflow. For example, if 10 different media files are submitted to a 
workflow, 10 new jobs are started.

Vantage Workflow Designer also includes tools that allow you to monitor the status of 
workflows and jobs in the domain.

For comprehensive information on designing Vantage workflows, see the Vantage 
User’s Guide.
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Vantage Workflow Portal
The Vantage Workflow Portal (a licensed option) allows operators to manually review 
and update media and submit jobs. Workflow designers create the workflows, and 
workflow operators use Workflow Portal to do the following:

• Review catalogs and binders used in workflows

• Scrub media and set in and out points for trimming

• Review and edit metadata labels used in workflows

• Review and edit variable values used in workflows

• Submit media to workflows for processing

• Stitch multiple files together

The Workflow Portal’s user interface can be configured to display only those features, 
and access only those resources which are necessary to perform certain work. Workflow 
Portal cannot operate until it is installed on a Windows workstation and configured 
using the Vantage Management Console. To process media in Workflow Portal, you 
must also create a workflow to preprocess the media and register it in a Vantage 
catalog. 

For information about creating configurations for the Workflow Portal, see Vantage 
Domain Management Guide > Configuring Workflow Portal Operation. For information 
about using the Workflow Portal, refer to the Vantage User’s Guide.
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Vantage Workflow Portal Web Application
The  optional Workflow Portal Web App is a Web version of the Workflow Portal 
Windows program, with a subset of Workflow Portal features. After you install Web 
Apps on a server, you can access the portal at http://[server name]/Vantage/Portal/. The 
login is the same as for other clients. For information on using the Workflow Portal Web 
app, see the Vantage User’s Guide.

Vantage Job Status Views Web Application
The Job Status Views Web Application provides Vantage operators and managers with 
detailed job status information about all jobs in the domain. Using the Vantage 
Management Console, Vantage administrators can configure custom views, which 
define what information an operator sees when opening a view. When there is a large 
volume of jobs or when security policies dictate, you might want to create custom 
views for individual operators or departments.

After you install Web Apps on a server, you can access the Job Status Views at http://
[server name]/Vantage/JobStatusViewer/. The login is the same as for other clients.

For information on using the Vantage Job Status Views, see the Vantage Domain 
Management Guide and the Vantage User’s Guide.

Vantage Dashboard Web Application
The Vantage Dashboard app is designed to help domain administrators track the status 
and system health for the entire Vantage domain, as opposed to other tools which 
enable management of domain components.

The Vantage Dashboard pages are designed to help you quickly assess the health of the 
domain and progressively dig into deeper detail as needed. For example, the Summary 
Status page allows you to quickly see the workflow completion success rate and the 
error rate on domain servers. The information on the Summary Status page can help 
you determine if it is more appropriate to look for problems in a workflow or in a 
particular server.

Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

For information on using Vantage Dashboard, see Monitoring the Domain with 
Vantage Dashboard in the Vantage Domain Management Guide.
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Vantage Web Transcode UI Web Application
Vantage Web Transcode UI is a browser-based application that allows users to quickly 
and easily build transcoding workflows in a browser, based on a fixed workflow 
template using these three simple steps: Watch > Transcode > Deliver.

Vantage Web Transcode UI allows users to build workflows that include one or more 
hot folders to watch for incoming media, one or more output formats, and can include 
delivery to one or more destinations. You can also review job status directly in Web 
Transcode UI, where jobs can be stopped, restarted and deleted.

Workflows designed in Web Transcode UI are automatically displayed in Workflow 
Designer as well. However, when a workflow is edited in Workflow Designer, it no longer 
displays in the Web Transcode user interface. Workflows originally implemented in Web 
Transcode UI can be extended to include more advanced features such as Analysis, 
email notifications, and more, in Workflow Designer.

Note: The Vantage Web Transcode UI, should be installed on a different server from 
the Telestream Transcode & Analysis engine. For this reason, Web Applications are 
included only with the array installer and not with the single-node installer. 

After you install Vantage Web Applications on a server, you can access the Vantage Web 
Transcode User Interface at this browser location:
http://[server name]/Vantage/Transcode/ 

The same login applies as for other clients.

Vantage Dublist Portal
Dublist Portal is an optional application—a TrafficManager-licensed program which 
allows users to manage dublist processing. It allows you to view a list of dublists for 
recently active Dublist Monitor workflow actions, manage dublist expiration, and test 
dublists to prequalify them for workflows. For more information on using the Dublist 
Portal, see the TrafficManager User’s Guide.

Vantage Web Upload Portal
The Vantage Web Upload Portal is a TrafficManager web application that allows remote 
advertisers to upload ad media and associated files to your Vantage traffic workflows. 
Your Vantage administrator sets up the portal for the client and specifies the workflow 
to which the files are uploaded. The application is very easy to use, providing a simple 
3-step process for uploading. For more information, see the Upload Portal 
Administrator’s Guide and the Upload Portal User’s Guide built into the application’s 
help system.
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Vantage Licenses
Vantage licenses enable specific Vantage features or feature sets. All Vantage software 
is available on the Telestream web site. Vantage allows you to download and install 
Vantage software in demo mode without licenses. At your convenience you can 
purchase licenses and add them to Vantage for only those features you need. If you 
need additional features later, you can purchase licenses for additional options. 

Note: Some Vantage programs and features are available only with particular 
Vantage product licenses. To ensure you get the features you want, contact Telestream 
sales for the latest bundling and licensing information.

The following topics introduce the licenses available when this guide was written:

 Transcoding Licenses

 Transcoding License Options

 Workflow Licenses

 Workflow Third Party Integration Licenses

 Vantage Array and System Management

 Vantage TrafficManager for Broadcast

 Vantage TrafficManager for Cable/IPTV

 Vantage Post Producer

 Lightspeed Server

Transcoding Licenses

The transcoding licenses enable specific encoders and packagers. The following are the 
transcoding license configurations:

• Vantage Transcode—Includes Vantage Workflow Designer, SD & HD New Media, 
Edit, VOD, Broadcast Server, IPTV and MXF transcoding format support, and FTP/
Network folder workflow support. Also includes enhanced video processing and 
image sequence monitoring and decoding. 

• Vantage Transcode Pro—Includes Vantage Workflow Designer, SD and HD New 
Media, Edit, VOD, Broadcast Server, IPTV and MXF transcoding format support, and 
FTP/Network folder workflow support. Also includes enhanced video processing 
and image sequence monitoring and decoding.

• Vantage Transcode Connect—Includes Vantage Workflow Designer, SD and HD 
New Media, Edit, and VOD Transcoding Format support. Provides broadcast server 
monitoring, XML metadata transformation and delivery, and Web Service notifica-
tion. Also includes enhanced video processing and image sequence monitoring 
and decoding.
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• Vantage Transcode Pro Connect—Includes Vantage Workflow Designer, SD and HD 
New Media, Edit, VOD, Broadcast Server, IPTV and MXF transcoding format support. 
Includes broadcast server monitoring and delivery, Avid Send to Playback and 
Interplay delivery, XML metadata transformation and delivery, and Web Service 
notification. Also includes enhanced video processing and image sequence moni-
toring and decoding.

• Vantage Transcode Multiscreen—Multiscreen transcoding for Apple HLS, Adobe 
Dynamic Streaming, Microsoft Smooth Streaming, and MPEG DASH. Includes x264 
encoding technology, adaptive bit rate packaging, encryption for DRM and full 
workflow automation. Also includes Vantage Workflow Designer, enhanced video 
processing, TAR creation, FTP/Network folder workflow support, and image 
sequence monitoring and decoding.

• Vantage Transcode IPTV VOD— IPTV and cable VOD transcoding for H.264, MPEG-2 
and MPEG-1 Transport Stream files. Includes Manzanita Systems multiplexing and 
x264 encoding. Also includes Vantage Workflow Designer, enhanced video process-
ing, FTP/Network folder workflow support, and image sequence monitoring and 
decoding.

• Vantage IPTV Pro Lightspeed Bundle—Includes a Lightspeed Server, Transcode 
IPTV VOD, and Transcode Pro Connect.

• Vantage IPTV Multiscreen Lightspeed Bundle—Includes a Lightspeed Server, Trans-
code Multiscreen, and Transcode IPTV VOD.

For information on which encoders and packagers are provided with each license, refer 
to the Telestream Web site: http://www.telestream.net/telestream-support/vantage/
support.htm

Transcoding License Options

Transcode options extend Vantage transcoding capabilities:

• Advanced Avid Integration—Adds advanced Avid integration features to Vantage 
Transcode Pro Connect.  Includes Avid Web Service integration for creating assets 
and adding multiple media versions within Interplay; Avid Media Toolkit encoder 
for creating native AAF and OpAtom MXF files (DNxHD, DV, IMX, and H.264 proxy 
for Interplay); Avid Metadata capabilities for adding timeline locators and descrip-
tive metadata into Interplay, using either TransferEngine or Web Services.

• SpectreView Windows Media Plug-In—Encodes IPV SpectreView compatible Win-
dows Media files and performs sequencing for Vantage transcoding.

• Dolby E Decode Option for Vantage Transcoding

• GraphicsFactory Upgrade—Upgrade that can be added to any Vantage Transcode.  
Includes engine, template creator and submit tool.

• GraphicsFactory Template Creator—Provides node-locked seat of the Graphics Fac-
tory Template Creator, which can be run on a separate computer. Does not have to 
be run on a Vantage server.

• Nielsen Watermarking Option—Adds Nielsen NAES2 Audio Watermarking.
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Workflow Licenses

The workflow licenses enable various features specific to automating media workflows:

• Vantage Analysis—Includes single-file analysis for curtains, letterboxing, telecine, 
black detection, slate/spot detection, macroblocking, Also includes loudness mea-
surement with dialog detection and gating controls for compliance with CALM Act, 
ATSC A/85, BS-1770-2 and EBU R128, and more. Includes PSNR measurement for 
two-file QC analysis, and new Analyze action.

• Vantage Analysis Pro—Includes Analysis features plus QC action, Reporting action, 
and MediaInfo action. 

• Vantage Workflow Portal—The Vantage Workflow Portal allows operators to 
browse assets in the Vantage catalog, construct EDLs, enter metadata, and submit 
jobs to Vantage workflows. Each V-PORTAL license allows one instance of client 
access from any client machine; the total number of licenses in the Vantage data-
base determines how many clients can connect simultaneously.

• Vantage Metadata Conversion—Enables ability to transform XML files, create or 
populate metadata labels, and perform Web Services notification. Includes Web 
Services notification, Populate, Transform, Gather and Archive actions.

• Vantage TrafficManager—Automates processing of national, regional, and local 
commercials by broadcast stations and multiple system operators. This solution 
significantly reduces or eliminates manual media file handling and the associated 
costs in both time and money. 

• Post Producer—Offers a post-production and delivery engine that automates 
repetitive production processes, reducing the load on editors and non-linear edit-
ing workstations. Based on user templates, Post Producer assembles a segment or 
spot, compositing video, graphics, titles and captions or subtitles, and applying 
audio processing as required. Alternate versions are automatically created by sim-
ply substituting the necessary elements.
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Workflow Third Party Integration Licenses
• Screen MediaMate Integration (various models are available)

• DP600 integration—Allows Vantage integration with a Dolby DP600 (not included). 
One connector allows up to four concurrent work sessions (jobs) on the DP600. 

• Tachyon Video Processing—Enables Cinnafilm Tachyon inverse telecine processing 
and standards conversion for up to two GPUs, within Transcode or Transcode Pro. 
Requires Transcode or Transcode Pro, and a Lightspeed Server.

• Civolution integration—Provides watermarking integration with Vantage.

• Digimetrics Aurora Connector—provides QC integration with Vantage workflows 
(requires Transcode or Transcode Pro but does not require an array license).

• Vantage Agility ECS Connector—Allows a Vantage server or array to submit jobs to 
an Agility ECS. License allows connection to one ECS.

• Aspera Faspex integration—Allows integration of Aspera for delivering files to Fas-
pex locations. This connector allows up to four concurrent file transfers.

• Baton Connector—Allows integration of Interra Baton software with Vantage. 
Allows up to four concurrent QC sessions. An array license is not required.

• Signiant integration—Enables Vantage to connect with Signiant servers and inte-
grate their high-speed file delivery capabilities into Vantage workflows. Up to four 
concurrent file transfers across up to four machines are allowed. 

• VidCheck Connector—Allows users to select VidCheck QC as part of the Vantage 
workflow, choose the testing template, and then see the QC results within the Van-
tage interface. The quality control results can be used to select further steps in the 
Vantage workflow. VidCheck not only checks, but also corrects, the most common 
video and audio problems in file-based media. Up to four concurrent file transfers 
across up to four machines are allowed. An array license is not required.
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Vantage Array and System Management

The Vantage Array license allows you to install Vantage services on multiple Windows 
servers, increasing the capacity and reliability of your Vantage domain. Vantage array 
features include the following:

• Redundancy—Multiple Vantage array servers can host the same service, increasing 
the processing capacity of the Vantage domain.

• Session-based load balancing—When a Vantage service is enabled on multiple 
Vantage array servers, individual workflow actions can be executed by any Vantage 
array server that is configured for the supporting service. Action execution is sched-
uled based on CPU availability and priority.

• Priority acceleration for transcoding actions—Vantage servers, both single node 
and arrays, can pause lower priority actions, execute the higher priority action, and 
then resume the lower priority action.

• N+1 failover protection—Vantage array servers communicate with each other and 
can redistribute the workload if a Vantage array server fails. If a job fails to complete 
due to a Vantage array server failure, another Vantage array server restarts the job.

• Support for mirrored Microsoft SQL Server Enterprise databases to provide redun-
dancy and failover protection for the Vantage domain database.

If the current domain is an all-in-one domain, the activation of a Vantage Array license 
changes the Vantage server to a Vantage array server. You can then create a distributed 
domain by adding Vantage array servers. In a Vantage array, every Vantage server is a 
Vantage array server and requires the Vantage Array license.

Additional System Management options to the Vantage Array license are:

• Advanced Task Scheduling—Adds advanced task scheduling to Vantage. Increases 
overall system throughput with less hardware by optimizing server usage based 
upon user-specified task costs and server capacity. In a Vantage array configuration, 
this option must be added to all servers in the array. Array license sold separately.

• Reporting & Analytics—Enables PDF reporting and workflow analytics in Vantage. 
Includes CSV/TXT file Notify plug-in. 

• System Web Dashboard—Web dashboard enables remote visibility of system 
health and status for administrators, and allows array remote maintenance. 
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Vantage TrafficManager for Broadcast

Provides broadcast commercial traffic management workflow capability. Includes 
Transcode Pro Connect features, Analysis features, Traffic Service, BXF and dublist 
notification (the CSV/TXT notification), dublist monitoring, dublist analysis tool, and 
five Workflow Portal licenses. 

Vantage TrafficManager for Cable/IPTV

Provides cable/IPTV commercial traffic management workflow capability. Includes 
Transcode Connect features, Transcode IPTV VOD features, Analysis features, Traffic 
Service, BXF and dublist notification (the CSV/TXT notification), dublist monitoring, 
dublist analysis tool, and five Workflow Portal licenses.

Vantage Post Producer

Post Producer™ automates the post-production editing, composing, and encoding of 
promos, based on a common design template and varying sets of input media. 
Features include the same baseline features as the Transcoder package, input formats 
for Post Producer, output formats for Post Producer, and AN2, TSEDL and 
GraphicsFactory Compose features.

Lightspeed Server

The Lightspeed Server accelerates video processing and x.264 encoding for all Vantage 
Transcode products (Transcode, Pro, and Pro Connect).  Requires Vantage v4.0 or later; 
Server Specs: 1RU server, Dual GPUs, Dual Intel Processors,  Microsoft Windows Server 
OS, and Lightspeed license to enable hardware acceleration.  See the following topic or 
the Lightspeed User’s Guide for more information.
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Lightspeed Server
The Telestream® Lightspeed Server can be added to any Vantage Transcode product to 
accelerate video processing and H.264 transcoding. Lightspeed Server accelerates 
Vantage video and H.264 processing with GPUs and multicore CPUs to provide the best 
image quality in the least amount of time. Housed in an efficient 1 RU server, 
Lightspeed Server reduces rack space, power and cooling requirements while meeting 
increased output capacity needs. 

Lightspeed Server accelerates compute-intensive image processing within Vantage 
workflows, including scaling, deinterlacing, frame rate conversion, motion vector 
calculation, and other tasks that require computation and analysis to modify or create 
new video frames. Faster video preprocessing acceleration benefits the output quality 
of all video output formats.

Your Lightspeed Server comes preconfigured to your order. You can order Lightspeed 
configured as an all-in-one server containing a complete Vantage system and licenses, 
ready to run. You can also order a Lightspeed Server or multiple servers with various 
Vantage components and licenses installed, ready to network together to create a 
Vantage array. 

For more information about the Lightspeed Server, see Lightspeed Server on the 
Telestream Web site. 

Processing Live and Tape Feeds from Pipeline
Using a Telestream Pipeline encoder as part of your Vantage system, Vantage can ingest 
live or tape feeds into Vantage workflows. Combining Pipeline’s baseband capture with 
a Vantage system, you can create high-quality real-time or near real-time output in any 
format supported by Vantage. 

For example, you can simultaneously create high-res files for storage while creating a 
low-res proxy, or create any number of additional file formats in real-time or near real-
time. File processing begins immediately while ingesting the captured media, saving 
you time and money. Pipeline also preserves important metadata, such as ancillary 
data, throughout your transcoding workflow. Pipeline encoder channels allows for a 
high degree of scalability and flexibility.

For more information about utilizing Pipeline in Vantage workflow see Using Vantage 
Publish within Pipeline Control on the Telestream Web site. 
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Topics in this Guide
The following topics introduce the major topics in this guide:

• The Before You Install topic discusses Vantage requirements that should be 
addressed before you install your domain. This topic discusses hardware, operating 
system, software, and network requirements, as well as guidelines for planning 
your installation. Your Vantage domain installation will proceed more efficiently if 
you familiarize yourself with all the content in this topic.

• The Installing and Upgrading Vantage topic discusses how to install all-in-one 
domains and Vantage arrays, and how to install additional applications such as the 
Vantage client programs, Vantage Web Applications, and Vantage Workflow Portal. 
Additional topics describe how to upgrade Vantage and how to move a Vantage 
domain database.

• The Using the Vantage Management Console topic discusses how to start and use 
the Vantage Management Console.

• The Managing a Vantage Domain topic discusses how to use the Vantage Manage-
ment Console to manage domain administrative features such as licensing and 
load balancing.

• The Supporting Workflow Design and Operation topic discusses how to use the Van-
tage Management Console to manage the Vantage components used by workflow 
designers. These components include workflows, media nicknames, binders, and 
workflow analytics.

• The Configuring Job Status Views Operation topic discusses how to use the Vantage 
Management Console to configure support for the Vantage JSV Web application. 
Before Vantage operators can use JSV, the Vantage administrator must configure 
support as described in this topic.

• The Configuring Vantage Workflow Portal Operation topic discusses how to use the 
Vantage Management Console to configure support for the VWP client. Before Van-
tage operators can use the VWP, the Vantage administrator must configure support 
as described in this topic.

• The Managing Dublists topic explains how to configure the Dublist Portal. 

• The Monitoring the Domain with Vantage Dashboard topic discusses how to use 
the Vantage Dashboard Web application to view domain status at the domain, 
server, service, and job levels. This topic also describes how to use Vantage Dash-
board controls to do tasks such as take services and servers offline, reset statistics 
counters, stop jobs, and change action priority.

• The Removing Vantage Software topic discusses how to uninstall Vantage products 
from servers and workstations, and how to remove the database and database files.

• The Glossary topic defines terms used in Vantage product documentation.
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Before You Install
Use this topic to understand the hardware, software, database, and network 
requirements before performing an installation. You’ll also learn about Vantage 
installers, how to obtain a Vantage license, and some distributed Vantage domain 
planning advice – this topic is about what you need to know before you install a 
Vantage domain.

Installing Vantage is easiest when you plan carefully, and you have a working 
knowledge of Windows server administration, networking, Microsoft SQL Server, and 
installation and configuration of enterprise-level software. Consult your IT group for 
assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to 
browse the Vantage Web library, user’s guides, patches, application notes, and other 
documents.

The following topics provide information you should consider when planning a 
Vantage installation:

 Server Hardware Requirements

 Operating System Requirements

 Third-Party Software Requirements

 Network Requirements

 Database Selection and Configuration Guidelines

 Vantage Installers Overview

 Licensing Overview

 Planning for a Vantage Array Installation

http://www.telestream.net/telestream-support/vantage/support.htm


Before You Install
Server Hardware Requirements

46
Server Hardware Requirements
Vantage is optimized for dual quad-core Intel and Intel-compatible processors that 
support Windows operating systems. The following topics provide more information 
on Vantage server hardware requirements:

 Vantage Server Requirements

 Database Server Requirements for SQL Standard

 Disk Space Requirements

Vantage Server Requirements
Vantage server requirements depend on which domain components (services, media 
files, and database) are installed on the server, as well as how much media you plan to 
store on the server. Table 4 lists the hardware requirements for servers that host 
Vantage and SQL Express database services.

Table 4. Vantage Server Hardware Requirements

Hardware Requirements

Processor Dual quad-core processors; 4MB cache recommended. A 64-bit 
processor computer should be used for best performance.

RAM At least 4GB RAM recommended, depending on the number of 
concurrent transcode sessions desired. More than 4GB is 
recommended when running a 64-bit operating system.

Disk space All-in-one installations: 500 GB; approximately 100 MB for 
Vantage services and clients, approximately 500 MB for the 
Transcode and Analysis Engine, and approximately 400 GB for 
the Vantage store media and database. The initial database size 
is approximately 100 MB.

For more information, see Disk Space Requirements.

Ethernet/Fibre All-in-one installations: Gigabit Ethernet (GbE / 1 GigE) 
minimum. (Dual Ethernet may be needed in some situations). 

Vantage arrays: Gigabit Ethernet (GbE / 1 GigE) minimum. 
Recommend dual bonded Ethernet or 10GigE. The Vantage 
domain database and all Vantage services should be on the 
same subnet.

Numeric Processing 
Instruction Set

 MMX, SSE, and SSE2 enabled.
Vantage Domain Management Guide



Before You Install
Server Hardware Requirements

47
Database Server Requirements for SQL Standard
Telestream recommends using a dedicated database server for high-traffic Vantage 
arrays that use SQL Standard. The requirements for SQL Standard differ from those for 
SQL Express. Table 5 lists hardware requirements for servers that host SQL Standard.

Note: The computer name of the server hosting the principal Vantage domain 
database is used as the Vantage domain name. Telestream recommends providing a 
computer name that is appropriate to your Vantage installation. For example: Vantage 
or VantageDB.

Note: Vantage may have difficulty decoding MPEG2 or H.264 video when running on 
a server with more than 32 cores (or 16 hyperthreaded cores). This does not include 
certain MOV wrapped H.264 files. Symptom: the job hangs at 0 percent.
To solve this problem, host the Transcode service on servers with 32 cores or less, or 
turn off hyper-threading in the BIOS.

Note: Telestream recommends utilizing a Gigabit Ethernet or Fibre-Channel for 
connecting Vantage servers and connecting to media stores to improve performance.

For more guidelines on database installation in a Vantage domain, see Database 
Selection and Configuration Guidelines.

Table 5. Database Server Recommendations (With or Without Vantage)

Configuration Recommendations
Processor Dual quad-core processors; 4MB cache recommended. A 

64-bit processor computer should be used for best 
performance.

RAM • Recommended: minimum 8 GB RAM
• Preferred: 32 GB RAM

Disk space All-in-one installations: 30 GB

Array database servers:

• Minimum 300 GB drive space for the database.
• Recommend: 2 physical hard drives or RAID arrays, one 

for the OS, and one for SQL and the database files.

For more information, see Disk Space Requirements.
Ethernet/Fibre Gigabit Ethernet (GbE / 1 GigE) minimum. Recommend 

dual bonded Ethernet or 10GigE. The Vantage domain 
database and all Vantage services should be on the same 
subnet.

Numeric Processing 
Instruction Set

 MMX, SSE, and SSE2 enabled.
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Disk Space Requirements
A Vantage domain requires disk space for the following:

• Vantage services

• Vantage domain database

• Vantage input and output files

Compared to the storage needs for the database and input and output files, the 
Vantage services and clients require relatively little disk space (approximately 100 MB). 
The disk space requirements for a Vantage domain database are listed in Table 4 and 
Table 5, and additional database guidelines are provided in Database Selection and 
Configuration Guidelines.

The disk space required for the input and output files depends on the size of the files 
and how long the files are stored. In a Vantage store, files related to a specific job are 
deleted when the job expires or the job is deleted by a user. 

For Vantage all-in-one installations, the disk space requirements listed in Table 4 should 
be sufficient for all Vantage services, client applications, the database, and the input 
and output files. However, it is a good practice to monitor disk usage after installation 
and at periodic intervals to determine if the available disk space is appropriate.

For Vantage arrays, some form of centralized storage must be used for media files. The 
centralized storage, which might be a SAN, a NAS, or a network share, is required so 
that all Vantage services and clients can access the files. To determine the storage 
needed for input and output files, evaluate the expected media file size and storage 
duration, and add sufficient disk space. The recommended disk space listed in Table 5 is 
for the database only; media file storage is not included. If media files are added to the 
database server, they should be stored on a different drive than the database to 
prevent resource contention.
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Operating System Requirements
The following topics describe the operating system requirements for Vantage 
components:

 Vantage Web Applications OS

 Vantage Client Software OS

 Vantage Services, Domain Database, and MS SQL Server OS

Vantage Web Applications OS
Vantage Web Applications should be installed on an IIS server running on the same 
subnet as the Vantage domain database, so that the Web applications can auto-
discover the Vantage domain. To improve the performance of Vantage Web 
Applications and Vantage services, place the Vantage Web Applications on a dedicated 
server, separate from the Vantage domain database and Vantage services. The 
following list ranks the possible Vantage Web Application configurations from most 
preferred (#1) to least preferred:

1. Dedicated Vantage Web Application server.

2. Vantage Web Applications installed on a Vantage domain database server that 
does not host Vantage services.

3. Vantage Web Applications installed with the Vantage domain database and 
Vantage services on the same server (includes all-in-one domains).

Vantage Web Applications should only be installed and operated on the following 32-
bit or 64-bit operating systems:

• Windows Server 2008 R1 (32-bit|64-bit) + IIS 7 + .NET Framework 4.0

• Windows Server 2008 R2 (64-bit only) + IIS 7 + .NET Framework 4.0

Note: Windows XP Pro SP3 and Windows Server 2003 remain valid operating systems 
for Vantage clients but are no longer recommended for Vantage 6.0 system 
installations. Please contact Telestream Support for additional information and 
assistance.

Microsoft IIS must be installed with ASP.NET and IIS 6 Management Capability installed.

Note: For information on Vantage Web application browser requirements, see 
Vantage Web Applications Browser Requirements.
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Vantage Client Software OS
Vantage client programs (Vantage Management Console, Vantage Workflow Designer, 
and Vantage Workflow Portal) may be installed and run directly on a Vantage server, or 
on client workstations.

Note: Telestream recommends installing Vantage client programs only on users’ 
workstations (not directly on Vantage servers) when there are three or more Vantage 
servers and over 500 jobs routinely in the Vantage domain database.

Vantage client programs are supported on the following operating systems:

• Windows 7 and 8

• Windows Server 2003 R2, 2008 R1 and R2, 2012

• Windows Vista

• Windows XP Pro SP3

Note: To effectively operate Vantage services and their client programs in an array, 
and with other networked systems, you must disable the Windows Firewall and 
upgrade all systems to the latest Microsoft service packs and security updates.

For Windows Server 2008 R2, Telestream recommends that you set the Windows theme 
to Windows 7 Basic to ensure proper display of the client programs. This theme is only 
available when Desktop Experience is installed (see Install the Desktop Experience). 

Note: If you do not install Desktop Experience, Vantage Windows clients are 
displayed using the Windows Classic theme, which may result in functional limitations. 
Additionally, you may not be able to preview media files in the Vantage binder 
Preview window in both the Management Console and the Workflow Designer. 
However, in a binder you can still right-click a file, select Open Containing Folder to 
access the file in Windows, and double-click the file to play it. 

If you connect to the server using a Remote Desktop Protocol (RDP) product, you must 
install the Desktop Composition role feature to make the Windows 7 Basic theme 
available: Server Manager > Roles > Remote Desktop Services > Remote Desktop 
Session Host > Desktop Composition. 

Once Desktop Composition is installed, the Desktop Composition po licy must be 
enabled: Local Policy Editor > Computer Configuration > Administrative Templates > 
Windows Components > Remote Desktop Services > Remote Desktop Session Host > 
Remote Session Environment > Allow Desktop Composition for remote desktop 
sessions > Edit Policy Setting > Enable. 

Note: If you cannot install or enable Desktop Composition because needed options 
are grayed out, group policies set by your IT administrator may be preventing access. 
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Vantage Services, Domain Database, and MS SQL Server OS
Vantage services, the Vantage Domain Database, and the MS SQL Server for Vantage 
should be installed and operated only on the following 32-bit or 64-bit operating 
systems (64-bit recommended for performance):

• Windows Server 2008 R2 (Recommended, 64-bit only)

• Windows Server 2008 R1 (32-bit | 64-bit)

Windows Server 2008 Requirements
The following topics describe additional Vantage requirements for the Windows Server 
2008 operating system:

 Use Windows Installer 4.5 or 5.0

 Install the Desktop Experience

 Understand User Account Control Admin Approval Mode

 Enable Computer Browser Service

Use Windows Installer 4.5 or 5.0

Windows servers hosting a Vantage domain database must be updated with Windows 
Installer 4.5 or 5.0, the application installation and configuration service for Windows, 
before installing the Vantage domain database. Windows Installer 5.0 is provided with 
Windows Server 2008 R2. To obtain the Windows 4.5 Installer, go to Microsoft’s 
Download Center Windows Installer 4.5 page. Review the requirements, download the 
appropriate installer, and install it on your server(s) before continuing.

Install the Desktop Experience

Prior to installing Vantage, the Microsoft Desktop Experience must be installed (except 
on dedicated database servers). The Desktop Experience feature provides a variety of 
Windows 7 features on your server running Windows Server 2008. These features 
include the ability to display the Windows 7 Basic theme, which is recommended for 
displaying Vantage client windows. Follow these steps to install Desktop Experience.

1. Click Start > Administrative Tools > Server Manager.

2. In the console tree, click Features, then click Add Features.

3. Check Desktop Experience and click Next.

4. Follow the steps to complete Desktop Experience installation.

5. When installation is complete, restart the server when prompted to do so.

6. After restarting, open Services and double-click Themes (or right-click Themes and 
select Properties) to open the Themes service Properties configuration window. 

7. Change Startup type to Automatic, and click OK.

8. Restart the server again. (The Themes service must be set to automatic startup and 
the computer restarted for the Windows 7 Basic theme to be made available.)

9. After restarting, right-click on the Desktop and select Personalize.

10. Select the Windows 7 Basic theme and close the Personalization window.
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Understand User Account Control Admin Approval Mode

If User Account Control: Run all administrators in Admin Approval Mode is enabled, run 
installers by right-clicking the installer and selecting Run as Administrator. If this feature 
is disabled, you can run the installer normally. 

To verify the setting value (Enabled | Disabled):

1. Display the command window (Start > Command Prompt).

2. In the command window, type secpol.msc and press Enter.

3. In the Local Security Policy window, select Local Policies > Security Options. In the 
Policy column, find User Account Control: Run all administrators in Admin Approval 
Mode and view the Security Setting.

Enable Computer Browser Service

Although set by default on the standard distribution of Server 2008, ensure that the 
Computer Browser service is enabled by doing the following:

1. In Windows, display the Services Control Panel.

2. If the Computer Browser service is set to disabled, right-click and open the 
Properties window.

3. On the General tab > Startup type, select Automatic and click OK.

4. Start the service.

Power Options Settings

All Vantage servers should be set to High Performance in the Power Options Control 
Panel. This ensures that the network interface cards never sleep, which is desirable to 
ensure all Vantage servers remain in communication with each other all the time.

1. In Windows, display the Control Panel folder.

2. Search for Power Options. 

3. Click Power Options, and select High Performance.

4. Close the Control Panel.
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Third-Party Software Requirements
The following topics describe Vantage software requirements and recommendations 
for third-party products:

 QuickTime Requirements

 .NET Framework Requirements

 Anti-Virus Software Recommendations

CAUTION: If you do not install/upgrade all required software, Vantage may not 
operate correctly.

QuickTime Requirements
The Telestream Media Transcode and Analysis engine requires QuickTime if you plan to 
transcode QuickTime files. Obtain the free QuickTime installer from Apple.com here: 

http://appldnld.apple.com/QuickTime/041-0025.20101207.Ptrqt/
QuickTimeInstaller.exe. 

Note: If you do not install the Telestream Media Transcode and Analysis engine 
version that is supplied with the Vantage installer, be sure to install the QuickTime 
version that is recommended for the version you are installing.

The Vantage Setup installer checks for QuickTime. If it is not installed in the default 
directory, the installer alerts you that QuickTime is not installed or up to date.
After installation, be sure to uncheck Check for Updates, so that this version is not 
updated without your knowledge, then restart the server.

If you do not install the correct QuickTime version, encoding some formats causes this 
error: “An error occurred during execution of the Transcode Task: RenderSession 
Configuration Error, message: Requested encoder | decoder not installed.”
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.NET Framework Requirements
Vantage requires .NET Framework 3.5 Service Pack 1 on all servers that host the Vantage 
domain database, Vantage services, or Vantage client programs. All workstations that 
run Vantage client programs must also run .NET Framework 3.5 Service Pack 1. If it is not 
present, the Vantage installer will notify you that .NET 3.5 is missing and will quit. You 
must then download and install .NET 3.5 before attempting to install Vantage again.

Vantage Web Applications require .NET Framework 4 on the IIS server. If it is not 
present, the Vantage installer will install it and continue with the Vantage installation.

Note: Microsoft .NET Framework 3.5 Service Pack 1 and .NET Framework 4 provide 
different services and can both be installed on the same server. Microsoft .NET 
Framework 4 does not provide all the services provided in .NET Framework 3.5 Service 
Pack 1, so both applications must be present on Vantage servers.

Install the .NET Frameworks as follows:

• For Windows Server 2008 R2, install .NET 3.5 SP1 directly from Server Manager > 
Features.

• For Windows XP, Server 2003 and 2008 R1, download .NET 3.5.1 from Microsoft and 
install it.

• To install .NET 4, simply run the Vantage_6.0_Setup.exe installer, which will install 
.NET 4 automatically before installing the Vantage applications.

Note: Install Microsoft hotfix KB2183292 for .NET 4.0. Without this hotfix, .NET 4.0 fails 
when sending emails with attachments larger than 3 MB. This appears in Vantage 6.0 
as a Vantage mail service SMTP error. The hotfix resolves the problem.

Anti-Virus Software Recommendations
Telestream recommends that you do not use anti-virus software on Vantage servers. 
You should not enable real-time scanning. If you do use anti-virus software, you should 
identify Vantage as a safe or trusted application. Telestream recommends that you 
disable real-time file scanning, because it will impact performance and potentially lock 
files being processed, impacting Vantage’s ability to operate properly.

Note: Be sure to turn off anti-virus software during Vantage installation or install the 
anti-virus software after you install Vantage.
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Network Requirements
The following topics provide information on Vantage network requirements and 
guidelines:

 IP Address Requirements

 Port Requirements

 Firewall Guidelines

 Windows Authentication Guidelines

 Time Synchronization Guidelines

IP Address Requirements
Telestream recommends using static IP addresses for all machines within a Vantage 
domain. This is especially important when the network does not have a DNS server.

In a Vantage array installation, Telestream recommends that you install the Vantage 
domain database, Vantage services, and client programs in the same subnet to avoid 
communication issues. Within Vantage client and web applications, the service 
discovery feature automatically discovers all Vantage domains within a subnet. If you 
must access a Vantage domain from outside the subnet that hosts the Vantage domain 
database, you can use a DNS host name or IP address to specify the domain.

Port Requirements
Vantage services are preconfigured with default TCP port numbers for network 
communications. To enable communications between Vantage components, you must 
ensure that there are no port number conflicts between the applications on each 
Vantage server. Table 6 lists the default port numbers used by Vantage services. For 
additional port numbers, see Firewall Guidelines.

Note: For instructions on viewing or changing the default port settings, see 
Configuring Vantage Services.
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Table 6. Default Port Numbers for Vantage Services

Vantage Service Ports

Agility HTTP: 8678, TCP: 8679

Analysis HTTP: 8672, TCP: 8673

Aspera HTTP: 8700, TCP: 8701

Aurora HTTP: 8688, TCP: 8689

Baton HTTP: 8702, TCP: 8703

Catalog HTTP: 8664, TCP: 8665

Communicate HTTP: 8662, TCP: 8663

Edit HTTP: 8698, TCP: 8699

IPTV VOD HTTP: 8696, TCP: 8697

MediaMate HTTP: 8684, TCP: 8685

Metadata HTTP: 8674, TCP: 8675

Monitor HTTP: 8658, TCP: 8659

Multiscreen HTTP: 8682, TCP: 8683

SDK HTTP: 8676, TCP: 8677

Signiant HTTP: 8708, TCP: 8709

Staging HTTP: 8686, TCP: 8687

Traffic HTTP: 8680, TCP: 8681

Transcode HTTP: 8670, TCP: 8671

Transport HTTP: 8660, TCP: 8661

VidChecker HTTP: 8704, TCP: 8705
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Firewall Guidelines
Telestream recommends that you disable the Windows Firewall on all computers that 
will communicate with or support Vantage services. The default Windows Firewall 
configuration will block access to a Vantage server from other Vantage components, 
such as other Vantage servers or workstations running Vantage client software.

If you must run a firewall, keep in mind that Vantage communicates with the following 
systems/component ports, which should be considered when configuring firewall 
settings:

• Agility ECS Connection—TCP: 80. Note: this default value is configured on Vantage 
servers as described in Configuring an Agility ECS Connection.

• Avid Interplay (Unity Client, Transfer Engine, Web Services)—Discovery: UDP port 
8321. For other ports, see Avid documents including Interplay Admin Guide and 
Avid Interplay Software Installation and Configuration Guide.

• FTP (Passive mode)—TCP: 20, 21. Custom FTP port numbers can be entered in Van-
tage workflows. Also, FTP uses additional port numbers as specified in the protocol 
specifications. Refer to the protocol specifications for additional information.

• Grass Valley AMP—Port 3811 by default.

• Harris NEXIO—TCP: 2098.

• HTTP—TCP: 80.

• Microsoft Distributed Transaction Coordinator (DTC)—User configurable; default 
port: 3372 when TIP is enabled. See Microsoft documentation for details.

• Microsoft SQL Server—TCP ports: 1433 and 49150–49300, UDP port: 1434—see 
Microsoft documentation for details.

• Server Message Block (SMB)—TCP: 137–139, 445, UDP: 137–139, 445.

• SFTP—TCP: 22. Custom SFTP port numbers can be entered in Vantage workflows. 
Also, SFTP uses additional port numbers as specified in the protocol specifications. 
Refer to the protocol specifications for additional information.

• SMTP—TCP: 25. Note: this default value is configured on Vantage servers as 
described in Configuring Vantage Email Notifications.

• Vantage service ports listed in Table 6.

• WS-Discovery—TCP: 46123, UDP: 3702.

Note: The third-party port numbers mentioned above are listed for your convenience 
and, due to the scope and variety of server products available, this list is not complete. 
Port numbers utilized by third-party products are obviously beyond control of 
Telestream; they change over time, and some are user or runtime configurable. Please 
contact each product’s vendor for additional port usage details.
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Windows Authentication Guidelines
By default, Vantage services use the Windows Local System account when accessing file 
space for media storage and delivery. When all Vantage services, clients, and delivery 
targets are on one server, the default configuration works well. When any Vantage 
service, client, or delivery target is on another computer, Windows authentication 
requirements must be met to enable communication between multiple computers.

The following topics provide additional authentication guidelines:

 About Vantage Windows Authentication

 Configuration Guidelines for the Vantage Windows User Account

 Configuring Folders for Vantage Access

About Vantage Windows Authentication
A Vantage domain requires authentication planning when workflows require Vantage 
to ingest media from or send media to another computer. For remote file access, use 
the following guidelines:

• Configure each Vantage service that accesses files on another server to use a Win-
dows log on ID and password. For example: VantageWinUser.

• Configure each remote storage folder to support access from the log on ID for Van-
tage services.

• If the same service operates on multiple Vantage servers, and requires access to 
files at a remote location, configure the same log on ID and password for all 
instances of that service. 

For example, if the Transcode service is running on three servers, it operates as one 
Transcode service with three instances or nodes. Vantage requires that every Van-
tage node within a service use the same log on ID. 

Note: When a service is comprised of multiple nodes, the Local System account, 
which is the default log on ID for all-in-one installations, cannot be used because it 
represents a different user on each system.
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Configuration Guidelines for the Vantage Windows User 
Account
To support Vantage service access to other Vantage servers and file folders on other 
computers, Telestream recommends that you create a Vantage user account within the 
Windows domain or workgroup. To distinguish the Vantage Windows user account 
from regular Vantage user accounts, use a name that indicates that this is a Windows 
user account. For example, VantageWinUser. 

Your Windows domain or workgroup administrator can configure the Vantage 
Windows user account before Vantage installation. When configuring this account, 
consider the following guidelines:

• The Vantage Windows user account should be added to the local administrator 
group on each server so that Vantage has the proper authority to run Vantage ser-
vices and install Vantage software.

• The Vantage Windows user account must be authorized to log on as a service (see 
your Windows domain or workgroup administrator), so that Vantage services can 
log on as the Vantage Windows user on each Vantage server.

• The Vantage Windows user account should have appropriate read and write per-
mission to network locations that Vantage will access. These network locations 
include the Vantage store and input and output storage locations.

• You can use the Vantage Windows user account to install the Vantage software.

For instructions on configuring services to use the Vantage Windows user account, see 
Setting the Vantage Windows Log On ID for Services.

Configuring Folders for Vantage Access
Vantage servers and clients may need access to folders on other computers for any of 
the following:

• Input of files in Watch folders

• Manual submission of input files

• Storage of output files for future Vantage use

• Delivery of output files to remote destination folders

The following topics describe how to configure folders for Vantage use:

 Configuring Folder Access Within the Windows Domain or Workgroup

 Configuring Folder Access Outside of the Windows Domain or Workgroup

 Configuring Access to a SAN System

Note: Vantage cannot access network locations defined using a Windows mapped 
drive. You must use a universal naming convention (UNC) path to define network 
locations for Vantage use.
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Configuring Folder Access Within the Windows Domain or Workgroup

If you create a Vantage Windows user account as described Configuration Guidelines for 
the Vantage Windows User Account, granting Vantage access to any folder within the 
domain is as simple as granting access to the Vantage Windows user. If Vantage 
workflow designers, operators, or administrators also need access, grant folder access 
to their Windows user names.

Configuring Folder Access Outside of the Windows Domain or Workgroup

When Vantage needs to access computers in a different Windows domain or 
workgroup, the Windows log on ID from the current domain or workgroup is not 
accepted. To support Vantage service access, you can configure a Vantage 
authorization record as described in Specifying Authorization Credentials for Remote 
Folder Access.

Configuring Access to a SAN System

When you want to access files in a SAN system, be aware that some systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. Although Vantage cannot reference a Windows mapped drive, you can 
reference SAN drives via a drive letter, provided that each Vantage server is a client of 
the SAN and that all mount points use the same letter.

Time Synchronization Guidelines
When a Vantage domain includes multiple servers and workstations, you should verify 
that all the computers are set to the same regional settings and the correct time zone. 
Otherwise, the timestamps associated with Vantage events may display incorrectly and 
time-driven events might not occur on schedule. When checking the time 
configuration in the Vantage domain, be sure to check the configuration on the 
following:

• All servers with Vantage services

• All Vantage domain database servers

• All Vantage web hosts

• All file servers that support Vantage stores and folders

• All workstations that run Vantage Workflow Designer, Vantage Workflow Portal, and 
Vantage Management Console (VMC)

Network time protocols on your network should keep the time within tolerances, as 
long as you correctly configure the following:

• The time zone for each server or workstation should be correct for the respective 
time zone.

• Any adjustment for daylight savings time should be consistent on all servers and 
workstations within the same time zone.
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Database Selection and Configuration Guidelines
Vantage is supported on the following database systems:

• Microsoft SQL Server 2008 R1 SP2 Express

• Microsoft SQL Server 2008 R1 SP2 Standard

• Microsoft SQL Server 2008 R2 Standard

Telestream recommends the following database installation configurations:

• All-in-one single node domain with SQL Server 2008 R1 SP2 Express

• All-in-one single node domain with SQL Server 2008 R2 Standard

• Array with SQL Server 2008 R2 Standard

If your Vantage installation requires an all-in-one single node domain, you can choose 
between SQL Express and SQL Standard. If your installation requires an array, 
Telestream recommends SQL Standard. The following topics provide guidelines for 
choosing a database and for implementing a database:

 Guidelines for Selecting SQL Express or SQL Standard

 Guidelines for an All-In-One Installation with SQL Express

 Guidelines for an All-In-One Installation with SQL Standard

 Guidelines for an Array Installation with SQL Standard

 Tips for Improving Performance on Non-Dedicated Servers

 Improving Availability with Mirroring

Note: You cannot use database utility programs to move a Vantage domain database 
of one version to a later version of Vantage. To upgrade Vantage, only use Vantage 
installers, as described in the upgrade instructions (see Upgrading from the Previous 
Version).

Guidelines for Selecting SQL Express or SQL Standard
The decision about whether to use SQL Standard instead of Express should consider 
your planned maximum database size and the expected average volume of database 
traffic. The following topics provide information that can help you choose which 
database system to use:

 Database Size Guidelines

 Database Traffic Guidelines

 SQL Express Limitations

 SQL Standard Limitations
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Database Size Guidelines
The size of the database is generally related to the number of jobs in a database. Each 
workflow record stores its entire job history, which means that simple workflows (such 
as a basic transcode) require less database space for each job than complex workflows 
(such as those involving decision-making or multiple steps).

As a rule of thumb, if you plan to store more than 500-1,000 jobs in your Vantage 
domain database at the same time—either running or in job history—use SQL 
Standard.

Database Traffic Guidelines
Several factors affect the volume of database traffic. While there is no single rule for 
when you should use SQL Standard, the following factors may influence your decision:

• The number of actions in current jobs. If you often have more than 50-100 actions 
running simultaneously, you may improve performance by using SQL Standard.

• Array installations (such as a 3-node Vantage Array) are designed for high job 
throughput and may often have more than 50-100 actions running simultaneously. 
SQL Standard is recommended for arrays where high volumes of media are submit-
ted for concurrent processing.

• High Use of Web Applications. If you have more than three Web clients accessing 
Vantage simultaneously, or if you have more than 100 jobs in the job history view, 
consider using SQL Standard to improve client performance.

• Workflow Analytics (provided with Vantage System Management) typically requires 
SQL Standard, especially if you have more than 50-100 jobs in the database.

Note: Domains with database mirroring require SQL Standard. Database mirroring is 
not available when using SQL Express.

SQL Express Limitations
SQL Express has the following limitations:

• Database Size, SQL 2008 Express: 4 GB

• Maximum RAM Usage: 1 GB RAM

• Number of CPUs: 1 CPU 

SQL Standard Limitations
SQL Standard has the following limitations:

• No size limit for database

• Maximum RAM Usage: 64 GB RAM usage

• Number of CPU Threads: 4 CPUs
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Guidelines for an All-In-One Installation with SQL Express
An all-in-one installation with SQL Express supports all Vantage features up to the limits 
imposed by SQL Express.

When installing an all-in-one domain with SQL Express, ensure that the database 
requirements do not exceed the limits of SQL Express (see Guidelines for Selecting SQL 
Express or SQL Standard) and that the server hardware meets the requirements 
described in Vantage Server Requirements.

Guidelines for an All-In-One Installation with SQL Standard
When your installation requires the additional features and performance provided by 
SQL Standard, SQL Standard may compete for system resources (CPU activity and RAM) 
with Vantage media file transport, analysis, and transcoding services. Both SQL 
Standard and Vantage services can require a significant amount of network traffic.

When installing an all-in-one single node domain with SQL Standard, ensure that the 
server hardware meets the requirements described in Vantage Server Requirements. 
For optimum Vantage performance, install SQL Standard and the database on a 
dedicated physical drive or RAID array, separate from the operating system, the 
Vantage store, and the input and output files. For performance improvement 
suggestions, see Tips for Improving Performance on Non-Dedicated Servers.

Guidelines for an Array Installation with SQL Standard
For high traffic installations, Vantage performance improves when you use SQL 
Standard and separate the database from other services such as the operating system 
and Vantage services. The following guidelines provide increasing levels of 
performance improvement:

• Place SQL Standard and the database on a dedicated server, separate from Vantage 
services, the Vantage store, and the input and output files. This approach provides 
the largest increase in performance.

• Place the Vantage database files on a dedicated physical drive or RAID array, sepa-
rate from the operating system.

• Place the database on a dedicated server, and use dedicated drives as follows:

– Dedicated physical drive or RAID array for the operating system.

– Dedicated physical drive or RAID array for the Vantage database files.

Note: Installing a Vantage domain database on a separate server does not require an 
extra Vantage license for that server.

When installing a Vantage array with SQL Standard, ensure that the server hardware 
meets the requirements described in Database Server Requirements for SQL Standard. To 
improve database availability, see Improving Availability with Mirroring. 
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Tips for Improving Performance on Non-Dedicated Servers
When installing the Vantage domain database on a non-dedicated server, consider the 
following performance improvement guidelines:

• If you are using SQL Standard, place SQL Standard and the database on a dedicated 
physical drive or RAID array, separate from the operating system and Vantage ser-
vices.

• Limit the number of concurrent Transcode/Analysis tasks on the server to ensure 
that adequate CPU and network resources are available for the database.   This can 
be done by configuring the relevant services in the Vantage Management Console.

• In an array, limit the number of concurrent transport actions on the server to ensure 
that adequate network resources are available for database access.

• Limit the typical size of processed media files to less than 1GB.

• Limit CPU processing for the Transcode and Analysis services to 75% by restricting 
the number of jobs that are performed. This can be done by configuring the Trans-
port service in the VMC.

• Limit Transport actions within a workflow to the transport of one large file (>1GB) 
at a time. This can be done by using the VMC to configure the Transport service to 
allow only one session at a time.

• To limit the resources used by Vantage services, set service limits to a low number. 
For more information, see Managing Services.
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Improving Availability with Mirroring
Telestream supports mirroring for SQL 2008. Database mirroring can prevent Vantage 
domain interruption if a single database server fails. A mirrored database requires the 
following physical servers:

• A dedicated server to host the principal database

• A dedicated server (of similar capability to the principal database server) to host the 
mirror database

• An optional dedicated server to host the witness server. 

The witness database is a lightweight service which can run effectively on a low-end 
server, but cannot be installed on a database server.

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Note: Telestream strongly recommends using a dedicated server for the witness 
server to ensure uninterrupted operation in case of a database failover. If the witness 
server function is placed on a server with Vantage services, transcoding can consume 
too many resources and prevent timely database switchover.

Microsoft SQL Server Standard Client Access Licenses (CALs) are required for the 
principal and optional mirror servers. The witness server can use SQL Express, which 
does not require a license.

Note: CAL is an acronym for Client Access License, offered by Microsoft for their SQL 
Server products. There are two types of CAL’s: A device CAL allows any number of users 
to gain access to licensed server software from a particular device, and a user CAL 
allows a particular user to gain access to licensed server software from any number of 
devices. For example, a customer with fifteen Vantage nodes requires one CAL per 
node. Additionally, if the Vantage Workflow Portal is deployed for use, a CAL for each 
connection is required.
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Vantage Installers Overview
The following topics introduce the Vantage installers:

 Obtaining the Vantage Installer

 Vantage Installation Package

Note: The Vantage installer on CD-ROM is available upon request. Contact 
sales@telestream.net to request a CD-ROM.

Obtaining the Vantage Installer
The Vantage installer is available from Telestream’s Web site. To locate and download 
the Vantage installer, follow these steps:

1. Use your Web browser to go to dynamic.telestream.net/downloads/download-
vantage.asp?prodid=vantage.

2. If you do not have a Telestream account, click Create an Account to display the 
Create a Telestream Account page. Fill out the form and click Create Account. You 
can use your user name and password immediately. Telestream will send you a 
confirmation email.

3. On the login page, enter your authorized user name & password, then click Log In.
4. On the Downloads page, click Download Now to download the Vantage installer 

package.
Select a folder (or desktop) destination and click Save to download and save the zip 
file on your computer. The zip file is named Vantage_x.x.x.zip. For example: 
Vantage_6.0.0.zip.

5. The Download Progress window displays as the file is downloaded to your 
computer. When the download is complete, close the Web browser.

6. Right-click the Vantage installer zip and select Extract All. Follow the steps to 
extract the installers and related files.

The main Vantage installer is Vantage_6.0_Setup.exe and other installers may be 
provided to allow installing of individual components. Note that installer files may 
include a build number in the file name, as indicated by the x’s in this example: 
Vantage_6.0_Setup_xx.xx.xxx.xxxxx.exe.
Also included:

• Vantage Patch installers as necessary

• Release Notes

• Vantage Domain Management Guide (this document).

Later, you’ll use these installers to install Vantage as directed.
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Vantage Installation Package
The installation package includes the following installers:

 Vantage Setup Installer

 Vantage Database Setup Installer

 Vantage Client Installer

 Vantage Web Applications Installer

 Vantage Web Upload Portal Setup Installer

Vantage Setup Installer
The Vantage Setup installer (Vantage_6.0_Setup.exe) is the main Vantage installation 
program. It installs all of the server software and all of the clients except for Web 
Applications. When you use it to install Vantage programs and services (using 
VantageSetup), you can choose an all-in-one Single Node installation or an Array node 
installation. Choose Single Node to install all components on a single server. Choose 
Array Node if you are installing selected components on a Vantage array server. You can 
also choose Install Products or Custom Install. Install Products lets you select licensed 
product groups, and Custom Install lets you select individual components. 

The Vantage Setup installer is capable of installing everything needed for a complete 
Vantage installation. If you check all components, Vantage Setup installs these items: 

• Creates a Telestream directory for Vantage and related files. For Single Nodes only, 
this directory includes Local Store, Default Catalog, and Samples workflow folders.

• Installs Intel Performance Primitives software for Intel processors

• Checks for QuickTime (only Telestream Media Transcode and Analysis engine uses 
QuickTime, if implemented in your workflows) and advises if missing or obsolete

• Installs SQL Server 2008 Express if Express or Standard are not already installed

• Creates a SQL instance named VANTAGE

• Creates the Vantage domain database on the VANTAGE instance

• Installs the Telestream Media Transcode and Analysis engine

• Installs Vantage services and client programs according to your selections, includ-
ing Web Applications for arrays

• Creates entries in the Windows Programs list for (depending on options):

– Vantage Media Transcoding & Analysis engine

– Vantage (clients and services)

– Vantage Domain Database

– Vantage Web Applications (array installations only) 

• Creates desktop shortcuts for Vantage clients on the desktop
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Vantage Database Setup Installer
The Vantage Domain Database installer (Vantage 6.0 Database Setup.exe) enables you 
to install the Vantage domain database separately, such as when installing the 
database in preparation for a Vantage Array installation or when upgrading a database 
installation. When you install the Vantage domain database (using 
VantageDatabaseSetup), the installer performs the following tasks:

• Installs SQL Server 2008 Express if Express or Standard is not already installed (for 
an array, install SQL Server 2008 Standard prior to running Vantage installers)

• Creates a SQL instance named VANTAGE

• Creates the Vantage domain database on the VANTAGE instance.

Note: If you run the database installer and a SQL instance named VANTAGE already 
exists, this installer will update the existing instance.

Vantage Client Installer
The Vantage Client installer (Vantage 6.0 Client Applications.msi) provides a convenient 
installer for quickly installing Vantage client applications on client workstations. The 
Client installer can install the Management Console, Workflow Designer, Workflow 
Portal, Dublist Portal, and Transcode User Interface. 

Vantage Web Applications Installer
The Vantage Web Applications installer (Vantage 6.0 Web Applications.msi) installs 
Microsoft IIS (if not already installed) and these Vantage Web Applications on the 
Vantage Array server:

• Vantage Dashboard—allows administrators to view Vantage system information.

• Vantage Job Status Views—enables operators to view job status information, and if 
properly authorized, execute job controls.

• Vantage Workflow Portal (VWP)—allows operators to view job status information, 
preview job output, and manage job variables and metadata labels.

• Vantage Web Transcode User Interface—allows users to create quick and easy 
transcoding workflows without accessing the Workflow Designer. 

Vantage Web Upload Portal Setup Installer
The Vantage Web Upload Setup installer (VantageUploadPortal_6.0.msi) installs the 
TrafficManager Web Upload Portal on advertisers’ remote client machines used to 
upload spots to the Vantage Traffic Manager catch server.
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Licensing Overview
The following topics describe Vantage license topics:

 Using Vantage in Demo Mode

 Obtaining a Vantage License

 Adding or Replacing License Files

Note: A Vantage domain with more than one node requires one Vantage Array 
license per node. 

Using Vantage in Demo Mode
When you install Vantage without a license, Vantage operates in demo mode. Demo 
mode allows you to design workflows, input Windows Media (.wmv and .avi) files for 
transcoding (with a watermark), and analyze a few seconds of video and audio. Some 
features that are not available in demo mode include:

• Support for broadcast server protocols

• Support for Transcode Multiscreen, which requires a Lightspeed Server

Note: If you'd like to unlock the entire set of features in Vantage for a time-limited 
trial, please contact your Telestream sales representative, or contact the Telestream 
sales team at sales@telestream.net. Demonstration mode is limited to all-in-one single 
node domains.
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Obtaining a Vantage License
You must obtain, install, and activate a license to:

• Test a Vantage array in demo mode

• Operate Vantage in production

• Upgrade Vantage from one version to another

• Add more Vantage services (more Transcode services, for example)

• Add licensed features (GraphicsFactory, for example).

Please contact your Telestream sales representative or contact the Telestream sales 
team at sales@telestream.net to determine your Vantage requirements and obtain or 
update your license. When your license has been prepared, Telestream will email you 
the license as an attachment.

For Telestream contact details, go to www.telestream.net/company/contact-
telestream.htm.

When you receive the license (an XML file), save it in a safe place for installation and 
activation at the end of the installation process.

Adding or Replacing License Files
Depending on your requirements, you may obtain a new license file or you may obtain 
updated files. Contact Telestream Sales or Customer Service, and follow their 
instructions for adding or updating license files.

Note: You can evaluate an All-in-One Single Node Vantage installation without 
installing a license. Demo mode allows you to design workflows, perform transcoding 
with a watermark, and analyze short video or audio clips. However, in demo mode (no 
license is installed), some features (such as broadcast server protocols) are disabled, 
and Vantage can only read Windows Media (.wmv and .avi) files for transcoding or 
analysis. You cannot operate a Vantage array without a license.
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Planning for a Vantage Array Installation
Prior to installing a Vantage array, Telestream recommends that you develop a system 
diagram, indicating each server and the Vantage services and client programs it should 
host, plus the database server (and optional mirror and witness server).

Figure 3. Typical Vantage Array

The diagram should also identify which computers host client programs (Vantage 
Management Console, Vantage Workflow Designer, and Vantage Workflow Portal).

Additionally, document all network resources utilized by the Vantage domain (file 
sources and destinations).

When adding Vantage services to scale performance, Telestream generally 
recommends adding one or more Vantage transcoding servers, which is typically the 
first service to max out server capacity. Multiple transcode servers improves load 
balancing and speeds overall job throughput. Secondly, if you use the Vantage Analysis 
service heavily, consider hosting it on a dedicated server as well.

Note: Each server hosting Vantage services requires a Vantage Array or Vantage 
Enterprise System Management license. Dedicated database servers do not require a 
special license.

Note: When naming servers, do not use underscores in the names. Underscores are 
not valid URL characters and will prevent the Web Applications from connecting to 
the Vantage domain.

Gig-E Ethernet Fibre-Channel Local Storage

Network Servers

FTP Servers

Catch Servers

Broadcast Servers

Principle Database & IIS Server

Mirror Database Server

Witness Server

Automatic Failover

Vantage Analysis server

Vantage Transcode server 1

Vantage Transcode server 2

Lightspeed Server 1

Lightspeed Server 2

Vantage Workstations

    Vantage Domain Console

    Vantage Workflow Designer

    Vantage Workflow Portal
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Installing and
Upgrading Vantage
Use this topic to install, upgrade, or scale Vantage, and configure it for operation.

Note: For instructions on obtaining the Vantage installation software, see Obtaining 
the Vantage Installer. Go to www.telestream.net/telestream-support/vantage/
support.htm to browse the Vantage Web library, user’s guides, application notes, and 
other documents.

The following topics describe how to install and upgrade Vantage components:

 Installation Overview

 Upgrading from the Previous Version

 Installing Vantage on a Single Node

 Installing a Vantage Array

 Post-Installation Steps for Single Nodes and Arrays

 Updating Vantage Components

 Moving the Vantage Domain Database to Another Database

 Adding a Server to a Vantage Domain

 Adding a Lightspeed Server to an Existing Vantage Domain

 Verifying DTC Service Settings
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Installation Overview
The following overview and Figure 4 summarize the main Vantage installation steps 
with links to the detailed procedures. If you are familiar with installation, the overview 
may save you time. If this is your first installation, read the overview and then follow the 
appropriate installation procedure in this chapter: Upgrading from the Previous Version 
(before re-installing), Installing Vantage on a Single Node, or Installing a Vantage Array.

1. Review Vantage platform requirements to ensure your hardware, OS, and software 
meet the Vantage installation requirements. See Before You Install.

2. Download the Vantage 6.0 Setup.exe installer from the Telestream Web site. See 
Obtaining the Vantage Installer.

3. If upgrading Vantage, uninstall the old version before installing the new version: 

a. Stop all jobs using Vantage Dashboard or the Workflow Designer. 
b. Back up your database (recommended) using VMC Domain Backup/Restore.
c. Use Windows to uninstall Vantage components in this order: Portals, Clients, 

Updates, Web Apps, T&A Engine, Vantage, and Vantage Domain Database. 
d. You can leave MS SQL and the Telestream\Vantage files intact. The installer will 

update your files, leaving your existing configuration unchanged.

4. Run the Vantage 6.0 Setup.exe installer to install all licensed Vantage components. 

– Single computer installation: Installing Vantage on a Single Node

– Array installation: Installing a Vantage Array

To install product feature groups (recommended), select Install Product and select 
the product groups for which you have licenses, or to install individual compo-
nents, select Custom Install and select components. 

5. If installing a new Vantage array, set up database access for distributed services and 
Windows log on IDs: 

– Adding Vantage Services

– Setting the Vantage Windows Log On ID for Services.

6. Continue post-installation tasks: Post-Installation Steps for Single Nodes and Arrays 

– Restoring Your Existing Database

– Setting Up a Vantage Store

– Installing and Configuring Vantage Web Applications

– Enabling Vantage Licenses

– Installing Client Programs on Client Workstations

– Installing the Upload Portal

– Verifying the Installation

7. Install Vantage Updates, if any: Updating Vantage Components.

8. Restart the computers.

Now that you have the overview, continue step-by-step through the chapter. 
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Figure 4. Installation Overview 
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Upgrading from the Previous Version
If a previous Vantage version is not already installed, skip this section and go on to the 
next section, Installing Vantage. If Vantage is already installed, follow the steps below to 
remove it except for your domain database files before installing a new version.

CAUTION: If you are upgrading, upgrade everything at once. Upgrading only selected 
components can result in component mismatches, causing a non-functioning 
Vantage system. If you have any questions, contact Telestream Vantage Support.

Before you can upgrade an existing Vantage installation to the latest version, you must 
properly remove the existing Vantage software. Removing the software does not 
remove the existing domain database data files, which can be attached and updated 
when Vantage 6.0 is installed. 

To remove Vantage in preparation for installing a new version, do the following:

1. Back up your Vantage database by using the Domain Backup/Restore feature in the 
Vantage Management Console. 

2. Log on to Vantage Workflow Designer Domain Job Status and stop all jobs or allow 
all jobs to complete.

3. Close all Vantage client programs and Web applications using this domain.

4. For each computer with Vantage client programs installed in this domain, log on 
with a local administrator account and perform the following steps:

a. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

Note: Windows XP Pro and Windows Server 2003 remain valid operating systems for 
Vantage clients but are no longer recommended for Vantage 6.0 system installations. 
Please contact Telestream Support for additional information and assistance.

b. Select Vantage Client Applications (if present) and click Remove or Uninstall.
c. Uninstall all Vantage update packs that are installed: Select each Vantage update 

pack in reverse sequential order (latest to oldest), and click Remove or Uninstall. 
Perform this step for all installed update packs. 

5. On the server hosting Vantage Web apps, use the Control Panel uninstall tool (see 
Step 4) to select Vantage Web Applications and click Remove or Uninstall.
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6. On the servers hosting the Telestream Media Transcode and Analysis engine, log on 
with a local administrator account and follow these steps:

a. Select Start > Administrative Tools > Services to display the Services window.
b. Right-click and select Stop for the following services: Vantage Analysis service 

and the Vantage Transcode service.
c. In the Control Panel uninstall tool (see Step 4), select Telestream Media 

Transcoding & Analysis Engine and click Remove or Uninstall.

7. On the Vantage database server log on with a local administrator account, and 
using the Control Panel uninstall tool (see Step 4), follow these steps:

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created 
are not removed.

a. Select Vantage and click Remove or Uninstall.
b. Select Vantage Domain Database and click Remove or Uninstall.

Note: If you want to change the Microsoft SQL version (for example, from Express to 
Standard), or if you want to move the Vantage domain database to a different server, 
follow the procedure in Moving the Vantage Domain Database to Another Database 
before you continue.

At this stage, the Vantage Domain Database software has been removed, but your 
database and service configuration files and the SQL Server are still intact. When 
you install the latest Vantage, you can reuse these database files and let Vantage 
upgrade them. Continue now with the next topic, Installing Vantage.
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Installing Vantage
The following instructions lead you step-by-step through Vantage installation.

Installation Prerequisites
These prerequisites must be installed before you install Vantage: 

• Microsoft’s .NET 3.5.1 must be installed on your database server (required by MS 
SQL 2008). Click Start > Server Manager > Features > Add Features> .NET Frame-
work 3.5.1.

• Microsoft’s .NET 4.0 is also required on servers running Vantage clients or Web 
Apps, but it is installed automatically by the Vantage installer. (Also install Microsoft 
hotfix KB2183292 for .NET 4.0 to prevent mail system errors when using Vantage 
messages to send files larger than 3 MB.)

• QuickTime 7.6.9 from Apple.com is required by the Vantage Transcode & Analysis 
engine. If it is not present, you will need to download it and install.

With the prerequisites installed, you’re ready to start the Vantage installation. Vantage 
can be installed in one of two ways: 

(1) An all-in-one domain on a single server (node), or 

(2) An array with distributed processing spread across multiple servers. 

Differences between what’s installed for the two installation types are listed in Table 7.
 

Table 7. Single Node vs Array Installation

Single Node Installation Array Installation

• Installs Intel Performance Primitives and 
.NET 4.0 (if not present). Checks for 
QuickTime and .NET 3.5.1. 

• Installs MS SQL 2008 Express unless 
deselected or MS SQL is detected as 
already installed. 

• Automatically installs or updates 
Domain Database and SQL, if present.

• Creates Vantage Store, Catalog (default), 
and Samples folders in C:\ Program Files 
(x86)\Telestream\Vantage folder.

• Installs the Vantage Media Transcode & 
Analysis engine, if needed.

• Installs clients: Management Console, 
Workflow Designer, Workflow Portal, 
and Dublist Portal.

• Installs Intel Performance Primitives and 
.NET 4.0 (if not present). Checks for 
QuickTime and .NET 3.5.1. 

• Does not install MS SQL 2008 Express 
unless selected. MS SQL 2008 Standard 
is preferred (customer supplied).

• Does not install or update Domain Data-
base or SQL unless selected.

• Does not create Store, Catalog, or Sam-
ples folders but does create C:\ Program 
Files (x86)\Telestream\Vantage folders.

• Installs the Vantage Media Transcode & 
Analysis engine, if needed.

• Installs clients: Management Console, 
Workflow Designer, Workflow Portal, 
and Dublist Portal.

• Installs Web Apps, if selected. 
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Note: A Vantage array requires one Vantage Array license per node. Installation for an 
array requires additional steps compared to installation on a single node.

The first step in installing Vantage software is to choose the type of installation you 
plan to do: Single Node or Array. Then click one of the links below to do the installation:

 Installing Vantage on a Single Node

 Installing a Vantage Array

Be sure to follow all steps carefully and in sequence. 

Note: Use only the Vantage 6.0 Setup.exe installer for installing client components on 
your Vantage servers. The Vantage 6.0 Client Application.msi installer is provided only 
for installing software on client machines. On clients, you can use either the Vantage 
6.0 Setup.exe installer or the client installer, but don’t switch installers if you later make 
installation changes on the client machine.
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Installing Vantage on a Single Node
An all-in-one Vantage domain is one in which all Vantage server components are 
installed and operate on a single server (node). The components include the Vantage 
software and services, the Vantage domain database, and Vantage client programs 
(Vantage Management Console, Vantage Workflow Designer, Vantage Workflow Portal, 
and Vantage Dublist Portal). Additional licensed client programs can also be installed 
separately on client workstations. 

Note: A Vantage domain with more than one node is a Vantage array and requires 
one Vantage Array license per node. Installation differs for an array. See Installing a 
Vantage Array and skip these single node instructions.

The fastest, easiest, and recommended way to install Vantage on a single node is to 
follow the steps below to install everything at once. If you need to update or reinstall 
specific individual components, you can do so by following the instructions later in this 
chapter: Updating Vantage Components. 

To install all licensed Vantage components on a single server, follow these steps:

1. Be sure you have backed up and uninstalled the previous Vantage version, if any, as 
explained previously in Upgrading from the Previous Version.

2. Log on to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

Note: Telestream recommends that you do not use anti-virus software on Vantage 
servers. If you prefer to use anti-virus software, identify Vantage as a safe/trusted 
application. For additional information on using Vantage with anti-virus software, see 
Anti-Virus Software Recommendations. For more information on using Vantage with 
the Windows Firewall, see Firewall Guidelines.

3. Run the Vantage 6.0 Setup.exe installer that you downloaded earlier (see Obtaining 
the Vantage Installer). The installer extracts and installs all components.

Note: If Microsoft .NET 3.5 and 4 Frameworks are not installed, the installer notifies 
you to install 3.5 manually and automatically installs 4. After .NET is installed, open 
Server Manager > Roles > Server Roles, and check Web Server (IIS) to enable it. Then 
enable the services listed in Table 8, IIS Role Service Requirements for Vantage Web 
Applications. When finished, continue with the next step in this procedure.
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4. When the Welcome dialog appears, click Next to display the license agreement. 
Click I Accept if you agree to the license terms, and then click Next.

5. When the license agreement appears, click I accept the terms in the License 
Agreement (if you accept the terms), and click Next (or click Cancel).

6. Select Single Node Installation (the default) when the dialog instructs you to “Select 
the type of Vantage system you want to install on.” Then click Next.

7. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option. 

8. In the Install Product or Custom Install display, check the boxes by the components 
you want to install, and click Next. 

At a minimum, you should choose to install the Transcode/Transcode Pro selection. 
If licensed, you may choose multiple options that include additional services, the 
Workflow Designer, and the Workflow Portal. Be sure to check Vantage Domain 
Database at the bottom; if a database is already present, the installer will update it 
without removing the previous database contents.

9. Browse to Configure the installation locations for the Installation base and the 
default Vantage Store.

10. When the Ready to Install dialog appears, click Install to begin product installation. 
This process takes a few minutes to complete and shows progress and components 
being installed as it runs.

Note: If Intel Performance Primitives (IPP) is not present, it is installed. If QuickTime 
7.5.5 or later is not installed, the installer displays a message advising you to visit 
Apple’s QuickTime for Windows Web page (www.apple.com/quicktime/win.html), 
download the current version, and install it. Telestream recommends that you install 
version 7.6.9, which is not available on the Apple Web site.

11. During installation the database installer opens automatically and asks you to 
select Install new database or Upgrade existing database. Install new database 
replaces your database, erasing your data as it does so. An upgrade keeps your data 
and upgrades the database to the current version. If you’re upgrading and your MS 
SQL and Vantage files are intact, the installer should detect that and automatically 
set this selection to Upgrade existing database but it’s wise to verify.

12. If you chose to install a new database, browse to choose the location of the Vantage 
domain database. The default location is recommended.

13. When installation is complete, the progress text displays Finished. Click Next.

14. The dialog displays Installation successful! Click Done to complete the installation. 
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This completes the initial Vantage installation. Vantage installs these components 
(visible in the Control Panel Programs and Features list): 

• Microsoft SQL Server 2008 Express, including Browser, Native Client, Support Files

• Telestream Media Transcoding and Analysis

• Vantage

• Vantage Domain Database

Also, shortcuts for the clients are added to the desktop: Workflow Designer, 
Management Console, Workflow Designer, and Dublist Portal. 

If any components failed to install, you can run the installer again selecting a Custom 
Install and checking only the components you want to install again. 

Quick Installation Check
At this point, the Vantage installation should be functioning, though not licensed. 
Vantage Management Console should be operational if you double-click the Vantage 
Management Console icon on the desktop and log in with the user name 
“administrator” and no password. 

Next, continue with the following post-installation tasks:

• Post-Installation Steps for Single Nodes and Arrays 

– Restoring Your Existing Database

– Setting Up a Vantage Store

– Installing and Configuring Vantage Web Applications

– Enabling Vantage Licenses

– Installing Client Programs on Client Workstations

– Verifying the Installation
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Installing a Vantage Array
A Vantage array consists of two or more Vantage server components distributed 
among two or more servers for optimum speed and efficiency. Typically a Vantage array 
implements the Vantage domain database on one server and the Vantage Services, 
Transcode Engine, Clients, and Vantage Web Applications on another server. It is even 
possible to split Vantage Services and the Vantage Transcode Engine across multiple 
servers for maximum throughput and to put the Web Applications on their own server. 
To implement a Vantage domain across multiple servers, specific configurations must 
be applied to all computers that host any Vantage services or host the Vantage domain 
database for the array.

A Vantage array installation and configuration generally takes from one hour to several 
hours to install, depending on the complexity (number of servers). To install a Vantage 
array, perform the tasks in the specified order:

1. Setting Up the Vantage Domain Database

2. Installing Vantage Array Components

3. Adding Vantage Services

4. Setting the Vantage Windows Log On ID for Services

Note: Each Vantage domain requires one Vantage Array license per server. 

Setting Up the Vantage Domain Database
If you are upgrading an existing Vantage installation, you should already have SQL 
Server 2008 installed. Skip this step and go on to the next step, Installing Vantage Array 
Components. If the database is not installed, continue with this procedure.

Although you can install and operate the Vantage domain database and Vantage 
services on the same server (as is done in an all-in-one, single node domain), 
Telestream recommends that you use a dedicated server for the Vantage array domain 
database and that you use Microsoft SQL Server 2008 Standard instead of the SQL 
Server 2008 Express used in single node installations. 

To set up the Vantage domain database, follow these procedures in the order listed:

1. Installing SQL Server 2008 Standard

2. Configuring SQL Server Standard Memory Settings

3. Installing the Vantage Domain Database
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Installing SQL Server 2008 Standard

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Follow these steps to install SQL Server 2008 Standard on a server:

1. Log on to the target server with a local administrator account.

2. Insert the SQL Server 2008 Standard DVD into the server and start the installer 
(setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. Setup Support Files—Click Install, allow the installer to complete its actions, and 
click Next.

Note: If Restart computer... Failed displays in the report, this is caused by a bug in the 
SQL Server 2008 Standard R1 installer. To correct the problem, run Regedit and 
navigate to this key: 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\PendingFileRenameOperations. 
Clear the Value Data string. After you clear the Value Data string, return to Setup 
Support Rules and click Re-run on the right by the status bar. The Setup Support Rules 
should complete successfully—click OK to continue.

Note: On SQL Server 2008 R2 only, select SQL Server Feature Installation and click Next.

8. Feature Selection—Check Database Engine Services and Management Tools, and 
click Next.

9. Instance Configuration:

a. Select Named instance.
b. Enter VANTAGE in the Named instance field and the Instance ID field.
c. Click Next to continue.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration:

a. For SQL Server Agent, select NT AUTHORITY\NETWORK SERVICE.
b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.
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12. Database Engine Configuration:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the SQL Server 2008 Standard installer.

Configuring SQL Server Standard Memory Settings
When using SQL Server Standard, the maximum server memory for SQL should be set 
to utilize a maximum 75% of the system's memory.

1. Select Start > SQL Server Management Studio.

2.  Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

4. In the Server Properties window, go to the Memory page.

5. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

6. Click OK.

7. Close the SQL Server Management Studio.

Installing the Vantage Domain Database
This task installs the Vantage domain database instance.

Follow these steps:

1. Log on to the database server with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Run the Vantage 6.0 Database Setup.exe Vantage Domain Database installer that 
you downloaded from the Telestream.net Web site. Alternatively, you can run the 
Vantage_6.0_Setup.exe installer and select to install Array Node and only Domain 
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Database. The installer extracts the components and continues. Component 
installation takes a few minutes.

Note: The setup program checks for SQL Server 2008 Standard, and if the product is 
found, setup skips the installation of SQL Server 2008 Express.

3. When the Vantage Domain Database Setup Wizard appears, click Next to display 
the license agreement.

4. License Agreement—Read the Vantage Software License Terms and Conditions, 
then click I Accept if you agree to license terms. Click Next.

5. Select whether to Install new database or Upgrade existing database.

If there is no database on this server, when the Database install mode dialog 
appears, select Install new database, and click Next. This will install SQL Server 2008 
Express.

Note: Telestream recommends that you install the database on a different hard drive 
from the one allocated for temporary media storage. For more information, see 
Database Selection and Configuration Guidelines.

If there is a Vantage database on this server, when the Database install mode dialog 
appears, select Upgrade existing database, and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

Note: Existing workflows do not require updating to run as they did on an earlier 
Vantage release. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading.

6. Destination Folder—Accept the default folder or click Change to select an alternate 
folder. Click Next.

7. Ready to Install Vantage Domain Database—Click Install to begin database 
installation. This process takes a few minutes to complete.

8. Completed—When installation is complete, click Finish.
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Installing Vantage Array Components
Once you have your SQL database and Vantage Domain Database installed, you’re 
ready to install the Vantage Array components, including Vantage services, transcoders, 
and clients. Telestream recommends that you install these components on a different 
server than your database for maximum operating efficiency.

To install the Vantage components, follow these procedures in the order presented:

1. Installing Vantage Services, Transcode Engine, and Clients

2. Adding Vantage Services

3. Setting the Vantage Windows Log On ID for Services

Installing Vantage Services, Transcode Engine, and Clients
This procedure installs the Vantage services, Transcode & Analysis Engine, Vantage 
Management Console, and Vantage Workflow Designer on a server. 

Note: Vantage installers modify Windows Distributed Transaction Coordinator 
(MSDTC) properties to meet Vantage services and database communication 
requirements. This modification is automatic, and requires no action on your part.

To install the Vantage components, do the following:

1. Be sure you have backed up and uninstalled the previous Vantage version, if any, as 
explained previously in Upgrading from the Previous Version.

2. Log on to the target server with a local administrator account. Make sure that virus-
checking software and Windows Firewall are turned off.

Note: Telestream recommends not using anti-virus software on Vantage servers. If 
you use anti-virus software, you should identify Vantage as a safe/trusted application. 
Be sure to turn off anti-virus software during Vantage installation or install anti-virus 
software after installing Vantage.

3. Run the Vantage installer, Vantage 6.0 Setup.exe, which you previously downloaded 
(see Obtaining the Vantage Installer). The installer extracts components, and 
continues. 

CAUTION: Telestream recommends that you upgrade all software components as 
part of the upgrade process, or Vantage may not operate correctly.

4. When the Welcome dialog appears, click Next to display the license agreement.

5. When the license agreement appears, click I accept the terms in the License 
Agreement (if you accept the terms), and click Next (or click Cancel).

6. Select Array Node Installation when the dialog instructs you to “Select the type of 
Vantage system you want to install.” Then click Next.
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7. Select the type of installation you want to perform: Install Product or Custom Install. 
Install Product lists products and options in licensed groups. Custom Install lists 
every Vantage component and option. 

8. In the Install Product or Custom Install display, check the boxes by the components 
you want to install, and click Next. 

At a minimum, you should choose to install the Transcode/Transcode Pro selection. 
If licensed, you may choose multiple options that include additional services, the 
Workflow Designer, the Workflow Portal, and Web Applications. 

Note: If Vantage Web Applications have never been installed and you are not 
installing them on a Lightspeed server, leave them unchecked in the installer and 
install them later as explained in Installing and Configuring Vantage Web Applications. If 
they have been installed before (and IIS is already configured), or you are installing on 
a Lightspeed server, you can check the installer to install them now.

9. Browse to Configure the installation location for the Installation base.

10. When the Ready to Install dialog appears, click Install to begin product installation. 
This process takes a few minutes to complete and shows progress and components 
being installed as it runs.

Notes: If Intel Performance Primitives (IPP) is not present, it is installed. 

If QuickTime 7.5.5 or later is not installed, the installer displays a message advising you 
to visit Apple’s QuickTime for Windows Web page (www.apple.com/quicktime/
win.html), download the current version, and install it. 

If Microsoft .NET 3.5 and 4 Frameworks are not installed, the installer notifies you to 
install 3.5 manually and automatically installs 4. 

After .NET is installed, open Server Manager > Roles > Server Roles, and check Web 
Server (IIS) to enable it. Then enable the services listed in Table 8, IIS Role Service 
Requirements for Vantage Web Applications. When finished, continue with the next 
step in this procedure.

11. If you install QuickTime, do the following when QuickTime installation completes:

a. Uncheck Check for Updates, so QuickTime is not updated automatically.
b. Restart the server and re-run the Vantage_6.0_Setup.exe installer to continue.

12. When installation is complete, the progress text displays Finished. Click Next.

13. The dialog displays Installation successful! Click Done to complete the installation. 

This completes the initial Vantage installation. At a minimum, Vantage installs these 
components (visible in the Control Panel Uninstall Programs list): 

• Telestream Media Transcoding and Analysis
• Vantage
• Vantage Domain Database
• Vantage Web Applications
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If any components failed to install, you can run the installer again selecting a Custom 
Install and checking only the components you want to install again. 

At this point, the Vantage installation should be functioning, though not licensed, and 
Vantage Management Console should be operational if you double-click the Vantage 
Management Console icon on the desktop and log in with the user name 
“administrator” and no password. 

Continue with the next task: Adding Vantage Services.

Adding Vantage Services
When Vantage services are installed on a server, the installer looks for the Vantage 
domain database on the server. If the Vantage domain database is present, all services 
are configured to connect to that domain. If no Vantage domain database is present, 
the Vantage services are not configured, and you must configure each service to 
connect to the appropriate Vantage domain. 

To add Vantage services to a Vantage domain, follow these steps:

1. Start VMC, select the domain to manage, and log on as described in Starting the 
Vantage Management Console.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

2. Select Services in the component (left) panel.

The Services details (right) panel shows all services on all servers that are con-
nected to the domain you selected.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.

4. Select one or more services to add to this domain, and click OK to add them.

Services are identified by name, machine or host, and Vantage domain. Make sure 
that you do not select services that are properly attached to another domain. To 
select multiple services, use shift-click to select a series of services, or use Ctrl-click 
to select individual services.

If you are moving a service from one domain to another, VMC displays the Reassign 
Services window. Click OK to add them to this domain.

Continue with the next task: Setting the Vantage Windows Log On ID for Services.
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Setting the Vantage Windows Log On ID for Services
After installation, the default log on ID for each Vantage service is the Local System 
account. This log on ID provides access to files on the local server only. If a service, such 
as Transcode, requires access to files on another server, the Local System account 
cannot provide that access. If Vantage services need access to input folders, output 
folders, or a Vantage store that is on another computer, you must do the following:

• Create a Vantage Windows user ID for the service

• Grant access to the Vantage Windows user ID on the other computers.

For more information, see Windows Authentication Guidelines.

Except for Agility, Catalog, and SDK, most Vantage services require a Vantage Windows 
user ID to access files on other computers.

For services of the same type, the Windows log on ID for that service must be the same 
on all Vantage servers in the domain. For example, all Analysis services within the 
domain must use the same log on ID. However, the Catalog service, which does not 
access files, can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the array:

1. Log on to the target server with a local administrator account.

2. On the Vantage server, select Start > Administrative Tools > Services.

You can also select Start, type services.msc in the search box, and press Enter.

3. Right click on a Vantage service and select Properties. (All Vantage services begin 
with the word Vantage.) Then select the Log On tab.

Figure 5. Vantage Service Log On Properties
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4. Select This account.

5. Click Browse and use the Select User dialog to select the Vantage Windows user 
account name (for example, VantageWinUser), then click OK.

If the Vantage Windows user name has not been defined, it will not appear in the 
browser. You can also enter a user name in the This account text box. For informa-
tion on the Vantage Windows user name and how to create it, see Windows Authen-
tication Guidelines.

Note: All Vantage services in a Vantage domain should be located in the same 
Windows domain. In the preceding figure, Starfleet represents the Windows domain.

6. Enter the password for the Vantage Windows user in the Password and Confirm 
password text boxes, then click OK.

7. Repeat Steps 3 to 7 as needed for the other Vantage services.

Note: In some cases; you may be required to indicate that the specified user has been 
granted log on as a service right. If the service fails to start and displays an error 
indicating that the service log on user name may not have the necessary permissions, 
consult your IT administrator to set the appropriate rights for the new account.

8. Restart any updated services.

Quick Installation Check
At this point, the Vantage installation should be functioning, though not licensed. 
Vantage Management Console should be operational if you double-click the Vantage 
Management Console icon on the desktop and log in with the user name 
“administrator” and no password. 

Vantage Web Apps should also start if you enter the following URL in a browser on the 
server: http://[server name]/Vantage/.

Next, continue with the following post-installation tasks:

• Post-Installation Steps for Single Nodes and Arrays 

– Restoring Your Existing Database

– Setting Up a Vantage Store

– Installing and Configuring Vantage Web Applications

– Enabling Vantage Licenses

– Installing Client Programs on Client Workstations

– Installing the Upload Portal

– Verifying the Installation
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Post-Installation Steps for Single Nodes and Arrays
This section includes post-installation procedures common to both Vantage Single 
Node and Vantage Array installations. After the initial installation is finished, continue 
with these steps: 

 Restoring Your Existing Database

 Setting Up a Vantage Store

 Installing and Configuring Vantage Web Applications

 Enabling Vantage Licenses

 Installing Client Programs on Client Workstations

 Installing the Upload Portal

 Verifying the Installation

Restoring Your Existing Database
If this is not a new installation and you left SQL and your domain database files in place 
before installing, you can skip this procedure. The Vantage installer will have added 
new data while leaving your existing domain database intact and fully functional.

If you deleted your domain database but preserved it in a Vantage backup using the 
Vantage Management Console, you can follow this procedure to restore the domain 
database from the backup. This will restore licenses, user accounts, workflows, catalogs, 
and so on.

To restore the database from a backup, follow these steps:

1. Start and log into the Vantage Management Console as the administrator (user 
name “administrator” with no password).

2. At the bottom of the left menu panel, click Domain Backup/Restore

3. At the top of the Domain Backup/Restore page, click Restore....

4. Browse for the Vantage backup file and click Open. 

5. Vantage restores the database from the file and notifies you when the restoration is 
complete. 

6. Run the database installer, Vantage 6.0 Database Setup.exe to upgrade the database 
to the latest version.

Your domain database should now be fully updated and operational. Continue with the 
remaining post-installation tasks.

Note: Existing workflows do not require updating to run as they did on the earlier 
Vantage release. However, new options in actions do not display automatically and are 
not usable until you upgrade each action as described in the Vantage User’s Guide.
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Setting Up a Vantage Store
A Vantage store is a required folder that serves as a temporary location to store media 
files while Vantage processes them. It is used by the transcoders and the Workflow 
Portal (including Web Apps Workflow Portal) and must be in place before you use the 
domain. A Vantage array installation does not automatically set up a Vantage Store, so 
you will need to create one now. An all-in-one, single-node installation creates a default 
storage location at Program Files (x86)\Telestream\Vantage\Store and also creates a 
Vantage catalog. However, you may prefer to set up a more convenient location for 
processing your Vantage jobs. For more information on storage, see Understanding 
Vantage Storage.

To create a Vantage Store, follow these steps: 

1. If you have not created a Windows share to serve as the Vantage store, create it now 
and make it available to the Vantage Windows user. For more information, see 
Configuring Folders for Vantage Access.

2. In the component (left) panel, open Vantage Domain to display the domain 
management options.

3. Open Storage to display the Vantage storage options.

4. Select Vantage Stores to display the Vantage Stores list in the details (right) panel.

5. Click the New Vantage Store toolbar button  to open the Add New Store dialog.

6. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

7. To specify the store root directory, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

Note: If you use a local drive letter to specify a directory, only Vantage services and 
clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

8. Click OK.

9. Click the Save button  to save the new store.
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Installing and Configuring Vantage Web Applications
Vantage Web Applications (for Vantage arrays only) provide convenient operator and 
administrator browser-based access to Vantage without the overhead of running the 
full Vantage clients. Functions include the Dashboard, Job Status Views, Workflow 
Portal, and Web Transcode UI. When planning Web Apps installation, it is 
recommended that you run them on a separate server from the Transcoder & Analysis 
Engine with the firewall enabled, since users may be accessing the Web Apps remotely. 

If you are updating existing Web Apps, the server is already configured. See Updating 
Vantage Web Applications for an abbreviated procedure.

If you are installing Web Applications for the first time, use the following procedure. 

The following topics explain Web Application installation and configuration:

 Installing Vantage Web Applications

 Managing Alias Support for the VWP Web Client

 Troubleshooting Vantage Web Applications Installation

Installing Vantage Web Applications
When installing the Vantage Web Applications on a server for the first time, the 
procedure is different for Lightspeed servers and standard servers:

• Standard servers—You must set up IIS first. If IIS is already installed, you must install 
and uninstall IIS role services to create the configuration that supports Vantage 
Web Applications. 

• Lightspeed servers—Lightspeed servers ship with IIS properly installed. There is no 
need to set up IIS on a Lightspeed server. Skip the steps below and see Updating 
Vantage Web Applications for an abbreviated installation procedure.

Note: If UAC is enabled, the installer displays this error: “You do not have sufficient 
privileges to complete this installation...”. 
To resolve this, either disable UAC before installation, or:
1. Select Start > All Programs > Accessories.
2. Right-click the Command prompt and select Run as Administrator.
3. CD to the Vantage Web Applications installer directory.
4. Run the installer from the elevated command prompt.

To install the Vantage Web Applications and IIS, follow these steps:

1. Log on to the target server with a local administrator account. 

2. If you are installing on a Lightspeed server, skip to Step 7.

3. Verify that your IIS server requirements are met (see Vantage Web Applications OS).

Note: The following step ensures that .NET 4.0 is correctly installed.
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4. Verify that the .NET 4.0 Framework is installed. If it is missing, running the 
Vantage_6.0_Setup.exe installer later in this procedure will install it automatically.

5. If IIS 7 is installed on the target server, configure it as follows:

a. Open the Server Manager and select Roles.
b. When the Roles page appears, click Web Server (IIS).
c. Scroll down the page and install and uninstall services as needed so that the role 

services match those listed in Table 8.
d. If prompted, restart the server.

Table 8. IIS Role Service Requirements for Vantage Web Applications

Service Install Uninstall
Common HTTP 
Features

Static Content
Default Document
Directory Browsing
HTTP Errors

HTTP Redirection
WebDAV Publishing

Application 
Development 

ASP .NET
.NET Extensibility
ISAPI Extensions
ISAPI Filters

ASP
CGI
Server Side Includes

Health and 
Diagnostics

HTTP Logging
Request Monitor

Logging Tools
Tracing
Custom Logging
ODBC Logging

Security Request Filtering Basic Authentication
Windows Authentication
Digest Authentication
Client Certificate Mapping 
Authentication
IIS Client Certificate Mapping 
Authentication
URL Authorization
IP and Domain Restrictions

Performance Static Content Compression Dynamic Content 
Compression

Management Tools IIS Management Console
IIS 6 Management 
Compatibility 
IIS 6 Metabase Compatibility
IIS 6 WMI Compatibility
IIS 6 Scripting Tools
IIS 6 Management Console

IIS Management Scripts and 
Tools
Management Services

FTP server FTP server
FTP Service
FTP Extensibility

IIS Hostable Web Core IIS Hostable Web Core
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6. If IIS 7 is not installed on the target server, install IIS 7 with ASP.NET and IIS 6 
Management Compatibility as follows:

a. Open the Server Manager and select Roles.
b. When the Roles page appears, click Add Roles.
c. Click Server Roles.
d. Check Web Server (IIS) and click Next.
e. Click Next.
f. Enable ASP.NET, IIS 6 Management, and all IIS 6 Management subcomponents, 

and click Next.
g. Click Install.

7. To start the Vantage Web Applications installation, run the Vantage_6.0_Setup.exe 
installer.

8. Choose an Array > Custom installation, and check the box to install only the Web 
Applications (all else unchecked). Alternatively, run the separate Vantage Web 
Applications installer: VantageWebApplicationsSetup.msi. 

Note: The Vantage Web Apps, should be installed on a different server from the 
Telestream Transcode & Analysis engine. For this reason, Web Applications are 
included only with the array node installer and not with the single-node installer. 

9. When the Welcome Window appears, click Next.

10. Click I accept... to accept the license terms after reading them, and click Next (or 
click Cancel if you do not agree to the license terms).

11. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings as required, and click Next.

Note: The Application Pool setting automatically defaults to ASP.NET 4.0. If it is not set 
to ASP.NET 4.0, there is an issue with the IIS or .NET installation.

12. Click Install to begin installation.

13. When the Installation Complete dialog appears, click Finish.

14. If Vantage services were running before the Vantage Web Applications installation, 
restart them using Microsoft Services (Start > Administrative Tools > Services).

15. Provide the Vantage Web Applications login requirements to each of your Vantage 
users, so that they know how to access them. The URL for the Vantage Web 
Applications is: http://[hostname]/Vantage where [hostname] is the server where 
you installed them.

Note: For information on the browser requirements for Vantage Web Applications, 
see Vantage Web Applications Browser Requirements.

Note: If your installation uses the VWP Web application, configure support for this 
program as described in Managing Alias Support for the VWP Web Client.
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Managing Alias Support for the VWP Web Client
The Vantage Workflow Portal Web application requires HTTP access to Vantage stores 
for viewing of proxy media files, and it requires the installation of Microsoft Silverlight 
on computers that will view proxy media files. If your Vantage installation does not use 
the VWP Web client, or if operators will not be using the Worfkflow Portal Web client to 
view proxy files, you do not need to configure alias support.

Providing HTTP access to Vantage stores requires the following:

• Create and configure a virtual directory on the IIS server that references the Van-
tage store. A virtual directory must be created for every store that will store proxy 
files for the VWP Web application.

• Create and configure a Vantage alias for the virtual directory.

• Create and configure a VWP configuration to support operator management as 
described in Configuring Vantage Workflow Portal Operation.

• Install Microsoft Silverlight on computers that will view proxy media files using the 
VWP Web application.

The following topics describe how to manage an alias for a Vantage store:

 Creating a Virtual Directory

 Creating an Alias

 Modifying an Alias

 Deleting an Alias

 Installing Microsoft Silverlight

Creating a Virtual Directory

For detailed instructions for creating an IIS virtual directory, refer to your Microsoft 
product documentation. The following procedure provides an example of how to 
configure a virtual directory on an IIS server:

1. If not already installed, install the Vantage Web Applications as described in 
Installing and Configuring Vantage Web Applications.

2. On the server that hosts the Vantage Web Applications, select Start > 
Administrative Tools > Computer Management.

3. In the left pane of the Computer Management window, expand Services and 
Applications and select Internet Information Services (IIS) Manager.

4. In the Connections pane, expand the server entry, and expand the Sites entry.

Note: In some situations, adding or removing a virtual directory causes Web 
Dashboard sessions to close. This does not change the Web Dashboard configuration 
or operation. Web Dashboard users can restart the program as described in Starting 
the Vantage Dashboard.

5. Right click Default Web Site and select Add Virtual Directory.
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6. Configure the virtual directory as follows:

a. Enter an Alias name for the virtual directory.

Consider using a name that is easy to associate with the Vantage store directory, 
and note this name, as you will need to use it to create a Vantage alias.

b. Type the path to the Vantage store directory in the Physical path text box, or click 
the browse button to the right of the text box and select a directory.

For an all-in-one domain, the path to the default Local Store is [local drive]:\Pro-
gram Files (x86)\Telestream\Vantage\Store. The default path works only when 
the store and the Vantage Web Applications are located on the same server.

If your Vantage store is located on a network attached storage device or other 
network accessible location, enter the UNC path to the location (for example, //
myserver/myStore/).

c. Click Connect as, click Specific user, and click Set.
d. Enter user name and password information for a Windows user with access to the 

Vantage store directory, and click OK twice.

If required, the user name should include a domain name. For example, 
user@domain.net or VantageGuru@MyCompany.net.

Note: If you are operating in a Windows workgroup, the IIS 7 server machine name 
and the machine name of the file share for the Vantage store should have the same 
local account name (VantageUser, for example) and password. This allows for easy 
authentication from IIS to the Vantage store location. In this case, the user name in the 
Set Credentials window can be specified simply as VantageUser.

e. Click Test Settings.

The Test Connection dialog should show that the Authentication and Authoriza-
tion tests passed.

f. Click Close.
g. Click OK to complete the virtual directory configuration.

The virtual directory should now display in the Computer Management window 
as a folder below the Web site you modified.

h. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the VWP Web application.
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Creating an Alias

After you create virtual directories for your Vantage stores, create a Vantage alias for 
each Vantage store that will store proxy files. To create an alias, do the following:

1. Start VMC, select the domain to manage, and log on as described in Starting the 
Vantage Management Console.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

2. In the left panel, open Vantage Domain to display the domain management options.

3. Select Storage > Vantage Stores.

4. Click the Modify button to the right of the Alias text box.

5. In the Folder Location Editor dialog, select the HTTP file system and click Next.

6. Specify a host name or IP address for the HTTP server and the TCP port number, 
then click Next.

7. Leave the User name and Password text boxes blank and clear the checkbox to Use 
anonymous login, then click Next.

8. Enter the virtual directory alias you created for the virtual directory, and click Finish.

9. Click the Save button  to save the changes.

10. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the VWP Web application.

Modifying an Alias

After you have created an alias, you can modify the alias path in the Alias text box and 
save the changes. To modify other alias settings, do the following:

1. Click the Modify button.

2. Click Next to retain the HTTP file system selection.

3. Verify or change the host name or IP address for the HTTP server and the TCP port 
number, and click Next.

4. Verify that the User name and Password text boxes are blank and the checkbox to 
Use anonymous login is empty, then click Next.

5. Verify the correct virtual directory selection, or use the Folder Location Editor 
dialog to select the virtual directory, and click Finish.

6. Click the Save button  to save the changes.

Deleting an Alias

To delete an alias, select the alias path in the Alias text box, press Delete, and save.

Installing Microsoft Silverlight

If Microsoft Silverlight is not installed on the host computer when the VWP Web 
application is started, a Microsoft Silverlight message appears in the preview window. 
To install, click Click now to install and follow the instructions.
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Troubleshooting Vantage Web Applications Installation
The following are some symptoms and remedies that apply to troubleshooting the 
installation of the Vantage Web Applications:

• Web Apps can’t be accessed by the browser or not all applications show up. 

Refresh the Vantage domain by clicking Change Domain in the upper right corner 
and selecting the desired domain from the list.

• HTTP 500.19 error appears in the browser when you attempt to access the Vantage 
Web Applications after a new install.

Run the ASP.NET registration tool (aspnet_regiis.exe) to fix the .Net installation. For 
more information, refer to the Microsoft MSDN Web site.

• When running Vantage Web Applications.msi, if the Select Installation Address 
page does not default to ASP.NET v4.0 for the Application Pool AND if .NET Frame-
work 4.0 is already installed, run the aspnet_regiis.exe registration tool and then 
run Vantage Web Applications.msi again.

• If "*IE / Compatibility mode detected. Click for details/" displays in yellow font on 
the top of the web application page, AND if 'Compatibility Mode' is already dis-
abled in IE9 (or if you're using Firefox or Chrome), use the aspnet_regiis.exe registra-
tin tool and close and re-open the web browser.

• If your Web applications do not display correctly or do not allow you to log in, run 
the aspnet_regiis.exe tool.

Using the aspnet_regiis.exe Registration Tool

The aspnet_regiis.exe registration tool should be used whenever ASP.NET is not 
functioning properly within IIS. This tool might be required, for example, if IIS is 
installed after the .NET framework, or in other scenarios when configuring ASP.NET and 
IIS. The most common indicator that the registration tool is needed occurs when IIS 
does not properly register and see the .NET v4.0 application pool. The benefit of using 
the tool is that it does not require a full removal and re-installation of IIS and .NET to 
correct ASP.NET registration problems. 

Follow these steps to use aspnet_regiis.exe on Windows Server 2008 R2:

1. On the web host server, open a run dialog window.

2. In the dialog window, enter the following: 
"C:\Windows\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis.exe" -i

3. Click OK on the dialogue window to run the command

For other installation issues, refer to the Windows event log for IIS messages that might 
help you discover the problem.
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Enabling Vantage Licenses
If you are implementing Vantage in a new production environment or you did not back 
up your previous database, enable your new licenses now using this procedure. If you 
have not yet obtained a license or if you need additional licenses, see Licensing 
Overview.

The following topics describe Vantage license installation:

 Installing a Vantage License

 Troubleshooting License Installation Problems

 Activating a Vantage License Offline

 Resolving a DEP Conflict

Note: A Vantage domain with two or more nodes requires one Vantage Array license 
for each node. Additional licenses are required to activate optional features.

Installing a Vantage License

Note: You should remove a license from one domain before you use it in another 
domain—you cannot use the same license in more than one domain at a time. For 
instructions on removing a license, see Deactivating a License.

When you receive a license (an XML file), install it using these steps:

1. Store a copy of the license file in a safe place. 

Always keep a backup in case you need to move the database later.

2. Store a copy of the license file in a location that is accessible to the server where 
you are installing the license, and note the directory where the file is stored. 

3. Start VMC as described in Starting the Vantage Management Console.

4. In the left panel, select Licenses.

5. In the right panel, click the Add License button  in the toolbar to display the Add/
Update License dialog.

6. Navigate to the folder containing the licenses, select the licenses, and click Open.

If this computer has an Internet connection, Vantage prompts you to accept the 
license agreement. If an error message appears, see Troubleshooting License Installa-
tion Problems.

7. Click I Accept... if you agree to the license terms, and click OK.

8. When the Licensing Changed dialog appears, read the message and click OK.

9. Repeat this procedure to install additional licenses.

When installation is complete, the license is stored in the Vantage domain database for 
use by all Vantage services and clients in the domain. Telestream recommends that you 
archive a copy of the original XML file, in case you need to move the license to another 
Vantage domain later.
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Troubleshooting License Installation Problems
There are three common problems that might occur during license installation:

• General eSellerate engine failure—the eSellerate server may be momentarily 
unavailable; wait one to two minutes, and then repeat the license procedure.

• No Internet connection—see Activating a Vantage License Offline.

• Data Execution Prevention (DEP) conflict—see Resolving a DEP Conflict.

Activating a Vantage License Offline
If the computer has no Internet connection, this error displays:

The Vantage Management Console might not have access to the Internet, or the 
network firewall might be prohibiting Web server (HTTP) traffic.

You can activate the Vantage license yourself using a different computer, or you can call 
Telestream Customer Service and they will assist you to activate your license.

To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the Product Activation dialog:

2. Click the second option (Activate using a different computer that has Web Access) 
to indicate you’re using a different computer, and click Next. Vantage displays the 
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Activate Using Another Computer dialog, along with the installation ID for your 
license (sample ID displayed):

3. Click Save to display a File Save dialog, so that you can create a text file which 
contains the activation key.

4. Save this file locally and copy this file to a computer with Internet access or save it 
directly to a share on (or accessible to) a computer which has Internet access. 

After saving the file, leave the dialog open and proceed to the computer with Inter-
net access to validate the Installation ID.

5. On the computer with Internet access, open a Web browser and navigate to 
activate.esellerate.net.

6. Open the installation ID text file and copy and paste the Installation ID into the 
Installation ID field on the Web page:
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7. Click Submit – Vantage connects to the eSellerate server. 
The eSellerate server validates the installation ID and returns a page which displays 
your unique activation key composed of ten groups of numbers and letters. 

8. If your Vantage server is not immediately adjacent, print this page or write down 
the activation key.

9. Return to the Vantage server where the Activate Using Another Computer dialog 
displays:
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10. Click Next to display the Enter Activation Key dialog:

11. Paste (or manually enter) the activation key and click Activate. (Note that you can 
also save the activation information to a file for safekeeping using the Save button 
before you click Activate.)

The activation key is accepted and the Vantage license is activated. Vantage dis-
plays a dialog confirming the activation:

12. Click Done—Vantage displays the activated license in the license details panel.
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Resolving a DEP Conflict
If Vantage displays the error eSellerate can not run with Data Execution Prevention 
enabled, follow these steps:

1. Right-click My Computer to display the System Properties dialog.

2. On the Advanced tab, click the Performance Settings button to display the 
Performance Options window.

3. On the Data Execution Prevention tab, check Turn on DEP for all programs and 
services except those I select.

4. Click Add and navigate to the location of the Vantage Management Console 
program (Normally located in C:\Program Files 
(x86)\Telestream\Vantage\VantageManagementConsole.exe).

5. Click Open, and click OK to apply this change.

6. Click OK to restart the computer.

7. Restart your computer and activate the license.

The activated license is stored in the Vantage domain database for use by Vantage 
services in this domain.

Note: If you move your Vantage domain database to another server, remove your 
license to deactivate it, and then import it and activate it again in the new database. 
Be sure to keep your license file (XML) as a backup.
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Installing Client Programs on Client Workstations
The available Vantage Client programs include the Vantage Management Console, the 
Vantage Workflow Designer, the Workflow Portal, and the Dublist Portal. These are 
installed on the Vantage server during initial installation, but they may also be installed 
on client workstations for use by administrators and workflow designers. 

To install the Vantage client programs on a workstation, do the following:

1. Log on to the target workstation with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

2. Copy the Vantage 6.0 Client Application.msi installer or the Vantage 6.0 Setup.exe 
installer to the workstation where you want to install the clients, or make the 
installer available on a network share. 

Note: Installers should not be mixed. Whether you use the Vantage installer or the 
client installer to install the clients, use the same installer for all subsequent client 
installation changes. Mixing installers may produce unexpected results.

3. Double-click the installer program to run it.

4. When the Welcome dialog appears, click Next to display the license agreement.

5. Read the Vantage Software License Terms and Conditions, click I Accept... if you 
agree to license terms, and click Next.

6. If using Vantage 6.0 Client Application.msi select which client apps to install.

7. If using Vantage 6.0 Setup.exe, select Single Node or Array Node installation and click 
Next.

8. If using Vantage 6.0 Setup.exe, select Custom Install, Client Applications, and click 
Next.

9. If using Vantage 6.0 Client Application.msi select where to install and click Next.

10. When the Ready to Install dialog appears, click Install. 

11. When installation is done, click Finish to close the installer. 
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Installing the Upload Portal
The Vantage Upload Portal is a TrafficManager option that may be installed and 
removed separately. 

1. Verify that IIS 7.0 or 7.5 is installed prior to running the Upload Portal installer. IIS 
roles must be enabled as listed previously for the Vantage Web Applications (see 
Table 8, IIS Role Service Requirements for Vantage Web Applications).

2. Download and unzip the Upload Portal files to access the Upload Portal Setup.exe 
and the VantageUploadPortal_6.0.msi installers. Be sure to preserve the existing 
unzipped file structure while running the installers.

3. Run Setup.exe as an administrator on the target server. Setup.exe runs prerequisite 
checks and installs .NET 4.0, SQL Server Compact Edition 4.0, and Windows Installer 
3.1 if they are not present. It then calls the VantageUploadPortal_6.0.msi installer. 

4. When the Welcome Window appears, click Next.

5. Read the license agreement, and if you accept the terms, click I Agree, and click 
Next.

6. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings to meet your server requirements, 
and click Next. 

Note: On the Select Installation Address page, you can set the address used to access 
the portal by changing the Virtual directory field. The default value is UploadPortal 
(http://servername/UploadPortal/). If you change the value to MyPortal, for example, 
the URL becomes http://servername/MyPortal/.

7. Click Install to start the installation.

8. When the Installation Complete dialog appears, click Finish.

For details about administering and using the Upload Portal, refer to the built-in help 
system and the Vantage 6.0 Upload Portal Administration Guide.
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Verifying the Installation
At this point in the installation, you should have a fully installed, fully functioning 
Vantage domain. Before installing updates or doing further system configuration, do a 
thorough check of all domain components to verify they are fully operational. 

Launch the following desktop shortcuts to make sure they are working:

• Vantage Management Console

• Vantage Workflow Designer

• Vantage Workflow Portal

• Vantage Dublist Portal

• Vantage Web Apps (arrays)—use a browser to access this URL: 
http://[server name]/Vantage

Testing the domain at this point assures you that everything has been installed 
correctly or allows you to pinpoint any components that need reinstalling or 
configuring. 

Once your system is known to work correctly, you can proceed to the next topic, 
installing updates. If any problems develop after updating, you will know that the 
update caused the problem, and you can focus on resolving the problem with the 
update.

Note: Existing workflows do not require updating to run as they did on the earlier 
Vantage release. However, new options in actions do not display automatically and are 
not usable until you upgrade each action as described in the Vantage User’s Guide.
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Updating Vantage Components
The Vantage 6.0 Setup.exe installer allows you to add (or re-install) individual Vantage 
components (services, clients, T&A Engine) as your needs change. You can rerun the 
installer, select Modify at the first screen, and check the components you want to add. 

Updates to the current version of Vantage may be periodically published by Telestream, 
and made available from the Telestream Web site. For these updates, Update installers 
accompanied by instructions may be used to replace individual Vantage components 
or the entire installation. The following topics explain how to find and download 
Vantage updates and how to install individual components, if required. 

CAUTION: Updating individual components should be done only as recommended 
by Telestream. Upgrading only selected components can result in component 
mismatches, causing a non-functioning Vantage system. If you have any questions, 
contact Telestream Vantage Support before updating.

To locate and install Vantage update packs, do the following:

1. Go to the Telestream Vantage download Web site:

http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=van-
tage

2. Review the Vantage download page to determine if there are any update packs 
that should be installed.

3. If there is an update pack to install, review the Release Notes that accompany the 
update and install the update pack according to your requirements and the 
instructions in the Release Notes.

The following instructions explain how to install individual components:

• Updating the Vantage Domain Database

• Updating Vantage Server Components

• Updating Vantage Clients on Client Workstations

• Updating Vantage Web Applications

• Updating the Upload Portal
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Updating the Vantage Domain Database
To update the Vantage domain database, follow these steps:

1. Log on to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

Note: For additional information on Vantage use with anti-virus software, see Anti-
Virus Software Recommendations. For more information on Vantage use with the 
Windows Firewall, see Firewall Guidelines.

2. To protect your data, open the Vantage Management Console and back up your 
database using the Domain Backup/Restore feature to create a backup file. See 
Backing up the Existing Database if you need detailed instructions.

3. Run the Vantage 6.0 Database Setup.exe installer. 

4. When the Welcome dialog appears, click Next to display the license agreement.  
Click I Accept if you agree to the license terms, and then click Next.

5. Select Upgrade existing database when the Database install mode dialog appears, 
and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

6. When the Destination Folder dialog appears, accept the default folder or click 
Change to select an alternate directory on another drive; then click Next.

7. When the Ready to Install Vantage Domain Database dialog appears, click Install to 
begin database installation. This process takes a few minutes to complete.

The Vantage installer upgrades your database and preserves information for work-
flows, design items, job history, catalogs, stores, application configurations, user 
settings and licenses.

Note: Existing workflows do not require updating to run as they did on earlier 
Vantage releases. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading. Refer to the 
Vantage User’s Guide for details about enabling new features in actions and workflows.

8. When installation is complete, click Finish to quit.
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Updating Vantage Server Components
The following procedure updates the Vantage services, clients, the Transcode & 
Analysis Engine, and the Domain Database:

Note: If you plan to update Vantage and Vantage Web Applications on the same 
server, you can avoid a Vantage service restart by first updating Vantage Web 
Applications. See Updating Vantage Web Applications. After installing the Web Apps, 
return here and continue this procedure.

1. Log on to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off.

Note: Telestream recommends not using anti-virus software on Vantage servers. If 
you use anti-virus software, you should identify Vantage as a safe/trusted application. 
See Anti-Virus Software Recommendations and Firewall Guidelines.

2. Uninstall Vantage Client Applications, the Telestream Media Transcode & Analysis 
Engine, Vantage, and the Vantage Domain Database using the Windows Programs 
and Features Control Panel. (Removing the T&A Engine and the Domain Database 
only removes the executables; your services configurations and database files 
remain intact in the Telestream\Vantage folder.)

3. Run the Vantage 6.0 Setup.exe installer. 

4. Select Modify which products and features are installed. (This option is not presented 
if you use a newer installer instead of the original installer, which you should do 
only if so instructed by Telestream.)

5. Accept the license agreement, select single node or array installation, and select 
the installation location, if presented. (Modify installations do not present these 
options.) Be sure to install the updated components in the same location as the 
original installation. 

6. Select Custom Install, and check the boxes for all Vantage components on this 
server for which you have a license (including the Domain Database if it’s on this 
server), and click Next. (The installer 

7. When the Ready to Install dialog appears, click Install to begin product installation. 
This process takes a few minutes and shows progress as it runs.

8. If Intel Performance Primitives (IPP) is not present, it is installed. For existing 
installations, it should already be present.

9. If QuickTime 7.5.5 or later is not installed, the installer displays a message advising 
you to visit Apple’s QuickTime for Windows Web page (www.apple.com/quicktime/
win.html), download the current version, and install it. Telestream recommends 
that you install version 7.6.9, which is not available on the Apple Web site. Again, 
this application will already be present in existing installations.
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Note: If you install a different version of the Telestream Media Transcode and Analysis 
engine than supplied with this Vantage installer, be sure to use the QuickTime version 
recommended for the version you are installing.

10. When installation is complete, click Finish to close the installer.

Note: For an All-in-One Single Node installation, Vantage creates a temporary storage 
area on the local hard drive, and creates a default Vantage catalog in the database.

11. In Windows, open the Control Panel’s Services panel and verify that the Vantage 
services you selected are present and started. The Transcode & Analysis Engine 
should also be present.

12. Start the services if they have not started.

Note: Occasionally, only a subset of the Vantage services and actions appear in 
Vantage Workflow Designer after a new install. This only happens once, immediately 
following the install. To resolve this issue, restart the Vantage server.
Vantage Domain Management Guide



Installing and Upgrading Vantage
Updating Vantage Components

114
Updating Vantage Clients on Client Workstations
The following procedure explains how to update Vantage clients installed on client 
machines. To update clients on Vantage Servers, see Updating Vantage Server 
Components. These client programs can be updated:

• Vantage Management Console (VMC)
• Vantage Workflow Designer
• Vantage Dublist Portal
• Vantage Workflow Portal

You can use either the Vantage 6.0 Client Applications.msi installer or the Vantage 6.0 
Setup.exe installer to update clients on client machines. When installing on client 
machines, the client installer is recommended because it downloads faster and takes 
up less space during installation than the Vantage installer. 

Note: Installers should not be mixed. Whether you use the Vantage installer or the 
client installer to install the clients, use the same installer for all subsequent client 
installation changes. Mixing installers may produce unexpected results.

Using the Client Installer to Install or Update Clients
Install or update Vantage clients using the Vantage 6.0 Client Applications.msi installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.

2. Run the Vantage 6.0 Client Applications.msi installer as an administrator.

3. Accept the license, and select the installation location.

4. Check the clients you want to install and uncheck the others. 

5. Follow the installer steps to complete the installation. 

Note: If you simply want to add or remove existing applications, the client installer 
allows you to Change, Repair, or Remove. These options are presented if you leave the 
applications in place before running the installer. If you choose Change, applications 
you check will be installed, and applications you uncheck will be removed.

Using the Vantage Installer to Install or Update Clients
Install or update Vantage clients as follows using the Vantage 6.0 Setup.exe installer:

1. Use Windows Control Panel Programs and Features to uninstall existing clients.

2. Run the Vantage 6.0 Setup.exe installer as an administrator.

3. Select Single Node Install.

4. Select Custom Install.

5. Check the clients you want to install and uncheck the others.

6. Browse to select where to install the clients. 

7. Follow the installer steps to complete the installation. 
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Updating Vantage Web Applications
Vantage Web Applications may be installed as part of a Vantage Array and may be 
updated separately or as part of an array upgrade.

Note: If you are updating the Vantage Web Applications on a server that also hosts 
Vantage services, the Vantage Web Applications upgrade will stop those services, 
which will interrupt Vantage operation. Plan to upgrade the Vantage Web 
Applications when the upgrade will cause the least interruption to Vantage users. This 
is not an issue when the Vantage Web Applications are installed on a dedicated server.

If you are updating the Vantage Web Applications from version 3.0 or later to 6.0, you 
do not need to repeat the IIS and .NET server preparation described for new 
installations. To update Vantage Web Applications, do the following:

1. Uninstall the Web Apps using the Windows Programs and Features Control Panel.

2. Download and run the Vantage Web Applications installer or the Vantage installer: 
VantageWebApplicationsSetup.msi or VantageSetup.exe as an administrator.

3. When the Welcome Window appears, click Next.

4. Read the license agreement, and if you accept the terms, click I Agree, and Next.

5. If using the Vantage 6.0 Setup.exe installer, select Array Installation, select Custom 
Install, scroll the list, and select Web Applications.

6. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings to meet your server requirements, 
and click Next.

Note: The Application Pool setting automatically defaults to ASP.NET 4.0. If it is not set 
to ASP.NET 4.0, there is an issue with the IIS or .NET installation. See Installing Vantage 
Web Applications for IIS and .NET configuration with the Web Applications.

7. Click Install to start the installation.

8. When the Installation Complete dialog appears, click Finish.

9. If Vantage services were running before the Vantage Web Applications upgrade, 
restart those services using Vantage Management Console > Services or the 
Microsoft Services tool (Start > Administrative Tools > Services).

Note: If you experience any problems with the upgrade, refer to Troubleshooting 
Vantage Web Applications Installation. For information on the browser requirements 
for Vantage Web Applications, see Vantage Web Applications Browser Requirements.
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Updating the Upload Portal
The Vantage Upload Portal is a TrafficManager option that may be removed and 
installed separately.

1. Uninstall Upload Portal using the Windows Programs and Features Control Panel.

2. Download the Upload Portal Setup.exe and VantageUploadPortal_6.0.msi installers. 
Run Setup.exe as an administrator on the target server. Setup.exe runs prerequisite 
checks and then calls the VantageUploadPortal_6.0.msi installer.

3. When the Welcome Window appears, click Next.

4. Read the license agreement, and if you accept the terms, click I Agree, and click 
Next.

5. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings to meet your server requirements, 
and click Next.

6. Click Install to start the installation.

7. When the Installation Complete dialog appears, click Finish.
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Moving the Vantage Domain Database to Another 
Database

You might want to move the Vantage domain database because:

• You are upgrading SQL Server from Express to Standard

• You are upgrading SQL Server from 2005 to 2008

• You are moving the database from one server to another

Note: If you are moving the database in conjunction with a Vantage upgrade, you 
should complete the upgrade prior to moving the database.

Note: This guide does not provide instructions for moving a mirrored database. 
Consult your database administrator or contact your Telestream representative 
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in 
the sequence presented:

1. Preparing for the Move

2. Backing up the Existing Database

3. Removing the Vantage Domain Database

4. Removing Microsoft SQL Server

5. Installing SQL Server 2008 Standard

6. Configuring SQL Server Standard Memory Settings

7. Installing the Vantage Domain Database

8. Restoring the Vantage Domain Database Backup

9. Finishing the Move

Note: This procedure backs up the database, moves the database to a different 
SQL Server version and/or server, and restores the database. Vantage does not 
support a Vantage restore from a version 3 Vantage database to a version 4 domain.
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Preparing for the Move
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database, but it is not required. However, if you are moving the Vantage 
domain database to a new server, you must backup the database, as the backup file will 
be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new 
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status 
Views web application, or Vantage Dashboard to either determine when all jobs are 
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

When you move the Vantage domain database from one server to another, the 
Storage, Variable, and Qualification rule configuration for each service is lost. 
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost 
when you change the SQL Server version on a server. Skip to Step 4 if you are not 
moving the Vantage domain database to a different server.

b. In VMC, remove all services from the Vantage domain as described in Removing a 
Service from the Domain.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

c. In VMC, select Licenses in the components panel.
d. On the Licenses tab, select all licenses and click the Delete button .

Note: To add the licenses back a the end of this procedure, you will need access to the 
license files. If you do not know where these files are, you might want to postpone the 
move until you have located them.

4. If you are changing the Microsoft SQL version on a server (and not moving the 
database to another server), place all services in Maintenance Mode as described in 
Entering and Exiting Service Maintenance Mode.
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Backing up the Existing Database
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database. If you are moving the Vantage domain database to a new server, you 
must backup the database, as the backup file will be used to restore the domain on the 
new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. In VMC, select the domain you want to modify, select Domain Backup/Restore in 
the components panel, click Backup, and use the file save dialog to save the backup 
file to a safe location.

You will need to access the backup file to restore the Vantage domain database 
after you move it. For more information, see Backing Up the Domain.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web 
Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database
To remove the Vantage domain database, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Windows Server 2008: Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.
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Removing Microsoft SQL Server
When you are upgrading Microsoft SQL Server, you will need to remove either 
Microsoft SQL Express or Microsoft SQL Server 2005. If Microsoft SQL Server 2008 
Standard is installed and you are moving the Vantage domain database to another 
server, you might want to remove Microsoft SQL Server 2008 Standard. 

To remove Microsoft SQL Server, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. If Microsoft SQL Server 2008 Express or Standard is installed, do the following:

a. Select Microsoft SQL Express or Microsoft SQL Standard and click Remove or 
Uninstall.

b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.
j. Optional step—Click the refresh button in the Control Panel to update the 

display, which will clear some of the SQL Server components from the display.

4. If Microsoft SQL Server 2005 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2005 and click Remove or Uninstall.
b. In the Component Selection dialog, check Remove SQL Server 2005 instance 

components, select VANTAGE: Database Engine, check Workstation Components, 
and click Next.

c. Click Finish.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLEXPRESS and VANTAGE for example), you 
will need to remove them both.
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5. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your domain database files intact in 
[Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on 
removing the database files, see Uninstalling Vantage from a Server.

At this point, the Vantage domain database and the SQL Server are removed from the 
server and any Vantage services and clients that were installed on the server remain 
installed. The domain cannot resume operation until the Vantage domain database 
and SQL Server are reinstalled on this server or set up on another server.

Installing SQL Server 2008 Standard
This procedure begins the set up of the Vantage domain database and the SQL Server 
on the server from which you just completed the uninstall or on a new server. The first 
step is to install Microsoft SQL Server 2008 R2 Standard so that Vantage discovers the 
server instance when you install the Vantage domain database.

To install SQL Server 2008 Standard on a server, follow these steps:

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

1. Log on to the target server with a local administrator account.

2. Insert the SQL Server 2008 Standard DVD into the server and start the installer 
(setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. Setup Support Files—Click Install, allow the installer to complete its actions, then 
click Next.

Note: If Restart computer... Failed displays in the report, this is due to a bug in the SQL 
Server 2008 Standard R1 installer. 
To correct the problem, run Regedit and navigate to this key: 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\PendingFileRenameOperations. Clear the Value Data string.
After you clear the Value Data string, return to Setup Support Rules and click Re-run on 
the right by the status bar. The Setup Support Rules should complete successfully—
click OK to continue.
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Note: On SQL Server 2008 R2 only, select SQL Server Feature Installation and click 
Next.

8. Feature Selection—Check Database Engine Services and Management Tools, and 
click Next.

9. Instance Configuration—Select Named instance, enter VANTAGE in the Named 
instance field and the Instance ID field, and click Next.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration—Do the following:

a. For SQL Server Agent, select NT AUTHORITY\NETWORK SERVICE.
b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

12. Database Engine Configuration—Do the following:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the installer.

Configuring SQL Server Standard Memory Settings
When using SQL Server Standard, the maximum server memory for SQL should be set 
to utilize a maximum 75% of the system's memory.

1. On the target server, select Start > Microsoft SQL Server 2008 R2 > SQL Server 
Management Studio.

2.  Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

4. In the Server Properties window, go to the Memory page.

5. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

6. Click OK.

7. Close the SQL Server Management Studio.
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Installing the Vantage Domain Database
This task installs the Vantage domain database instance.

Follow these steps:

1. Log on to the database server with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Locate the Vantage domain database installer (for example, Vantage 6.0 Database 
Setup.exe), copy it to your server, or obtain the Vantage Installer CD. (Alternatively, 
you can use the VantageSetup.exe installer and choose to install only the Domain 
Database for your single node or array installation.)

3. Run the Vantage domain database installer, which extracts the components, then 
continues. Component installation takes a few minutes.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display 
the license agreement.

5. License Agreement—Read the Vantage Software License Terms and Conditions, 
then click I Accept if you agree to license terms. Click Next.

6. Database Install Mode—Click Install new database and click Next to continue.

7. Destination Folder—Accept the default folder or click Change to select an alternate 
folder. Click Next.

8. Ready to Install Vantage Domain Database—Click Install to begin database 
installation. This process takes a few minutes to complete.

9. Completed—When installation is complete, click Finish.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. 
Vantage should have discovered the old database files. Now you need to finish the 
process as described in Finishing the Move. 

If the old database files are not found, or if you are installing the Vantage domain 
database on a different server, restore the database from the backup file as described in 
Restoring the Vantage Domain Database Backup.
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Restoring the Vantage Domain Database Backup
To restore the Vantage domain database using the backup file you previously created, 
follow these steps:

1. Start VMC on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of 
the Vantage domain changed to the name of the new host server.

2. In VMC, select the domain you want to modify, select Domain Backup/Restore in 
the components panel, click Restore, and use the file open dialog to select the file 
to restore.

For more information, see Backing Up the Domain.

Finishing the Move
To finish the move, you must enable the services you disabled when preparing for the 
move. If you moved the Vantage domain database to another server, you must also 
install the appropriate Vantage licenses. To return Vantage to operation, follow these 
steps:

1. If you changed the Microsoft SQL version on a server (and did not move the 
database to another server), do the following:

a. Remove all services from Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode.

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage 
Domain licenses as follows:

a. In VMC, open the domain you want to modify, and select Licenses in the 
components panel.

b. On the Licenses tab, click the Add License button  and use the open file dialog 
to select the license file.

If your domain has multiple license files (for multiple features), repeat this step 
for additional licenses.

3. If you moved the database to another server, update the configuration of services 
as follows:

a. In VMC, open the domain you want to modify, and select Services in the 
components panel.

b. In the Services panel, click the Add Service button  and use the dialog to select 
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for 
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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Adding a Server to a Vantage Domain
Table 9 lists the types of servers you might want to add to a Vantage domain and shows 
where you can find instructions for adding these servers.

Table 9. Adding Servers to a Vantage Domain

Server Type Instructions

Vantage Lightspeed 
server

A Vantage Lightspeed server can be added to a Vantage domain that uses 
Vantage version 4.0 or later. When you add a Vantage Lightspeed server 
to a Vantage domain, the Lightspeed server must be running the same 
Vantage version as the Vantage domain.

The Vantage Lightspeed server ships with an installed Vantage domain 
database, and all Vantage services on the Lightspeed server are assigned 
to that Vantage domain database. To add the Vantage services on the 
Lightspeed server to the existing domain, use VMC to reassign the 
services.

After you reassign the Vantage services, Telestream recommends that you 
remove the Vantage domain database on the Lightspeed server so that 
the old Vantage domain is no longer advertised to Vantage client 
programs and Web applications.

To remove the Vantage domain database from the Lightspeed server and 
reassign services, see Adding a Lightspeed Server to an Existing Vantage 
Domain.

Vantage domain 
database server

A Vantage domain can host one Vantage domain database, which can be 
installed on a single or mirrored database server. 

If your Vantage domain has a Vantage domain database on a single 
database server, you can do the following:

• Move the Vantage domain database to another server as described in 
Moving the Vantage Domain Database to Another Database.

• Add a database server to mirror the current server. 

This guide does not provide instructions on setting up a mirrored 
database server. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Vantage array server Additional Vantage array servers add more throughput capacity to your 
Vantage domain. When you add a Vantage array server to a Vantage 
domain, the server must be running the same Vantage version as the 
Vantage domain. For instructions on adding a Vantage array server, see 
Installing Vantage Array Components.
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Adding a Lightspeed Server to an Existing Vantage 
Domain

This topic describes how to add a Lightspeed server to an existing Vantage domain. A 
Vantage domain can host just one Vantage domain database. When you add a 
Lightspeed server to an existing domain, Telestream recommends that you remove the 
Vantage domain database and SQL Server on the Lightspeed server so that Vantage 
does not advertise the unused Vantage domain on the Lightspeed server, and so that 
memory used by the SQL Server becomes available for Vantage use.

Note: The Lightspeed server and the existing Vantage domain must be using the 
same Vantage release, which must be Vantage 4.0 or later.

To add a Lightspeed server to an existing Vantage domain, follow the procedures in the 
following topics in the sequence presented:

1. Moving Licenses to Another Domain

2. Moving Vantage Services to Another Domain

3. Setting the Vantage Windows Log On ID for a Service

4. Removing the Vantage Domain Database

5. Removing Microsoft SQL Server

Vantage Web 
Applications server

For instructions on adding a Vantage Web Applications server, see 
Installing and Configuring Vantage Web Applications.

Vantage store You can add multiple Vantage stores to a domain. A Vantage store can 
reside on a dedicated server or with Vantage services. For instructions on 
setting up a Vantage store, see Setting Up a Vantage Store.

Table 9. Adding Servers to a Vantage Domain (Continued)

Server Type Instructions
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Moving Licenses to Another Domain
Any purchased licenses that have been added to the Lightspeed server should be 
removed from the Lightspeed server so they can be added to the existing domain. 
Most Vantage domains have a single license that contains multiple license options. 
However, Vantage can accept and combine license options in multiple license files. In 
most cases, you need to remove the license from the Lightspeed server and contact 
Telestream to arrange a Lightspeed server update to the license for the existing 
domain.

To delete licenses from the Lightspeed server and add them to the existing Vantage 
domain, do the following:

1. In VMC, open the domain for the Lightspeed server, and select Licenses in the 
components panel.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

2. Place all services in Maintenance Mode as described in Entering and Exiting Service 
Maintenance Mode.

3. On the Licenses tab, select all licenses and click the Delete button .

Note: To add licenses to the other domain, you will need access to any license files 
sent from Telestream or an updated license file for the other domain.

4. In VMC, open the domain to which you want to add the licenses, and select 
Licenses in the components panel.

5. If you are updating the license for the existing domain, do the following:

a. Select the license you are updating and click the Delete button .
b. Click the Add License button  and use the open file dialog to select the 

updated license file.

6. If you are adding licenses to the existing domain, click the Add License button  
and use the open file dialog to select a license file.

Repeat this step for additional licenses.

7. Take all services out of Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode.
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Moving Vantage Services to Another Domain
To move services from the Lightspeed server domain to the existing Vantage domain, 
do the following:

1. In VMC, open the existing domain to which you want to add the Lightspeed server 
services.

2. Select Services in the component (left) panel.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.

4. Select one or more Lightspeed server services to add to this domain, and click OK 
to add them.

Services are identified by name, machine, and Vantage domain. Use the machine 
name to identify the services on the Lightspeed server. To select multiple services, 
use shift-click to select a series of services, or use option-click to select individual 
services.

5. If you are moving a service from one domain to another, VMC displays the Reassign 
Services window. Click OK to add them to this domain.

Setting the Vantage Windows Log On ID for a Service
On the Lightspeed server, the default log on ID for each Vantage service is the Local 
System account. This log on ID provides access to files on the local server only. If a 
service, such as Multiscreen, requires access to files on another server, the Local System 
account cannot provide that access. If Vantage services need access to input folders, 
output folders, or a Vantage store that is on another computer, you must do the 
following:

• Create a Vantage Windows user ID for the service

• Grant access to the Vantage Windows user ID for the appropriate file space on other 
file systems.

For more information, see Windows Authentication Guidelines.

Vantage services except Agility, Catalog, and Sdk, require a Vantage Windows user ID to 
access files on other computers:

Within a single service, the Windows log on ID for that service must be the same on all 
Vantage servers in the domain. For example, all Analysis services within the domain 
must use the same log on ID. However, the Catalog service, which does not access files, 
can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the array:

1. Log on to the target server with a local administrator account.

2. On the Vantage server, select Start > Administrative Tools > Services.

You can also select Start, type services.msc in the search box, and press Enter.
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3. Right click on a Vantage service and select Properties. (All Vantage services begin 
with the word Vantage.)

4. Select the Log On tab.

Figure 6. Vantage Service Log On Properties

5. Select This account.

6. Click Browse and use the Select User dialog to select the Vantage Windows user 
account name (for example, VantageWinUser), and click OK.

If the Vantage Windows user name has not been defined, it will not appear in the 
browser. You can also enter a user name in the This account text box. For informa-
tion on the Vantage Windows user name and how to create it, see Windows Authen-
tication Guidelines.

Note: All Vantage services in a Vantage domain should be located in the same 
Windows domain. In Figure 5, Starfleet represents the Windows domain.

7. Enter the password for the Vantage Windows user in the Password and Confirm 
password text boxes, then click OK.

8. Repeat Steps 3 to 7 as needed for the other Vantage services.

Note: In some cases; you may be required to indicate that the specified user has been 
granted log on as a service right. If the service fails to start and displays an error 
indicating that the service log on user name may not have the necessary permissions, 
consult your IT administrator to set the appropriate rights for the new account.

9. Restart any updated services.
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Removing the Vantage Domain Database
To remove the Vantage domain database, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Domain Database and click Remove or Uninstall. 

Removing Microsoft SQL Server
To remove Microsoft SQL Server, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs (Control Panel > Programs and 
Features > Uninstall Programs).

3. Remove Microsoft SQL Server 2008 Standard as follows:

a. Select Microsoft SQL Standard and click Remove or Uninstall.
b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLSTANDARD and VANTAGE for example), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the Vantage Domain Database or the SQL Server does not delete 
your Vantage domain database files containing your workflows, resources, and 
transaction history. It leaves those files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. If you reinstall SQL and the Domain Database 
application later, you can attach these files and restore your previous Vantage domain.
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Verifying DTC Service Settings
During installation, Vantage configures and starts the Distributed Transaction 
Coordinator (DTC) Windows service. There is no need to verify DTC configuration and 
operation after the install, but if you suspect that the DTC service has stopped or the 
DTC configuration has changed, you can use the information in this topic to verify the 
DTC status and configuration.

Vantage uses DTC for communication between services and the SQL Server database to 
guarantee that messages are processed as atomic messages (that is, the entire message 
is successfully processed or the database state is reverted to the pre-message state). 
This guarantees that services do not duplicate jobs and that jobs do not register in a 
partial or incomplete state in the database. 

In a Vantage domain, DTC must be running and correctly configured on each Vantage 
database server and Vantage server, or Vantage services cannot communicate with the 
Vantage domain database, and the domain stops operation.

To verify operation and configuration, use the procedures in the following topics:

 Verifying DTC Operation

 Verifying the DTC Configuration

Verifying DTC Operation
To verify that the DTC is running, do the following:

1. In Windows, select Start > Administrative Tools > Services.

2. Verify that the startup type for Distributed Transaction Coordinator is set to 
Automatic.

3. If you need to change the startup type, do the following:

a. Right-click on the Distributed Transaction Coordinator service and select 
Properties to display the Properties window.

b. Select Automatic from the Startup Type dropdown and click OK.

4. If the DTC service is not running, right-click on the service name and select Start.

Verifying the DTC Configuration
To verify that DTC is configured correctly, do the following:

1. In Windows, select Start > Administrative Tools > Component Services.

2. In the left pane, navigate to Component Services >Computers > My Computer > 
Distributed Transaction Coordinator. 

3. In the right pane, right-click Local DTC and select Properties.

4. Click the Security tab.

5. To enable transactions to properly flow from one machine to another, set the 
Security configuration settings as shown in Figure 7, and click OK.
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Figure 7. DTC Security Settings

Note: You have to restart the database instance in order for SQL to receive 
notification of the changes to the DTC. You can restart the database by restarting the 
server that the database is on.
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Using the Vantage
Management Console

This chapter describes how to use the Vantage Management Console.

The Management Console (VMC) enables Vantage system administrators to configure 
their Vantage domain and to scale Vantage services across multiple servers (creating a 
Vantage array) to meet their operating requirements.

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

The following topics describe how to use VMC:

 Introduction

 Starting the Vantage Management Console

 Managing the Vantage Domain Connection

 Using the Vantage Management Console Workspace

 Managing Tips and Warnings

 Using the Help System

 Displaying Vantage Version Information

 Vantage Management Console Reference

Introduction
VMC is designed to facilitate centralized management of the software components and 
resources that comprise a Vantage domain, including settings and options, Vantage 
catalogs, Vantage stores, Vantage servicess, licenses, workflow design items, and client 
application configurations. VMC also provides real-time status details for services, 
machines, and the domain at large, plus a domain backup/restore utility and other 
support utilities.

VMC manages a single Vantage domain at a time. 

CAUTION: Although VMC is a multi-user application, when used for modifying a 
domain, it is intended for use by one user on one domain at a time. Connecting 
multiple consoles to the same Vantage domain for any other purpose than viewing 
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status and configuration details is not recommended and can lead to domain 
configuration problems.

Each Vantage domain includes a single Vantage domain database, which consists of a 
Microsoft SQL Server instance, Vantage domain database software, and database files. 
All configurations that you create with VMC are stored in the Vantage domain database.

Many organizations implement Vantage as a single domain. However, in large facilities, 
you may have several separate and independent Vantage domains for scaling to high-
volume workflow processing or for specialization and departmentalization purposes.

In a facility with multiple Vantage domains, you can connect to any Vantage domain in 
the network from any Management Console in the network.

Starting the Vantage Management Console
To start the Management Console, do one of the following:

• Select Start > Programs > Telestream > Vantage > Vantage Management Console

• Double-click the Vantage Management Console shortcut on your desktop:

Figure 8. Management Console Shortcut

After you start VMC, your domain configuration may prompt you for additional 
information, which is described in the following topics:

 Selecting a Domain

 Entering a Username and Password

Selecting a Domain
Each time you start VMC, the program connects to the last domain to which it was 
connected. If you are starting the program for the first time, VMC polls the network for 
domains in the same subnet, and displays the domains that responded in a list 
(Figure 9).
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Figure 9. Vantage Domain Selection Panel

The name for each Vantage domain is the name of the computer that hosts the Vantage 
domain database. If you do not know which domain you should connect to, see your 
Vantage domain administrator.

To select a domain, do the following:

1. If the domain you want appears in the list, select the domain (Figure 9). 

2. If the Vantage domain’s SQL database default username and password were 
changed during installation, do the following:

a. Click Connection Settings to display a dialog that you can use to specify the 
correct username and password for the MS SQL Server (Figure 10).

Figure 10. MS SQL Login Settings

b. Enter the Vantage domain database SQL Server account username and password 
(obtained from your Vantage administrator).
Vantage Domain Management Guide



Using the Vantage Management Console
Starting the Vantage Management Console

136
3. If the domain you want is not in the list (not in your current subnet), do the 
following:

a. Click My Vantage Domain isn’t Listed to display a dialog to manually enter the 
domain (Figure 11).

Figure 11. Vantage Domain Server Identification

b. Enter the domain name or IP address of the server that hosts the Vantage 
domain database (for example, VantageServer203 or 192.168.1.1).

If you do not know IP address of the server that hosts the Vantage domain data-
base, see your Vantage domain administrator.

4. Click OK to continue.

Entering a Username and Password
When you are accessing a Vantage domain, you need to provide your Vantage 
Username and Password to log in (unless User Administration is disabled—see 
Managing Vantage Users). Vantage prompts you for your user information when you 
start VMC (Figure 12).

Figure 12. Vantage Domain Login Dialog 

If the dialog prompts for credentials to a domain you cannot or do not want to access, 
click Cancel and select the domain to which you want to connect as described in 
Selecting a Different Domain.

When the dialog displays the correct domain name, enter your Vantage username, and 
password, if required, and click OK to connect.

The default Vantage user is Administrator, with no password assigned, and this user has 
Administrator privileges. Only Vantage users who are administrators can log into VMC.

Note: All user passwords are encrypted in the Vantage domain database.
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Managing the Vantage Domain Connection
Vantage Management Console connects to one domain at a time. You must connect to 
a domain before you can use VMC to manage that domain. In an environment where 
more than one Vantage domain is operating, you can use the same Management 
Console to connect to any single domain.

The following topics describe tasks for managing your domain connection:

 Identifying the Selected Domain

 Selecting a Different Domain

Identifying the Selected Domain
Each Vantage domain is identified by the name of the computer on which the Vantage 
domain database instance is running. To determine the domain to which the 
Management Console is currently connected, note the Vantage domain name in the 
window title as shown in Figure 13.

Figure 13. Vantage Domain Component
Current Vantage domain Current Vantage user
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Selecting a Different Domain
To select a different Vantage domain, do the following:

1. Select File > Change Vantage Domain.

2. Select a domain as described in Selecting a Domain.

When you change domains, VMC closes its connection to the current domain’s Vantage 
domain database and connects to the new domain’s database, refreshing the details of 
all of its components.

Using the Vantage Management Console 
Workspace

The Vantage Management Console window displays two panels that display Vantage 
configuration components and configuration settings as shown in Figure 14.

Figure 14. The Vantage Management Console Workspace

Components Panel
On the left is the Vantage components panel, which lists Vantage configuration 
components.

Details panelComponents panel
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Details Panel
To the right of the components panel is the details panel, which lists the configuration 
settings for the Vantage component selected in the components panel.

For example, when you select the Settings & Options component, the details panel 
displays all the configuration options for this component as shown in Figure 14. For the 
Settings and Options component, the details panel options are divided into four tabs. 
The details panel for other components is further divided into subpanels. These tabs 
and subpanels help to organize the configuration options.

Managing Tips and Warnings
To restore tip and warning messages that were previously disabled by clicking Don’t 
show me this again, select Options > Restore Tips & Warnings. When tips and warnings 
are restored, these tips and warnings display as you interact with VMC.

To disable all tip and warning messages select Options > Hide Tips & Warnings. These 
messages can also be individually disabled by clicking Don’t show me this again when 
they appear.

Using the Help System
The Vantage Management Console provides the following help documentation:

 Context-Sensitive Help

 The Vantage Domain Management Guide

 Tool Tips

 Online Help

Context-Sensitive Help
When you are using the Vantage Management Console, context-sensitive help displays 
the appropriate section of the Vantage Domain Management Guide (which is this 
guide). For example, if you select the Storage component in the components panel and 
open context-sensitive help, Vantage displays the Managing Vantage File Storage 
section of this guide. To start context-sensitive help, press F1 or click the ? button.
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The Vantage Domain Management Guide
The Vantage Domain Management Guide is available in PDF and program help formats. 
When you use context-sensitive help, you are opening the program help version of this 
guide to a section appropriate for the configuration settings you are viewing. You can 
also open this guide by selecting one of the following:

• Help > Contents—Displays the table of contents of this guide.

• Help > Index—Displays an index for this guide.

• Help > Search—Displays a search panel that you can use to search for information.

The Favorites tab in the help program can be used to save and display topics you want 
to quickly access. While viewing a help topic, click the Add button to add the current 
topic to the favorites list. To remove a topic, select the topic and click Remove.

Tool Tips
Tool tips display information about buttons and configuration options in the Vantage 
Management Console. To display the tool tip for a button or option, hover the cursor 
over the button or option.

Online Help
The latest documentation is posted on the Telestream, Inc. Web site. To quickly access 
the Telestream online documentation from within Vantage Management Console, 
select Help > Online Help.

Note: Access to the Vantage Online Help requires an Internet connection.

Displaying Vantage Version Information
Vantage software version information can be found in the Help menu of Vantage 
programs and in the Microsoft Windows Control Panel. 

To locate software version information in a Vantage program, select Help > About..., 
where the About... reference is unique to the Vantage program.

To display Vantage software version information in the Control Panel, do the following:

1. Select Start > Control Panel.

2. Click Uninstall a program.

3. Scroll through the list of programs to view the Vantage Program versions installed. 
(Be careful not to double-click any programs, as they will uninstall.)
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Vantage Management Console Reference
The following topics provide descriptions of Vantage Management Console controls:

 Vantage Management Console Menus

 Vantage Component Descriptions

Vantage Management Console Menus
Table 10 describes the Vantage Management Console menus.

Table 10. Vantage Management Console Menus

Menu Selection Description

File Change 
Vantage 
Domain

Displays a dialog that you can use to select another 
domain as described in Selecting a Domain.

Change 
Vantage 
User

Displays a dialog that you can use to change to another 
Vantage user name. See Entering a Username and 
Password.

Exit Quits the Vantage Management Console Program.

Options Restore Tips 
& Warnings

Restores tip and warning messages after they have been 
disabled. See Managing Tips and Warnings.

Hide Tips & 
Warnings

Hides tip and warning messages. See Managing Tips and 
Warnings.

Help Contents Displays the contents of this guide in program help.

Index Displays an index of this guide in program help.

Search Displays a search panel that you can use to search for 
information in the program help.

Online Help When you are connected to the Internet, this option 
opens the Vantage documentation Web page in your 
browser.

About Displays version information for the Vantage 
Management Console program.
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Vantage Component Descriptions
Table 11 describes the components in the Vantage Management Console components 
panel.

Table 11. Vantage Configuration Components

Parameter Description

Settings & Options Use this panel to display general settings that configure 
Vantage operation. For more information, see Settings 
and Options.

Catalogs The Catalogs panel allows you to manage catalogs and 
the binders they contain. For more information, see 
Managing Catalogs.

Storage The Storage panel allows you to manage the Vantage 
Stores and Vantage Folders where Vantage files are 
stored. For more information, see Managing Vantage File 
Storage.

Services Use the Services panel to configure your Vantage services 
according to your requirements. For more information, 
see Managing Services.

Licenses Use the Licenses panel to view, add, delete, and 
deactivate licenses for Vantage features. For more 
information, see Managing Licenses.

Status See Viewing the Active Workflows and Actions.

Workflow Design Items See Managing Workflow Design Items.

Domain Workflow 
Analytics

See Viewing Workflow and Action Analytics.

Support Utilities Use the Support Utilities panel to access Vantage utilities 
for the following:

• Managing Vantage Workflows
• Using the Data Collection Utility
• Using the Change Log
• Using the Error Log
• Exporting and Importing Workflow Action Configurations
• Displaying Plug-in Versions
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Settings and Options
Table 12 provides descriptions and references for the parameters for the Settings & 
Options component.

Application 
Configurations

Use the Application Configurations panel to select a 
Vantage application to configure. For more information, 
see:

• Configuring Job Status Views Operation
• Configuring Vantage Workflow Portal Operation
• Configuring the Dublist Portal

Report Configurations See Creating Report Formats.

Fulfillment Schemes Configure Dublist Schemes to parse incoming dublists.

Users Use the Users panel to manage how Vantage users access 
and use Vantage features. For more information, see 
Managing Vantage Users.

Domain Backup/Restore Use the Domain Backup/Restore panel to back up and 
restore the Vantage domain database. For more 
information, see Backing Up and Restoring the Vantage 
Domain Database.

Table 11. Vantage Configuration Components (Continued)

Parameter Description

Table 12. Settings & Options Panel Parameters

Tab Parameter Description

General Enable cost-based load 
balancing

Enables cost-based load balancing. For more 
information, see Managing Load Balancing.

Enable user 
administration

Enables or disables Vantage user 
management. For more information, see 
Managing Vantage Users.

Expire failed jobs See Enabling and Disabling Expiration of Failed 
Jobs.

Vantage Workflow 
Designer Grid

See Setting the Vantage Workflow Designer 
Grid Width/Height.

Email All See Configuring Vantage Email Notifications.
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Application Configurations
The Application Configurations component lists client applications that the Vantage 
Management Console can manage. 

To display the client programs that you can manage, select Application Configurations 
in the components panel.

Refer to the following topics for more information on these applications:

 Configuring Job Status Views Operation

 Configuring Vantage Workflow Portal Operation

Support Utilities
Vantage provides utilities to import and export workflows, collect important 
information about your domain, and send this data to Telestream Customer Service to 
help diagnose and solve a problem. Utilities also perform other important tasks to help 
you manage your domain effectively.

Figure 15. Support Utilities Panel

Authorization All See Specifying Authorization Credentials for 
Remote Folder Access.

Signiant All Configuring a Signiant Connection

Agility ECS All See Configuring an Agility ECS Connection.

Table 12. Settings & Options Panel Parameters (Continued)

Tab Parameter Description
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Refer to the following topics for more information on these utilities:

 Using the Data Collection Utility

 Using the Change Log

 Using the Error Log

 Exporting and Importing Workflow Action Configurations

 Displaying Plug-in Versions
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Managing a Vantage
Domain

This chapter describes how to manage a Vantage domain.

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

The following topics describe how to manage a Vantage domain:

 Managing Licenses

 Managing Vantage File Storage

 Managing Vantage Users

 Managing Services

 Managing Load Balancing

 Configuring Vantage Email Notifications

 Specifying Authorization Credentials for Remote Folder Access

 Configuring a Signiant Connection

 Configuring an Agility ECS Connection

 Using the Data Collection Utility

 Using the Change Log

 Using the Error Log

 Displaying Plug-in Versions

 Backing Up and Restoring the Vantage Domain Database

 Renaming a Vantage Domain

 Renaming a Vantage Server
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Managing Licenses
Telestream provides Vantage licenses to enable a specific set of capabilities in a 
Vantage domain. A single license file activates capabilities for every server in the 
domain—functionality that was specified in your license request. Production licenses 
can only be used by one Vantage Domain at a time.

When you receive a license file from Telestream, you need to activate the license file. 
Activation locks the license in the Vantage domain database, and the license remains 
locked until deactivated. Once activated, the license file is no longer used by Vantage. 
However, you should keep the license file in case it needs to be reactivated later.

The following topics provide information on managing Vantage licenses:

 Viewing Vantage Licenses

 Adding a License

 Deactivating a License

Note: For information on Vantage Workflow Portal session management, see Viewing 
and Resetting VWP Sessions.

Viewing Vantage Licenses
To view the Vantage licenses in your domain, start the Vantage Management Console 
and select Licenses in the components panel on the left. Vantage displays the Licenses 
detail panel shown in Figure 16. 

Figure 16. The Licenses Details Panel
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You use the Licenses details panel to add a license to the domain and activate it. You 
also use the details panel to remove a license from the domain.

Select a license to open and view the policies in this license and the associated 
capabilities it enables.

Adding a License
Vantage licenses are normally installed when the domain is installed. For instructions 
on adding a license, see Enabling Vantage Licenses.

Deactivating a License

Note: Before deactivating a license, all jobs using the license should be stopped, and 
all services using the license should be put into Maintenance Mode. Otherwise, the 
license will report being in use.

To deactivate a license in a domain, select the license and click the Remove license 
button  in the toolbar (or right-click and select Delete). Click Yes to confirm.

When you remove a license, Vantage attempts to deactivate it. A license should only be 
removed if you intend to install the same license on a different Vantage domain. In this 
case, the removal process also attempts to deactivate the license. The deactivation 
process will indicate that the license may be loaded on a different domain. If a license is 
not deactivated prior to adding it to another Vantage Domain, an error occurs—
indicating that the license is currently in use on a different Vantage domain and that it 
can not be activated a second time.
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Managing Vantage File Storage
Vantage storage is disk space that can be used to store files for Vantage processing. The 
following topics provide information on Vantage storage:

 Understanding Vantage Storage

 Understanding Path Specifications for Vantage Storage

 Managing Vantage Stores

 Managing Vantage Folder Addresses

Understanding Vantage Storage
Vantage storage is disk space that Vantage can use to store media files and 
attachments. Vantage storage is different from database storage, which stores data for 
Vantage configuration, job/binder status, and system status.

Vantage provides two types of storage:

• Vantage stores—Managed disk space where media files and attachments are auto-
matically deleted when they are no longer referenced by a binder.

• Vantage folder addresses—Unmanaged disk space to which media files and attach-
ments can be delivered, but from which files are not automatically deleted.

Vantage stores are defined in the Management Console and can be used in workflow 
actions that perform file operations. Vantage stores can also be associated with 
Vantage services for temporary storage (such as the location for a file that is being 
created during transcoding). Managed files remain in a Vantage store while either of 
the following is true:

• The files are referenced by a binder during job processing.

• The files are referenced by a binder that has been registered in a catalog, and the 
binder expiration date has not yet passed.

Vantage folders can be created in the console or in Vantage Workflow Designer. Like 
stores, Vantage folders can then can be used in workflow actions that perform file 
operations. 

Transport actions that are responsible for saving files can use both stores and folders as 
file access and delivery points.
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Understanding Path Specifications for Vantage Storage
Vantage stores and folders can be specified using the following path forms:

• UNC form: \\ComputerName\Sharename

• Physical drive-letter form: C:\folder\folder

• Mapped drive managed by SAN client software (for example, StorNext)

Note: Vantage cannot access network locations defined using a Windows mapped 
drive. For all network locations other than properly configured SAN locations, you 
must use a UNC path to define network locations for Vantage use.

If all your Vantage services, clients, and storage are on the same server, you can use 
either path form. However, Telestream recommends that you always use the UNC path 
form.

The disadvantage to using the drive-letter path form is that the drive letter is defined 
on the local machine, and the drive letter does not identify the computer that hosts the 
drive. For example, if you specify a Vantage store on drive C: using the drive-letter path 
form and a Vantage Workflow Portal (VWP) operator tries to view files in that store on a 
different computer, VWP will search for those files on drive C: on the operator’s 
computer, not on the Vantage server.

When any Vantage service or client program will use Vantage storage from a different 
computer, you must specify the path using the UNC form. You should also use the UNC 
form if you think you might ever support Vantage services or clients on another 
computer. You can change the path form later, but it is easier to use the UNC path form 
now, and it can prevent troubleshooting issues in the future.

Note: When services or clients will access Vantage storage from another computer, 
the Vantage storage location must be published as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: If you are creating a store to hold proxy files viewed in VWP, Telestream 
recommends that you reference the store with a UNC path. Some SAN clients do not 
allow frame-accurate representation of proxies when using shared drives.
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Managing Vantage Stores
Vantage stores management is performed in the Management Console. When you 
install Vantage in all-in-one mode, a default store named Local Store is created so that 
you can use Workflow Designer and access at least one store. You can add other stores 
as necessary.

To manage your stores, start the Vantage Management Console and select Storage > 
Vantage Stores in the components panel. Vantage displays the Vantage Stores detail 
panel shown in Figure 17.

Figure 17. The Vantage Stores Details Panel

Use the Vantage Stores details panel to add and configure stores. You also use the 
details panel to modify and delete stores.

The following topics describe how to manage Vantage stores:

 Adding and Configuring Vantage Stores
 Viewing Files in a Vantage Store
 Modifying a Vantage Store
 Moving a Store Online or Offline
 Identifying Workflows that Use a Store
 Setting the Block Size
 Duplicating a Vantage Store
 Exporting and Importing Vantage Stores
 Deleting a Vantage Store

Note: The Alias feature shown in Figure 17 supports the Web-based VWP application 
as described in Managing Alias Support for the VWP Web Client.
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Adding and Configuring Vantage Stores
To add a new Vantage store, do the following:

1. Click the New Vantage Store button  in the toolbar to display the Add New Store 
dialog (or right-click and select New Vantage Store).

2. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

3. To specify the store root directory with a UNC path (recommended), do the 
following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

4. To specify the store root directory with a drive letter path, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

5. Click OK.

6. Click the Save button  to save the new store.

Viewing Files in a Vantage Store
The Files text box on the Vantage Stores page displays the files in the Vantage store. 
You can also use tools in the host file system (Windows Explorer, for example) to view 
the files in the store. To refresh the display of files, click the refresh button .
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Modifying a Vantage Store
To modify a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.

2. To change the store name, type a new name in the Name text box.

3. To enter a description for the store, type a description in the Description text box.

4. To specify the store root directory with a UNC path (recommended), do the 
following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

5. To specify the store root directory with a drive letter path, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location field, such as C:\folder\folder.

Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

6. To specify a folder naming scheme for the store, select the scheme from the Folder 
Scheme drop down list.

When content is placed in a Vantage Store, Vantage creates a subfolder in the Store 
location to save the files in. If you select Identifier, the subfolder is named by auto-
generating a GUID. Date uses the current time and date stamp, and Name+Date 
uses the content name plus the time and date. For example, a Name+Date sub-
folder for a media file named Butterfly would be named something similar to: 
Butterfly_2010-09-17_01-59-50-5785.

7. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to 
bring the store back online.

For more information, see Moving a Store Online or Offline.

8. To set the block size used for the store access, click the Advanced button and follow 
the instructions in Setting the Block Size.
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9. For information on managing aliases for the store, see Managing Alias Support for 
the VWP Web Client.

10. Click the Save button  to save the changes.

Moving a Store Online or Offline
There may be times when you want to move a Vantage store offline to perform 
maintenance. When a store is offline, the Offline column in the Vantage Stores list 
displays an X for all stores that are offline. 

When you move a store offline, any jobs in progress that are using that store continue 
to run, but the offline store is no longer available for new jobs. A good practice is to 
take the store offline, let all jobs in progress for that store complete, and then perform 
the planned maintenance. If the store becomes inaccessible before the jobs in progress 
complete, the jobs in progress for that store fail.

To move a Vantage store offline or online, do the following:

1. Select an existing store in the Vantage Stores list.

2. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to 
bring the store back online.

The Offline checkbox is disabled if the store is assigned to a Vantage service. To 
enable the offline checkbox in this situation, identify to which service the store is 
assigned, and place that service in maintenance mode. You can located which ser-
vice is using the store by looking at the Storage tab for each service. For more infor-
mation, see Managing Services.

3. Click the Save button  to save the changes.

Identifying Workflows that Use a Store
Vantage allows you to search all workflows in a domain to see which workflows are 
using a store. This is very useful when you need to change or delete a store, and you 
want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the store for which you want to search.

2. Click the Search button  in the toolbar. 

If the store is used by any workflows, Vantage displays a list of workflows that use 
the store. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the store is not used by any workflows, Vantage displays a message to that effect. 
Click OK to dismiss the message.
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Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage stores. The default setting works best for most storage systems, but 
some fiber attached storage systems support higher throughput with larger block 
sizes.

CAUTION: This is an advanced system feature, and misconfiguration can disable your 
Vantage store. Be sure you understand the block size requirements of the storage 
system before making changes, and consider making changes to a production system 
only when you know the system is idle.

To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog.

Figure 18. Advanced Stores Settings Dialog

2. Check the Specify desired block size checkbox.

3. Use the up and down arrows to specify the new block size.

4.  To test the new block size, do the following:

a. Click Test.
b. Use the file selection dialog to select a test file, and then click Open.

The test does not open the test file or evaluate file content, so you can use any 
file, regardless of file content. Larger files usually give a more accurate average 
throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to save the new setting and close the dialog.

Duplicating a Vantage Store
To duplicate a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.

2. Click the Duplicate button  (or right-click and select Duplicate).

3. Select the new store and customize it as needed (see Modifying a Vantage Store).
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Exporting and Importing Vantage Stores
Vantage allows you to export one or more Vantage stores to XML files, which you can 
then use to import the same stores into another Vantage domain.

To export all stores in the list, click the Export drop down menu and select Export All. 
Then use the file system dialog to save the exported stores.

To export selected stores, do the following:

1. Select the store to export. You can Shift-click or Ctrl-click to select multiple stores.

2. Click the Export button  (or right-click and select Export, or click the Export drop 
down menu and choose Export Selected).

3. Use the file system dialog to save the exported stores.

The default file name is the store name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the store in 
the XML file.

To import a store, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the store to import, then click Open.

Note: If you try to import a store that is already in this Vantage domain, Vantage 
prompts you to either overwrite the existing store (click Yes) or cancel the import (click 
No).

Deleting a Vantage Store
Click on the store you want to delete, click the Delete button  in the toolbar (or right-
click and select Delete), and click OK to confirm.

Note: If there are any files in the store that are maintained by Vantage—such as those 
for unexpired jobs or binders in a catalog, you cannot delete the store. Deleting a store 
permanently removes the store from the domain. It does not delete directories, shares, 
or any files in them.
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Managing Vantage Folder Addresses
Vantage folder address book management can be performed either directly in the 
Management Console or in Vantage Workflow Designer (in Copy or Move actions).

To manage your Vantage folder addresses in VMC, start VMC and select Storage > 
Vantage Folder Address Book in the components panel. Vantage displays the Vantage 
Folder Address Book detail panel shown in Figure 19.

Figure 19. The Vantage Folders Address Book Details Panel

You can use the Vantage Folders Address Book details panel to add and configure 
Vantage folders. You also use the details panel to modify and delete Vantage folders.

The following topics provide information on managing Vantage folder addresses:

 Adding Vantage Folder Addresses

 Refreshing the List of Folders

 Modifying Vantage Folder Addresses

 Identifying Workflows that Use a Vantage Folder

 Deleting a Vantage Folder Address

 Setting the Block Size

 Duplicating a Vantage Folder Address

 Exporting and Importing Folder Addresses
Vantage Domain Management Guide



Managing a Vantage Domain
Managing Vantage File Storage

159
Adding Vantage Folder Addresses
To add a new folder address, do the following:

1. Click the Add Folder button  to display the Add New Folder dialog.

2. Enter a folder name in the Add New Folder dialog.

3. Click Modify to display the Folder Location Editor dialog.

Figure 20. Folder Location Editor Dialog

4. Select the file system where the Vantage files will be stored, then click Next.

5. To specify the folder root directory with a UNC path (recommended), do the 
following:

a. Click Browse to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the folder.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage folder is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

6. To specify the folder root directory with a drive letter path, do the following:

a. Click Browse to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.
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Note: If you use a drive letter to specify a folder, only Vantage services and clients on 
the same computer can access the folder. For more information, see Understanding 
Path Specifications for Vantage Storage.

7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

8. Click OK to save this new Vantage folder address to the domain and close the Add 
New Folder dialog.

Refreshing the List of Folders
To refresh the folder list, click the refresh button .

Modifying Vantage Folder Addresses
To modify a folder address, do the following:

1. Select the folder in the Vantage Folder Address Book.

2. If you want to change the folder name, enter a new name for the Vantage folder.

This name is displayed in Copy and Move action inspectors where you are specify-
ing the location in which to save a file.

3. If you want to enter a description, enter the description, purpose, or use of this 
folder address.

4. To change the folder storage location, click Modify (or right-click the folder name in 
the list and select Modify) and specify the new location as described in Adding 
Vantage Folder Addresses.

5. To define what action Vantage takes when it saves a file and a file with the same 
name exists in the Vantage folder, select an action from the Collision Resolution 
drop down list:

– Create Unique Name—Vantage creates the file with a unique name, leaving the 
other file intact.

– Overwrite—Vantage overwrites the old file.

– Set Failure State—Vantage does not save a new file and registers a failure with 
the action that attempted to create the file.

6. For instructions on using the Advanced features, see Setting the Block Size.

7. Click the Save button .
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Identifying Workflows that Use a Vantage Folder
Vantage allows you to search all workflows in a domain to see which workflows are 
using a Vantage folder. This is very useful when you need to change or delete a store, 
and you want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the Vantage folder for which you want to search.

2. Click the Search button  in the toolbar (or right-click and select Find Workflows). 

If the folder is used by any workflows, Vantage displays a list of workflows that use 
the folder. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the folder is not used by any workflows, Vantage displays a message to that effect. 
Click OK to dismiss the message.

Deleting a Vantage Folder Address
Click on the folder you want to delete, click the Delete button  in the toolbar (or right-
click and select Delete), and click OK to confirm.

Note: Deleting a folder permanently removes the folder from the domain. It does not 
delete directories, shares, or any files in them.

Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage folders. You can also use Vantage to test the throughput of different 
settings. The default setting works best for most storage systems, but some fiber 
attached storage systems support higher throughput with larger block sizes.

CAUTION: This is an advanced system feature, and misconfiguration can disable your 
Vantage folder. Be sure you understand the block size requirements of the storage 
system before making changes, and consider making changes to a production system 
only when you know the system is idle.

To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog (see Figure 18).

2. Check the Specify desired block size checkbox.

3. Use the up and down arrows to specify the new block size.
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4. To test the new block size, do the following:

a. Click Test.
b. Use the file selection dialog that appears to select a typical media file, and then 

click Open.

Larger files will usually give a more accurate average throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to keep the save the new setting and close the dialog.

6. Click the Save button .

Duplicating a Vantage Folder Address
Select the folder you want to duplicate, click the Duplicate button  in the toolbar (or 
right-click and select Duplicate). Select the duplicated folder, make the necessary 
changes and save it.

Exporting and Importing Folder Addresses
Vantage allows you to export folder addresses to XML files, which you can then use to 
import the same addresses into another Vantage domain.

To export all folder addresses, click the Export drop down menu and select Export All. 
Then use the file system dialog to save the exported folder addresses.

To export selected folder addresses, do the following:

1. Select a folder in the list, or you can Shift-click or Ctrl-click to select multiple folders.

2. Click the Export button , right-click and select Export, or select Export Selected 
from the Export button drop down menu.

3. Use the file system dialog to save the exported folder addresses.

The default file name is the folder address name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the folder 
address in the XML file.

To import a folder address, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the folder address file to import, then 
click Open.

Note: If you try to import a folder address file that is already in this Vantage domain, 
Vantage prompts you to either overwrite the existing folder address (click Yes) or 
cancel the import (click No).
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Managing Vantage Users
The user management feature enables you to control which users have access to the 
following:

• Vantage Web Applications

• Vantage Workflow Portal configurations

• Workflow categories in the Vantage Workflow Designer client application

• Vantage Management Console

User management requires Vantage users to log in using a Vantage username and 
password that is assigned to them by the Vantage administrator. The Vantage 
administrator uses VMC to create, remove, and edit user profiles. Vantage users are 
allowed to change their own password.

The following topics describe how to manage Vantage users:

 Enabling and Disabling User Management

 Managing Users with Vantage Management Console

 Adding Users

 Setting Passwords

 Removing Users

 Importing and Exporting Users

Enabling and Disabling User Management
To enable or disable user management, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable user administration 
checkbox to enable this feature, or clear the checkbox to disable this feature.

Note: When you disable user management, users do not need to enter a user name 
and password to log in to Vantage Management Console, Vantage Workflow Designer, 
or the Vantage Workflow Portal client application. To access most Vantage Web 
Applications, users must enter a user name and password. The exception for Vantage 
Web Applications is Job Status Views. When public access is configured for Job Status 
Views, users do not need to enter a user name and password.
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Managing Users with Vantage Management Console
To start user management in VMC, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Users.

Vantage displays the Users detail panel shown in Figure 21.

Figure 21. Users Detail Panel

Adding Users
To add a new user, click the New User button  or right-click and select New User. 
When the dialog box displays, enter the username and password (and confirm the 
password) of the new user. If the new user is to have administrator privileges, check the 
Administrator checkbox. Click OK to close the dialog box, then click the Save button  
to save your changes.

Users can be given or denied administrator privileges by checking (or unchecking) the 
Administrator checkbox located at the bottom of the User Management panel. The 
target user must be selected when this action is taken. After checking or unchecking 
the Administrator checkbox, click on the Users list to prompt a dialog box to confirm 
this change.
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Setting Passwords
To set the password of a user, click the Set Password button (or right-click the user in 
the list and click Set Password). When the dialog box displays, enter the password (and 
confirm the password) of the user. Click OK to close the dialog box, then click the Save 
button  to save your changes.

Removing Users
Users can be removed by selecting the user in the Users list and clicking the Delete 
button  at the top of the User Management panel (or right-click the user and select 
Delete). When requesting the removal of a user, a dialog box will display asking you to 
confirm this action. You cannot undo the removal of a user, thus to restore a user you 
must add him again as a new user.

Importing and Exporting Users
User lists can be imported and exported. To import a list of users, click the Import 
button , navigate to the XML file containing a list of users, and click the Open button. 
To export a list of users, click the Export button  (or right-click the list and select 
Export), enter an XML filename for the list of users, and click the Save button.

Managing Services
The term Services, as used in Vantage, refers to Vantage running as Windows services, 
which are required to perform a given action in a workflow. The term service refers to 
the specific instance of the Windows service on a particular computer that is 
responsible for actually executing the actions specified in a workflow when that 
workflow is executed as a result of a job submission to process a given media file.

Use the Services component of the Management Console to configure your Vantage 
services operating on various machines to function according to your requirements. 

You can configure each service’s program settings, storage requirements, variables, and 
qualification rules.

The following topics describe how to manage services:

 Using the Services Details Panel

 Adding a Service to the Domain

 Removing a Service from the Domain

 Entering and Exiting Service Maintenance Mode

 Entering and Exiting Server Maintenance Mode

 Resetting the Service Metrics History

 Configuring Vantage Services
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Using the Services Details Panel
To begin Vantage service management, start the Vantage Management Console and 
select Services in the components panel. Vantage displays the Services detail panel 
shown in Figure 22.

Figure 22. The Vantage Services Details Panel

Note: If duplicate entries appear for services on a specific Vantage server, it could be 
that the server has multiple network interface cards and one of them has been 
disabled. This does not affect Vantage operation.

Table 13 describes the columns in the Services panel.

Table 13. Services Panel Column Descriptions

Column 
Heading Description

Service Lists Vantage services by name.

Machine Displays the machine name that hosts the service.

State Displays the service state, which can be Online, Maintenance, 
Restarting, or Unreachable.
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Active 
Sessions

Displays the number of active sessions for the service. A service starts 
a session each time a workflow uses that service to process a job.

Queued 
Sessions

Displays the number of sessions that have been assigned to a service 
and are waiting for the service to become available.

Failed 
Sessions

Displays the number of sessions that did not complete successfully.

Total Sessions Displays the total number of jobs that have used the related service 
since the metrics were last reset.

Session Limit Displays the maximum number of concurrent sessions allowed for a 
service. This setting is made using the Setup tab, Service Limits 
selection. When cost-based load balancing is enabled, this setting is 
disabled. For more information on cost-based load balancing, see 
Managing Load Balancing.

License 
Failures

Displays the number of times users have requested a service and have 
been denied because no license was available for the session.

Table 13. Services Panel Column Descriptions (Continued)

Column 
Heading Description
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Adding a Service to the Domain
Before you can add a Vantage service to a domain, it must first have been installed and 
started on a computer on your network subnet.

To add a Vantage service to a domain, click the Add Service button  in the toolbar.

VMC scans the network for available services and displays those that are not currently 
part of this domain.

Figure 23. Select Services Dialog

Select the service you want to add to the current domain and click OK.

Services are added to a domain by removing them from the domain they are currently 
in. Services cannot be part of more than one domain at a time. Be sure that the other 
domain is prepared to lose the service you are adding to your domain.

Removing a Service from the Domain
To remove a Vantage service from a domain, select in and click the Delete button  in 
the toolbar.

Note: Removing a service does not stop or uninstall the service from any computer. It 
merely disengages it from the current domain.
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Entering and Exiting Service Maintenance Mode
You can enter and exit maintenance mode by selecting a service and clicking the Enter 

 or Exit  button (or right-click the service and select Enter/Exit Maintenance Mode). 
When a service is in maintenance mode it will not process any transactions. Exit 
maintenance mode to re-activate the selected service and cause it to reload its 
resources from the database.

Note: Placing a service in maintenance mode erases the metrics for that service, 
which affects the Vantage Dashboard bar graphs for that service. 

Note: The Tachyon Cinnafilm service is supported only on Lightspeed servers. On all 
other Vantage servers, this service stays in Maintenance Mode.

Entering and Exiting Server Maintenance Mode
To move multiple or all services on a server in and out of maintenance mode, do the 
following:

1. Display the Services detail panel.

2. To select specific multiple services in the list, Ctrl-click the services you want. 
To select all services, click the top service in the list and Shift-click the bottom 
service.

3. Click the Enter button  to place the services in maintenance mode.

4. Click the Exit button  to restart the services and exit maintenance mode.

Note: Placing all services in maintenance mode erases the metrics for all services, 
which affects the Vantage Dashboard bar graphs for those services.

Resetting the Service Metrics History
Click the Clear button  (or right-click and select Clear) to reset the service metrics 
history. This also resets all failed service metrics for the selected services. You can do 
this for multiple or all services by Ctrl-clicking or Shift-clicking the services you want.
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Configuring Vantage Services
Vantage services have a variety of configuration options; most of them with default 
settings. The following topics describe how to configure the settings on each tab:

 Setup

 Service Storage

 Service Variables

 Qualification Rules

Setup
The Setup tab includes Vantage domain database settings, service ports, 
instrumentation, time-out settings and log file options. 

Changing settings in the Setup tab requires that you restart the service before they 
take effect. You can make changes to settings in the other tabs without restarting the 
service—they take effect immediately. To modify the settings in the Setup tab, select 
the service you want to modify and click the Enter Maintenance mode button  in the 
toolbar (or right-click and select Enter). After making the changes, click the Exit 
Maintenance mode button  in the toolbar (or right-click and select Exit). Exiting 
maintenance mode reactivates the selected service and causes it to reload its resources 
from the database so it can begin accepting jobs again.

Changes to these settings can only be made in maintenance mode.

Click on each category in the Setup tab to display its settings.
Table 14. Setup Tab

Vantage Domain Settings
Host Name of the computer on which this domain database is installed. 

Not changeable.
Failover Name of the optional failover database instance that serves as the 

failover database should the primary database fail. This is the 
name of the mirrored database server (i.e. “BackupServer”). 

Instance Name of the primary Vantage domain database instance.
Database Name of the database.
User Username of the Microsoft SQL Server database user. Default: sa. 

Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.

Password Password of the database user. 
Default: vantage12!
Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.
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Service Limits
Session Limit In sessions mode (which is the default mode), this configures the 

maximum number of concurrent sessions for a service. For CPU-
intensive services—such the Transcode service—you should gate 
the maximum number of sessions to the power of the computer. 
For less demanding services, such as the Monitor service, a higher 
number is less likely to cause problems.
When cost-based load balancing is enabled, this setting is 
disabled. For more information on cost-based load balancing, see 
Managing Load Balancing.

Target Resource 
Usage

When cost-based load balancing is enabled, this setting configures 
the target resource usage level for this service. Each service has a 
default value for this setting. If server performance permits, raise 
this value to support simultaneous processing of additional 
workflow actions. If the server is having performance issues, lower 
this value to reduce the number of actions that run at the same 
time.
For more information on cost-based load balancing, see Managing 
Load Balancing.

Service Settings
TCP Port The TCP port is utilized for all intra-service traffic in the domain. If a 

certain port range is allowed by your IT infrastructure (given 
constraints such as routers and firewalls) an IT administrator can 
specify which port to use for intra-service communication to fit 
their environment. The default port settings are listed in Table 6.

HTTP Port The HTTP port is utilized for HTTP server traffic in the domain. An 
IT administrator can specify which port to use for intra-service 
communication to fit their environment. The default port settings 
are listed in Table 6.

Instrumentation Settings
Enable 
Instrumentation

Registers and reports certain internal events as Windows 
Management instrumentation events.

Service Timeout
Timeout The time (in minutes), that a non-responsive task will run before 

being terminated and failed.

Log File Settings
Log File Name The base name of the log file generated by this service. Log files 

are generated by service, and are stored in each service’s folder in 
<installdrive(C:)>\Program Files\Telestream\<Service Folder>.

Log File Size The maximum file size (in bytes) before the service creates an 
incrementally-numbered log file for continued logging.

Max Log File 
Count

The maximum number of log files for this service, before the oldest 
is deleted when a new one is written.

Table 14. Setup Tab (Continued)
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Service Storage
The Storage tab enables you to specify stores for a service to provide a repository so 
that their actions can obtain storage if they require it. Certain actions require storage 
where they can create temporary files or perform other operations that involve writing 
files to disk.

For example, the Transcode service requires access to a store in order to produce the 
files that it creates as part of the transcode process.

The process of assigning a specific store to a service is made with performance in mind. 
If you know you want a particular Transcode service to utilize a specific store, you can 
assign it here. In the absence of an assigned store for Transcode service, service will 
utilize any Vantage store it chooses to write temporary files to. This may not be optimal 
based upon your network topology.

Adding Stores

To add a store to the selected service, click the Add Store button , select the store 
from the Select Storage dialog and click OK.

Note: The Flip action can specify a store for output files. The selection of a store in a 
Flip action overrides the store defined for the host service.

Removing Stores

To remove a store from the selected service, select the store and click the Delete button 
 in the toolbar.

Service Variables
Use the Variables tab to attach variables to a service. Service variables perform two 
functions. First, they dictate which services can perform tasks as set up by the Run On 
Rules. Run On Rules allow you to target specific services to execute tasks, entirely based 
upon whether or not a variable is set for a Service. 

Note: Run on rules only look at Service variables, they do not look at variables in a job.

Second, service variables allow services to add variables to a workflow. Variables (such 
as job routing and action priority) can be passed to workflows to provide information 
about the service, and workflow actions can include this information in the output or 
make workflow processing decisions based on the variable values. 

When you add a variable to a service, you supply a constant value—one that does not 
change over time. The value of the variable is static for the service instance.

For example, you may want to implement email generation in the event of a transcode 
failure in a large domain with 20 separate transcode services, each running on separate 
machines. This allows a user to receive an email when a transcode fails that identifies 
the machine where the failure occurred.
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To implement this, create a text variable named EmailSubject as described in Creating 
Variables. Next, add the EmailSubject variable to each Transcode service as described in 
Adding Variables to a Service, and set the value of EmailSubject for each service to a 
combination of the respective machine name and the service name by typing it in 
manually in the Value field. For example, one might be named M-ORION-
VantageTranscodeService.

Now, in each workflow, you add a Message action and specify the email option, bind 
the Subject line with the EmailSubject variable, and set the Message action to only run 
on a Failure state.

Now, if a transcode failure occurs, the user receives an email indicating which system 
was transcoding the media when the failure occurred.

Adding Variables to a Service

To add a variable to the selected service, click the Add Variable button  (or right-click 
and select Add Variable), select the variable from the Select Variable dialog and click 
OK. Next, enter the static value for this variable in the Value field. When you click away, 
the Save Variable dialog displays. Click Yes to save this variable and its value.

Note: If you are using a Lightspeed Server, then a read-only Lightspeed variable will 
be added to services on that server. This is used for automated load balancing and 
may be used for Run On rule configuration as well.

Removing Variables from a Service

To remove a variable from the selected service, select the variable and click the Delete 
button  in the toolbar (or right-click and select Delete).

CAUTION: Deleting a variable that is used in workflows may render the workflow 
inoperable.
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Qualification Rules
Qualification rules give you control over which actions a service will process. 
Qualification rules enable a service to compare variable values set by the workflow 
against a baseline value, generate a merit value based on the comparison, and use the 
merit value in conjunction with other variables to determine if the service should 
process the job.

Note: Vantage also supports run on rules, which are defined in a workflow and allow 
a workflow designer to select a service based on Vantage variable values. Generally 
speaking, run on rules are easier to configure if you want to specify that parts of a 
workflow execute on specific services. For more information, see the Vantage User’s 
Guide.

Qualification rules can be based on system variables (such as Priority) and user-defined 
variables (for example, File Size). You can create multiple qualification rules per service 
to fine-tune each service’s fitness to perform certain tasks and improve over-all domain 
workflow and performance.

For example, suppose you have a large domain with 20 transcoding services on 
different machines. Your goal is to divide the transcoding services into groups: those 
that process the bulk of the jobs—those involving media of less than about 80MB in 
size. Another group is configured to optimally transcode media up to 2GB, another for 
long-form files, over 2GB.

To implement this, you create a variable named FileSize (Select Domain > Workflow 
Design Items > Variables). 

Next, you select the service that you want to run short jobs here, in Services > 
Qualification Rules, and create a qualification rule.

Select the FileSize variable and click OK. Configure the rule to specify operator = less 
than or equal, merit = 100 (an arbitrary value), qualifier = required, and value = 
80,000,000. This rule will pass the merit value of 100 to Vantage when a job being 
considered for execution has a FileSize variable with a value less than or equal 
80,000,000.

For each other transcode service, add a similar rule (or rules) to qualify it appropriately.

Now, in each workflow, add an Identify action before each Flip action and configure it 
to update the FileSize variable with the File Size metric.

When a job starts, the Identify action updates the FileSize variable, and each transcode 
service examines the variable against its comparison value to determine its fitness to 
process the Flip action, and if true, submits its merit value, if false, submits merit value 0 
to Vantage for final arbitration on which transcode service is assigned the job.
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Adding Qualification Rules

To add a qualification rule to the selected service, click the Add Qualification Rule 
button  (or right-click and select Add Qualification Rules), select the variable from the 
Select Variable dialog and then configure the rule.

Table 15. Qualification Rule Configuration Options

Option Description

Operator Select an operator from the dropdown list to qualify the workflow 
variable value being compared against the baseline value specified in 
the rule. 

For mathematical operators, if the equation is true, the merit value 
you supply is passed; if the equation is false, 0 is passed. 

For the contains operator, the equation is true if the workflow variable 
contains the text specified in the baseline value. The merit value you 
supply is passed if the equation is true, and 0 is passed if the equation 
is false.

Merit When an action meets the qualification rule requirements for 
multiple service instances, the action is assigned to the service with 
the highest merit value. For example, if a Flip action meets the 
qualification rule requirements for the Transcode service on both 
Server A and Server B, Vantage assigns action processing to the server 
that hosts the service qualification rule with the highest merit value.

Merit values should be consistent with a predetermined plan of 
implementation, so that each service is responding appropriately to 
influence the distribution of tasks. If you have few services and rules, 
values from 1 to 10 may provide enough granularity; for lots of 
services and/or rules, you may need values from 1 to 100 to provide 
enough granularity.

Qualifier Choose Optional when workflows may or may not provide a value for 
comparison. If no value is provided, the comparison always is false, 
and 0 merit is provided. Choose Required when workflows must 
provide a value for comparison. If no value is provided, the service 
rejects the request to process the job without further analysis.

Value Enter the baseline value against which the variable’s value is to be 
compared. (A null value is a valid value.)
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Removing Qualification Rules

To remove a qualification rule from the selected service, select the rule and click the 
Delete button  in the toolbar (or right-click and select Delete).

Use Wildcards Enables or disables the use of wildcard characters in the Value field. 
When enabled (checked), you can use a question mark (?) to indicate 
a single character that can have any value, and you can use an asterisk 
(*) to indicate a variable number of characters that can have any 
value. For example, *.mov matches any value that ends in ‘.mov’.

When disabled (unchecked), the * and ? characters are regular 
characters, not wildcard characters.

Ignore Case Enables or disables case validation in the Value field. When enabled 
(checked), the case in the Value field is ignored when comparing the 
value to a value received from an action. For example, TEST1 and 
test1 are considered a match when the Ignore Case option is checked.

When disabled (unchecked), the case in the Value field must exactly 
match that received from an action to be considered a match. 

Table 15. Qualification Rule Configuration Options (Continued)

Option Description
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Managing Load Balancing
The following topics provide information on managing load balancing:

 Overview of Load Balancing

 Examples of Cost-Based Load Balancing

 Enabling and Disabling Cost-Based Load Balancing

Overview of Load Balancing
Load balancing distributes the processing of individual workflow actions between the 
same service on multiple Vantage servers. For example, if you have the Transcode 
service running on three Vantage servers, the Flip action, which is processed by the 
Transcode service, can run on any of the servers. Load balancing determines which 
server receives the action to process.

Vantage supports session-based load balancing and cost-based load balancing.

Session-based load balancing requires a Vantage Array license and allows you to 
distribute the processing of service actions across multiple servers that support the 
same service. Session-based load balancing distributes action processing among the 
available servers up to the configured session limit for each server. This load balancing 
is done by taking the CPU utilization of each machine into account, as well as ensuring 
that any Run On rules (which allow tasks to be routed to specific machines) are 
observed. When the configured limit is reached on all servers, actions are queued until 
the workload drops below the configured session limit.

Cost-based load balancing requires the Advanced Task Scheduling license and is similar 
to session-based load balancing. Cost-based load balancing allows you to do the 
following:

• Assign a default cost for each type of action used in workflows

• Define a target resource usage level for each service on a server

• Override the default action cost in workflows as needed

Note: Session limits are ignored when cost-based load balancing is enabled, and the 
target resource usage level is ignored when session-based load balancing is enabled.

To determine its available resources, each service monitors the total cost of all actions it 
is processing and compares that cost to the configured target resource usage level for 
that service. A service can accept an action for processing if the available resource 
usage is at least half the cost of the action.

Actions are assigned to services in the order they are processed, which prevents low 
cost actions from consuming all service resources and starving higher-cost actions. 
Each action is forwarded to the service with the most available resources. If the action is 
forwarded to a service that does not have resources to immediately process the action, 
the action is queued for later processing.
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To implement cost-based load balancing, enable the feature (as described in Enabling 
and Disabling Cost-Based Load Balancing) and monitor the following:

• The server performance using server monitoring tools.

• The Services panel in VMC, which displays a list of services, including the current 
and target resource usage levels. For more information, see Using the Services 
Details Panel.

If the server is under- or over-loaded, you might adjust the default target resource 
usage level for each service as described in Configuring Vantage Services.

Note: A Lightspeed Server can run only four concurrent Lightspeed jobs at a time 
regardless of the cost/capacity setting. This limitation helps ensure the server retains 
enough GPU memory to efficiently process all jobs.

If you want to adjust the default cost of an action, see Managing Actions. For 
information on overriding the default action cost in a workflow, see the Vantage User’s 
Guide.

Examples of Cost-Based Load Balancing
You can use the target resource usage setting to limit the total action cost that a service 
will simultaneously process. For example, if you configure the Transcode service for a 
target resource usage of 16 and you configure the default Flip action resource cost to 4, 
the Transcode service supports a maximum of 4 simultaneous Flip actions.

Some services support multiple actions, and you can set the action resource cost for 
each action to a different value to define the relative usage levels. For example, the 
Transport service supports the Copy, Delete, Deploy, and Move actions, which are 
assigned default resource costs of 2, 1, 1, and 2, respectively. Based on the default 
values, a Transport service can support twice as many Delete and Deploy actions as 
Copy and Move actions.

Different codecs require different levels of processing resources. Using Workflow 
Designer, you can override the default resource cost for specific actions within a 
workflow. For example, you might configure a Transcode service to target resource 
usage of 16, specify a resource cost of 1 for a 3GP Flip action, and a resource cost of 8 for 
an MPEG-2 HD Flip action. During load balancing, Vantage will ensure that:

• No more than two MPEG-2 HD jobs execute simultaneously

• Up to 16 3GP jobs can execute simultaneously

• One MPEG-2 HD and eight 3GP jobs can execute simultaneously in ideal situations

• MPEG-2 jobs are not starved by 3GP jobs which only require one slot

Note: Resource costs are integer values that have an ordinal relationship to one 
another. You can implement any scale you want in your domain. Greater scales enable 
finer-grained control.
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Enabling and Disabling Cost-Based Load Balancing
To enable or disable the cost-based load balancing option, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable cost-based load balancing 
checkbox to enable this feature, or clear the checkbox to disable this feature.

4. Click the Save button .

5. When the Service Restart Required dialog appears, click OK.

6. Restart all Vantage services as described in Entering and Exiting Server 
Maintenance Mode.

Configuring Vantage Email Notifications
Vantage can send email messages to announce workflow and service events.

Message actions in Vantage workflows can be configured to send email messages for 
workflow events. The configured email destination address can be for an individual, a 
system, or an alias for a group of Vantage users or administrators. 

Note: Until you configure these settings, you will not be able to execute Message 
actions that utilize email in your workflows.

If a Vantage Service starts or stops running, or if a service fails, an email is sent to the 
administrator email address.

Note: An email is not sent when a Vantage Service enters or exits Maintenance Mode.

To manage email notifications, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Email tab.

4. Configure the email parameters, which are described in Table 16.

5. Click the Save button .
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Table 16. Email Tab Configuration Options

Option Description

Hostname or IP Address Supply the computer’s host name or IP address of the 
SMTP server.

SMTP Port Supply the port number of the SMTP server.

SMTP Host Requires 
Authentication

Check if the SMTP server is configured to require 
authentication.

Username and Password Supply the user name and password if SMTP Host 
Requires Authentication is checked.

This server requires an 
encrypted connection 
(SSL)

Check this checkbox if SMTP server requires an encrypted 
connection.

Administrator Email 
Address

Supply the email address of the Vantage administrator. 
The email specified for this account can be an alias for a 
larger group, maintained by your IT department.

Send Test Email Click to test your settings by sending an email to the 
administrator email address.

Email administrator upon 
service starting

Check to email the administrator when a service starts. 
For example, if a Vantage machine hosting an Analysis 
and a Monitor service is started without any problems, 
two emails are sent reporting the starting of each service.

Email administrator upon 
service stopping

Check this checkbox to email the administrator when a 
service stops.

Email administrator upon 
service failure

Check to email the administrator when this service fails 
(crashes or otherwise stops unexpectedly). For example, if 
a Vantage Analysis service is stopped from the Task 
Manager (forced termination), an email is sent to the 
administrator. Or, if a Vantage Analysis service crashes 
during start-up, an email is also sent to the administrator.
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Specifying Authorization Credentials for Remote 
Folder Access

This feature allows you to specify credentials (username and password) for a folder that 
is not located in the Windows domain or workgroup for which the Vantage is 
authorized. For example, if Vantage services are configured with a username and 
password for Domain A or Workgroup A, but output files must be saved to a folder in 
Domain B or Workgroup B, you can use this feature to specify the credentials to access 
the remote folder.

The following topics provide information on managing authorization settings:

 Understanding Authorization Settings

 Displaying the Authorization Settings

 Refreshing the Authorization Record List

 Adding an Authorization Record

 Modifying an Authorization Credentials Record

 Deleting an Authorization Credentials Record

 Exporting and Importing Authorization Records

Understanding Authorization Settings
Authorization settings are considered supplemental to Windows account and share 
settings, which should be your primary means of providing access and authentication 
to required storage for Vantage services. When accessing computers in workgroups, 
Vantage administrators should make sure that Vantage services are running under an 
account that has access to the locations that will be referenced. If this is done, then 
authorization records are unnecessary unless some computers must have unique 
accounts.

Use the Authorization Settings tab to create and manage credentials for Windows 
shares (on Windows computers) or UNC paths, where media may be ingested, stored, 
or delivered by a Vantage services using an account that is different from its logon 
account, when this Windows account and share settings do not provide access.

When each service starts, it reads all authorization records and stores them for use at 
runtime, as necessary. For example, the transport service may be called to execute a 
Copy action, which needs to write a file to a share or a non-domain server and 
directory, where the service is not authorized by its own account. The transport service 
will process the authorization records based on the path supplied, to determine if it can 
gain authority via one of its authorization records.

Note: Authorization settings should only be used when the normal Windows account 
and share settings do not provide access to necessary shares: for example, shares on 
other Windows domains, or on workgroups.
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The purpose of entering authorization records is to enable Vantage to maintain this 
information for network locations—independent of the authentication inherent with the 
logon account of a specific service—the Vantage Monitor Service, for example. If you 
know that a specific service does not have the authorization to utilize a given network 
location, you can create an authorization record to provide credentials.

When you provide authorization records for a network location, any service in the 
domain can utilize it.

It is important to understand that when you access network locations via Workflow 
Designer, the locations you navigate to are accessed with Workflow Designer’s logon 
account permissions—which may be different than the logon account for Vantage 
services.

However, these locations will ultimately be accessed by Vantage services during 
execution of your workflow—services which may have different users and permissions. 
Therefore, you need to take the extra step of ensuring that the service, which will be 
accessing this share at workflow runtime, has authenticated access to the location.

Additionally, authentication does not control sharing and security permissions (for 
example, access, and read/modify/delete/write permissions). Make sure that when you 
set up network locations, you have set each location with the proper permissions for 
the user accounts that will access it.

After you add, modify, or delete a record, click the Save button  to update the records 
in the Vantage domain database as encrypted data.
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Displaying the Authorization Settings
To display the authorization settings, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Authorization tab.

Vantage displays the Authorization tab shown in Table 16.

Figure 24. Authorization Tab

Refreshing the Authorization Record List
To refresh the list of authorization records, move a Vantage service in and out of 
maintenance mode as follows:

1. In the Vantage Management Console, click on Services in the details panel.

2. Right-click the target service and select Enter Maintenance Mode.

3. Right-click the service again and select Exit Maintenance Mode.
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Adding an Authorization Record
Click the Add new credentials button  in the toolbar (or right-click and select Add 
new credentials or Import credentials), and supply the details. Click Test to validate the 
record, and click the Save button to add this validated authorization record to the 
database for use by all Vantage services in the domain.

Modifying an Authorization Credentials Record
Click on the record you want to modify. Make changes to the username, password, and 
folder and click the Save button  in the toolbar.

Deleting an Authorization Credentials Record
Click on the record you want to delete, click the Delete button  in the toolbar (or 
right-click and select Delete), and click OK to confirm.

Table 17. Authorization Tab Configuration Options

Option Description

Username Enter the authorized username required to access the Windows share 
identified by the UNC path.

If the user account is part of a Windows domain, the username must 
include the domain or computer name, in the format 
domain\username or ComputerName\Username. For example, 
SierraVideo\Vantage or NewsServer\Bill.

If the username is part of a workgroup (a non-domain account), you 
must provide the machine name in addition to the user name. For 
example, if you want to use the account: VantageUser that exists on 
machine FooServer1, you should specify FooServer1\VantageUser.

Password Enter the authorized password for the Windows share.

Folder Click Browse and navigate to the Windows share you are 
authenticating. Or, enter it manually. The path must be in valid UNC 
form: \\ComputerName\Sharename\.

Test Click Test to verify that your credentials are entered correctly for 
access to the specified Windows share.
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Exporting and Importing Authorization Records
Vantage allows you to export an authorization record to an XML file, which you can 
then use to import the same record into another Vantage domain.

To export all authorization records, click the Export drop down menu and select Export 
All. Use the file system dialog to save the exported records.

To export selected authorization records, do the following:

1. Select the record to export. Shift-click or Ctrl-click to select multiple records.

2. Click the Export button  (or right-click and select Export, or click the Export drop 
down menu and select Export Selected).

3. Use the file system dialog to save the exported record.

The default file name is the record name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the record in 
the XML file.

To import an authorization record, do the following:

1. Click the Import button  (or right-click and select Import credentials).

2. Use the file system dialog to locate and select the record to import, then click Open.

Note: If you try to import an authorization record that is already in this Vantage 
domain, Vantage prompts you to overwrite the record (click Yes) or cancel the import 
(click No).
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Configuring a Signiant Connection
When you configure a Signant connection, you enable the Vantage domain to 
communicate with the Signiant server by supplying required credentials. The optional 
Signiant Delivery action can then be used to deliver files to Signiant-enabled servers. 
The Vantage Signiant Delivery action uses the Signiant feature, which must be licensed 
on the Signiant server. A Signiant Agent must be configured in the Management 
Console before it can be used in a Vantage workflow.

To configure a Signiant Agent in Vantage and test its connection, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Signiant tab. 

Vantage displays the Signiant agent configuration panel. 

Figure 25. Signiant Agent Configuration Panel

4. Click the Add New Setting button  in the toolbar (or right-click in the empty space 
below the button and select Add new setting).

5. In the Name field, enter a practical name for the Signiant server (for example, 
Signiant-Vantage Server).

6. In the Address field, enter the IP address or domain name of the Signiant server.

7. In the Certificate field, paste the CA Certificate text copied from the Signiant server. 
For instructions on obtaining a CA Certificate, see the following Signiant CA 
Certificate Instructions.

8. Click the Save icon to save the new agent.

9. To test the Vantage-Signiant connection, click Test at the bottom of the window. 

You can add Agents as needed for each Signiant server.
Vantage Domain Management Guide



Managing a Vantage Domain
Configuring a Signiant Connection

187
Signiant CA Certificate Instructions
 To get a CA Certificate to enable a Vantage-Signiant connection, follow the steps in 
either one of the two procedures that follow:

Use a Web Page to Get a Certificate
1. Use a Web browser to log into the Signiant server (e.g. signiant.sierrapost.com).

2. Navigate to Developer > CTE Test Configurations and click Add Configuration.

3. Enter a configuration name and configure settings for your system.

4. In the CA Certificate field (under Advanced Transfer Settings), select the certificate 
text and copy it (including the -----BEGIN CERTIFICATE----- and -----END 
CERTIFICATE----- lines).

5. Click Save at the bottom and close your Web browser.

6. Paste the certificate text into the Vantage VMC > Settings and Options > Signiant > 
Certificate field as explained in the previous procedure (Configuring a Signiant 
Connection).

Use the Command Line to Get a Certificate
1. Log into the Signiant Manager host as an administrator.

2. In a terminal window, navigate to the Signiant bin directory.

3. Enter the command dds_cert extract to extract a certificate from the credentials 
store.

4. Open the text file named ddsCA_Cert.pem and copy the entire text (including the --
---BEGIN CERTIFICATE----- and -----END CERTIFICATE----- lines).

5. Paste the certificate text into the Vantage VMC > Settings and Options > Signiant > 
Certificate field as explained in the previous procedure (Configuring a Signiant 
Connection).

Deleting a Signiant Agent
To delete a configuration, do the following:

1. Display the Dublist Portal  configuration window. 

2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiple 
configurations.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog appears, click OK. 
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Exporting and Importing Signiant Agents
Vantage allows you to export Signiant agents to files, which you can then use to import 
the same agents into another Vantage domain.

To export agents, do the following:

1. Select the agents to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected agents (or right-click and select 
Export, or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported agents.

The default file name is the agent name, but you can change the file name.

Note: Changing the file name does not change the name of the agent in the file.

To import agents, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the agent file to import, then click 
Open.

Note: If you try to import an agent that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Configuring an Agility ECS Connection
When you configure an Agility ECS connection (requires the Agility ECS Connector 
license), you enable Vantage domain support for the following:

• Vantage client communications with Agility through the Agility service.

• Vantage Dashboard monitoring of Agility ECS server status and statistics.

To identify the Agility ECS server and test its connection, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings & Options.

3. In the Settings & Options details panel, select the Agility ECS tab.

Vantage displays the Agility ECS tab shown in Figure 26.

Figure 26. Agility ECS Tab

4. Enter the Agility server’s host name or IP address.

5. If the default HTTP port value (80), is not correct, enter a new port number. 

Note: If the Agility IIS server is using a port other than 80, enter that port number 
here.

6. To test the connection to the specified Agility ECS server, click Test Connection.
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If there is a network problem, or you have supplied an invalid hostname or IP address, 
or the Agility server is not in a state where it can respond to queries, Management 
Console displays the following error: 

Figure 27. Test Failed Dialog

The connection to the Agility ECS server must be successful before you can use the 
action inspectors to configure Agility Job Profile and Agility Job XML actions in Vantage 
workflows and submit jobs.
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Using the Data Collection Utility
The Data collection utility enables you to collect relevant information about selected 
services for transmission to Telestream during a troubleshooting session. You can also 
log point-in-time details about a selected service into a log file for diagnostics 
purposes. 

To open the Data Collection utility, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Data Collection.

Vantage displays the Data Collection details panel shown in Figure 28.

Figure 28. The Data Collection Details Panel

To collect data for one or more services

1. Select the service (Shift-click or Ctrl-click to select multiple services)

2. Click Collect Data. 

Files named for each service are saved in the specified directory. Vantage writes the 
files out as <ServiceType>.txt and displays a dialog to notify you of the location of the 
file so that you can open and read the file or send it to others for analysis.

You can email these files to Telestream for assistance in solving problems during 
troubleshooting sessions.
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Using the Change Log
The Change Log utility captures changes to the Vantage domain configuration and 
operation and records the following for each change:

• Date and time of change

• Vantage user who made the change

• Host computer where the change occurred

• Change summary message

To open the Change Log utility, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Change Log.

Vantage displays the Change Log details panel shown in Figure 29.

Figure 29. Change Log Details Panel

You can use the Change Log utility to copy, delete, and refresh the entries in the change 
log. You can also use filters to display only the log entries that meet your criteria. 
Table 18 describes the Change Log utility controls.
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Table 18. Change Log Toolbar Buttons and Configuration Options

Button or 
Option Description

Delete button To delete one or more change log records, select the records to 
delete and do one of the following:

• Click the Delete button.
• Right-click a selected entry and select Delete.

Copy button To copy one or more change log records to the clipboard, select the 
records to copy and do one of the following:

• Click the Copy button.
• Right-click a selected entry and select Copy.
• Press Ctrl-C on the keyboard.

After you copy change log entries, you can paste the records into 
another application document, such as a spreadsheet or word 
processing document.

Refresh 
button 

Click to update the table from the database.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to specify the 
maximum number of log items.

User contains Specifies change log entries that contain the specified text in the 
User field.

Host contains Specifies change log entries that contain the specified text in the 
Host field.

Message 
contains

Specifies change log entries that contain the specified text in the 
Message field.

Newer than Displays change log entries that are newer than the specified date.

Older than Displays change log entries that are older than the specified date.
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Using the Error Log
The Error Log utility captures Vantage errors and records the following for each error:

• Date and time of error

• Error source (source Vantage service)

• Host computer where the error occurred

• Type of error (Info or Error)

• Error message

To open the Error Log utility, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Error Log.

Vantage displays the Error Log details panel shown in Figure 30.

Figure 30. Error Log Details Panel

You can use the Error Log utility to copy, delete, and refresh the entries in the error log. 
You can also use filters to display only the log entries that meet your criteria. Table 19 
describes the Error Log utility controls.
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Table 19. Error Log Toolbar Buttons and Configuration Options

Button or 
Option Description

Delete button To delete one or more error log records, select the records to delete 
and do one of the following:

• Click the Delete button.
• Right-click a selected entry and select Delete.

Copy button To copy one or more error log records to the clipboard, select the 
records to copy and do one of the following:

• Click the Copy button.
• Right-click a selected entry and select Copy.
• Press Ctrl-C on the keyboard.

After you copy error log entries, you can paste the records into 
another application document, such as a spreadsheet or word 
processing document.

Refresh 
button 

Click to update the error log display.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to specify the 
maximum number of log items.

User contains Specifies error log entries containing the specified text in the User 
field.

Host contains Specifies error log entries containing the specified text in the Host 
field.

Message 
contains

Specifies error log entries containing the specified text in the 
Message field.

Newer than Displays error log entries that are new than the specified date.

Older than Displays error log entries that are older than the specified date.
Vantage Domain Management Guide



Managing a Vantage Domain
Displaying Plug-in Versions

196
Displaying Plug-in Versions
Use the Plug-in Versions utility to display the list of plugins in the domain by service, 
including their version number.

To open the Plug-in Versions utility and display information for a service, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Plug-in Versions By Service.

3. Click a service to display the details panel for that service.

Vantage displays the details panel for the service, which will be similar to the Metadata 
service details panel shown in Figure 30.

Figure 31. Plug-In Versions, Metadata Service Details Panel
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Backing Up and Restoring the Vantage Domain 
Database

The domain backup feature allows you to save archival copies of the Vantage domain 
database in a separate file. The domain restore feature allows you to replace your 
current Vantage domain database with the contents of a previously-backed up domain. 
The domain backup and restore features are primarily used for the following:

• Returning the database to a previously backed-up state.

• Preparation for a database mirroring.

Note: The domain backup and restore features are not designed for use during 
Vantage upgrades. If you back up the database from a specific version of Vantage, that 
backup can only be restored to the same Vantage software version. During a Vantage 
upgrade, the Vantage installers manage any required database updates as described 
in Upgrading from the Previous Version.

The following topics describe domain backup and restore:

 Understanding Domain Backup and Restore

 Backing Up the Domain

 Restoring the Domain

Understanding Domain Backup and Restore
During a domain backup, Vantage creates a single backup file that contains all 
workflows, all services, and all jobs registered in the domain. It is important to 
remember that the backup file contents reflect the domain contents as of the moment 
the backup file is created. To capture changes made after a backup, you must create 
another backup.

When you restore a domain, all services are stopped, the current database contents are 
irretrievably destroyed, and the backup file you specify is used to create the 
replacement database. The services defined in the backup file are started and the 
Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, 
Telestream recommends that you back up the current database before restoring a 
previous database. Backing up the current database captures all database changes 
made since the last backup, and it gives you a backup file that you can use to restore 
the current database if necessary. 
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Backing Up the Domain
To back up the Vantage domain database, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Domain Backup/Restore.

Vantage displays the Domain Backup/Restore details panel shown in Figure 32.

Figure 32. Domain Backup/Restore Details Panel

3. Verify that all services in the Active Services list are hosting 0 sessions.

Note: Although you can create a successful backup while services are executing 
workflow tasks, some job records may be lost. It is best to back up the domain when 
there is no activity in the domain.

4. Click the Backup button.

5. In the Save the domain dialog, browse to the folder where you want to store the 
backup file, and click Save.

6. When the Backup Complete message appears, click OK.
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Restoring the Domain

CAUTION: Telestream recommends that you restore a Vantage domain using the 
same machine that created the backup file. If you restore the domain from another 
machine, the services defined in the database must match the services installed on 
the other machine.

To restore a Vantage domain database, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Domain Backup/Restore.

Vantage displays the Domain Backup/Restore details panel shown in Figure 32.

3. To provide the option to return to the current Vantage domain database later, back 
up the current domain database as described in Backing Up the Domain.

CAUTION: Always back up your current database before restoring it to an earlier 
backup. Restoring your Vantage domain database overwrites the entire contents of 
the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

Note: When you restore a domain, all services are stopped, and all information 
related to any jobs in progress is lost. The restored database contains only the domain 
information captured when the domain was backed up.

5. Click the Restore button, read the information dialog that appears, and click OK.

6. In the Load the domain dialog, browse to the backup file you want to restore, select 
the backup file, and click Open.

7. When the Restore Complete message appears, click OK.
Vantage Domain Management Guide



Managing a Vantage Domain
Renaming a Vantage Domain

200
Renaming a Vantage Domain
Each Vantage domain uses the name assigned to the Windows server that hosts the 
Vantage domain database. To rename a Vantage domain, you must complete the 
following tasks (which are described in more detail later in this topic):

• Remove all Vantage services from the Vantage domain.

• Rename the Windows server that hosts the Vantage domain database.

• Restart the renamed server and add all Vantage services to the renamed domain.

Note: If the Vantage domain database is a mirrored database, you must remove any 
Vantage licenses prior to renaming the Vantage domain. If you do not remove the 
licenses first, your licenses will become invalid after the rename is complete.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the Vantage domain 
configuration is retained. After the Vantage domain is renamed, all Vantage users and 
administrators will need to specify the new Vantage domain name when connecting to 
the domain with Vantage client or web applications.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage domain interrupts all Vantage services in the domain and all 
Windows services on the server to be renamed.

Use the following procedure to rename a Vantage domain:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

2. Select Services in the components panel.

3. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Click Start > Administrative Tools > Server Manager.

7. Click Server Manager in the left pane.

8. Click Change System Properties in the right pane.

9. Select the Computer Name tab and click Change.

10. Edit the computer name in the Computer Name text box and click OK.

11. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.
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Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

12. Restart the server.

13. Start the Vantage Management Console, select the new domain to manage, and 
log on.

14. Select Services in the components panel.

15. Click the Add Service button  in the toolbar.

16. When the Select Service dialog appears, click Machine to sort the services by 
machine name.

17. To add Vantage services for a specific machine, select the services you want and 
click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.

19. Send the new Vantage domain name to all Vantage users and administrators so 
they can reconnect to the Vantage domain.

Renaming a Vantage Server
To rename a Vantage server, you must complete the following tasks (which are 
described in more detail later in this topic):

• Remove all Vantage services for the server to be renamed from the Vantage 
domain.

• Rename the Windows server.

• Restart the renamed server and add all Vantage services on the renamed server to 
the Vantage domain.

Note: Do not use this procedure to rename a server that hosts the Vantage domain 
database. Instead, see Renaming a Vantage Domain.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the server 
configuration is retained.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage server interrupts all Vantage services and Windows services 
on the server to be renamed.
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Use the following procedure to rename a Vantage server:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

2. Select Services in the components panel.

3. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Click Start > Administrative Tools > Server Manager.

7. Click Server Manager in the left pane.

8. Click Change System Properties in the right pane.

9. Select the Computer Name tab and click Change.

10. Edit the computer name in the Computer Name text box and click OK.

11. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.

Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

12. Restart the server.

13. Start the Vantage Management Console, select the domain to manage, and log on.

14. Select Services in the components panel.

15. Click the Add Service button  in the toolbar.

16. When the Select Service dialog appears, click Machine to sort the services by 
machine name.

17. To add Vantage services for the renamed server, select the services you want and 
click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.
Vantage Domain Management Guide



Supporting Workflow Design and Operation 203
Supporting Workflow
Design and Operation

This chapter describes how to use the Vantage Management Console (VMC) to manage 
Vantage features that support workflow designers and operators.

Note: Features for which you do not have a license are disabled and indicate that you 
need a license to use them.

The following topics describe how to manage the features to support workflow design 
and operation:

 Managing Workflow Design Items

 Managing Binders

 Managing Catalogs

 Viewing the Active Workflows and Actions

 Viewing Workflow and Action Analytics

 Creating Report Formats
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Managing Workflow Design Items
The workflow design items described in this topic are configuration options that 
support workflow design, operation, and management. Some of these configuration 
options can be set for individual workflows using Vantage Workflow Designer, but 
some configuration options are only available in VMC.

The following topics describe how to configure workflow design items with VMC:

 Managing Vantage Workflows

 Enabling and Disabling Expiration of Failed Jobs

 Setting the Vantage Workflow Designer Grid Width/Height

 Managing Workflow Categories

 Managing Media Nicknames

 Managing Metadata Labels

 Managing Attachment Nicknames

 Managing Variables

 Managing Style Sheets

 Managing Actions

Managing Vantage Workflows
Typically, workflow designers manage workflows using Vantage Workflow Designer, 
and workflow operators manage the jobs that use workflows using Vantage Workflow 
Portal (VWP). The Vantage Management Console provides a limited set of workflow 
management options that allow you to do the following:

• View the workflows in a domain, sorted by category

• Select a workflow and open that workflow in Vantage Workflow Designer

• Export workflows to files for portability to other domains

• Import workflows previously exported to files

The following topics describe how to manage workflows with the Vantage 
Management Console:

 Managing Workflows with VMC

 Opening Workflow Designer and a Workflow

 Exporting Workflows

 Importing Workflows

 Refreshing the Workflow List
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Managing Workflows with VMC
To start the workflow management with the Vantage Management Console, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Vantage Workflows.

Vantage displays the Vantage Workflows details panel shown in Figure 33.

3. Double-click category folder icons to hide or display the workflows in the 
categories.

Figure 33. Vantage Workflows Details Panel

Opening Workflow Designer and a Workflow
You cannot edit a workflow with the Vantage Management Console, but you can select 
a workflow listed in the Vantage Management Console and open that workflow for 
management with the Vantage Workflow Designer. To launch Vantage Workflow 
Designer from Vantage Management Console and manage a workflow, select the 
workflow in Vantage Management Console and click the Workflow Designer button .

Note: If Vantage Workflow Designer is already open and positioned behind the 
Vantage Management Console window, VMC remains in front of the Workflow 
Designer window and the Workflow Designer button flashes in the task bar. Click the 
Workflow Designer button in the task bar to display the Workflow Designer window in 
front of VMC.
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Exporting Workflows
Exported workflows are saved as XML files—there is one workflow per file. You might 
want to export some workflows to send to a colleague at another station to replicate 
the same workflow. Or, you might want to export a workflow to import it into another 
domain. During a troubleshooting session with Telestream customer service, you might 
be asked to send the workflow in question to Telestream for clarity and review. 

Items exported with workflows include media nicknames, attachment nicknames, 
variables, metadata labels, stores, and output folders. Items not exported are style 
sheets and catalogs; however, these items can be exported separately.

To export all workflows in a category: 

1. Click the category.

2. Click the Export drop down menu and select an option. Export Workflows in 
Selected Category exports only the workflows in that category; Select Export 
Workflows By Category exports all workflows in all selected categories. (Or right-
click and select Export Workflows to export all workflows from the category).

3. Use the file system dialog to save the workflows in the desired location.

To export a single workflow, do the following:

1. Select the workflow to export. 

2. Click the Export button  (or right-click and select Export, or click the export 
button drop down list and select Export Workflow).

3. Use the file system dialog to save the workflows in the desired location.

The exported workflows are stored in a folder that is named for the workflow category 
that contains the workflow. For example, if you have four workflows in a category 
named Production, exporting all four workflows stores four XML files in a folder named 
Production. Each exported file is named the same as the workflow name. 

Note: Telestream recommends that you do not change the exported file name during 
or after the export.

Importing Workflows
To import one or more workflows, do the following:

1. Click the toolbar Import button  (or right-click a category and select Import Workflow). 

2. Navigate to the directory where the workflow XML file is stored, select the file you 
want to import, and click Open.

3. When prompted, select a category from the drop down list or type a new category 
name, then click OK. (The default category name is Imported.)

Note: Importing a workflow can cause duplicate variables, such as when a variable 
already exists and a workflow is imported having a different variable with the same 
name. To prevent confusion, you can rename one of the variables (see Modifying 
Variables). If you change a variable name, you must update all affected workflows.
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Refreshing the Workflow List
To refresh the list of Vantage workflows, click the Refresh button .

Related Workflow Management Topics
For additional information on workflow management, refer to the following topics:

 Managing Workflow Categories

 Viewing the Active Workflows in a Domain

 Viewing Workflow Analytics

Enabling and Disabling Expiration of Failed Jobs
To use storage space efficiently, Vantage can regularly delete binders and any 
associated temporary files related to failed jobs. 

Note: The feature only deletes binders and job-related files in a Vantage Store. By 
default, Flip action output is saved to a Vantage store, so you should use a Copy, 
Deploy, or Move action to place files that you want to keep in an output directory. Files 
in an input or output folder can be deleted using a workflow Delete action, but files in 
input and output folders are not automatically deleted when a job expires.

Each job has an expiration time and date, which can be disabled. If a job completes 
successfully and job expiration is enabled, the binder and all job-related files in the 
Vantage store are deleted when all the following are true:

• The job expiration time is exceeded or an operator has deleted the job.

• The binder expiration time defined in the catalog is exceeded or the binder is 
deleted.

• Temporary files to be deleted are not being used by any other unexpired binder.

If a job fails and the expiration period ends, the job is either retained or deleted, based 
on the configuration of this feature. When the Expire failed jobs feature is enabled, all 
job related files in the Vantage store are deleted as described above for completed jobs. 
When this feature is disabled, the binder and all job related files are retained until 
manually deleted.

To enable or disable expiration of failed jobs, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings and Options.

3. Select the General tab.

4. To enable expiration of failed jobs, check the Expire failed jobs checkbox.

5. To retain failed jobs until manually deleted, clear the Expire failed jobs checkbox.

6. Click the Save button .
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Setting the Vantage Workflow Designer Grid Width/Height
Vantage Management Console allows you to define the width and height values for the 
Vantage Workflow Designer grid. To define these values, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Settings and Options.

3. Select the General tab.

4. Enter the width and height values.

5. Click the Save button .

Managing Workflow Categories
Workflow categories are folders that contain workflows. These folders can be created or 
deleted in Vantage Workflow Designer or Vantage Management Console. When 
managing categories in VMC, you can also do the following:

• Duplicate categories

• Export and import category folders

• Define which Vantage users can access the workflows in a category

To configure categories with the Vantage Management Console, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Workflow Categories.

Vantage displays the Workflow Categories details panel shown in Figure 34.

3. Configure categories using the controls listed in Table 20.

4. Configure user access to a category by selecting the category and clicking the 
Permitted Users tab. Select Everyone (the default) to allow all users access to the 
category. To restrict access, uncheck Everyone, and use the Add/Remove buttons to 
move users from the Available list on the left to the Permitted Users list on the right. 
This enables configuration access for only those users in the Permitted Users list. 

5. Click the Save button .
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Figure 34. Workflow Categories Panel

Table 20. Workflow Categories Toolbar Buttons

Button Description

Create Click the Create button to create a new category (folder). Categories 
can also be created in the Workflow Designer.

Delete Click the Delete button to delete a category (folder). A warning about 
losing all workflows in this category is displayed to prevent accidental 
removal of workflows.

Save Click the Save button to save changes made in user permissions. If 
changes are not saved, you will be prompted to save upon leaving 
that category.

Duplicate Click the Duplicate button to duplicate a selected category. Only the 
category (folder) is duplicated. None of the workflows in the folder 
are duplicated. However, all of the user permissions are duplicated in 
the new folder.
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Import Click the Import button to display a file system dialog, so you can 
select a category file. Navigate to the directory where the category 
XML file is stored, select the file (or files) you want to import, then 
click OK.

Note: If you attempt to import a category that is already present in 
the domain, Vantage prompts you to overwrite the category (click 
Yes) or cancel the import (click No).

Export Click the Export button to display a file system dialog to select the 
server and directory where you want to save the selected categories 
as XML files. You can save a category (Export Selected), or save all 
categories (Export All). The XML files by default are named the same 
as the category names, but can be changed before saving.

Note: Changing the name of the XML file does not change the name 
of the category in the XML file.

Refresh Click the Refresh button to update the list of categories.

Table 20. Workflow Categories Toolbar Buttons (Continued)

Button Description
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Managing Media Nicknames
The following topics describe media nickname management concepts and tasks:

 Understanding Media Nicknames

 Managing Media Nicknames with VMC

 Creating Media Nicknames

 Deleting Media Nicknames

 Exporting and Importing Media Nicknames

 Searching for Media Nicknames in Workflows

Note: Workflow designers can only define new media nicknames in Vantage 
Workflow Designer. Vantage administrators must perform all other nickname 
management tasks.

Understanding Media Nicknames
A media nickname serves as an alias for a media file within a workflow. Without media 
nicknames, workflow designers would need to refer to the full path and name of each 
file in every workflow action that uses a file. When a media nickname is assigned to a 
file, the workflow designer can simply refer to the nickname; Vantage associates the full 
path and file name of the actual file with the nickname.

Vantage requires that a workflow designer associate a media nickname with every 
unique media file that is processed by a workflow. This means that each input media 
file must be assigned a nickname, and every unique output media file must have a 
nickname. Vantage provides the default nicknames described in Table 21.

Table 21. Vantage-Provided Media Nicknames

Media 
Nickname Description

Original This media nickname can be used to specify an input media file.

Vantage EDL This media nickname identifies media than contains an Edit Decision 
List (EDL).

Vantage 
Proxy

The Vantage Proxy nickname identifies a file that is suitable for 
viewing in the preview panel in Vantage Workflow Portal, Vantage 
Workflow Designer, or Vantage Management Console.

Vantage 
Thumbnail

The Vantage Thumbnail nickname identifies a file that contains an 
image that can be used to visually represent the contents of a media 
file. Thumbnail images typically represent content when the media 
file appears in Windows Explorer or in the binder view in Vantage 
programs.
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The media nicknames make it easier to manage files in a workflow. Consider the 
following:

• When a media file is input to a workflow, either manually or automatically from a 
watch folder, the workflow origin action immediately assigns a nickname (typically 
Original) to the file. The workflow designer does not need to know the name of the 
input file, so the same workflow can be used with any suitable media file, regardless 
of the media file name.

• When the workflow designer configures a Flip action to transcode the input file, the 
designer specifies the input file nickname (typically Original) and a different output 
file nickname. Selecting nicknames is as easy as selecting them from a dropdown 
list or entering a new nickname.

• Actions displayed in Vantage Workflow Designer display media nicknames on the 
action, which makes it easier to visualize how the workflow processes a file.

Managing Media Nicknames with VMC
To start managing media nicknames with the Vantage Management Console, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Media Nicknames.

Vantage displays the Media Nicknames details panel shown in Figure 35.

Figure 35. The Media Nicknames Panel
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Creating Media Nicknames
To create a new nickname, click the Create Nickname button  in the toolbar. VMC 
displays a Create Media Nickname dialog. Enter the name of this nickname and click 
OK.

VMC adds this nickname to the table. Optionally, add a description and click the Save 
button .

Note that you can’t rename media nicknames after you create them. To rename, create 
a new nickname and delete the old one, being sure to update all affected workflows.

Deleting Media Nicknames
To permanently remove a media nickname from the domain, select the nickname and 
click the Delete button  in the toolbar (or right-click and select Delete). Click OK to 
confirm the deletion.

Exporting and Importing Media Nicknames
Vantage allows you to export media nicknames to XML files, which you can then use to 
import the same media nicknames into another Vantage domain.

To export a media nickname, do the following:

1. Select the media nickname to export.

2. Click the Export button  (or right-click and select Export).

3. Use the file system dialog to save the exported media nickname.

The default file name is the media nickname, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the media 
nickname in the XML file.

To import a media nickname, do the following:

1. Click the Import button .

2. Locate and select the media nickname to import, and click Open.

Note: If you try to import a media nickname that is already in this Vantage domain, 
Vantage warns you that it will overwrite the existing media nickname.
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Searching for Media Nicknames in Workflows
Vantage allows you to search all workflows in a domain for a media nickname. This is 
very useful when you need to change or delete a nickname, and you want to know 
which workflows might be affected by the change.

To search for media nicknames, do the following:

1. Select the media nickname for which you want to search.

2. Click the Search button  in the toolbar (or right-click and select Find Workflows). 

If the media nickname is used in any workflows, Vantage displays a list of workflows 
that use the nickname. Double-click any workflow in the list to open that list in Van-
tage Workflow Designer. Click Done to dismiss the list.

If the media nickname is not used in any workflows, Vantage displays a message to 
that effect. Click OK to dismiss the message.

Managing Metadata Labels
The following topics describe Vantage metadata label concepts and management 
tasks:

 Understanding Metadata Labels

 Vantage Metadata Label Applications

 Managing Metadata Labels with VMC

 Creating Metadata Labels

 Adding Metadata Label Parameters

 Duplicating a Parameter within a Metadata Label

 Adding a Copy of a Metadata Label Parameter to Another Metadata Label

 Deleting a Metadata Label Parameter

 Modifying Metadata Labels and Parameters

 Previewing Metadata Labels and Values

 Sorting Metadata Label Parameters

 Exporting and Importing Metadata Labels

 Searching for Metadata Labels in Workflows

Note: Workflow designers can use Vantage Workflow Designer to perform some 
metadata label management tasks, and operators can also perform some label 
management with Vantage Workflow Portal. Only Vantage administrators can use 
Vantage Management Console to export, import, and delete metadata labels.
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Understanding Metadata Labels
Vantage supports metadata attachments and metadata labels. Metadata attachments 
are separate files that contain data about associated media. Metadata labels are used in 
some media files as containers to carry data about the media. In Vantage, metadata 
labels are defined using the Vantage Management Console and can be used to manage 
media data within and between workflows.

Each metadata label has a name and is comprised of one or more parameters. Each 
parameter has a name and holds a data value that conforms to a data type, such as text, 
date, timecode, or integer.

Vantage provides a comprehensive list of industry-standard metadata labels with 
parameters for use in Vantage workflows. You can also define custom labels with 
custom parameters.

During workflow processing, metadata labels can be populated with the following 
types of data:

• Data imported from metadata attachments

• Data from workflow analysis (Analysis, Examine, and Identify actions)

• Data from workflow variables (Metadata Populate action)

• Data entered by VWP operators

During workflow processing, metadata label content can be used to do the following:

• Provide media information to operators, who use the information to make media 
processing decisions

• Provide media information to workflow processes for automated decision process-
ing

• Output media information to metadata attachments for use after workflow pro-
cessing

• Add metadata labels to the output media (embedded in the media file)
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Vantage Metadata Label Applications
The following are some examples of how metadata labels can be used with workflows:

• Operator selection of distribution channels—An ingest workflow can be used to 
collect data and populate metadata labels. When the ingest workflow completes, 
an operator examines the workflow output (media and metadata labels) and con-
figures metadata labels that are used by a target workflow to choose a distribution 
channel.

• Easier operator selection of trim points and thumbnails—An ingest workflow can 
be used to generate a proxy media file, which the operator can use to review 
media. During review, the operator can use hotkeys to instantly transfer timecodes 
for the trim points and thumbnail to metadata labels, and the label timecode val-
ues can be used in the target workflow to trim the media and generate a thumb-
nail. Also, three timecode metadata parameters can be grouped together as a Trim 
Group, which automatically calculates and displays the difference between a Mark 
In and Mark Out point to show a duration.

• Metadata addition to media output files—For media formats that support meta-
data, a workflow can be configured to collect metadata from operators or populate 
the metadata with default values.

• Quicker location and evaluation of macroblocking—An ingest workflow can be 
configured to detect the worst macroblocking in input media and store the frame 
timecode in a metadata label. An operator can then use the label timecode value to 
quickly locate the issue and evaluate the severity.

• Flexible graphics and title insertion—With the addition of a template produced by 
GraphicsFactory software, the same workflow and template can be reused for mul-
tiple applications by using metadata labels to define a graphic file to insert, title 
text to insert, and timecodes for placement. 

• Operator specification for automatic commercial insertion—As with trim points 
and thumbnail selection, proxy media from an ingest workflow can be used with 
hotkeys and metadata labels to simplify operator specification for commercial 
insertion. After the metadata labels are populated, a target workflow can automati-
cally insert commercial media at the point specified by the metadata labels.
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Managing Metadata Labels with VMC
To start managing metadata labels with the Vantage Management Console, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Metadata Labels.

Vantage displays the Metadata Labels details panel shown in Figure 36.

Figure 36. Metadata Labels Panel
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Creating Metadata Labels
To create a new metadata label, do the following:

1. Click the New Label button  to create a new metadata label (far left) in the 
toolbar. 

2. In the dialog that appears, enter a name for the new metadata label, and click OK.

Metadata label names are case-sensitive. For example, FrameHeight and frame-
height are different labels.

3. If desired, enter a description for the metadata label.

4. Add metadata label parameters as described in Adding Metadata Label Parameters.

5. Click the Save button .

Adding Metadata Label Parameters
To add a metadata label parameter, do the following:

1. Click an existing metadata label name, or create a new metadata label as described 
in Creating Metadata Labels.

2. Click the Create Parameter button  in the design toolbar.

3. Enter a name for the new parameter.

4. If desired, do the following to configure the optional parameter values:

a. Enter a description for the new parameter.
b. Enter a category name.

Categories can be used to group logically related parameters. Parameters with 
the same category name are grouped together in the parameter list. If no cate-
gory is specified, the parameter displays in the Misc category.

c. Select a parameter value type from the dropdown list of values.
d. Click the password option if you want the parameter value to be obscured by 

asterisk (*) characters.
e. To define a list of optional values for the parameter, click the Modify button, 

enter one value per line, and click OK.

This feature can be used to create a dropdown list to reduce the chance of data 
entry errors. For example, you might create a Ratings parameter and specify the 
terms G, PG, PG-1, TV-14, and R. Operators can then use a dropdown list in VWP to 
select one of these values, instead of typing the value.

f. To limit the parameter value to one of the values defined with the Modify button, 
check the Exclusive checkbox.

In the above example for a Ratings parameter, checking the Exclusive checkbox 
limits operators to selecting one of the specified ratings. Operators are not 
allowed to type in a rating.

g. To define a default value for the parameter, enter the default value in the Default 
Value text box, or select a default value from the dropdown list.

The entry options depend on the other parameter value option settings.
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h. To change the displayed order of parameters, select a parameter in the 
parameter list and use the green up  and down arrow  buttons to move the 
variable in the list. You can also Ctrl-click or Shift-click to select multiple 
parameters.

The parameter list order that you define configures the order of parameters dis-
played in VWP.

i. To view how parameters appear to VWP operators, click the Categorize button 
, which toggles the display between showing categories and showing a flat list 

with no category names.

Note: Operators can configure VWP to display or hide the category names.

5. Click the Save button .

Duplicating a Parameter within a Metadata Label
To add a parameter that is a copy of another parameter in the same metadata label, do 
the following:

1. Select the parameter to copy. (Ctrl-click or Shift-click to select multiple parameters.) 

2. Open the Copy button  drop down list in the Design toolbar and select 
Duplicate selected (or right-click and select Duplicate).

3. Modify the parameter options and values as needed.

4. Click the Save button .

Adding a Copy of a Metadata Label Parameter to Another 
Metadata Label
To add a copy of one parameter to a different metadata label, do the following:

1. Select the parameter to copy. (Ctrl-click or Shift-click to select multiple parameters.)

2. Open the Copy button  dropdown list in the Design toolbar and select Copy 
selected (or right-click and select Copy).

3. Select the metadata label to which you want to copy the parameter.

4. Click the Paste button  in the Design toolbar.

5. Modify the new parameter options and values as needed.

6. Click the Save button .

Deleting a Metadata Label Parameter
To delete a parameter from a metadata label, do the following:

1. Select the parameter to delete. (Ctrl-click or Shift-click to select multiple 
parameters.)

2. Click the Delete button  in the design toolbar (or right-click and select Delete).

3. Click the Save button .
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Modifying Metadata Labels and Parameters
To modify a metadata label, do the following:

1. Click an existing metadata label name.

2. Make changes to the metadata label description as needed.

3. To modify a parameter, select the parameter and change the parameter settings.

4. Click the Save button .

Note that to rename labels, you must create a new label or duplicate and rename an 
existing label and delete the old one, being sure to update all affected workflows.

Previewing Metadata Labels and Values
To preview a metadata label and its values, select the label. All parameters for that label 
appear in the Preview/Test panel.

To toggle the display or to include or exclude category names, click the Categorize 
button . One display state displays parameters with the category headings, and the 
other display state displays parameters without the category headings.

Sorting Metadata Label Parameters
To change the order of the label parameters in the list, select a parameter (Ctrl-click or 
Shift-click to select multiple parameters) and click the green up  and down arrow  
buttons on the right side of the label list. Categories will display according to the order 
of the first parameter in each category.

Deleting Metadata Labels
To permanently remove a metadata label from the domain, select the label and click 
the Delete button  in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: When you delete a metadata label, the deletion can render services and 
workflows inoperable. Be sure to update all actions and services that used the deleted 
label. For information on locating workflows that contain a specific metadata label, see 
Searching for Metadata Labels in Workflows.

Duplicating a Metadata Label
It can be easier to duplicate and rename a metadata label than it is to make a new one. 
To duplicate a metadata label, do the following:

1. Select the metadata label.

2. Click the Duplicate button  in the toolbar (or right-click and select Duplicate). 

3. Enter a new metadata label name.

4. Change additional metadata label settings as needed.

5. Click the Save button .
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Exporting and Importing Metadata Labels
Vantage allows you to export metadata labels to XML files, which you can then use to 
import the same labels into another Vantage domain.

To export all metadata labels, click the Export drop down menu and select Export All.

To export one or selected metadata labels, do the following:

1. Select the metadata label to export. Ctrl-click or Shift-click to select multiple labels.

2. Click the Export button  to export labels (or right-click and select Export, or select 
Export Selected from the Export button drop down menu).

3. Use the file system dialog to save the exported metadata labels.

The default file name is the metadata label name, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the metadata 
label in the XML file.

To import a metadata label, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the metadata label to import, then 
click Open.

Note: If you try to import a metadata label that is already in this Vantage domain, 
Vantage prompts you to either overwrite the existing label (click Yes) or cancel the 
import (click No).

Searching for Metadata Labels in Workflows
Vantage allows you to search all workflows in a domain for a metadata label. This is very 
useful when you need to change or delete a metadata label, and you want to know 
which workflows might be affected by the change.

To search for metadata labels, do the following:

1. Select the metadata label for which you want to search.

2. Click the Search button  in the toolbar (or right-click and select Find Workflows). 

If the metadata label name is used in any workflows, Vantage displays a list of work-
flows that use the label. Double-click any workflow in the list to open that workflow 
in Vantage Workflow Designer. Click Done to dismiss the list.

If the metadata label name is not used in any workflows, Vantage displays a mes-
sage to that effect. Click OK to dismiss the message.
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Managing Attachment Nicknames
Like media nicknames, an attachment nickname serves as an alias for an attachment 
file within a workflow. An attachment file might be an XML file, an SCC caption file, an 
STL subtitle file, a PDF, or any other type of file which does not contain video or audio 
media. Without attachment nicknames, workflow designers would need to refer to the 
full path and name of each file in every workflow action that uses a file. When an 
attachment nickname is assigned to a file, the workflow designer can simply refer to the 
nickname; Vantage associates the full path and file name of the actual file with the 
nickname.

Vantage administrators can use the Vantage Management Console to manage 
attachment nicknames. The following topics describe nickname management 
concepts and tasks:

 Understanding Attachment Nicknames

 Managing Attachment Nicknames with VMC

 Creating Attachment Nicknames

 Deleting Attachment Nicknames

 Exporting and Importing Attachment Nicknames

Note: Workflow designers can only define new attachment nicknames in Vantage 
Workflow Designer. Vantage administrators must perform all other nickname 
management tasks.

Understanding Attachment Nicknames
Vantage requires that a workflow designer associate an attachment nickname with 
every unique attachment file that is processed by a workflow. This means that each 
input attachment file must be assigned a nickname, and every unique output 
attachment file must have a nickname.
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Managing Attachment Nicknames with VMC
To start managing attachment nicknames with the Vantage Management Console, do 
the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Attachment Nicknames.

Vantage displays the Attachment Nicknames details panel shown in Figure 37.

Figure 37. Attachment Nicknames Details Panel

Creating Attachment Nicknames
To create a new nickname, click the Create Nickname button  in the toolbar. VMC 
displays a Create Attachment Nickname dialog. Enter the name of this nickname and 
click OK.

VMC adds this nickname to the table. Optionally, add a description and click the Save 
button .

Note that you can’t rename media nicknames after you create them. To rename, create 
a new nickname and delete the old one, being sure to update all affected workflows.

Deleting Attachment Nicknames
To permanently delete a nickname from the domain, click the Delete button  in the 
toolbar (or right-click and select Delete). Click Yes in the warning to confirm.

Note: When you delete a nickname, it will render services and workflows inoperable if 
the nickname was used in it. Be sure to modify all actions and services that used the 
nickname you just deleted.
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Exporting and Importing Attachment Nicknames
Vantage allows you to export attachment nicknames to XML files, which you can then 
use to import the same nicknames into another Vantage domain.

To export all attachment nicknames, select Export all from the Export button drop 
down menu.

To export one or selected attachment nicknames, do the following:

1. Select the attachment nickname to export. Ctrl-click or Shift-click to select multiple 
nicknames.

2. Click the Export button  (or right-click and select Export, or click the Export drop 
down menu and select Export Selected).

3. Use the file system dialog to save the exported attachment nicknames.

The default file name is the attachment nickname, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the 
attachment nickname in the XML file.

To import an attachment nickname, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the attachment nickname file to 
import, then click Open.

Note: If you try to import an attachment nickname that is already in this Vantage 
domain, Vantage prompts you to either overwrite the existing attachment nickname 
(click Yes) or cancel the import (click No).
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Managing Variables
The following topics describe variable management concepts and tasks:

 Understanding Variables

 Managing Variables with VMC

 Creating Variables

 Modifying Variables

 Deleting Variables

 Duplicating a Variable

 Exporting and Importing Variables

 Searching for Variables in Workflows

Note: Workflow designers can create new variables and change variable values in 
Vantage Workflow Designer. With the proper permissions, operators can use Vantage 
Workflow Portal to change variable values. Vantage administrators must perform all 
other variable management tasks using the Vantage Management Console.

Understanding Variables
Variables in Vantage are similar to variables in programming languages. You can create 
a variable, name it, assign and change its value, and use the variable in workflow 
actions and services to automate decisions.

Each variable can be configured with a name, description, value type, and default value. 
The name and type are required, and the description and default value are optional.

The variable type describes what type of value the variable represents. Some 
supported types include text, date, integer number, and timecode.

The default value is only used by a workflow action when the variable has not been 
assigned a value earlier in the workflow.

For example, suppose you want a variable named Email that you can use to specify an 
email address for use in a Message action within a workflow. Also suppose that you 
want to send the email to a single address most of the time, but you want the option to 
override the email address in a workflow. To do this, create an Email variable in Vantage 
Workflow Designer or the Management Console, and set the default value to the email 
address you want to use most of the time.

During workflow execution, the Message action operates as follows:

• If no other instance of the Email variable is created earlier in the workflow, the email 
is sent to the address specified by the default value in the email variable.

• If the Email variable is set earlier in the workflow, before the Message action, the 
email is sent to the address specified by the earlier workflow action.
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Managing Variables with VMC
To start managing variables with the Vantage Management Console, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Variables.

Vantage displays the Variables details panel shown in Figure 38.

Figure 38. Variables Details Panel

Creating Variables
Variables are typically created in Vantage Workflow Designer, but you can create 
variables in Vantage Management Console as follows:

1. Click the Create Variable button  in the toolbar.

2. Provide a name for the variable. 

Variable names are case-sensitive. For example, FrameHeight and frameheight are 
different variables.

3. Select a variable type from the Value Type dropdown menu.

Note: You cannot change a variable type after you save the variable configuration.

4. Enter a default value for the variable.

5. If needed, enter a description for the variable.

6. Click the Save button .
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Modifying Variables
Exercise caution when modifying a variable that is already being used by a workflow. If 
you change the variable name, all workflows that use the variable must be updated. If 
you change the default value of a variable, existing workflows continue to use the older 
default value until you unbind and rebind the variables in the workflows.

To modify a variable, select the variable, make your changes, and click the Save button 
.

Note: When you modify a variable, the change can render a service or workflow 
inoperable. Be sure to modify all services/actions that use the modified variable. For 
information on locating workflows that contain a specific variable, see Searching for 
Variables in Workflows.

Deleting Variables
To permanently remove a variable from the domain, select the variable and click the 
Delete button  in the toolbar (or right-click and select Delete). Click OK to confirm.

Note: When you delete a variable, the deletion can render services and workflows 
inoperable. Be sure to update all actions and services that used the deleted variable. 
For information on locating workflows that contain a specific variable, see Searching 
for Variables in Workflows.

Duplicating a Variable
It can be easier to duplicate and rename a variable than it is to make a new one. To 
duplicate a variable, do the following:

1. Select the variable.

2. Click the Duplicate button  in the toolbar (or right-click and select Duplicate). 

3. Enter a new variable name.

4. Change additional variable settings as needed.

5. Click the Save button .
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Exporting and Importing Variables
Vantage allows you to export variables to XML files, which you can then use to import 
the same variables into another Vantage domain.

To export all variables, click the Export drop down menu and select Export All.

To export one or selected variables, do the following:

1. Select the variable to export. Ctrl-click or Shift-click to select multiple variables.

2. Click the Export button  (or right-click and select Export, or click the Export drop 
down menu and select Export Selected).

3. Use the file system dialog to save the exported variable. The default file name is the 
variable name, or you can change the file name.

Note: Changing the name of the XML file does not change the name of the variable in 
the XML file.

To import a variable, do the following:

1. Click the Import button .

2. Use the file system to locate and select the variable to import, then click Open.

Note: If you try to import a variable that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

Searching for Variables in Workflows
Vantage allows you to search all workflows in a domain for a variable. This is very useful 
when you need to change or delete a variable, and you want to know which workflows 
might be affected by the change.

To search for variables, do the following:

1. Select the variable for which you want to search.

2. Click the Search button  in the toolbar (or right-click and select Find Workflows). 

If the variable is used in any workflows, Vantage displays a list of workflows that use 
the variable. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the variable is not used in any workflows, Vantage displays a message to that 
effect. Click OK to dismiss the message.

Note: It is possible to have multiple variables with the same name if a variable already 
exists and a workflow is imported having a different variable with the same name. This 
does not pose any problem for Vantage (which uses a GUID number behind the scenes 
to tell the variables apart), but you may have to search using both variable instances to 
find all workflows using that variable name. You may also want to change the name of 
one of the duplicates and update your workflows to prevent confusion.
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Managing Style Sheets
The following topics describe style sheet management concepts and tasks:

 Understanding Style Sheets

 Managing Style Sheets with VMC

 Adding a Style Sheet

 Renaming a Style Sheet

 Deleting Style Sheets

 Exporting and Importing Style Sheets

Understanding Style Sheets
A style sheet defines how an input metadata format is converted to an output 
metadata format. A style sheet does not change the metadata values; it changes the 
presentation of the metadata. The Transform action requires a style sheet, and style 
sheets can only be managed using the Vantage Management Console.

Style sheets (XSL files) are the keystone of the Transform action. Style sheets enable you 
to convert one attachment file (XML) into a different attachment (XML file) or to 
convert the contents of an attachment into a custom label schema and vice-versa. Each 
style sheet has a nickname to make it easy to assign style sheets in a workflow.

When you are processing media with metadata in a specific XML format and you are 
creating a workflow to convert the XML file into a different format or into a specific 
contextual metadata structure (for example, a label); you will need to provide a style 
sheet to perform the transformation.

When you add a new style sheet to your Vantage domain, the style sheet itself is 
wrapped in an XML file, providing a structure for the Vantage metadata: the name, 
description and identifying GUID. 

When you export style sheets, the entire XML file (the wrapper and the actual style 
sheet inside it) is saved. When you import a previously exported style sheet, you are 
importing an entire wrapper back into the domain. 

Note: Style sheets and metadata transformation are advanced concepts. If you 
require assistance in implementing specific metadata transformations, please contact 
your customer service representative at Telestream to discuss custom style sheets for 
your specific workflow requirements.
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Managing Style Sheets with VMC
To start style sheet management with the Vantage Management Console, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Style Sheets.

Vantage displays the Style Sheets details panel shown in Figure 39.

The Management Console displays the Style Sheets details panel:

Figure 39. Style Sheets Details Panel

Adding a Style Sheet
To add a new style sheet to the domain, do the following:

1. Click the Add Style Sheet button  in the toolbar. 

Vantage displays a file system dialog, so you can select a style sheet (XSL) file. 

2. Navigate to the directory where the style sheet file is stored, select the file you want 
to import, and click OK.

VMC adds the new style sheet to the table.

3. Name the style sheet and enter a description.

4. Click the Save button .

Renaming a Style Sheet
To rename a style sheet definition, select it in the table, edit the name to meet your 
requirements, and click the Save button .
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Deleting Style Sheets
To permanently remove a style sheet from the domain, click the Delete button  in the 
toolbar (or right-click and select Delete). Click Yes in the warning to confirm.

Note: When you remove a style sheet from the domain, the XSL file is not erased—its 
reference is removed from the Vantage domain database. Removing a style sheet will 
render services and workflows inoperable if the style sheet was used in them. Be sure 
to update all actions and services that used the style sheet you just deleted.

Exporting and Importing Style Sheets
Vantage allows you to export style sheets to XML files, which you can then use to 
import the same style sheets into another Vantage domain.

To export all style sheets, click the Export drop down menu and select Export All.

To export selected style sheets, do the following:

1. Select the style sheet to export. Ctrl-click or Shift-click to select multiple style 
sheets.

2. Click the Export button  to export a single style sheet (or right-click and select 
Export, or click the Export drop down menu and select Export Selected).

3. Use the file system dialog to save the exported style sheet.

The default file name is the style sheet name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the style 
sheet in the XML file.

To import a style sheet, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the style sheet to import, then click 
Open.

You cannot import XSL files—only style sheets that have been previously exported 
as XML files.

Note: If you try to import a style sheet that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Managing Actions
The following topics describe action management tasks:

 Understanding Actions

 Managing Action Default Settings with VMC

 Configuring the Resource Cost

 Configuring Retry Settings

 Exporting and Importing Action Default Settings

 Exporting and Importing Workflow Action Configurations

 Related Action Management Topics

Understanding Actions
An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its subtask in the context of the workflow task.

Vantage services execute the actions within a workflow. Each service executes a specific 
set of actions, so the actions are often sorted by service in Vantage programs. For 
example, workflow designers select individual actions from action groups that are 
usually named for the service that executes the action. 

Note: The Common group displayed in Vantage Workflow designer is an exception 
because it lists actions that can be executed by any service.
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Managing Action Default Settings with VMC
The action default settings define the default resource cost and retry settings for 
Vantage workflow actions. You can export these settings for use in other domains, and 
you can import settings from exported files.

To start action default setting management with the Vantage Management Console, do 
the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Workflow Design Items > Action Defaults.

Vantage displays the Action Defaults details panel shown in Figure 40.

Figure 40. Action Defaults Details Panel
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Configuring the Resource Cost
When cost-based load balancing is enabled, the resource cost establishes a default cost 
for an action. A higher resource cost means that fewer actions can run at the same time, 
which reduces demand on server resources. A lower resource cost allows more actions 
to run simultaneously. For information on enabling cost-based load balancing, see 
Managing Load Balancing.

Note: When cost-based load balancing is disabled (which is the default setting), the 
resource cost for every action is 1 and any other setting is ignored.

Configuring Retry Settings
For some actions, Vantage allows you to configure a retry rule that defines how and 
when Vantage tries to execute an action that failed. Retry rules can be configured for an 
action type in the Vantage Management Console, and rules can be configured for 
specific actions in a workflow using Vantage Workflow Designer. When a retry rule is 
defined in a workflow for an action, that rule overrides any rule for that action type that 
is defined in Vantage Management Console.

The default retry rule for all action types defined in Vantage Management Console is No 
Retry. When an action type supports retry rules, you can specify a limited retry rule or a 
recurring retry rule.

A Limited Retry rule can specify up to 3 retries, each with a defined delay period and a 
priority. For example, you can specify (in the Vantage Management Console) that all 
Flip actions retry the first time after five minutes at priority 10, and that Flip actions 
retry a second time after 10 minutes at priority 20.

A Recurring Retry rule allows unlimited retries of failed actions of the specified type 
until the action executes. You can specify a retry interval (in seconds, minutes, hours, or 
days) and specify a relative priority. For example, you can set Vantage to retry failed 
Copy actions every 2 minutes (a 2-minute Delay) at Priority 30 until the Copy action 
executes successfully. You can also specify a Stop after a maximum number of iterations 
or leave Stop unchecked for unlimited retries.

It is important to keep in mind that individual action retry rules specified in Vantage 
Workflow Designer override the default retry rules specified in the Vantage 
Management Console. For example, if a workflow is configured to retry a Message 
action twice after failure and the Vantage Management console is configured for No 
Retry for Message actions, Vantage will retry the failed Message action twice, as 
specified in the workflow.

The following topics describe retry rule management:

 Viewing Action Retry Rules

 Configuring Action Retry Rules
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Viewing Action Retry Rules

To view the retry configuration for any action, do the following:

1. In the Vantage Management Console components panel, open Workflow Design 
Items > Action Defaults.

2. Select an action in the Action Defaults details panel.

3. View the configuration in the Action panel.

Note: Not all actions support action retry rules.

Configuring Action Retry Rules

To configure a retry rule for any action, do the following:

1. In the Vantage Management Console components panel, open Workflow Design 
Items > Action Defaults.

2. Select an action in the Action Defaults details panel.

3. To disable retries, click No Retry.

4. To define a limited retry rule, click Limited Retry and complete the rule as follows:

a. For the first retry, specify the delay period number and units and execution 
priority.

b. For a second or third retry, check the appropriate checkbox and complete the 
rule configuration.

5. To define a recurring retry rule, click Recurring Retry and complete the rule as 
follows:

a. Specify the delay period number and units and execution priority.
b. Clear the Stop after checkbox to enable unlimited retries, or check the checkbox 

and specify a maximum number of retry iterations.

6. Click the Save button .
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Exporting and Importing Action Default Settings
Vantage allows you to export action default settings to XML files, which you can then 
use to import the same default settings into another Vantage domain.

To export default settings for all actions, select Export All from the Export button drop 
down menu.

To export default settings for selected actions, do the following:

1. Select the action. Ctrl-click or Shift-click to select multiple actions.

2. Click the Export button  to export settings (or right-click and select Export, or 
click the Export drop down menu and select Export Selected).

3. Use the file system dialog to save the exported settings.

The default file name is the action name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the action in 
the XML file.

To import settings for an action, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the file to import, then click Open.

Note: When you import settings for an action that is already in this Vantage domain, 
Vantage prompts you to confirm replacement of the current settings or cancel the 
import.

Exporting and Importing Workflow Action Configurations
Every workflow action and action template is stored in the Vantage domain database, 
and you can use the Vantage Management Console to view these actions and action 
templates. With VMC, you can view when an action was created, which workflow uses 
the action, and whether the action is a template or not. You can also export and import 
actions and action templates.

You might want to export an action so that you can import it to another domain, or you 
might want to export an action so that you can email it to Telestream for evaluation. 
When you import an exported action or action template from another domain, Vantage 
automatically makes the imported action a template in the new domain. Imported 
action templates make the imported action available to all workflow designers in the 
Vantage domain.

Actions are saved as XML files—one action per file. The following topics describe 
export and import tasks:

 Displaying Actions for Export and Import

 Exporting Actions

 Importing Actions
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Displaying Actions for Export and Import

To display actions for export and import, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Support Utilities > Actions > By Service.

3. Select the service for which you want to display actions.

Vantage displays a service details panel that lists actions, similar to the Transport 
details panel shown in Figure 41.

Figure 41. Transport Service Details Panel, Showing Actions for the Transport Service

Exporting Actions

To export one or more actions, do the following:

1. Select the actions to export. (Ctrl-click to select multiple actions.)

2. Click the Export button  (or right-click and select Export).

3. Use the file system dialog to save the exported actions.

The default file name is the action name, but you can change the file name.

Note: Changing the XML file name does not change the action name in the XML file.
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Importing Actions

When you import an action into a domain, Vantage imports the action as a template, 
and the action template becomes available to all workflow designers in the Vantage 
domain. If a workflow designer creates a new action using the imported template, the 
new action uses all of the settings of the original action.

To import an action, do the following:

1. Click the Import button .

2. Browse the file system to locate and select the action file to import, and click Open.

Related Action Management Topics
For additional information on action management using Vantage Management 
Console, refer to the following topics:

 Viewing Active Actions

 Viewing Action Analytics

For information on action management using Vantage Dashboard, refer to the 
following topics:

 Displaying Action Error Details

 Changing Action Priority

 Restarting Actions
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Managing Binders
The following topics describe binder management concepts and tasks:

 Understanding Binders

 Managing Binders with VMC

 Creating and Deleting Binders

 Submitting Binders from VMC

 Renaming a Binder

 Configuring a Binder Expiration Policy

 Managing Media Files in a Binder

 Managing Metadata Labels in Binder

 Managing Binder Attachments

Understanding Binders
When a workflow executes, Vantage creates a job and a binder. A binder is not a 
physical entity like a folder but a temporary list or collection of information for a 
particular job that is created when a workflow runs. The binder points to input files, 
output files, temporary files, metadata labels, and other references used by that job. 
The references in a binder identify both media files and non-media attachment files 
such as XML or PDF files. 

Vantage uses binders as follows:

• Records the locations of all media files, attachment files, temporary files, and out-
put files for a job.

• Stores metadata labels for a job.

• Retains job information for evaluation by a Vantage Workflow Portal operator and 
submission to a new workflow.

• Determines which files can be deleted when Vantage is done with a binder.

• Allows you to return to a job after processing and locate or view the files.

To manage binders, you need to understand how the workflows in your Vantage 
domain use the binders. For example, one workflow might be designed to produce 
output to be evaluated by a Vantage operator for approval. If the operator approves the 
output, the operator might forward the output of the first workflow to a second 
workflow for processing. When the output is forwarded, what is actually forwarded is 
the binder, which contains all the file references and metadata needed for the next job.

In the preceding example, the binder must be retained long enough for the operator to 
become aware of job completion, evaluate the results, and make a decision. You might 
want to retain the binder for an extra day, week, or month, for auditing purposes. 
However, if your business creates many workflows, you will eventually want to delete 
the binder and related temporary files to conserve disk space.
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Vantage stores binders in the Vantage domain database. By default, binders are deleted 
according to an expiration policy defined for each workflow in Vantage Workflow 
Designer. Workflow designers can also use Workflow Designer to manually delete jobs, 
which deletes the associated binders. This default setting places binder management 
under the control of Vantage workflow designers.

To extend binder management to support access from Vantage Management Console 
or Vantage Workflow Portal, you can use the Vantage Management Console to create 
catalogs (see Managing Catalogs). A catalog serves as a container or folder to which a 
binder can be associated. Because each catalog has its own expiration policy, some 
additional conditions must be met before a binder is deleted. Binders and the related 
temporary files are deleted only when all the following are true:

• The job expiration time is exceeded or an operator has deleted the job.

• The binder expiration defined in the catalog is exceeded or the binder is deleted.

• Temporary files to be deleted are not being used by any other unexpired binder.

Note: Only files in a Vantage Store are automatically deleted according to the above 
rules. By default, Flip action output is saved to a Vantage store, so you should use a 
Copy, Deploy, or Move action to place files that you want to keep in an output 
directory. Files in an input or output folder can be deleted using a workflow Delete 
action, but such files are not automatically deleted when a job expires.

To associate a binder with a catalog, Workflow designers add a Register action to a 
workflow and configure it for the appropriate catalog. The Register action and catalog 
are required to support binder forwarding from one workflow to another or to retain a 
binder beyond the expiration period and control of Workflow Designer. 

Note: TrafficManager workflows that use the Dublist Monitor action require that the 
binder name be set to match the ISCI code in the catalog. This ensures the binder and 
catalog are matched up when processed by the Dublist Monitor action.

Workflows are not limited to accessing or registering media in a single catalog. For 
example, a given workflow might ingest media from Catalog A, produce another 
version of the content, and register the new content in Catalog B.

As a Vantage administrator, you might need to manage binders as follows:

• Establish binder expiration times, so that the binders and related temporary files 
are deleted (to conserve disk space) at an appropriate time after job completion.

• View binder contents to evaluate or troubleshoot workflow operation.

• Submit a binder to a workflow to test workflow operation.

• Create, delete, rename, and modify binders as needed to support the development 
of workflows and manage Vantage resources.
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Managing Binders with VMC
Vantage Management Console provides binder management only for binders that are 
associated with a catalog. The following tasks must be completed before you can 
manage binders with VMC:

1. You must create a catalog if you want workflow designers to use a catalog other 
than the Default Catalog.

2. A workflow designer must create a valid workflow with a Register action that 
registers the workflow (and the binders it produces) to the catalog.

3. A job must be submitted to Vantage using the workflow with the Register action.

When binders are associated with a catalog, you can start binder management by 
doing the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Catalogs.

Vantage displays the Catalogs details panel shown in Figure 42.

3. In the Catalogs details panel, select a catalog in the list on the left; then select a 
binder from the list on the right.

Figure 42. Catalogs Details Panel, Showing Catalog and Binder Lists
Catalog List Binder List
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Creating and Deleting Binders
In normal operations, binders are created when a new job starts, and they are deleted 
as described in Understanding Binders.

Note: The Vantage Management Console controls for creating and deleting binders 
are provided for testing and troubleshooting, not for regular maintenance.

To create a new binder, do the following:

1. Select the catalog to which you want to add the binder.

2. Click the New Binder button  (or right-click the catalog and select New Binder).

The Management Console displays a file system dialog so that you can navigate to 
and select the media you want to assign the binder. 

3. Select the target media file and click Open to create the binder for this media file.

To delete a binder, do the following:

1. Select the catalog and folder in which the binder resides.

2. Select the binder to remove.

3. Click the Delete button .

CAUTION: Removing a binder permanently deletes Vantage store files as described in 
Understanding Binders.
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Submitting Binders from VMC
You can use the catalog feature in VMC to submit binders to workflows. Binder 
submission in VMC is intended as a test/diagnostic feature and is not recommended for 
regular use in production.

When submitting a binder, it is your responsibility to ensure that the binder contains 
the requisite items (source media, metadata labels and/or attachments) that the 
targeted workflow requires. If the binder specified does not contain all of the required 
items, the job will fail.

To submit a binder to a workflow from VMC, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Submit To Workflow.

Figure 43. Submit to Workflow Dialog

3. When the Submit To Workflow dialog appears, select a target workflow.

4. If you need to submit variables with the binder, do the following:

a. Click the Variables button. The Management Console displays the Select Variable 
dialog (Figure 44).

Figure 44. Select Variables Dialog
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b. To add variables to the Variable list, click the Add Variable button , select one or 
more variables (control-click), and click OK.

c. To change a variable value, select a variable and change the value (which 
appears below the list).

The Vantage Management Console displays the Variables dialog, with the 
selected variables listed, so you can update the values:

Figure 45. Variables Dialog

d. When all the variable values are set, click OK.

5. In the Submit To Workflow dialog, click Submit to process this binder using the 
selected workflow.

To view job processing, open Workflow Designer, select the workflow, and click the Job 
Status tab.

Renaming a Binder
To rename a binder, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Properties.

3. Edit the binder name and click OK.
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Configuring a Binder Expiration Policy
The binder expiration policy overrides the binder configuration policy for the parent 
catalog or folder.

To configure the binder expiration policy, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Properties.

3. Edit the binder expiration date or check the Never Expire checkbox.

4. Click OK.

Note: The expiration policy can be set for individual binders when they are registered 
in a catalog; this is done using the workflow Register action.

Managing Media Files in a Binder
To view and manage the media files referenced in a binder, click the target binder in the 
binder list, then click the Media Files tab. You can add and delete media file references 
to a binder, and you can rename the media file names listed in the binder.

Each binder may also contain references to metadata and attachments. You can view 
and manage these items by clicking the appropriate tab. You can also right-click a 
binder and select Properties to change the binder name or expiration policy.

Figure 46. Binder Assets, Organized by Tab

Adding a Media File Reference
When you add a media file to a binder, you select the file from a browse dialog, name 
the media file, and specify a media nickname.

Within a binder, each media and attachment file has a nickname; these nicknames are 
how Vantage workflows access the underlying files. Nicknames serve a dual purpose. 
First, because they are abstracted from the actual location of the underlying files, it 
allows workflows to be designed without worrying about the underlying file locations. 

Media Files Toolbar. 

Mini-player controls.
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Second, when a step in a workflow requires one or more input files, nicknames allow 
Vantage to pre-validate the workflow and availability of nicknames prior to execution.

However, binders may in fact be processed by more than one workflow simultaneously 
(either by using the Forward action or using VWP). When this happens, Vantage cannot 
pre-detect which nicknames are necessary in each separate workflow. Administrators 
who build workflows in this way must take care to ensure that their design does not 
cause files necessary in one workflow to be deleted by another.

To add a media file reference, do the following:

1. Click the Add Media File button  in the toolbar (or right-click in the empty list 
area and select Add Media File).

2. In the Select the Media Version text box, type a media nickname or select an 
existing media nickname from the drop down list.

3. Click the Browse button and use the browse dialog to select a media file.

4. In the Enter the Name text box, enter the media file name that appears in the 
binder.

Note: The filename you specify in this dialog applies only to the name displayed in 
the binder. The original media filename remains unchanged.

Removing a Media File Reference
To remove a media file reference from a binder, select the file, and click the Remove 
button  in the toolbar (or right-click and select Remove).

Note: Removing a file reference from a binder does not delete the source media file.

Renaming a Media File Reference
To rename a media file reference, click the media file name, and enter a new name (or 
right-click and select Rename, and enter a new name).

Note: Renaming a media file does not rename the source media file.
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Previewing a Media File
The preferred preview format for Vantage 6.0 is QuickTime H.264. You can preview files 
that use this format in VWP.

You can use VMC to preview ASF, WMV, and MP4 media files. Select the media file on 
the Media Files tab, and use the playback controls below the media display area to the 
right of the Media Files tab.

Note: You can also preview ASF, WMV, and MP4 media directly in the Workflow 
Designer (right-click a job on the Job Status tab and select View Binder).

Managing Metadata Labels in Binder
Metadata labels in a binder are stored in the Vantage domain database. Only one of 
each type of metadata label can be part of a binder (for example, a binder may contain 
one Identify label and one Curtains label, but not two Identify labels). Some labels may 
contain information that is specific to one media file—for example, an Identify label will 
typically contain file properties for one of the media files in a binder, not necessarily all 
of them.

You can use the Vantage Management Console to view and manage the metadata 
labels assigned to a binder. To view, add, delete, or modify the labels assigned to a 
binder, start by clicking the target binder in the binder list, then click the Metadata 
Labels tab.

Note: This topic discusses metadata label use with binders. For additional metadata 
label management information, see Managing Metadata Labels.

Adding a New Label

To add a new label, click the Add Labels  button in the toolbar (or right-click the 
empty file area and select Add Labels).

The Management Console displays a label list, so you can select the label you want to 
assign to the binder. Select the label and click OK to add the label to the binder.

Removing a Label

To remove a label reference from a binder, select the label to remove, and click the 
Remove Label button  in the toolbar (or right-click and select Remove).

Note: This procedure removes the reference in the binder; it does not remove the 
metadata label from the Vantage domain.

Modifying Label Parameter Values

To modify a label parameter value for the binder, select the label to display the 
parameters and values in the parameter detail table on the right. Select the parameter 
to edit and make your changes. Click Save to update the Vantage domain database 
with your changes. 
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Managing Binder Attachments
To view and manage attachments—independent files associated with this binder—
click the target binder in the binder list, then click the Attachments tab. Binders can 
contain multiple attachments. You can add, delete and rename attachments.

Adding a New Attachment

To add a new attachment, click the Add Attachments button  in the toolbar (or right-
click in the empty list space and select Add Attachment).

The Management Console displays a file system dialog so that you can navigate to and 
select the file you want to assign the binder. Select the target attachment file, select an 
attachment tag, enter a name, and click OK to add the file reference to the binder for 
this media file.

Removing an Attachment

To remove an attachment, select the attachment to permanently remove, and click the 
Delete button  in the toolbar (or right-click and select Remove).

Note: Removing an attachment does not delete the underlying file.

Renaming an Attachment

To rename an attachment, select the attachment to rename, and enter the new name 
(or right-click and select Rename to enter the new name).

Note: Renaming an attachment does not rename the underlying file.
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Managing Catalogs
The following topics describe catalog management concepts and tasks:

 Understanding Catalogs

 Managing Catalogs with VMC

 Creating and Deleting Catalogs

 Creating and Deleting Catalog Folders

 Configuring a Catalog or Folder Expiration Policy

Understanding Catalogs
Vantage catalogs serve as containers for the binders created by workflows (see 
Managing Binders). You can use catalogs to organize binders, define a binder expiration 
policy at the catalog level, and control access to binders. Vantage provides a default 
catalog named Default Catalog.

Similar in concept to file folders that organize files, Vantage catalogs organize the 
binders that are created each time a workflow is run. A catalog folder serves as a 
subfolder for a catalog or a catalog folder. Catalog folders allow you to further organize 
and group associated content together. For example, you might have a National Parks 
catalog, with a Yellowstone and a Yosemite folder. You can make as many folders as you 
need to organize your content, and you can create catalog folders in catalog folders to 
create a hierarchy.

Each catalog and catalog folder has an expiration policy that you can use to define 
when binders within that catalog or folder expire. For more information, see 
Understanding Binders.

You can use catalogs to control operator access to binders. When configuring VWP 
support (see Configuring Vantage Workflow Portal Operation), you can specify which 
operators can access a specific catalog or folder. For example, you can create catalogs 
for different organizations or departments, and then restrict operators to managing 
binders in the appropriate catalogs.
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Managing Catalogs with VMC
To start catalog management using the Vantage Management Console, open the 
Catalogs details panel as follows:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Catalogs.

Vantage displays the Catalogs details panel shown in Figure 47.

Figure 47. Catalogs Details Panel

Hover over a toolbar button to display a description for the button. Right-click in the 
Catalogs details panel (on or away from an object) to display a context menu for 
available options (see Table 22).

Table 22. Catalogs Panel Context Menu Options

Option Description

Import Folder Select to import a Windows directory of media, which is organized in 
the manner you want the catalog organized. Vantage replicates the 
directory structure, and creates a binder for each media file located in 
the folder hierarchy being imported.

New Binder Select to create a new binder in the selected folder or catalog.

New Catalog Select to create a new catalog.

New Folder Select to create a new folder in the selected catalog.
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Creating and Deleting Catalogs
You can create as many catalogs as you need to meet the needs of your organization.

To create a new catalog, do the following:

1. Click the New Catalog button  in the toolbar (or right-click in the empty catalog 
space and select New Catalog).

The Management Console displays a new catalog in the catalog tree, with the 
default text selected.

2. Type in the name of the new catalog and click away from the catalog.

To delete a catalog, do the following:

1. Select the catalog.

2. Click the Delete button  (or right-click and select Remove) to permanently delete 
the catalog.

CAUTION: Removing a catalog permanently deletes binders and Vantage store files 
as described in Understanding Binders.

Creating and Deleting Catalog Folders
Inside each catalog, you can create as many folders as you need to organize the media 
in this catalog. Folders can be created in a hierarchy, and you can drag them around to 
re-organize them.

To create a new folder, do the following:

1. Click the catalog or folder where you want to create a new folder.

2. Click the Add Folder button  in the toolbar (or right-click and select New Folder).

VMC displays a new folder in the catalog explorer panel and also in the Folders 
panel, with the default text selected. 

3. Type in the name of the new folder and click away from the folder.

Properties Select to display and configure properties (including the expiration 
time) for the selected catalog/folder. 

Refresh Click to refresh the catalog list.

Remove Select to permanently delete the selected catalog or folder.

Note: Removing a catalog/folder permanently deletes binders and 
Vantage store files as described in Understanding Binders.

Rename Select to rename the catalog/folder.

Table 22. Catalogs Panel Context Menu Options (Continued)

Option Description
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To delete a folder, do the following:

1. Select the folder.

2. Click the Delete button  in the toolbar (or right-click and select Remove) to 
permanently remove the folder.

CAUTION: Removing a catalog folder permanently deletes binders and Vantage store 
files as described in Understanding Binders.

Configuring a Catalog or Folder Expiration Policy
A catalog or folder expiration policy defines the default expiration policy for all binders 
in the catalog/folder. This policy can be overridden by a binder expiration policy as 
described in Configuring a Binder Expiration Policy.

To configure the binder expiration policy, do the following:

1. Right-click the catalog or folder you want to configure, and select Properties 
(Figure 48).

2. Edit the binder expiration date or check the Never Expire checkbox. Checking apply 
to subfolders applies the expiration date to all folder levels in the catalog.

3. You can also set catalog attributes to be fixed or transient. Checking apply to 
subfolders applies the attribute selection to all folder levels in the catalog. 

4. Click OK.

Note: The expiration policy can be set for individual binders when they are registered 
in a catalog; this is done using the workflow Register action.

Figure 48. Catalog Properties
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Viewing the Active Workflows and Actions
When monitoring Vantage or troubleshooting workflow issues, it can be helpful to see 
which workflows and actions are active and view information about those workflows 
and actions. 

The following topics describe how to use Vantage Management Console to get 
information on the active workflows and actions:

 Viewing the Active Workflows in a Domain

 Viewing Active Actions

Viewing the Active Workflows in a Domain
When you view the active workflows in the domain, you can view the following 
information about each workflow:

• Workflow name

• Type of workflow

• Category

• State

• Date and time started

• Date and time updated

• Scheduled expiration date and time

This information can help you discover the source of problems. For example, if a 
workflow was working until yesterday and you notice the workflow was updated today, 
you might want to investigate what change was made.

To view the active workflows, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Status > Active Workflows in Domain.

Vantage displays the Active Workflows in Domain details panel shown in Figure 49.
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Figure 49. The Active Workflows In Domain Panel

You can sort the workflows in ascending or descending order by clicking a column title.

Viewing Active Actions
When you view the active actions, you can view the following information about each 
action:

• Action name

• State

• Host Vantage server (machine)

• Host workflow

• Job name

• Resource cost

• Date created

• Date updated

• Description

You can view the active actions for a specific service or a specific Vantage server as 
described in the following topics:

 Viewing Active Actions for a Service

 Viewing Active Actions for a Vantage Server
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Viewing Active Actions for a Service
To view the active actions for a service, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Status > Actions By Service.

3. Select the service that hosts the actions you want to view.

Vantage displays a details panel for the service you selected, which lists all active 
actions for that service.

You can sort action entries in ascending or descending order by clicking a column label.

Note: VMC might not display action list items the first time that VMC is started after 
installation. To resolve this issue, close and restart VMC. 

Viewing Active Actions for a Vantage Server
To view the active actions for a Vantage server, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Status > Actions By Machine.

3. Select the Vantage server that hosts the actions you want to view.

Vantage displays a details panel for the Vantage server you selected, which lists all 
active actions on that server.

You can sort action entries in ascending or descending order by clicking a column label.

Note: VMC might not display action list items the first time that VMC is started after 
installation. To resolve this issue, close and restart VMC. 

Viewing Workflow and Action Analytics
Workflow and Action Analytics is a licensed optional feature that calculates and 
displays key statistics and performance data about your Vantage domain. You can use 
analytics information to identify problems and improve overall system performance.

You can use Vantage Management Console to view analytics as described in the 
following topics:

 Viewing Workflow Analytics

 Viewing Action Analytics

Note: Analytics features in Vantage Workflow Designer display information on the 
actions in a workflow. For details about how to use Workflow Analytics in the Workflow 
Designer, click the Help button  in the toolbar to display the Designer help system.
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Viewing Workflow Analytics
You can use workflow analytics to collect information that will help you improve 
Vantage workflow design and domain performance and efficiency.

In VMC, the workflow analytics feature displays columns for the workflow data listed in 
Table 23.

Table 23. Column Descriptions, Workflow Analytics Details Panel

Column Description

Workflow The name of the workflow as it was defined in Vantage 
Workflow Designer.

Total Jobs The total number of jobs (in a selected group) that have 
run using the named workflow.

Cumulative Workflow 
Processing Time

The total execution time for all jobs that used the 
workflow.

Average Completion 
Time

Total Completion Time divided by Total Jobs.

Cumulative Action 
Execution Time

The total execution time of all actions in a workflow.

Average Action Execution 
Time

Total Action Execution Time divided by the number of 
actions in the workflow.

Bottleneck Action 
Average Execution Time

The longest action execution time in the workflow.

Bottleneck Action The name of the bottleneck action. If there is no apparent 
bottleneck, no action is listed (blank).

Bottleneck Action 
Description

Description associated with the bottleneck action.
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Each analytic provides key information about your Vantage domain performance. For 
example, you can click on the Cumulative Workflow Processing Time column head to 
sort all the times in that column and quickly identify which workflows require the most 
processing time.

The bottleneck identification feature identifies the action within each workflow that 
requires the most time to process, while the Bottleneck Action Average Execution Time 
column shows how much time the bottleneck action requires. If the Bottleneck Action 
Average Execution Time value is insignificant, there is likely no issue with that action. 
However, if you identify a workflow that is consuming significant resources, knowing 
the bottleneck action for that workflow gives you an indication of where to look for 
issues.

To view workflow analytics in VMC, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Domain Workflow Analytics > Workflow Analytics.

Vantage displays a the Workflow Analytics details panel shown in Figure 50.

Figure 50. Workflow Analytics Details Panel

You can sort all entries in ascending or descending order by clicking a column label.

You can right-click on any workflow and select Open Workflow to launch (or display, if 
already running) Workflow Designer and display the selected workflow. 

Note: If Workflow Designer is already running and is hidden behind another window 
when a workflow is requested, the Windows task bar button will flash, indicating that 
the Workflow Designer has something new to display.
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The set of workflows to be analyzed can be selected by checking the Only analyze jobs 
checkbox, checking other checkboxes that apply, and changing dates and times. 
Table 24 describes the options that you can use to filter the list of displayed workflows.

Figure 51. Workflow Analytics Selection Panel

Table 24. Workflow Analytics Configuration Options

Option Description

Only analyze jobs Enables filtering of the job list based on the other options 
specified.

Newer than and 
Older than

Workflows within a range of dates and times can be selected by 
checking Newer than and Older than checkboxes and setting the 
dates and times accordingly.

That ran between Workflows between a beginning and end time can be selected by 
checking the That ran between checkbox and setting the times.

That ran after the 
last workflow 
layout change

Check the That ran after the last workflow layout change check box 
to select all workflows that ran after the last workflow layout 
change.

Whose state is Check any combination of the four provided state checkboxes to 
select a set of workflows. (See the Vantage Workflow Designer User 
Guide for the definitions of these states).
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Viewing Action Analytics
Action analytics displays the average execution time for each action in every workflow. 
The workflow analytics show the average execution time for all actions in a workflow 
and the bottleneck action execution time. Use workflow analytics to discover a 
workflow and bottleneck action that require a closer look; use the action analytics to 
display analytics for the other actions in workflows.

To view action analytics in VMC, do the following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Domain Workflow Analytics > Action Analytics.

Vantage displays a the Action Analytics details panel shown in Figure 52.

Figure 52. Action Analytics Details Panel

Table 25 describes the data and controls in the Action Analytics details panel.
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Table 25. Action Analytics Buttons and Configuration Options

Button or Option Description

Workflow Designer 
button

Click the Workflow Designer button to open the 
Workflow Designer.

Note: If Workflow Designer is already open and 
positioned behind the VMC window, VMC remains in 
front of the Workflow Designer window and the 
Workflow Designer button flashes in the task bar. Click 
the Workflow Designer button in the task bar to display 
the Workflow Designer window in front of the VMC 
window.

Refresh button Click the Refresh button to update the list of actions.

Action Name This column displays all of the actions in the workflows.

Action Description This column displays the descriptions that are associated 
with each action.

Average Execution Time This is the average execution time of the named action 
for all workflows.

Workflow The name of the workflow that contains the named 
action.

The set of workflows to be analyzed can be selected by 
checking the Only analyze jobs checkbox, checking other 
checkboxes that apply, and changing dates and times.

Newer than and Older 
than

Workflows within a range of dates and times can be 
selected by checking Newer than and Older than 
checkboxes and setting the dates and times accordingly.

That ran between Workflows between a beginning and end time can be 
selected by checking the That ran between checkbox and 
setting the times.

That ran after the last 
workflow layout change

Check the That ran after the last workflow layout change 
check box to select all workflows that ran after the last 
workflow layout change.
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Creating Report Formats
Report formats (optional) define which data Vantage exports when a workflow 
designer uses Vantage Workflow Designer to export data. In the current release, 
Vantage supports custom report formats for exporting job data as described in 
Creating Job Report Formats.

Creating Job Report Formats
Job report formats define which job status and metadata label data is exported when 
workflow designers generate reports using Vantage Workflow Designer. Exported data 
is saved to files using the comma separated value (CSV) format, which can be read by 
many programs, including word processor and spreadsheet programs. The following 
topics describe how to view and manage job report formats:

 Managing Job Reports with VMC

 Creating a New Job Report Format

 Including and Excluding the Header Row

 Choosing the Report Format Columns

 Duplicating a Job Report Format

 Deleting a Job Report Format

 Refreshing the Format List

 Exporting and Importing Job Report Formats
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Managing Job Reports with VMC
To view and manage job reports using the Vantage Management Console, do the 
following:

1. Start VMC as described in Starting the Vantage Management Console.

2. In the components panel, select Report Configurations > Job Reports.

Vantage displays the Job Reports details panel shown in Figure 53.

Figure 53. Job Reports Details Panel
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Creating a New Job Report Format
You can create job report formats in VMC and in Workflow Designer.

To create a new report format in VMC, do the following:

1. Display the Job Reports details panel (Figure 53).

2. Click the Create button , (or right-click the empty area of the Job Reports panel 
and select New Configuration).

VMC adds a new report format to the list.

3. Select the new report format in the list.

4. Enter a new name in the Name text box.

5. If you want, enter a report format description in the Description text box (the 
description is optional).

6. Click the Save button .

Including and Excluding the Header Row
To include or exclude a header row in the report format, do the following:

1. Display the Job Reports details panel (Figure 53).

2. Select the report format to modify.

3. Check the Add Header Row check box to include the header row, or clear the 
checkbox to exclude the header row.

4. Click the Save button .

Choosing the Report Format Columns
You can configure report formats to include or exclude the following columns:

• Job ID

• Job Name

• State

• Progress

• Started

• Updated

• Expires

• Workflow Name

• Additional columns for metadata label parameters

When you choose to display a column for a metadata label, the column displays the 
label value.
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To define which columns appear in a report, do the following:

1. Display the Job Reports details panel.

2. Select the report format to modify.

3. In the Columns row (see Figure 53), check (display) or clear (hide) the checkboxes 
for the columns you want to display.

4. To add or delete columns for metadata labels, do the following:

a. Click the Column button .
b. In the Labels pane, select a label for which you want to display parameters.
c. In the Parameters pane, check the checkbox for any parameter you want to 

display, and clear the checkbox for any parameter you do not want to display.
d. To toggle the display to include or exclude category names, click the Categorize 

button . One display state displays parameters with the category headings, 
and the other display state displays parameters without the category headings.

e. Repeat parameter label selection until all labels are properly selected.
f. Click OK.

5. To change the displayed order of parameter labels, select a label in the list (Ctrl-click 
or Shift-click to select multiple labels) and use the green up  and down arrow  
buttons to move the label in the list.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other label columns. The last item in the list becomes 
the last column on the right.

6. Click the Save button .

Duplicating a Job Report Format
When you duplicate a job report format, a new format is created with a modified name. 
All other configuration settings in the duplicate format match those in the original 
format.

To duplicate a job report format, do the following:

1. Display the Job Reports details view.

2. Select the report format to duplicate. (Ctrl-click or Shift-click to select multiple 
formats.)

Note: You duplicate one report at a time.

3. Click the Duplicate button , (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate format.

5. In the Description text box, enter a description for the duplicate format.

6. Click the Save button .
Vantage Domain Management Guide



Supporting Workflow Design and Operation
Creating Report Formats

265
Deleting a Job Report Format
To delete a job report format, do the following:

1. Display the Job Reports details view.

2. Select the format or formats to delete. (Ctrl-click or Shift-click to select multiple 
formats.)

3. Click the Delete button , (or right-click and select Delete).

4. When the confirmation dialog appears, click OK.

Refreshing the Format List
When you open the Job Reports detail panel, VMC displays the current list of job report 
formats. If another administrator adds or changes formats, you must refresh the display 
to see those changes. To refresh the display, click the Refresh button .

Exporting and Importing Job Report Formats
Vantage allows you to export report formats to XML files, which you can then use to 
import the same reports into another Vantage domain.

To export one or all job report formats, do the following:

1. If you are exporting a single format, select the format to export.

2. Click the Export button  to export a single format, or select Export all from the 
Export button drop down menu. You can also right-click and select Export.

3. Use the file system dialog to save the exported formats.

The default file name is the format name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the report 
format in the XML file.

To import a report format, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the format file to import, then click 
Open.

Note: If you try to import a report format that is already in this Vantage domain, 
Vantage prompts you to cancel or confirm replacement.
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Configuring Job
Status Views

Operation

Job Status Views is a Web application that provides operators and managers with job 
status information that focuses on jobs, rather than the comprehensive system point of 
view offered by Web Dashboard. Using VMC, you can configure views, which define 
what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows. 
You can create additional views that represent a single workflow, and those views can 
be configured as public or private. Public views are available to all Vantage users, and 
private views are available only to approved users.

Note: For a comprehensive overview of the Job Status Views Web application 
program, see the Vantage User’s Guide.

The following topics provide information on view configuration tasks:

 Displaying the View Configuration Panel

 Enabling and Disabling the All Workflows View

 Creating a New View

 Renaming a View

 Duplicating a View

 Deleting a View

 Selecting and Changing the Workflow for a View

 Displaying All Jobs or All Jobs in Process

 Enabling Stop, Restart, and Delete

 Choosing the Display Columns

 Configuring User or Public Access

 Refreshing the View List

 Exporting and Importing Views
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Displaying the View Configuration Panel
To view the view configuration window, open Application Configurations in the 
component panel and select Job Status Views. VMC displays the Job Status Views detail 
panel shown in Figure 54.

Figure 54. The Job Status View Configuration Window

Enabling and Disabling the All Workflows View
When you enable the All Workflows view, any Vantage user with access to this view sees 
information on all workflows in the domain. When this view is disabled, no user can 
view information on all workflows.

To enable or disable the All Workflows view, do the following:

1. Display the Job Status Views details view.

2. Select the All Workflows view.

3. Check (enable) or clear (disable) the Enable checkbox.

4. Click the Save button .
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Creating a New View
To create a new view, do the following:

1. Display the Job Status Views details view.

2. Click the Create Configuration button  (or right-click in the empty workflow lists 
space and select New Configuration).

3. When the Select Workflow dialog appears, select a workflow for the view and click 
OK.

4. If you want, enter a description of the view in the Description text box (this is 
optional).

5. Click the Save button .

Renaming a View
To rename a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to rename.

Note: You cannot rename the All Workflows view.

3. In the Name text box, enter a new name for the view.

4. Click the Save button .

Duplicating a View
To duplicate a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to duplicate.

Note: You cannot duplicate the All Workflows view.

3. Click the Duplicate button  (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate view.

5. In the Description text box, enter a description for the duplicate view.

6. Click the Save button .
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Deleting a View
To delete a view, do the following:

1. Display the Job Status Views details view. 

2. Select the view to delete. (Ctrl-click or Shift-click to select multiple parameters.)

Note: You cannot delete the All Workflows view.

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog appears, click OK.

Selecting and Changing the Workflow for a View
To change the workflow for a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

Note: You cannot change the workflow displayed in the All Workflows view.

3. Click the Workflow Select button.

4. When the Select Workflow dialog appears, select a workflow for the view and click 
OK.

5. Click the Save button .

Displaying All Jobs or All Jobs in Process
You can configure each view to display all jobs or only the jobs that are currently in 
process. When configured to display only in process jobs, jobs that are in any other state 
(completed, failed, stopped by user, etc.) do not display. Some people might prefer to 
view all jobs, while others prefer to view the shorter list of in process jobs.

To configure the scope of jobs for a view, do the following:

1. Display the Job Status Views details view.

2. To display in process jobs only, check the Show Only “In Process” Jobs checkbox.

3. To display all jobs, clear the Show Only “In Process” Jobs checkbox.

4. Click the Save button .
Vantage Domain Management Guide



Configuring Job Status Views Operation
Enabling Stop, Restart, and Delete

271
Enabling Stop, Restart, and Delete
You can configure each view to permit operators to use Job Status Views to control jobs 
with the Stop, Restart, and Delete functions or restrict access to those functions. 

To enable or disable Stop, Restart, and Delete for jobs in a view, do the following:

1. Display the Job Status Views details view.

2. Check Options checkboxes as preferred to enable (checked) or disable (unchecked) 
Allow Stop, Allow Restart, and Allow Delete.

3. Click the Save button .

Choosing the Display Columns
Every view displays the Job and State columns. You can configure views for individual 
workflows to include or exclude the following columns:

• Total Progress

• Started

• Updated

• Expires

• Additional columns for workflow actions

When you choose to display a column for a workflow action, the column displays the 
state of that action. This can help you use Job Status Views to view the state of actions 
during workflow processing.

To define which columns appear in a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

3. In the Columns row, check (display) or clear (hide) the checkboxes for the columns 
you want to display.

Figure 55. Single Workflow Configuration

Description
Select
Options
Columns

Selected Workflow

Actions
Permitted Users
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4. If you are modifying a view for a single workflow, you can add or delete columns for 
actions as follows:

a. Select the Actions tab.
b. In the Available pane, select the actions you want to display in the view, and click 

Add.
c. In the Visible to user pane, select the actions you want to hide, and click Remove.
d. To change the display order in the view, select an Action in the Visible to user 

pane (Ctrl-click or Shift-click to select multiple actions), and use the green up  
and down arrow  buttons to arrange the viewing order.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other action columns. The last item in the list 
becomes the last column on the right.

5. Click the Save button .
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Configuring User or Public Access
You can configure a view to be available to individual users or all users (public).

Note: Users with administrative privileges will have full access whether or not they 
are given permission.

To define which Vantage users can access a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

3. Select the Permitted Users tab.

Note: The Permitted Users tab is available only if you select Enable User 
Administration in VMC Settings & Options.

Figure 56. All Workflows Configuration

4. To make the view available to all Vantage users, do the following:

a. Check the Everyone (Public View) check box.
b. Click the Save button .

5. To make the view available to select Vantage users, do the following:

a. Clear the Everyone (Public View) check box.
b. In the Available pane, select the users who should have access, and click Add.
c. In the Visible to user pane, select the users who should not have access, and click 

Remove.
d. Click the Save button .

Default description

Enable
Options
Columns
Permitted Users
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Refreshing the View List
When you open the Job Status Views detail panel, VMC displays the current view 
configuration. If another administrator is making changes (such as adding Vantage 
users), you must refresh the display to see those changes. To refresh the display, click 
the Refresh button .

Exporting and Importing Views
Vantage allows you to export views to XML files, which you can then use to import the 
same views into another Vantage domain.

To export views, do the following:

1. Select the view to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected views (or right-click and select Export, 
or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported views.

The default file name is the view name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the view in 
the XML file.

To import views, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the view file to import, then click 
Open.

Note: If you try to import a view that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Use this chapter to learn how to set up and configure Vantage Workflow Portal (VWP) 
configurations that control how VWP operators use VWP. This chapter includes the 
following topics:

 Introduction to Vantage Workflow Portal

 VWP Licensing

 Introduction to VWP Configurations

 Managing VWP Configurations

 VWP Deployment Tips

 Vantage Workflow Portal Tours

Introduction to Vantage Workflow Portal
Vantage includes two VWP applications, a Windows client and a Web client, that allow 
operators to do some or all of the following:

• View binder information created by a workflow

• View proxy media generated by a workflow

• View metadata provided by the source media or generated by a workflow

• View variables generated by a workflow

• Make changes to metadata labels and variables in preparation for submission to a 
target workflow

• Submit media to a target workflow for processing

With proper configuration, VWP allows operators to perform tasks such as:

• Review and approve workflow output prior to production

• Enter and review metadata for controlling multi-channel distribution in a target 
workflow

• Forward media to specific distribution channels or audience targets

• Extract sub-clips from media
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• Assemble (stitch) multiple assets into a single output file

• Automate tag & bag editing for promo and highlights production

Note: For more information on Vantage Workflow Portal, see the Vantage User’s Guide.

VWP Licensing
Each Vantage Workflow Portal license supports a single user or a single machine, 
depending on your Vantage configuration. Under certain conditions, a single user or 
machine can host multiple instances of a license, and these instances are called 
sessions. When a license is in use by a user or a machine, it is unavailable to other users 
or machines. To support multiple users or machines, you must purchase additional 
licenses. The following topics provide additional information on VWP licensing:

 User-Based Licensing

 Machine-Based Licensing

 Viewing and Resetting VWP Sessions

Note: For information on VWP license management, see Managing Licenses.

User-Based Licensing
When Vantage user administration is enabled (see Managing Vantage Users), each 
Vantage operator reserves a single VWP license when starting the program. That 
operator can open additional VWP sessions on other machines without reserving 
additional licenses, provided that the operator uses the same username on all 
machines. However, no other user can use the reserved license until the first operator 
closes all VWP sessions that use the first operator’s username.

Machine-Based Licensing
When Vantage user administration is disabled (see Managing Vantage Users), a Vantage 
operator reserves a single VWP license when starting the program on a machine. That 
operator or other operators can open additional VWP sessions on the same machine 
without reserving additional licenses. However, no other machine can use that license 
until all Workflow sessions are closed on the first machine.
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Viewing and Resetting VWP Sessions
When a license is in use by a user or a machine, it becomes unavailable to other users or 
machines. If all licenses are in use and another license is needed, you might need to do 
one or more of the following:

• Reset all sessions for a license that is now idle due to a lost network connection or 
sudden program termination.

• Reset all license sessions for a lower priority user or machine to make a license avail-
able for a higher priority user or machine.

• Buy more licenses.

To view the VWP license and session usage, select Licenses in the components panel, 
and click on the Portal Sessions tab. The Management Console displays the Portal 
Sessions details panel (Figure 57).

Figure 57. The Licenses details License Sessions Panel

The Portal Sessions list displays a row for each portal session in use. When user 
administration is enabled (see Managing Vantage Users), a single Vantage user can 
open multiple VWP sessions, and each session is represented by a row in the session 
list. When user administration is disabled, a single machine can host multiple VWP 
sessions, and each session is represented by a row in the session list. 

When user administration is enabled, the User column displays the username of the 
operator using a license session. When user administration is disabled, the Machine 
column displays the computer name of the machine that is using a license session.

The Status column displays Licensed when the session is using a valid license, and it 
displays Demo when the session is unlicensed and open in demo mode.

To reset a license session for a user or machine, select the session and click the Stop  
button. 
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Introduction to VWP Configurations
As a Vantage domain administrator, you can create and configure VWP configurations, 
which control which VWP features an operator can use. While VWP operators do have 
some control over the application display, most features are controlled by the Vantage 
domain administrator using VMC.

Vantage administrators must create and configure at least one VWP configuration 
before operators can access binders using VWP.

When a workflow requires operator involvement, workflow support requires some or all 
of the following tasks:

• Preparation of an ingest workflow, which can analyze source media and produce 
media for evaluation. The ingest workflow is optional for some applications.

• Preparation of at least one VWP configuration, which enables and supports the 
tasks you want operators to do when working with workflows.

• Installation of VWP to test VWP configurations.

• Preparation of a target workflow to process the media submitted by operators.

VWP installation is described in Installing the Upload Portal. For guidelines on creating 
workflows for use with VWP, see the “Using Workflow Portal” topic in the Vantage User’s 
Guide.
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Managing VWP Configurations
Note: If you are creating a store to hold proxy files viewed in the VWP, Telestream 
recommends that you reference the store with a UNC path. Some SAN clients do not 
allow frame-accurate representation of proxies when using shared drives.

The following topics describe configuration tasks for VWP configurations:

 Creating and Editing VWP Configurations

 Selecting a Configuration Mode

 Specifying Catalog Access for a Configuration

 Hiding and Displaying the Media List (Nicknames)

 Managing Asset Requirements for Ingest Workflows

 Enabling and Disabling Binder Deletions

 Enabling and Disabling Binder Filtering

 Defining the Controls and Display Items in Binder View

 Managing Metadata Label Configuration Options for Operators

 Managing Variable Configuration Options for Operators

 Controlling Operator Workflow Forwarding

 Defining EDL Storage

 Managing User Access to VWP Configurations

 Deleting a Configuration

 Saving a Configuration

 Duplicating a Configuration

 Exporting and Importing Configurations

 Refreshing the Configuration List
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Creating and Editing VWP Configurations
To create or edit a VWP configuration, do the following:

1. Start the Vantage Management Console and connect to the appropriate Vantage 
domain.

2. Select Application Configurations > Workflow Portal. 

As shown in Figure 58, the Workflow Portal pane displays the options for VWP con-
figurations.

Figure 58. The Workflow Portal Configuration Pane

3. To create a new configuration, click the Create configuration button  in the tool 
bar (or right-click in the empty configuration list space and select New 
Configuration) and name the new configuration.

4. To make changes to an existing configuration, select the configuration in the 
Configuration list.

5. If you have created a new configuration, or if you have made changes to an existing 
configuration, click the Save button  to save your changes.
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Selecting a Configuration Mode
Workflow Portal Configurations can be enabled for four modes that appear just below 
the Name and Description:

 Browse Catalogs (Copy Binder) Mode

 Browse Catalogs (Forward Binder) Mode

 Browse Windows Network (Create Binder) Mode

 Create EDLs from Catalogs (Create Binder) Mode

These modes allow operators to access functions related to the kind of workflow 
processing they need to do—manually forwarding files to workflows or responding to 
ingest workflows. 

Choosing a Mode: Forwarding Files or Responding to Ingest
As can be seen in the mode descriptions that follow, one mode allows operators to 
forward files to workflows, and three others allow responding to ingest. When 
operators must manually forward files to workflows, consider assigning them to the 
Browse Windows Network mode. This mode allows multiple files to be submitted 
simultaneously. Each submitted file becomes a separate job with its own binder. During 
submission, the operator can add metadata labels (as permitted by the VWP 
configuration). For a batch submission (of multiple media files), each media file receives 
a copy of the same metadata label in its binder.

The Browse Windows Network (Create Binder) Mode mode is appropriate when:

• Operators manually submit files, rather than copy those files to a hot folder.

• No ingest workflow is required before operator involvement.

In other situations, operators need to evaluate ingest workflows and take actions:

• To forward media to a target workflow for further processing and distribution

• To quarantine media that does not meet specifications

• To edit metadata and then forward it to a target workflow

Configurations that support the evaluation of ingest workflows are the catalog-based 
configurations. Catalog-based configurations present jobs to operators based on the 
catalog to which the binder is assigned. In a simple configuration, all workflows assign 
binders to the same catalog, and operators can view all binders. Workflows in a more 
complex configuration might assign binders to different catalogs, and operators might 
be permitted to view only the binders for which they are responsible.

Each of the four modes is described on the following pages, concluding with a 
discussion of Catalog Mode Considerations, which applies to the three catalog modes.
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Browse Catalogs (Copy Binder) Mode
This configuration mode enables an operator to browse the selected Vantage catalog 
for binders. They can then select one binder, and submit it to one or more workflows. 
When the submission occurs, the original binder is copied, and the copy is submitted to 
the workflow—the original binder remains in the catalog and remains unchanged.

Note: A binder contains metadata labels, and references to media files and 
attachments. When a binder is copied, the metadata labels are also copied and thus 
may be different from the original. Any media files or attachments in the original 
binder are not copied, and are referenced by both the original and the new copy.

The Browse Catalogs configuration mode is ideal when:

1. You want the original binder to remain in the catalog

2. You do not want to change the original binder's metadata

3. The original media files are not affected by the target workflow, and

4. You want operators to be able to submit the same asset multiple times.

Target Workflow Considerations

The target workflow must include a Receive action. Remember that any media files or 
attachments present in the original binder will also be referenced in the copy. As a 
result, the target workflow should not delete any of those original files; the original 
binder would then have missing files.

Example Workflows
• Operator marks an in point, and an out point for a highlight; multiple highlights can 

be extracted from the same input.

• Operator marks trim points around a promo from a captured satellite feed, and 
marks a branding entry point on the timeline; the target workflow then trims the 
promo and applies graphics for multiple distribution channels.
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Browse Catalogs (Forward Binder) Mode
This configuration mode enables an operator to browse the selected Vantage catalog 
for binders. The operator can select a binder, and either edit its metadata, or submit it 
to one or more workflows. When the submission occurs, the original binder is 
forwarded to the workflow (and optionally removed from the catalog, if configured that 
way by the administrator).

Note: Because the binder is directly affected by the target workflow, if the binder 
remains in the catalog, any changes to the binder will appear in the catalog as the 
workflow processes media files.

The Browse Catalogs (Forward Binder) configuration mode is ideal when:

• You want to use the catalog as a task list for the operator, automatically removing 
binders from the catalog when they are forwarded

• You want the workflows to update binders that remain in-place in the catalog

• You want operators to edit metadata in-place.

Target Workflow Considerations

The target workflow must include a Receive action. Remember that if the binder is not 
removed from the catalog, any changes made by the target workflow will be apparent 
in the catalog.

Example Workflows
• Operator reviews an asset, marks it as approved/rejected, and forwards to a work-

flow that responds to that metadata. The asset is removed from the catalog.

• An ingest workflow detects quality issues and places an asset in a catalog for 
review. An operator reviews the asset, using a proxy to review the video at error 
timecodes published by the ingest workflow. If the asset is unacceptable, the oper-
ator forwards to a workflow for quarantine; otherwise the operator forwards to the 
appropriate next step for the asset.

• Operator edits asset metadata in-place in the catalog. When the asset is ready for 
distribution, the operator chooses distribution channels and forwards to the target 
workflow. The target workflow responds to the operator choices and forwards for 
distribution.

• Operator reviews black segments detected by Vantage, and confirms black removal 
points. The target workflow uses those timecode parameters to remove black from 
the original media.
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Browse Windows Network (Create Binder) Mode
If a project requires operators to browse network locations to locate files to submit to 
workflows, they will need the Browse Windows Network mode. As discussed previously, 
this mode allows multiple files to be submitted simultaneously. Each submitted file 
becomes a separate job with its own binder. During submission, the operator can add 
metadata labels (as permitted by the VWP configuration). For a batch submission (of 
multiple media files), each media file receives a copy of the same metadata label in its 
binder.

The Browse Windows Network (Create Binder) configuration mode is appropriate 
when:

• You expect operators to manually search for and submit files, rather than copy 
those files to a hot folder.

• No ingest workflow is required before operator involvement.

To select the Browse Windows Network configuration mode, do the following:

1. Display the Workflow Portal configuration pane as described in Creating and Editing 
VWP Configurations.

2. Click the Browse Windows Network (Create Binder) radio button.

3. Click the Save button  to save your changes.

Media files are submitted directly, so there is no ingest workflow. However, operators 
should ensure that any media files submitted are in locations that are accessible to the 
Vantage services. For example, files on a local drive (for example, 
C:\media\myvideo.mpg) are not accessible to a remote Vantage server.

The target workflow must include a Receive action. Each media file is assigned the 
nickname Original when it is submitted.
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Create EDLs from Catalogs (Create Binder) Mode
This configuration mode changes VWP operation to include a tab that enables an 
operator to stitch assets using an EDL (edit decision list). An operator can use the EDL to 
stitch multiple assets in the catalog together or to trim a clip. 

The EDL is stored in a .tsedl file, which can be stored with other media files in a Vantage 
store or folder, or it can be stored in a special Vantage store or folder, designated for 
EDL files. (For more information, see Defining EDL Storage.)

After an operator has created an EDL, the operator can forward that EDL to a target 
workflow to create the output defined by the EDL. To support EDL processing, you must 
modify the configuration to support forwarding to a workflow that contains a Receive 
action. (For more information, see Controlling Operator Workflow Forwarding.)

Note: The Microsoft User Account Control (UAC) feature denies access to the default 
Vantage store for submitted EDLs. If Vantage users report that access to the Vantage 
store is denied, do one of the following: 1) reconfigure the default store to specify a 
UNC path or a directory that is not protected by UAC, 2) specify a different store for 
EDLs as described in Defining EDL Storage, or 3) disable UAC on the Vantage server that 
hosts the default store.

The following topics provide additional information on supporting EDL creation in 
VWP:

 Target Workflow Considerations

 Example Workflows

Target Workflow Considerations

The target workflow must include a Receive action. It will receive a .tsedl file with the 
nickname Original and can then transcode—or direct convert—this list into an output 
file (or multiple output files). 

Note: If MPEG-2 is the EDL source format, a Direct Convert mode can be used to avoid 
a full transcode. Any timeline cut that breaks GOP structures is replaced with I-Frame 
material, otherwise original GOPs are preserved. If the output file is not MPEG-2, a full 
transcode can be performed. In either case, the VANC, captions, and audio are 
correctly stitched during the processing of the EDL.

Example Workflows
• Operator creates a list of syndication segments that are stitched together into a sin-

gle program.

• Operator selects a bumper, a clip, and a trailer, enters metadata, chooses distribu-
tion channels, and submits the package for distribution. The target Vantage work-
flow uses distribution channel choices and metadata to generate the correct 
formats and deploy to the chosen distribution channels.
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Catalog Mode Considerations
In order for assets to appear in a Vantage catalog, they must be registered as part of an 
ingest workflow. A thumbnail should also be added to the binder and given the 
nickname Vantage Thumbnail; a QuickTime H.264 MOV proxy can also be added and 
given the nickname Vantage Proxy.

Note: If you are using the Safari 5 browser, the Silverlight viewer in the VWP Web 
application is supported only on Mac OS X. For more information on supported 
browsers, see Vantage Web Applications Browser Requirements.

For Create EDL from Catalogs mode, EDL processing requires Program Stream or 
Transport Stream MPEG-2 video, and such a file should be provided in the binder with 
the nickname Vantage EDL. Vantage provides support for MXF DV, IMX, and XDCAM HD 
video formats as well.

Note: All assets in the EDL list must have the same frame size and frame rate; 
operators are not allowed to combine mixed media.

Specifying Catalog Access for a Configuration
For catalog-based configurations, Vantage allows you to specify how operators access 
those catalogs and the binders they contain, as described in the following topics:

 Enabling and Disabling Operator Access to Catalogs

 Hiding and Displaying the Operator Catalog List

Enabling and Disabling Operator Access to Catalogs
The Browse Catalogs configurations and the Create EDL from Catalogs configuration 
support catalog access control on a per-configuration basis. When you configure a VWP 
configuration, any users who have access to the configuration have access to any 
catalogs supported by that configuration and to the binders the catalogs contain.

The default setting for each catalog-based configuration enables access to all catalogs 
for all users who have access to the configuration. To limit access to one or more 
catalogs, you add the catalogs to the Visible to user list as described in the procedure 
below. When the list is empty, all catalogs are available to all permitted users. Once a 
catalog name is added to the Visible to user list, the permitted users can view and access 
only catalogs in the list, and all other catalogs are hidden for that configuration.

Note: Vantage provides one catalog named Default Catalog. If you use only the 
Default Catalog, you can add that catalog to the Visible to user list to prevent future 
catalogs from automatically becoming available to configuration users, or you can 
leave the Visible to user list empty to enable automatic access to future catalogs for all 
configuration users. For instructions on creating catalogs, see Managing Catalogs.
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To enable or disable operator access to a catalog, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab (see Figure 59).

3. To add a catalog to the list of available catalogs, select the catalog in the Available 
list and click Add.

4. To remove a catalog from the list of available catalogs, select the catalog in the 
Visible to user list and click Remove.

5. Click the Save button  to save your changes.

Figure 59. Workflow Portal Details Panel, Showing Browse Catalogs Tab
Vantage Domain Management Guide



Configuring Vantage Workflow Portal Operation
Managing VWP Configurations

288
Hiding and Displaying the Operator Catalog List
If your domain uses only one catalog, you can simplify the VWP operator interface by 
hiding the list of catalogs, which is also called the catalogs browser. If operators need 
access to multiple catalogs using a single VWP configuration, you should display the 
catalogs browser so that operators can select a catalog to work with.

The design and choice of catalogs has an impact on how easily operators can perform 
their tasks. For example:

• In Forward mode, bear in mind that the configuration can be set to automatically 
remove the binder from the catalog when it is forwarded. When using this mode, 
the catalog can serve as a task list for operators to work from.

• In Copy mode, the binders are not removed from the catalog by the operators. As a 
result, you might want to set appropriate expiration times on the catalogs.

• In all cases, you can use folders to structure how operators see assets. For example, 
bumpers assets may be kept in a Bumpers folder, separate from Primary Assets, in a 
Primary Assets folder.

• You might have multiple ingest workflows all providing binders to a target catalog.

To hide or display the catalogs browser, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the catalogs browser, clear the Show Catalogs browser checkbox (see 
Figure 59).

4. To display the catalogs browser, check the Show Catalogs browser checkbox.

5. Click the Save button  to save your changes.

Hiding and Displaying the Media List (Nicknames)
The media list displays the media files for a binder/job that you select in the binder list. 
For example, the media list might include the original media submitted to a workflow 
and the output media from that workflow. When the media list is visible, operators can 
play the media or view the contents of the folder that contains the media.

To hide or display the media list, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the media list, clear the Show media nickname list checkbox (see Figure 59).

4. To display the media list, check the Show media nickname list checkbox.

5. Click the Save button  to save your changes.
Vantage Domain Management Guide



Configuring Vantage Workflow Portal Operation
Managing VWP Configurations

289
Managing Asset Requirements for Ingest Workflows
When you create a catalog-based configuration, Vantage allows you to define whether 
or not media files, labels, and attachments referenced in the target workflow are 
required in the ingest workflow. If you require these assets, Vantage does not process 
ingest workflows that are missing these items. If you do not require these assets, 
Vantage does not check the ingest workflow for the assets and attempts to process the 
ingest workflow.

Note: A target workflow can fail if required assets are not provided by the ingest 
workflow.

To configure asset requirements for ingest workflows, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To require assets in the ingest workflow, check the Require all expected nicknames 
checkbox (see Figure 59).

4. To make reference assets optional, clear the Require all expected nicknames 
checkbox.

5. Click the Save button  to save your changes.

Enabling and Disabling Binder Deletions
When configuring a VWP catalog-based configuration, you can enable or disable the 
manual binder deletion by operators. For Browse Catalogs (forward binder) mode, you 
also have the option to enable or disable the automatic deletion of binders. The 
following topics provide more information on binder deletion:

 Configuring Operator Binder Deletions

 Configuring Automatic Binder Deletions

Note: Vantage provides several levels of control over binder deletion. For more 
information, see Understanding Binders.

Configuring Operator Binder Deletions
In the Browse Catalogs and Create EDL from Catalogs modes, you can enable or disable 
manual deletion of binders by checking the Allow Binder Delete check box. When 
enabled, this feature allows operators to remove binders from the catalog after the 
associated jobs are complete, leaving only binders that have not yet been processed. 
This effectively makes the catalog a manually-managed task list that operators can 
control at their discretion. 

If you prefer to save binders and do not want operators to delete them, uncheck the 
Allow Binder Delete check box. 
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Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action.

To enable or disable operator binder deletions, do the following:

1. Select the Workflow Portal Configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder deletions, check the Allow Binder Delete checkbox (see Figure 59).

4. To disable binder deletions, clear the Allow Binder Delete checkbox.

5. Click the Save button  to save your changes.

Configuring Automatic Binder Deletions
In Browse Catalogs (forward binder) mode, you can enable or disable the automatic 
deletion of binders. When automatic binder deletion is enabled, the binder from the 
source workflow is deleted when the operator forwards a job to a target workflow. This 
effectively makes the binders in a catalog an automatically managed task list that 
removes each binder after the operator takes action on it.

Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action.

To enable or disable automatic binder deletions, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable automatic binder deletions, check the Auto Delete Binder checkbox (see 
Figure 59).

4. To disable automatic binder deletions, clear the Auto Delete Binder checkbox.

5. Click the Save button  to save your changes.
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Enabling and Disabling Binder Filtering
You can use the binder filtering feature to enable or disable operator control of the 
binder contents that are submitted to a workflow with VWP. When binder filtering is 
enabled, the VWP Submit Jobs dialog displays the Media Files and Attachment tabs 
shown in Figure 60.

Figure 60. VWP Submit Jobs Dialog, Showing Binder Filters

The Media Files and Attachments tabs list all media and attachments associated with 
the job. VWP operators can use the controls on these tabs to filter (not submit) select 
assets and change nicknames. If you disable this feature, neither tab is visible to the 
operator, and each submission includes all binder assets.

To enable or disable binder filtering, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder filtering, check the Allow Binder Filtering checkbox (see Figure 59).

4. To disable binder filtering, clear the Allow Binder Filtering checkbox.

5. Click the Save button  to save your changes.
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Defining the Controls and Display Items in Binder View
Vantage allows you to control what Operators see in the VWP binder list. The standard 
features that you can display for each binder are:

• Binder name

• Binder creation date

• Binder expiration date

• Play button

• Submit button

You can also display parameters for any of the metadata label parameters that are 
defined in the domain.

Note: Vantage allows you to hide all columns and controls in the binder list, which 
means that no items appear in the binder list. At least one display or control item 
should be configured to display so that binders appear in the binder list.

The following topics describe how to configure what appears in the binder list:

 Defining the Standard Feature Settings

 Adding and Deleting Columns for Metadata Parameters

Defining the Standard Feature Settings
To enable or disable the standard binder display components, do the following:

1. Select the configuration to change.

2. Select the Binder Details View tab shown in Figure 61.

Figure 61. Binder Details View
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3. Check each feature checkbox to display the information or control, or clear the 
checkbox to hide the feature. The following are standard features:

– Binder name. Displays the name assigned to the binder when it was created.

– Created. Displays the date and time the binder was created.

– Expiration. Displays the date and time the binder expires.

– Play button. Displays a button that the operator can use to play or pause the 
selected job.

– Submit button. Displays a button that the operator can use to submit a job to 
another workflow.

Note: The play button operates only when the workflow has generated and 
registered a proxy file (see the Using Workflow Portal topic in the Vantage User’s 
Guide). The Submit button appears only when target workflows are selected on the 
Forward to Workflows tab.

4. Click the Save button  to save your changes.

Adding and Deleting Columns for Metadata Parameters
To add or delete metadata parameter columns for the binder list, do the following:

1. Select the configuration to change.

2. Select the Binder Details View tab (see Figure 61).

3. Click the Column button .

4. Do the following for each metadata label parameter for which you want to display a 
column:

a. Select a metadata label in the Labels pane.
b. In the Parameters pane, check the checkbox for the metadata label parameter 

you want to display.
c. When you are done making changes, click OK.

5. For each metadata label parameter column that you want to remove from the 
binder view, do the following:

a. Select the parameter in the parameter list.
b. Click the Delete button  to delete a parameter from the parameter list, and 

then confirm the delete.

6. To change the displayed order of parameters, select a parameter in the parameter 
list (Ctrl-click or Shift-click to select multiple parameters) and use the green up  
and down arrow  buttons to move the variable in the list.

7. Click the Save button  to save your changes.
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Managing Metadata Label Configuration Options for Operators
Vantage allows operators to view and set metadata labels when they submit jobs to a 
workflow. These labels can be used by the workflow to customize job processing.

Note: For an introduction to metadata labels, see Understanding Metadata Labels. 

When an operator views metadata labels in VWP, the labels that appear in the binder 
are only those labels that are set in the workflow and configured to be visible for the 
VWP configuration. If the VWP configuration supports it, operators can add and delete 
labels in the binder for the target workflow. 

Trim groups can be configured in metadata labels. A trim group consists of three 
timecode controls for trimming media proxies: In point, Out point, and Duration. 
Creating multiple trim groups allows operators to trim multiple times along the video 
timeline, for example, to remove multiple black separators between video segments. 

Vantage also allows you to configure hotkeys for setting the time code values. When an 
operator locates a frame and wants to set a label parameter to the time code for the 
specified frame, the operator simply presses the appropriate hotkey for Mark In, Mark 
Out, or Duration, and the timecode is recorded in the label parameter. 

To configure metadata label usage for operators, do the following:

1. Select the configuration to change.

2. Select the Labels tab (see Figure 62).

Figure 62. Labels Tab

Note: Before a metadata label can be made available to an operator, it must be 
defined using VMC as described in Creating Metadata Labels.
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3. To enable or disable operator viewing of metadata labels, check (enable) or clear 
(disable) the Show Metadata Labels checkbox.

Note: If you disable operator viewing of metadata labels, you also disable operator 
management of metadata labels. Operators can only manage labels they can see.

4. To allow or disallow operators to add and delete metadata labels to binders, check 
(allow) or clear (disallow) the Allow Add/Delete checkbox.

Note: The Allow Add/Delete checkbox is not provided in Browse Windows Network 
mode because you are viewing files, not binders. You must run a job in a workflow to 
create a binder before you can add labels to the binder.

5. To make a metadata label available to operators, do the following:

a. Select labels in the Available pane. (Ctrl-click or Shift-click to select multiples.)
b. Click Add.

6. To change label order, select labels in the Visible to user list (Ctrl-click or Shift-click to 
select multiples) and use the green up  and down arrows  to move the labels.

7. Add Trim Groups (if desired, Figure 63) to labels that include time code. Trim groups 
allow operator trimming of media by setting timecode in and out points and clip 
duration at multiple locations in the media timeline (as many locations as the 
number of trim groups):

a. Select the label in the Visible to user list.
b. Click Trim. This opens a Trim Groups dialog. 
c. Select Add New Trim Group in the Trim Groups dialog. 
d. Use the add Mark In, Mark Out, and Mark Duration drop down menus to add 

those trim controls to the Workflow Portal display for that label. 
e. Click OK to save your changes (or Cancel).

8. You can define hotkeys for each of the timecode controls:

a. Select the metadata label in the Visible to user list.
b. Click the dropdown menus and select hotkeys corresponding to the Mark In, Mark 

Out, and Duration controls.
c. If you want to clear all hotkeys, you can click the Clear button and then click OK 

to confirm the clear.
d. Click OK to save your changes (or Cancel). 
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Figure 63. Trim Groups and Timecode Mark Hotkeys

9. To hide metadata labels from operators, do the following:

a. Select one or more labels in the in the Visible to user list.

You can use the Control and Shift keys to select multiple users as described in the 
previous step.

b. Click Remove.

10. Click the Save button  to save your changes.

Note: When testing your VWP configuration, the metadata label display is different 
for the different configuration modes. For the Browse Windows Network mode, labels 
are only visible to operators after they select a media file and target workflow and click 
Submit. For Browse Catalogs (copy binder) mode, labels are only visible to operators 
after they select a binder and target workflow and click Submit. For Browse Catalogs 
(forward binder) mode and Create EDL from Catalogs mode, labels are visible to 
operators as soon as they select a binder.
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Managing Variable Configuration Options for Operators
Vantage allows operators to set variables when they submit jobs to a workflow. These 
variables can be used by the workflow to customize job processing.

Note: For an introduction to Vantage variables, see Understanding Variables.

To enable or disable operator use of variables, do the following:

1. Select the configuration to change.

2. Select the Variables tab (see Figure 64).

Figure 64. Variables Tab

Note: Before a variable can be made available to an operator, it must be defined 
using VMC as described in Creating Variables.

3. To make a variable available to operators, do the following:

a. Select one or more variable names in the in the Available pane. (You can Ctrl-click 
or Shift-click to select multiple names.)

b. Click Add.

4. To hide variables from operators, do the following:

a. Select one or more labels in the in the Visible to user pane. You can use the 
Control and Shift keys to select multiple users as described earlier.

b. Click Remove.

Note: When all variables are hidden from operators, the Variables tab does not show.
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5. To change the displayed order of variables, select a variable in the Visible to user 
pane and use the green up  and down arrow  buttons to move the variable in 
the list. (You can Ctrl-click or Shift-click to select multiple variables and move them.)

6. Click the Save button  to save your changes.

Note: If you are testing your VWP configuration, variables are only visible to operators 
after they select a binder and target workflow and click Submit.

Controlling Operator Workflow Forwarding
With the appropriate permissions, Vantage operators can forward binders to one or 
more target workflows for further processing. As a Vantage administrator, you can 
control the following:

• Whether operators can view the Forward to Workflows tab in VWP.

• The target workflows to which operators can forward binders.

• Whether operators are required to forward to a target workflow.

When workflow forwarding is enabled in a VWP configuration, operators can forward to 
any visible target workflow by selecting the workflow on the Forward to Workflows tab 
and clicking Submit. If a target workflow is required, it is automatically selected on the 
Forward to Workflows tab and the binder is forwarded to the required workflow when 
the operator clicks Submit.

To enable or disable binder forwarding to other workflows, configure a VWP as follows:

1. Select the configuration to change.

2. Select the Forward to Workflows tab (see Figure 65).

Figure 65. Forward to Workflows Tab
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3. To enable or disable operator viewing of target workflows, check (enable) or clear 
(disable) the Show Forward to Workflows checkbox.

Note: If you disable operator viewing of target workflows, you also disable operator 
forwarding to target workflows. Operators cannot forward binders to workflows that 
they cannot see.

4. To make target workflows available to operators, do the following:

a. Select one or more workflow names in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

b. Click Add.

Note: To accept forwarded binders, the target workflow must contain at least one 
Receive action. The Available pane only displays workflows that contain a Receive 
action.

5. To specify whether a target workflow is required for forwarding or optional, check 
(required) or clear (optional) the Req’d checkbox next to the workflow in the 
Visible to user pane.

6. To hide workflows from operators, do the following:

a. Select one or more users in the in the Visible to user pane.

You can use the Control and Shift keys to select multiple users as described ear-
lier.

b. Click Remove.

7. Click the Save button  to save your changes.
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Defining EDL Storage
EDL files can be stored in any Vantage store or folder, or they can be stored in a special 
Vantage store or folder, designated for EDL files. 

Note: The Microsoft User Account Control (UAC) feature denies access to the default 
Vantage store for submitted stitched assets (EDLs). If Vantage users report that access 
to the Vantage store is denied, do one of the following: 1) reconfigure the default store 
to specify a UNC path or a directory that is not protected by UAC, 2) use the procedure 
below to specify a different store, or 3) disable UAC on the Vantage server that hosts 
the default store.

To specify a storage location for EDL files, do the following:

1. Select an EDL configuration to change.

2. Select the Storage tab.

3. To store EDL files in any available Vantage store, click the Available Vantage Store 
radio button.

4. To store EDL files in a specific Vantage store or folder, click the Vantage Store/Folder 
radio button, then select a Vantage store or folder in the drop down list adjacent to 
this radio button.

5. Click the Save button  to save your changes.

Managing User Access to VWP Configurations
When the User Management feature is enabled, you can use VMC to define which 
Vantage users can access each VWP configuration. You can enable access for one, some, 
or all users.

Note: For more information on the user management feature, see Managing Vantage 
Users.

To define which users can access a VWP configuration, do the following:

1. Select the configuration to change.

2. Select the Permitted Users tab (see Figure 66).
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Figure 66. Permitted Users Tab

3. To grant access to all users, check the Everyone checkbox.

4. To grant access to one or more Vantage users, do the following:

a. If the Everyone checkbox is checked, clear the checkbox.
b. Select one or more users in the in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

c. Click Add.

5. To remove access for one or more Vantage users, do the following:

a. Select one or more users in the in the Permitted users pane.

You can use the Control and Shift keys to select multiple users as described in the 
previous step.

b. Click Remove.

6. Click the Save button  to save your changes.
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Deleting a Configuration
To delete a VWP configuration, do the following:

1. Select the configuration to delete.

2. Click the Delete button  in the tool bar.

3. Click OK to confirm the delete or click Cancel to abort the delete.

Saving a Configuration
Changes that you make to a VWP configuration are not applied or saved until you save 
the configuration as follows:

1. Select the configuration to save.

2. Click the Save button  in the tool bar.

Duplicating a Configuration
If you need a new configuration that is similar to an existing configuration, it might be 
easier to duplicate the configuration and modify the duplicate, instead of creating a 
new configuration. When you duplicate a configuration, the console creates a new 
configuration with Copy of prepended to the source configuration name.

To duplicate a VWP configuration, do the following:

1. Select the configuration to duplicate.

2. Click the Duplicate button  in the tool bar.

Exporting and Importing Configurations
Vantage allows you to export one or all VWP configurations to XML files, which you can 
then use to import the same configurations into another Vantage domain.

To export one or all configurations, do the following:

1. If you are exporting a single configuration, select the configuration to export.

2. Click the Export button  to export a single configuration, or select Export all from 
the Export button drop down menu.

3. Use the file system dialog to save the exported configurations.

The default file name for each configuration is the configuration name, but you can 
change the file name.

Note: Changing the name of the XML file does not change the name of the 
configuration in the XML file.
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To import a configuration, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the configuration to import, then 
click Open.

Note: If you try to import a configuration that is already in this Vantage domain, 
Vantage prompts you to overwrite the record (click Yes) or cancel the import (click No).

Refreshing the Configuration List
The configuration list is a static display that is automatically updated when you add or 
delete configurations. However, if other administrators add or delete configurations, 
you must refresh the configuration list to display the changes.

To refresh the configuration list, click the Refresh button  in the tool bar.

VWP Deployment Tips
As a Vantage domain administrator, you can make it easier for operators to start using 
VWP by doing the following:

• Install the VWP program on the operator’s computer.

• Launch VWP for the first time and pre-select the following:

– Vantage domain

– VWP configuration

– Binder catalog
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Vantage Workflow Portal Tours
This topic contains examples of how to set up portals allowing operators to perform 
certain tasks. These tours assume that you are familiar with Vantage; they provide high-
level design guidelines only.

VWP Tour: Operators Submit an EDL
This tour describes how to configure the ingest workflow, target workflow, and Portal 
configuration, to allow operators to stitch assets together by specifying an EDL, and 
create an MPEG-2 Transport Stream output file.

Step 1: The Ingest Workflow
This workflow watches a hot folder for incoming media files. 

Figure 67. Typical EDL Ingest Workflow

When new files are detected, the workflow will: 

1. Generate a proxy at 29.97 fps, with the nickname Vantage Proxy.

2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.

3. Create a Transport Stream MPEG-2 file to be used for stitching, with the nickname 
Vantage EDL.

4. Register the binder in the catalog named Assets.
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Step 2: The Target Workflow
The desired output format is MPEG-2 Transport Stream. Because the EDL inputs are also 
MPEG-2 Transport Stream, the Direct Convert container type is implemented. 

Figure 68. Typical EDL Processing Workflow

Video from the input files is re-wrapped without transcoding, and I-Frames are inserted 
at any GOP breaks. 

This workflow:

1. Receives the .tsedl file from VWP with the nickname Original.

2. Uses the .tsedl file to stitch MPEG-2 from the source assets using Direct Convert to 
MPEG-2 Transport Stream

3. Uses the .tsedl file to transcode a Windows Media output.
Vantage Domain Management Guide



Configuring Vantage Workflow Portal Operation
Vantage Workflow Portal Tours

306
Step 3: VWP Configuration
The VWP configuration is set up as follows:

1. The Create EDL from Catalogs configuration mode is selected

2. The Assets catalog is selected

3. The target workflow is made available to the operator.

Figure 69. Typical EDL Configuration
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VWP Tour: Extracting Highlights
This tour describes how to configure the label design, ingest workflow, target workflow, 
and Portal configuration, to allow operators to mark in/out points on a master asset for 
highlight extraction, and also choose distribution channels and enter metadata.

Step 1: Label Design
In this workflow, the operator provides the following information:

• What timecodes should be used for the highlight start, end, and keyframe

• A description and title for the highlight

• To which distribution channels the highlight should be sent

The label is designed accordingly, as illustrated here:

Figure 70. Typical Highlight Extraction Label Design
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Step 2: The Ingest Workflow
This workflow watches a hot folder for incoming media files. 

Figure 71. Typical Highlight Extraction Ingest Workflow

When new files are detected, the workflow will: 

1. Generate a QuickTime H.264 MOV proxy at 29.97fps, with the nickname Vantage 
Proxy.

2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.

3. Populate the Highlight label in the binder, with the default values.

4. Register the binder in the catalog named Assets.
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Step 3: The Target Workflow
Figure 72 shows an example of a target workflow.

Figure 72. Typical Highlights Extraction Target Workflow

The target workflow uses the metadata provided by the operator as follows:

1. Receives from the Portal, and expects the Original asset to be available.

2. Uses the Populate action to extract the timecodes and metadata from the label, as 
variables.

3. Trims the original to a short, mezzanine format that can be used for multi-channel 
transcoding, using the Start/End timecodes specified by the operator.

4. Creates a JPEG keyframe at the time specified by the operator.

5. Uses the Populate action to extract the true/false values specified by the operator 
checkboxes for distribution channels.

6. Uses those true/false values to determine whether each branch of the workflow 
should execute.

7. Encodes the appropriate output formats, embedding the metadata information 
provided by the operator into the output files, and deploying to the target.
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Step 4: The Portal Configuration
The Portal configuration is set up as follows:

1. The Browse Assets (Copy Binder) configuration mode is chosen.

2. The Assets catalog is selected.

3. The Highlights metadata label is made available to the operator.

Figure 73. Typical Highlights Extraction Portal Configuration

4. The target workflow is made available to the operator.
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Managing Dublists

This chapter explains how to use the Vantage Dublist Portal feature and the Dublist 
Schemes feature of the Vantage Management Console.

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

The following topics are presented in this chapter:

 Configuring the Dublist Portal

 Fulfillment Schemes

 Dublist Schemes

Configuring the Dublist Portal
The Dublist Portal provides operators and managers with the ability to view and 
manage TrafficManager dublists. Using the VMC Dublist Portal configuration window, 
you can create configurations, which define the information an operator sees when 
using the Dublist Portal. In order for users to use the Portal, at lease one configuration 
must exist.

You can create configurations in VMC Application Configurations and specify which 
users can use them and which workflows containing dublist monitors are included. 

Note: For a comprehensive overview of the Dublist Portal application, see the 
Vantage TrafficManager User’s Guide.

The following topics provide information on Dublist Portal configuration tasks:

 Displaying the Dublist Portal Configuration Panel
 Creating a New Configuration
 Renaming a Configuration
 Duplicating a Configuration
 Deleting a Configuration
 Setting Options and Choosing Columns
 Configuring Permitted Users
 Selecting and Changing Workflows
 Refreshing the Configuration List
 Exporting and Importing Configurations
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Displaying the Dublist Portal Configuration Panel
To view the Dublist Portal configuration window in Vantage Management Console, 
open Application Configurations in the side panel and select Dublist Portal. The VMC 
displays the Dublist Portal configuration window shown in Figure 74.

Figure 74. The Dublist Portal Configuration Window

Creating a New Configuration
To create a new configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Click the Create a New Configuration button  (or right-click in the empty 
configuration list space and select New Configuration).

3. Enter a name in the Name field after the new configuration appears in the 
Configuration list.

4. Enter a description of the configuration in the Description text box (this is optional).

5. Click the Save button .
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Renaming a Configuration
To rename a configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Select the configuration to rename in the Configuration list.

3. In the Name text box, enter a new name for the configuration.

4. Click the Save button .

Duplicating a Configuration
To duplicate a configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Select the configuration to duplicate.

3. Click the Duplicate button  (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate configuration.

5. In the Description field, enter a description for the configuration (optional).

6. Click the Save button .

Deleting a Configuration
To delete a configuration, do the following:

1. Display the Dublist Portal  configuration window. 

2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiple 
configurations.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog appears, click OK.
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Setting Options and Choosing Columns
You can set Dublist Portal configuration options and columns below the Name and 
Description. The Columns selections enable you to include or exclude these columns: 
Dublist, Folder, Workflow, Catalog, Submitted, ISCI, House ID, Matched, and Status. The 
columns you select determine which columns and associated information are visible 
when the Dublist Portal displays this configuration. In this way, you can control what 
information the Dublist Portal operator sees.

To define which columns appear in a configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Select the configuration you want to modify from the Configuration list.

3. In the Options row, check the boxes for options you want to enable for this 
configuration, and uncheck to disable. The only current option allows the user to 
manually expire dublists in addition to any automatic expiration.

4. In the Columns row, check the boxes for the columns you want to display in this 
configuration, and uncheck the boxes for columns you want to hide.

5. Click the Save button .

Figure 75. Configuration Options and Columns

Columns
Options
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Configuring Permitted Users
You can set a configuration to be available to individual users or all users (public).

Note: Users with administrative privileges will have full access whether or not they 
are given permission.

To define which Vantage users can access a configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Select the configuration you want to modify from the list.

3. Select the Permitted Users tab (Figure 76).

Note: The Permitted Users tab is available only if you select Enable User 
Administration in VMC Settings & Options.

Figure 76. Configuration Permitted Users

4. To make the configuration available to all Vantage users, do the following:

a. Check the Everyone (Public View) check box.
b. Click the Save button .

5. To make the configuration available to select Vantage users, do the following:

a. Clear the Everyone (Public View) check box.
b. In the Available pane, select the users who should have access, and click Add.
c. In the Visible to user pane, select the users who should not have access, and click 

Remove.
d. Click the Save button .

Permitted
Users

Everyone

Add &
Remove
buttons
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Selecting and Changing Workflows
To change the workflows for a configuration, do the following:

1. Display the Dublist Portal configuration window.

2. Select the configuration to modify.

3. Click the Dublist Monitor Workflows tab in the lower panel (Figure 77).

4. Select a workflow in the Available pane and click Add to add it to the configuration, 
or click a workflow in the Included pane and click Remove to delete it from the 
configuration.

5. Click the Save button .

Figure 77. Dublist Workflows 

Refreshing the Configuration List
When you open the Dublist Portal configuration panel, VMC displays the current 
configurations list. If another administrator is making changes (such as adding Vantage 
users), you must refresh the display to see those changes. To refresh the display, click 
the Refresh button .

Dublist
Workflows

Add & 
Remove 
buttons
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Exporting and Importing Configurations
Vantage allows you to export configurations to XML files, which you can then use to 
import the same configurations into another Vantage domain.

To export configurations, do the following:

1. Select the configurations to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected configurations (or right-click and 
select Export, or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported configurations.

The default file name is the configuration name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the 
configuration in the XML file.

To import configurations, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the configuration file to import, then 
click Open.

Note: If you try to import a configuration that is already in this Vantage domain, 
Vantage prompts you to cancel or confirm replacement.
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Fulfillment Schemes
The Fulfillment Schemes folder of the Vantage Management Console contains 
interfaces that pre-process information used in components of Vantage 
TrafficManager, such as the Dublist Portal and the Dublist Monitor action. Current items 
located in this folder are these interfaces:

 Dublist Schemes

Dublist Schemes
Dublist schemes, located in the VMC Fulfillment Schemes folder, contain dublist 
parsing patterns you can create for each type of dublist you plan to use with Vantage 
TrafficManager. The schemes provide the patterns that Traffic Dublist actions use in a 
workflow for extracting particular data fields from dublists. You can set up a scheme to 
extract any data fields you need so that TrafficManager can find and process media files 
and include their metadata. For example, you might extract the Advertiser, Title, ISCI 
code, and Duration and pass those along to the traffic workflow for further action.

The advantage of dublist schemes is that you don’t have to set up the parsing pattern 
for the dublist each time you use a Dublist Monitor action in a workflow. Instead, you 
set it up once as a scheme in the Dublist Schemes panel and then specify that scheme 
by name in a Dublist action. Different types of broadcast automation systems use 
different dublist formats, so you can create a scheme for each type. The dublist files 
themselves can consist of comma-separated values (CSV), column-based files, and 
supported dublist databases.

The following topics are explained as part of the Dublist Schemes functionality:

 Displaying the Dublist Schemes Panel

 Creating a New Dublist Scheme

 Renaming a Scheme

 Duplicating a Scheme

 Deleting a Scheme

 Creating Dublist Scheme Fields
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Displaying the Dublist Schemes Panel
To view the Dublist Schemes panel, open Fulfillment Schemes in the side panel and 
select Dublist Schemes. VMC displays the panel shown in Figure 78.

Figure 78. The Dublist Schemes Window
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Creating a New Dublist Scheme
To create a new dublist scheme, do the following:

1. Display the Dublist Scheme window.

2. Click the Create a new dublist scheme button  (or right-click in the empty schemes 
list space and select New Dublist Scheme).

3. Choose Column-based or CSV in the dialog that appears, depending on whether 
your dublist is formatted in columns or with commas separating the values (CSV).

4. Enter a scheme name in the Name field. 

When naming your dublist schemes, you probably want to use the type of dublist 
in the name, so a scheme for BXF dublists might be called “BXF Dublist Scheme” to 
make it easy to identify.

5. Enter a description of the scheme in the Description text box (this is optional).

6. Click the Save button .

Renaming a Scheme
To rename a scheme, do the following:

1. Display the Dublist Schemes window.

2. Select the scheme to rename in the scheme list.

3. In the Name text box, enter a new name for the scheme.

4. Click the Save button .

Duplicating a Scheme
To duplicate a dublist scheme, do the following:

1. Display the Dublist Schemes window.

2. Select the scheme to duplicate.

3. Click the Duplicate button  (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate scheme.

5. In the Description field, enter a description for the scheme (optional).

6. Click the Save button .

Deleting a Scheme
To delete a dublist scheme, do the following:

1. Display the Dublist Schemes window. 

2. Select the configuration to delete. (Ctrl-click or Shift-click to select multiples.)

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog appears, click OK.
Vantage Domain Management Guide



Managing Dublists
Dublist Schemes

321
Creating Dublist Scheme Fields
You can set up Dublist Scheme field options below the field Name and Description. 
These options determine which data columns, lines, and fields in a particular type of 
dublist are extracted and forwarded to TrafficManager and which are ignored. Typical 
data to extract from a dublist might include the advertiser, the media title, the ISCI 
code, the length of the media in hours/minutes/seconds/frames, and so on. The 
following figure shows a typical dublist with data arranged in columns, each of which 
will be described and extracted by a field in your dublist scheme.

Figure 79. Typical Dublist

Field List
The field list shows the fields you create as part of a scheme. You can add fields as 
needed. Each field in a scheme is created and configured to extract data from a 
particular column in the dublist when a dublist is parsed. 

Skip Lines—Enter the number of header lines to skip at the top of a file before dublist 
parsing starts. 

Add New Field—Click Add Field  to add a new data field to extract from dublists.

Delete Field—Click Delete Field  to delete the highlighted field from the field list.

Field Name—Enter a name for the field.

Description—Enter a description of the field.

Value Type—Enter the type of value to search for and extract from the field. Available 
values are True/False, Integer Number, Size, Decimal Number, Date, Text, Path, 
Timecode, and Mail Address. See Table 26 for descriptions of these values.

Qualifier—Set to the type of field being extracted: an Ad ID or ISCI identifier, a House ID, 
or some other General qualifier.

Extraction Criteria, Starting Column—Set this to the number of the column in which to 
start extracting data. That is, counting from the left margin, how many characters to the 
right should the parser count before starting to extract data for this field?

Extraction Criteria, Width—Set this to the width of the data to be extracted. That is, 
counting from the starting column (above) how many characters to the right should 
the parser count before ending extraction of the field?
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After entering your selections for each item described previously, click the Save button 
 to save the field and scheme.

The following table presents Value Type descriptions. 

Table 26. Dublist Schemes Field Value Types

Value Type Description

True/False A true or false value

Integer Number A signed 32-bit integer (decimals are rounded)

Size A signed 64-bit integer (decimals are rounded)

Decimal Number A double precision floating point decimal number

Date A date specified according to local standards:
MM/DD/YYYY or DD/MM/YYYY

Text Any text string; use this when your data does not fit any 
other value type 

Path A valid Windows or UNC path. 
Must follow this pattern: [Drive Letter]:\ 
Or this pattern: \\Device\path

Timecode A video timecode value in this pattern: HH:MM:SS:FF@FR

HH is hours, MM is minutes, SS is seconds, FF is the frame 
number, and @FR is the frame rate. Examples: 
00:00:30:04 or 01:00:30;00@29.97 or 00:02:30:00@25. A 
frame rate of 29.97 is assumed if not specified. 

Mail Address A valid email address consisting of an @ sign with a 
string before and after—email@domain. Example: 
name@telestream.net
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Testing Schemes
The Test button in the center of the Dublist Schemes window lets you test your 
schemes on actual dublists to verify that the scheme works correctly. To test a scheme, 
do these steps:

1. Select a dublist scheme in the scheme list. For this example, the dublist shown in 
Figure 79 was used.

2. Press the Test button.

3. Examine the Test Results display for a clean output as shown in Figure 80.

4. Adjust each field of the scheme until a test produces a satisfactory output. 

Figure 80. Dublist Scheme Test Display
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Monitoring the
Domain with Vantage

Dashboard

Vantage Dashboard is a Web application that you can use to monitor and manage your 
domain from any computer, anywhere on your network, as long as that computer has a 
compatible browser. 

Note: Vantage Dashboard is an option available with the Vantage System Web 
Dashboard license. Vantage Dashboard access requires that you enable the user 
management feature (see Managing Vantage Users).

The following topics describe how to use the Vantage Dashboard:

 Overview

 Managing Vantage Dashboard Sessions

 Monitoring a Domain

 Managing Servers

 Managing Services

 Managing Jobs

Note: For instructions on how to install the Vantage Dashboard on your IIS server, see 
Installing and Configuring Vantage Web Applications.

Overview
Vantage Dashboard is designed to help domain administrators manage the entire 
Vantage domain, as opposed to other tools which allow management of domain 
components, such as jobs.

The Vantage Dashboard pages are designed to help you quickly assess the health of the 
domain and progressively dig into deeper detail as needed. For example, the Summary 
Status page allows you to quickly see the workflow completion success rate and the 
error rate on domain servers. The information on the Summary Status page can help 
you determine if it is more appropriate to troubleshoot a problem or evaluate system 
performance.
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Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

Managing Vantage Dashboard Sessions
When you start Vantage Dashboard in a Web browser, you establish a session with the 
Vantage domain. The following topics describe how to manage a Vantage Dashboard 
session:

 Vantage Web Applications Browser Requirements

 Starting the Vantage Dashboard

 Understanding the Vantage Dashboard Display

 Hiding and Displaying the Header Pane

 Managing the Menu Pane

 Sorting Lists in the Status Pane

 Logging Out

 Changing Your Vantage User Password

 Changing Vantage Domains

 Displaying Product Version Information

 Displaying Help

 Returning to the Welcome Page

 Troubleshooting Tip

Vantage Web Applications Browser Requirements
Telestream recommends the following Web Browsers for use with the Vantage 
Dashboard: 

• Internet Explorer 9 64-bit (Windows only)

• Internet Explorer 9 32-bit (Windows only)

• Current version of Chrome (Mac OS X & Windows)

• Current version of Firefox (Mac OS X & Windows)

• Safari 5 (Mac OS X only)

Note: To use Vantage Dashboard with Internet Explorer 9, you must configure 
Internet Explorer as described below.
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To configure Internet Explorer for use with Vantage Dashboard, do the following:

• Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click the Active 
scripting Enable radio button, click OK, and click OK.

• Disable Compatibility View in Internet Explorer at the following locations:

– Tools > Compatibility View

– Tools > Compatibility View Settings > Display intranet sites in Compatibility View

– Tools > Compatibility View Settings > Display all Web sites in Compatibility View

• If you are using Internet Explorer on a Windows Server operating system, disable 
Enhanced Security Configuration (ESC) using the Windows Server Manager (Server 
Manager > Security Information > Configure Internet Explorer ESC).

Starting the Vantage Dashboard
To start the Vantage Dashboard, open your web browser and navigate to the location 
of the Vantage Dashboard on an IIS server. There are 2 URLs that you can use to access 
the Vantage Dashboard:

• http://<ServerName>/Vantage

• http://<ServerName>/Vantage/Dashboard

The first URL displays links for all Vantage Web Applications (including the Vantage 
Dashboard), and the second URL directly starts the Vantage Dashboard. Replace 
<ServerName> with the name of the Vantage Dashboard host server (or its IP address). 
If you do not know the URL of the Vantage Dashboard, obtain it from your Vantage 
administrator or IT department.

Note: To access Vantage Dashboard, you must enable user administration as 
described in Enabling and Disabling User Management.

The following topics describe how to connect to the Vantage domain after you enter 
the URL:

 Connecting for the First Time

 Reconnecting to Vantage Dashboard
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Connecting for the First Time
The first time you connect to the Vantage Dashboard, you are asked to select a domain 
to which the Vantage Dashboard should attach (see Figure 81). Select the domain and 
click OK.

Figure 81. Selecting a Vantage Domain

If the Vantage domain database does not have a default password, click Advanced and 
enter Connection Settings (see Figure 82).

Figure 82. Connection Settings

Vantage Dashboard logs onto the selected domain, and prompts you for your Vantage 
user login information. 
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When the login dialog box displays (see Figure 83), enter the User Name and Password 
assigned by your Vantage Administrator, then click Log In.

Figure 83. Vantage Dashboard Log In

The default user name and password, which remain the same until changed, are:

• User Name: Administrator

• Password: <none> (no characters entered)

Note: User passwords are encrypted in the Vantage domain database. Users have the 
option of changing their password (see Changing Your Vantage User Password).

Check Remember me next time to store the authentication token in a persistent cookie 
in the browser. This keeps you authenticated if you close your browser and reopen it. 

Reconnecting to Vantage Dashboard
After you connect to the Vantage Dashboard for the first time, the Vantage Dashboard 
remembers the domain to which you connected and displays the Dashboard Login 
prompt (see Figure 83). Enter the User Name and Password assigned by your Vantage 
Administrator, then click Log In.

Note: Cookies should not be disabled by either browser settings or group policy. If 
cookies are disabled, the Vantage domain will not be remembered.

User Name

Password

Log In 
button
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Understanding the Vantage Dashboard Display
Upon successful login, Vantage Dashboard displays the welcome screen shown in 
Figure 84.

Figure 84. Welcome Window and Dashboard Header Controls

Vantage Dashboard displays information and controls in three panes: header, menu, 
and status. The header pane displays controls for session management, and the left 
menu pane displays menu selections, which are described in the Welcome page in the 
status pane when Vantage Dashboard starts. The status pane displays information 
about your domain, based on the selection you make in the menu pane.

Hiding and Displaying the Header Pane
The header pane displays the Vantage user name you are using and the Vantage 
domain to which you are connected. The header pane also displays controls you can 
use to change your Vantage user password, change the selected Vantage domain, or 
log out from the Vantage domain. To hide or display the header pane, click the display/
hide button shown in Figure 84.

Menu
Pane

Status
Pane

HeaderDisplay/Hide 
Header Button

Display/Hide 
Menu Button

Collapse/
Expand Button
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Managing the Menu Pane
You can collapse or expand the items in the menu pane, and you can hide or display the 
menu pane.

You can collapse menus by clicking the up arrow to the right of the menu name 
(Figure 84), and you can expand menus by clicking the down arrow, which displays for 
collapsed menus.

To hide or display the menu pane, click the display/hide button shown in Figure 84.

Sorting Lists in the Status Pane
Most pages that appear in the status pane contain lists, which can be sorted based on 
the content of any of the columns. To do this, click on any column heading. The first 
click sorts the list rows in ascending order of the information in the selected column. 
The second click sorts them in descending order. A third click removes sorting and 
displays the default sort order.

Logging Out
When you are logged in to the Vantage Dashboard, anyone with access to your 
computer has access to the Vantage Dashboard reports and controls. To prevent 
unauthorized access to Vantage Dashboard when your computer is unattended, log 
out by clicking Logout in the Vantage Dashboard header.

After log out, the log in window displays again (See Figure 83).

Changing Your Vantage User Password
To change your Vantage password, do the following:

1. Click Change Password in the Vantage Dashboard header.

Vantage Dashboard displays the dialog to change your password (Figure 85).

Figure 85. Change Password

2. Enter your current password in the Password field. 

3. Enter your new password in the New Password field, and confirm it by re-entering it 
in the Confirm Password field. 

4. Click Save when finished. 
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Changing Vantage Domains
Vantage Dashboard can monitor just one domain at a time. To change the domain you 
are monitoring, do the following:

1. Click Change Domain in the Vantage Dashboard header.

2. If you are logged into Vantage Dashboard, you are prompted to log out. Click OK to 
log out.

3. Select a domain name in the domain list that displays (Figure 81), and click OK.

4. When the Vantage Login dialog appears, enter a user name and password, and click 
Log In.

Displaying Product Version Information
To display the Vantage Dashboard version number, click Help > About in the menu 
pane. Vantage Dashboard displays the version information as shown in Figure 86.

Figure 86. About Dialog Box

Displaying Help
Vantage Dashboard provides help (the user's guide you are reading) in two different 
formats: PDF format and HTML.

To display this user guide in PDF format, click Help > User Guide in the menu pane.

To display context-sensitive help, click the Help button in Vantage Dashboard.

To display this user guide in HTML format, click Help > Web Help in the menu pane.

Version 
Information
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This HTML online help system consists of two panels:

• The left panel displays the following tabs: 

– Contents tab—This tab displays a hierarchically organized set of chapters and 
pages. This list provides a wide range of overview and how-to topics that explain 
how to add, configure, and manage Vantage components.

– Index tab—This tab provides a list of keywords you can click to display its 
associated page.

– Search tab—Looks for specific words or phrases, resulting in a display of topics 
that match your search criteria. 

– Favorites tab—lists favorite topic that have been saved by adding them to the 
list. Topics are added by clicking the Add button.

• The right panel displays the page you have selected from one of the tabs on the 
left.

Returning to the Welcome Page
Click Help > Welcome Page in the menu pane to display the welcome page that is 
presented when the Vantage Dashboard is first started up. This page displays 
descriptions of all the menu items for the Vantage Dashboard.

Troubleshooting Tip
In some situations, if a Vantage administrator modifies (adds or removes) a virtual 
directory on the IIS server, the Web Dashboard session will close. This does not change 
the Web Dashboard configuration or operation. To continue using Web Dashboard, 
start the program as described in Starting the Vantage Dashboard.

Monitoring a Domain
The following topics provide information on monitoring a domain:

 Displaying Domain Status

 Displaying Domain License Status

 Displaying Vantage Release and Patch Status
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Displaying Domain Status
The Summary Status page shown in Figure 87 provides a high-level status of the 
Vantage domain to which you have connected. To display the Summary Status page, 
select Monitoring > Summary Status in the menu pane.

Figure 87. Domain Summary Status

Note: You can use the Chart Type menu to display pie charts for action allocation and 
services. For more information, see Summary Status.

The pie chart displays the status of workflow operation in the domain. You can hover 
the cursor over the pie chart segments to display exact percentages for completed 
failed, and stopped workflows. This chart automatically updates over time.

If the pie chart shows that all jobs are completing, you might want to use other Vantage 
Dashboard pages to determine the domain performance level. If the pie chart indicates 
that there are failed jobs, you might want to use a time filter to define the period for 
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which you want summary status. For example, if you recently fixed a problem in the 
domain, you might want to use a time filter to limit the display to workflow operation 
since the fix was applied.

Note: The upper and lower panels in the Summary Status pane are separate reports 
for different views of the Vantage domain. In Figure 87, the pie chart displays statistics 
from Job Status, and the bar graph displays statistics based on service metrics. Be 
aware that certain events can change the reports to appear inconsistent. For example, 
once all failed jobs have expired or been deleted, the pie chart might show 100% 
success, while the bar graph still reports errors. Likewise, if a service is brought in and 
out of maintenance mode, which resets service statistics, the pie chart can show a 
larger percentage of errors than indicated by the bar graph.

To specify a time filter, do the following:

1. Click the Time Filter button above the pie chart.

Vantage Dashboard displays the dialog shown in Figure 88.

Figure 88. Time Filter Dialog Box

2. Type a date and time in each text box, or use the calendar and clock tools in the 
window to select the date and time.

3. Click Apply to close the filter dialog and display the pie chart for the filter period.

Start Date/Time

End Date/Time

Calendar button

Clock button
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Displaying Domain License Status
To display the domain license status, select Administration > License Status in the 
menu pane. Vantage displays the status as shown in Figure 89.

Figure 89. License Status

To update the License Status page, click Refresh. Table 27 describes the information on 
this page.

Note: To view which features are supported by a license, use the Vantage 
Management Console as described in Viewing Vantage Licenses.

Table 27. License Status Column Descriptions

Column Description

Name The name of the license.

Activated The state of license activation (true or false).

In Use The state of license utilization (true or false).

Expired The state of license expiration (true or false).

Maintenance Expires Date and time that the maintenance expires.

Refresh
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Displaying Vantage Release and Patch Status
The Release and Patch Status page shows information about the software plug-in 
modules used by each Vantage service. If you are troubleshooting a problem with 
Telestream Technical Support, you might be asked to use this page to collect 
information about your domain software.

To display the Vantage release and patch status, select Administration > Vantage 
Release & Patch Status. Vantage displays the page shown in Figure 90.

Figure 90. Release and Patch Status

The default page shows the plug-in modules for the Monitor service. To show the 
modules for a different service, select a service from the View By Service dropdown list. 
To refresh the list, click Refresh. Table 28 describes the information on this page.

Table 28. Vantage Release and Patch Status Information

Column Description

Name The name of the plug-in.

Created The date and time the plug-in was installed.

Version The plug-in version.

Refresh

View By Service
Vantage Domain Management Guide



Monitoring the Domain with Vantage Dashboard
Managing Servers

338
Managing Servers
The following topics describe how you can use Vantage Dashboard to monitor servers 
in your domain:

 Displaying Vantage Server Status

 Enabling and Disabling Vantage Server Maintenance Mode

 Managing Agility Servers

Displaying Vantage Server Status
Vantage Dashboard provides two pages for viewing server status:

• The Summary Status page, which displays server health information, as well as 
domain status.

• The Array Statistics page, which displays status and statistics for all servers in an 
array, as well as service statistics.

The following topics describe the server status information available:

 Vantage Server Health

 Array Statistics
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Vantage Server Health
The Vantage Server Health panel (Figure 91) on the Summary Status page displays the 
percentage of errors for each Vantage server in your domain. To display this panel, 
select Monitoring > Summary Status.

Figure 91. Vantage Server Health

The bar chart displays the error rate for all servers in the domain. You can hover over a 
bar in the bar chart to display an exact percentage, and you can use the Chart Type 
dropdown list to display the services that experienced the errors.
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Array Statistics
The Array Statistics panel (Figure 92) on the Array Statistics page displays the 
percentage of errors for each Vantage server in your domain, as well as the current 
input queue length and CPU utilization level. To display this panel, select Health > Array 
Statistics.

Figure 92. Array Statistics

The upper panel on the Array Statistics page displays server statistics. If you select a 
Vantage server in the upper panel, Vantage Dashboard displays service statistics in the 
lower panel.
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Enabling and Disabling Vantage Server Maintenance Mode
Vantage server maintenance mode places all Vantage services on the selected server in 
maintenance mode. Place a server in maintenance mode when you want to reconfigure 
services, delete a license, or make other changes that require Vantage services to be 
offline.

Note: Server maintenance puts all services in maintenance mode. If you want to shut 
down individual services, see Entering and Exiting Service Maintenance Mode.

Note: Placing all services in maintenance mode erases the metrics for all services, and 
this affects the bar graphs for those services.

To enable or disable server maintenance mode, do the following:

1. Select Health > Array Statistics.

2. Select a server in the upper panel.

3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.
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Managing Agility Servers
Vantage Dashboard provides a limited control set for monitoring and managing Agility 
servers. To display the page for managing Agility servers (Figure 93), do the following:

1. Use the Vantage Management Console to select an Agility server as described in 
Configuring an Agility ECS Connection.

2. Select Health > 3rd Party Devices.

Figure 93. Managing Agility Servers

To update Agility server status, click Refresh. 

To reset the Agility server statistics counters for a single worker, select an Agility server, 
click Options, and select Reset Counter (or right-click an Agility server and select Reset 
Counter).

To reset the Agility server statistics counters for all servers, click Options, and select 
Reset All Counters (or right-click an Agility server and select Reset All Counters).

Options Refresh
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Managing Services
The following topics describe how you can use Vantage Dashboard to manage services:

 Displaying Service Information

 Entering and Exiting Service Maintenance Mode

 Resetting Service Statistics

Displaying Service Information
Vantage Dashboard provides three pages for viewing service status:

• The Service Statistics page, which displays statistics for all services in a domain and 
also displays individual service statistics for a selected server.

• The Array Statistics page, which displays statistics for all services on a single server.

• The Summary Status page, which displays a pie chart of queued and running 
actions for individual services, as well as a bar chart of services with errors.

Queued actions are actions that are waiting to be processed. Each Vantage service can 
be configured to support a maximum number of actions (see Using the Services Details 
Panel). If multiple servers support a service, actions for that service are distributed 
between servers using the load balancing feature (see Managing Load Balancing). 
When workflow demand exceeds the configured limits for a service, service actions are 
queued until the demand for that service drops below the configured limits.

The following topics describe the service status information available:

 Service Statistics

 Array Statistics

 Summary Status
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Service Statistics
The Service Statistics page (Figure 94) displays two panels. The upper panel displays 
cumulative statistics for all services in the domain, and after you select a service in the 
upper panel, the lower panel displays statistics for that service for all servers in the 
domain.

To display the Service Statistics page, select Health > Service Statistics.

Figure 94. Service Statistics

Table 29 describes the columns in Cumulative Statistics and Individual Statistics lists.
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Table 29. Column Descriptions for Service Statistics Page

Column Description

Avg. Queue Displays the average number of actions in the service action queue. 
Queued actions are actions that are waiting to be processed. 

Cur. Queue Displays the current number of actions in the service action queue.

Load/Target 
Load

Displays load balancing status.

For session-based load balancing, this displays the current number of 
sessions for this service (Load) and the configured session limit for 
this service.

For cost-based load balancing, this displays the current cost of all 
active sessions for this service (Load) and the target cost (Target Load) 
configured for this service.

For more information on load balancing, see Managing Load 
Balancing. 

Machine Lists the servers in the domain that support the selected service.

Passed/Failed Displays the number of actions that have successfully completed 
(passed) and failed.

Service Displays the name of a service that is supported in the domain.

Sessions Displays the current number of active sessions.

State Displays the current state of each service, which is either Online or Not 
all Online. When a service is in maintenance mode, this column 
displays Not all Online for that service. Note that a service can be in 
maintenance mode on one server and online on other servers.
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Array Statistics
The Array Statistics page (Figure 95) displays two panels. The upper panel displays 
statistics for all servers in the domain, and after you select a server in the upper panel, 
the lower panel displays statistics for all the services on the selected server.

To display the Array Statistics page, select Health > Array Statistics.

Figure 95. Array Statistics

Table 30 describes the columns in Array Statistics and Service Statistics lists.

Table 30. Column Descriptions for Array Statistics Page

Column Description

% of Failures Displays the error rate for each server in the domain.

Avg. Queue Displays the average number of actions in the service action queue.

CPU 
Utilization

Displays the percentage of CPU resources that are currently being 
used by Vantage services on a server.

Cur. Queue Displays the current number of actions in the service action queue.
Vantage Domain Management Guide



Monitoring the Domain with Vantage Dashboard
Managing Services

347
Input Queue 
Length

Displays the number of queued actions for all services on a Vantage 
server.

Load/Target 
Load

Displays load balancing status.

For session-based load balancing, this displays the current number of 
sessions for this service (Load) and the configured session limit for 
this service.

For cost-based load balancing, this displays the current cost of all 
active sessions for this service (Load) and the target cost (Target Load) 
configured for this service.

For more information on load balancing, see Managing Load 
Balancing. 

Server Lists the servers in the domain that support the selected service.

Passed/Failed Displays the number of actions that have successfully completed 
(passed) and failed.

Service Displays the name of a service that is supported in the domain.

Sessions Displays the current number of active sessions.

State Displays the current state of each service, which is either Online or 
Maintenance.

Table 30. Column Descriptions for Array Statistics Page (Continued)

Column Description
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Summary Status
The Summary Statistics page (Figure 96) displays two panels. When an appropriate 
chart type is selected, the upper panel displays a pie chart that shows the relationship 
between queued and running actions for one or all services. When an appropriate chart 
type is selected in the lower panel, this panel displays a bar chart showing the error rate 
for services with errors.

Figure 96. Summary Status

The following topics describe how to display service status using the Summary Status 
page:

 Displaying Action Allocation Across Services

 Displaying the Queue and Run Status for a Service

 Displaying the Error Rate for all Services
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Displaying Action Allocation Across Services

When the Action Allocation chart type is selected, the Summary Status page shows a 
pie chart that shows the relative use of all active services (see Figure 96). You can hover 
the cursor over any chart segment to see the numerical value for that segment.

To display the Action Allocation chart, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 87.

2. Click Chart Type in the upper pane and select Action Allocation.

Displaying the Queue and Run Status for a Service

The upper pane of the Summary Status page supports pie chart views for Vantage 
services. When you select a chart type for a specific service, the Summary Status page 
displays a pie chart that shows the percentage of running and queued actions for a 
service (see Figure 97). You can hover the cursor over any chart segment to see the 
numerical value for that segment. If no chart appears, there are no active or queued 
actions for that service.

Figure 97. Monitor Service Chart

To display a chart for any service, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 87.

2. Click Chart Type in the upper pane and select a service from the list.
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Displaying the Error Rate for all Services

The Vantage Service Health chart (Figure 97) displays the percentage of errors for any 
domain services that have errors. This display is refreshed when services are restarted.

Figure 98. Service Health

To display the Services Health chart, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 87.

2. Click Chart Type in the lower pane and select Service Health.

Entering and Exiting Service Maintenance Mode
You might want to enter maintenance mode for an individual service to make a 
configuration change to that service, or to stop using that service on a domain server. 
After you complete a configuration change, you will need to exit maintenance mode to 
return the service to operation.

Note: Some configuration changes require that you move all Vantage services in and 
out of maintenance mode. For instructions on how to do this, see Enabling and 
Disabling Vantage Server Maintenance Mode.

Note: Placing a service in maintenance mode erases the metrics for that service, and 
this affects the bar graphs for that service.

You can control maintenance mode for a service on the Service Statistics and Array 
Statistics pages.
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To enter or exit a service using the Service Statistics page, do the following:

1. Select Health > Service Statistics.

2. Select the service to manage in the upper panel.

3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

To enter or exit a service using the Array Statistics page, do the following:

1. Select Health > Array Statistics.

2. Select a server to manage in the upper panel.

3. Select a service to manage in the lower panel.

4. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

Resetting Service Statistics
You might want to reset service statistics after making a configuration change to your 
Vantage Domain. When you reset statistics, all cumulative values are reset to zero, 
which allows you to establish a new baseline for the domain.

You can reset statistics on the Array Statistics and Service Statistics pages.

To reset statistics for one or all services using the Array Statistics page, do the following:

1. Select Health > Array Statistics.

2. Select a server to manage in the upper panel.

3. If you want to reset statistics for a single service, select the service to manage in the 
lower panel.

4. Click Options in the lower panel and select either of the following:

– Clear (Reset) Selected Service Metrics History—Clears only the metrics history of 
the service selected.

– Clear (Reset) All Service Metrics History—Clears the metrics history of all the 
services. 

To reset statistics for one or all services using the Service Statistics page, do the 
following:

1. Select Health > Service Statistics.

2. Select a service to manage in the upper panel.

3. Select a server to manage in the lower panel.

4. If you want to reset statistics for a single service, select the service to manage in the 
lower panel.

5. Click Options in the lower panel and select either of the following:

– Clear (Reset) Selected Service Metrics History—Clears only the metrics history of 
the service selected.

– Clear (Reset) All Service Metrics History—Clears the metrics history of all the 
services. 
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Managing Jobs
The Domain Job Status page (Figure 99) in Vantage Dashboard allows you to manage 
jobs throughout the domain.

Figure 99. Domain Job Status

The Domain Job Status page provides a real time view of Vantage workflow jobs, and it 
provides controls that you can use to manage job processing. The Domain Job Status 
page displays two lists: the Job Status list and the Actions list.

The Job Status list presents workflow jobs, the state of each job (complete, failed, 
stopped), and timestamps for job events. Whenever a job is selected, the actions 
associated with that job are listed in the Actions list at the bottom of the window. The 
Actions list presents status information for each action and controls for managing the 
actions.

The following topics describe how to manage the jobs and actions listed on the 
Domain Job Status page:

 Paging Through the Job List

 Filtering Jobs or Actions

 Highlighting Failed and Stopped Jobs or Actions

 Displaying Job Error Details

 Stopping Jobs

Job Status list Actions list
Vantage Domain Management Guide



Monitoring the Domain with Vantage Dashboard
Managing Jobs

353
 Restarting Jobs

 Deleting Jobs

 Displaying Action Error Details

 Changing Action Priority

 Restarting Actions

Paging Through the Job List
You can navigate to any page by clicking the page number or by clicking the forward 
(right arrow) and previous (left arrow) buttons (see Figure 100). The arrow buttons with 
the vertical bars navigate to the first and last pages.

You can also enter the number of jobs to be listed on each page using the page size 
control shown in Figure 100.

Page adjustments are useful when adjusting performance with large amounts of data. 
A smaller page size results in less data sent to the browser, but also displays a smaller 
amount of all the available data.

Figure 100. Job Status List Controls

Page controls
Vantage Domain Management Guide
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Filtering Jobs or Actions
The filter feature allows you to selectively limit the row entries in the Job Status list or 
the Actions list based on the contents displayed in one or more columns. After you 
apply each filter, the list displays only those rows in which the column entries conform 
to the filter settings. To remove filters and display more entries, you must change the 
filter settings to display all items.

To display the filters for the Job Status list or the Actions list, click Show Filters (see 
Figure 100 or Figure 101). Click Show Filters again to hide the filters.

Figure 101. Actions Panel

The filter settings fall into three groups, which are listed in Table 31 and described in 
the following topics:

 Setting Text Filters

 Setting State Filters

 Setting Period Filters
Vantage Domain Management Guide
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Table 31. Filter Types and Descriptions

Filter Type Description

Action Text The name of a workflow action.

Category Text The category to which the workflow is assigned.

Created Period The date and time that an action was created for job 
processing.

Expires Period The date and time that a job expires.

Job Text The name of a job, which is usually the ingress filename.

Machine Text The name of the domain server that is processing the 
action.

Progress Text The completion percentage for the action.

Resource Cost Text The resource cost assigned to the action.

Started Period The date and time that a job is started.

State State The current state of the job or action.

Updated Period The date and time of the last status update for the job or 
action.

Workflow Text The workflow that is processing a job.
Vantage Domain Management Guide
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Setting Text Filters

Text filters allow you to enter text and define a method that defines how the text is 
applied. For example, you can specify “.wmv” in a Job filter and then select a method to 
display only rows with that extension or to exclude all jobs with that extension. 
Table 32 lists the methods you can use to control text filters.

To set a text filter, display the filters, type text in the text box above the column you 
want, click the funnel button to the right of the text box, and select the method for the 
text filter (Figure 102).

Note: When you apply a text filter, be sure to enter a value that actually appears in 
that column. If the filter text does not match any values in the column, the filter might 
not exclude any rows, or it might exclude all rows, depending on the method selected.

Figure 102. Filter Methods

Table 32. Filter Methods for Text Filters

Method Description

Contains Displays only rows in which the column entry contains the specified 
text.

DoesNotCont
ain

Displays only rows in which the column entry does not contain the 
specified text.

EqualTo Displays only rows in which the column entry exactly matches the 
specified text.

NoFilter Removes any existing filter entry for this column.

NotEqualTo Displays only rows in which the column entry does not match the 
specified text.

Enter a filter criteria string

Select a filter method
Vantage Domain Management Guide



Monitoring the Domain with Vantage Dashboard
Managing Jobs

357
Setting State Filters

State filters limit the list items to those rows that display a state that is selected in the 
state list. The default filter selects rows in all states, and displays as All States. If you set 
the filter to display a subset of all states, the filter displays Custom.

To set a state filter, display the filters, click the down arrow in the State filter column for 
the appropriate list, and check or clear the checkboxes for each state (Figure 103).

Figure 103. States Filter Options

Setting Period Filters

Period filters define start and end times for a period of time for which you want to 
display rows. When a period filter is applied to a column, Vantage Dashboard only 
displays rows for which the selected column value falls within the defined period.

To specify a period filter, do the following:

1. Display the filters.

2. Select the period filter you want to set.

Vantage Dashboard displays the dialog shown in Figure 104.

Figure 104. Period Filter Dialog

3. Type a date and time in each text box, or use the calendar and clock tools in the 
window to select the date and time.

4. Click Apply to set the filter, or click Clear to remove the filter.

Start Date/Time

End Date/Time

Calendar button

Clock button
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Highlighting Failed and Stopped Jobs or Actions
Vantage Dashboard provides an option to highlight failed and stopped job or action 
rows using the color representing its state (red for failed and magenta for stopped). 
Highlighting can make these jobs more visible in a long list of jobs.

To change the highlighting for the Job Status list or the Actions list, click Highlight State 
Rows above the appropriate list. Each time you click this control, the highlighting 
toggles on or off, to the opposite of the previous state.

Displaying Job Error Details
To display error details for a job listed in the Job Status list, select a failed job and click 
Show Error Details. 

Stopping Jobs
To stop a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Stop (or right-click on the job and select Stop).

Restarting Jobs
To restart a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Restart (or right-click and select Restart).

Deleting Jobs
To delete a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Delete, or right-click on the job and select Delete.

Displaying Action Error Details
To display error details for an action listed in the Actions list, select a failed action and 
click Show Error Details.
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Changing Action Priority
Vantage evaluates action priority when multiple actions of the same type are ready for 
processing. Vantage processes actions with the highest numerical priority value first, 
and in some cases, Vantage pauses lower priority jobs, processes higher priority jobs, 
and then finishes processing of the lower priority jobs.

You can change action priority to change the processing order of queued actions. To 
change the priority of an action, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. In the Actions list, select an action.

4. Select Options > Change Priority, or right-click the action and select Change 
Priority.

5. Specify a new priority value and click OK.

Restarting Actions
To restart an action, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. In the Actions list, select an action.

4. Click Options and select Restart, or right-click on the action and select Restart.
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Removing Vantage
Software
The following topics describe how to remove some or all of the Vantage software:

 Uninstalling Vantage from a Server

 Uninstalling Vantage Clients from a Workstation

Uninstalling Vantage from a Server
Each Vantage server may host some or all of the software components listed in the 
following procedure. You can use this procedure whether you are removing all of 
Vantage or individual components. 

To completely uninstall Vantage or to uninstall specific components, follow these steps:

1. Log on to the server with a local administrator account.

2. In the Vantage Workflow Designer, stop all jobs.

3. In the Vantage Management Console, stop all services. Also if you intend to reinstall 
or upgrade Vantage, use the Backup function to save your domain database to a 
backup file. This protects your data in the event of a problem with reinstallation. 
(You can skip this step if you are only removing the Web Upload Portal or Web 
Applications.)

4. Open the Windows Control Panel and select Programs and Features.

5. Using the Control Panel, right-click each of the following Vantage programs in the 
order listed below and select Uninstall to remove them:

• Vantage Web Upload Portal

• Vantage Web Applications

• Vantage update packs in reverse sequential order

• Telestream Media Transcode and Analysis engine

• Vantage 

• Vantage Domain Database
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Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created 
are not removed.

Note: If your domain has a mirrored database server, be sure to disable mirroring, and 
stop the SQL Server Agent service before proceeding.

6. If Microsoft SQL Server 2008 Express or Standard is installed, do the following:

a. Select Microsoft SQL Express or Microsoft SQL Standard and click Remove or 
Uninstall.

b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.
j. Optional step—Click the refresh button in the Control Panel to update the 

display, which will clear some of the SQL Server components from the display.

7. If Microsoft SQL Server 2005 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2005 and click Remove or Uninstall.
b. In the Component Selection dialog, check Remove SQL Server 2005 instance 

components, select VANTAGE: Database Engine, check Workstation Components, 
and click Next.

c. Click Finish.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLEXPRESS and VANTAGE for example), you 
will need to remove them both.

8. In the Control Panel tool to remove programs (see Step 4), select Microsoft SQL 
Server Native Client and click Remove or Uninstall.

Note: Uninstalling the database does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. This allows you to re-attach a Vantage domain 
database and return Vantage to a previous state when re-installing or upgrading 
Vantage. In the event of any problems, you also have the backup you created earlier.
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9. To permanently delete all Vantage files, use Windows Explorer to delete the 
following directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage

CAUTION: Deleting these files permanently destroys the Vantage domain database 
including the domain configuration, workflows, and history. If you created a backup 
file earlier using the VMC or if you create one now, you can preserve the domain for 
reinstallation later.

Uninstalling Vantage Clients from a Workstation
On workstations, the Vantage client programs are the Vantage Management Console 
and Vantage Workflow Designer. Vantage Workflow Portal (VWP) and Vantage Dublist 
Portal can also be installed on a workstation.

To completely uninstall Vantage from a workstation, follow these steps:

1. Open the control panel tool to remove programs in your operating system:

– Windows XP: Control Panel > Add/Remove Programs.

– Windows 7: Control Panel > Programs and Features > Uninstall Programs.

2. If the Vantage client software is installed, select Vantage Client and click Remove or 
Uninstall.

3. If VWP is installed, select Vantage Workflow Portal and click Remove or Uninstall.
Vantage Domain Management Guide
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Glossary
action

An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its task in the context of the workflow, using an action 
Inspector. Action inspectors are specific to each type of action.

Actions are grouped by functional categories: communication, transcoding, file 
operations, metadata processing, etc. Each action is defined by the specific task it 
performs. For example, an email action, or a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose 
limitations on actions in a workflow. For example, you might require action B to depend 
on action A in a Vantage workflow.

During execution, actions operate on files, binders, variables, and states, and they 
generate an action state when they complete. Actions are executed by Vantage 
services, which perform the requirements of the action.

action state

The action state describes the condition of an action execution in process and after 
completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After 
execution, an action's final state may be Success | Ignore | Fail. Certain actions (Decide/
Examine/Compare/Identify, for example) allow the use to specify the post-execution 
state, including Ignore. For all other actions, the post-execution state is set by the 
service, and is either Success or Fail. These states display in the Vantage Workflow 
Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested by 
the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state 
(right-click the action, and select Perform On > Success | Fail | Ignore | Any).

If an action fails, then the next action will inherit the Fail state and (in most cases) will 
not execute. If one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the 
Ignore state and will also likely not execute. Certain special actions, such as Message, 



Glossary356
can be configured to perform on any state (Fail, for example)—this allows workflows to 
send an email if they detect a failure.

Action states have precedence when an action receives states from multiple incoming 
actions (a merge of multiple branches):

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state. Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state. Success has precedence over Ignore states.

• If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has 
lowest precedence of the three states. If an action receives an Ignore state and does 
not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state unless 
it is an action which can emit Ignore, and you have configured it to do so.

Agility Service

The Agility Service is the Vantage component which executes the actions relating to 
Agility job submission and interaction with Agility via the Job Profile action, Job XML 
action, and Process MMF action. Agility features are enabled by the Vantage Agility ECS 
License license.

All-in-one domain

An all-in-one (or single-node or single-server) Vantage domain is one in which all server 
components of Vantage—the Microsoft SQL Server database, all Vantage services, and 
the optional Vantage Web Applications—are installed and operate on a single 
computer.

See also Vantage array. 

Analyze action

An Analyze action, which is executed by the Analysis Service, enables you to perform 
analysis on media using a variety of analysis tools, as well as variables, with the result of 
the analysis, for use in downstream actions.

Analysis Service

The Analysis Service is the Vantage component which executes the actions relating to 
the analysis of content: Examine action, Compare action, Identify action, Analyze 
action, Report action, QC action, and MediaInfo action.

Archive action

An Archive action, which is executed by the Staging Service, uses the selected archiver 
(TAR, for example) to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements.

array

Another term for Vantage array. 
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Aspera Service

An Aspera Service implements the Aspera software for Vantage, and provides two-way 
communication between workflows (and the Faspex Delivery action) utilizing the 
Aspera software itself.

Associate action

An Associate action uses the Monitor Service to continually (and at regular periods) poll 
a target location (a directory, for example) on a device or file system (FTP, network 
folder, etc.) to discover new files, based on some permutation of the name of the file 
being processed.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files. For example, if media file 
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be configured in the Associate action's Inspector.

Associate actions begin executing when a job is submitted, and execute until a new file 
is discovered—subsequent actions do not execute until the file is found. When the new 
file is discovered, the Associate action makes the file available to the other actions in 
the workflow.

Configuration is accomplished in the inspector, and is based on the target device/file 
system being monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of a 
workflow. For example, an attachment may be an XML file that contains metadata, an 
SCC caption file, or an STL or PAC subtitle file. An attachment may also be a PDF file, 
Excel spreadsheet, or Word document, for example. Attachments are identified and 
processed using nicknames for simplicity. Processing is optional—attachments may be 
simply passed through a workflow for storage with the processed media and registered 
in a Vantage catalog.

attachment nickname

An attachment nickname is an alias or alternate name that is assigned to an attachment 
file during Vantage workflow execution. When an attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See media nickname and nickname.

Aurora action

An Aurora action is an optional, licensed feature in Vantage. It uses the Aurora Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Digimetrics Aurora software. The tests provide the ability to determine whether a 
particular input media (specified by nickname) either passes or fails a particular QC 
check. Each test also generates a report file that may be utilized during later stages of 
the workflow.
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Aurora Service

The Aurora Service implements the Digimetrics Aurora software for Vantage, and 
provides two-way communication between workflows (and the Aurora action) utilizing 
Aurora and the Aurora software itself.

Baton action

A Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Baton software. The tests provide the ability to determine whether a particular input 
media (specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.

Baton Service

The Baton Service implements the Baton software for Vantage, and provides two-way 
communication between workflows (and the Baton action) utilizing the Baton software 
itself.

binder

A binder is a collection of file and metadata information, created for each job that 
Vantage executes. A binder contains media and attachment file references and 
metadata labels that were ingested or created during the job. While a binder is created 
for every job, many binders are never used. Therefore, only media processing scenarios 
which require operator intervention should use the Register action in ingest workflows 
to create binders in a user-accessible catalog. 

You use the Register action to automatically create binders during a job, and you use 
Exist to determine if a binder of a certain name has already been created. Binders are 
most often named by some permutation of the name of the file that started the job. 
Binders that are not explicitly registered are accessible to users only in Workflow 
Designer, in the Job Status tabs. 

Vantage catalogs and their binders are accessible in Workflow Portal. Binders are saved 
in the Vantage domain database until deleted manually or by job expiration policies. 
You can also view binders in the Vantage Management Console, and manually create 
them there—or delete them. 

Binders are not file folders and are not part of the Windows file system—they are 
records in the Vantage database. Thus, binders do not contain the files themselves; they 
only have the paths to those files. 

catalog

Similar in concept to the folders in a file system, a Vantage catalog is a container that 
stores binders. Catalog folders are sub-containers that organize binders. To access a 
binder, VWP operators search through the visible catalogs and folders, just as they 
might sort through folders in a file system.

Catalog Service

The Catalog Service is the Vantage component that executes the Register action and 
Register action.
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Catch action

A Catch action is an origin action; it is a specialized origin action for ingesting 
commercials and syndicated media assets (including metadata) from catch servers in 
TrafficManager applications. It uses the Traffic Service to regularly poll the catch server 
to discover new files.

When a new file is discovered, the Catch action exposes all relevant metadata and 
submits a job to the workflow for processing. Typically, the workflow is an ingest 
workflow which localizes the media, populates a metadata label, creates proxies and 
thumbnails, and registers the asset in a Vantage catalog. For more details, see the 
TrafficManager User’s Guide.

Chronicle action

The Chronicle action, along with Compose and Conform actions, are part of the 
optional, licensed Post Producer feature in Vantage. Chronicle uses the Edit Service to 
convert post-rendered Composition XML files into SCTE35 files.

common action

Common actions are actions that are implemented in every Vantage Service; they are 
not restricted execution by a single service. See Receive action, Forward action, Decide 
action, Compute action, Construct action, Synchronize action.

Communicate Service

The Communicate Service is the Vantage component that executes the actions relating 
to electronic messaging: Message action, and Notify action.

Compare action

A Compare action uses the Analysis Service to compare media files based on certain 
metrics (for example, PSNR). These metrics can generally be published as variables or as 
metadata labels.

Composition (CML) file

A Composition file is an XML schema that provides the vocabulary to describe media 
elements and their temporal and spatial relationships on a video timeline. Composition 
files (or Composition XML objects in a computer program) are submitted to a Conform 
action in a workflow to render the media file from the description.

Compose action

A Compose action, along with Chronicle and Conform actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Compose action uses the Edit Service to 
convert various media descriptor file formats (such as Anystream AN2, QuickTime 
Reference, and Telestream TIFO) into a Composition XML file so that it can be used by 
the Conform action to compose media.

Compute action

A Compute action, which is implemented in every service, performs various arithmetic 
and string manipulation functions, permitting you to create and modify values in 
variables, for use in downstream actions.



Glossary360
Conform action

A Conform action, along with Compose and Chronicle actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Compose action uses the Edit Service to 
assemble and optionally transcode multiple video and still image files into a single 
output file, applying filters as specified by you. The input files and related specifications 
for the output file are all defined in a Composition XML file.

Construct action

A Construct action, which is implemented in every service, enables you to construct 
complex strings, paths, and math expressions from literals, variables, and tokens, for 
use in downstream actions.

Copy action

A Copy action is executed by the Transport Service and is used to replicate a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination.

Copy actions can be executed on any action state.

database

The term database is the common term used to refer to the Vantage domain database, 
where all specifications for the domain are stored, along with workflows and job 
history.

Decide action

A Decide action, which is implemented in every service, is an action which allows you to 
explicitly set the action state based upon analysis of variable values at runtime. It is 
most commonly used to determine whether or not subsequent actions (or actions in a 
given branch) in a workflow should execute.

When the Decide action is used, the state set by the Decide action is passed to the next 
action. Typically, more than one Decide action is required to support decision branches. 
For example, if one branch is for HD media, it will start with a Decide action that will set 
the state to Success for HD content, or set it to Ignore otherwise; if another branch is for 
all other media, it will start with a Decide action that performs the opposite behavior.

See variable, action state.

Delete action

A Delete action is executed by the Transport Service, and is used to permanently 
remove a file from a source target (file system/device and directory). Delete actions can 
be executed on any action state.

Deploy action

A Deploy action is executed by the Transport Service, and is used to save the specified 
files to a destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, 
Deploy actions allow multiple files to be operated on simultaneously, and do not 
maintain a reference to those files in the binder after completion.
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distributed domain

Another term for Vantage array. 

domain

See Vantage domain.

Dublist action

A Dublist action is a specialized origin action for ingesting dublist files from a specified 
server and directory in TrafficManager applications. It uses the Monitor Service to 
regularly poll the server to discover new files.

When a new dublist file is discovered, it is parsed by the specified scheme and new 
entries are added to the master dublist maintained by Vantage. The Dublist action 
simultaneously polls the selected Vantage catalog for any media files which match 
entries in the master list; when found, it submits a job to a TrafficManager application 
workflow for processing. The Dub List action uses the binder name as the commercial’s 
unique identifier, so it should be set to either the ISCI code or the Ad ID.

Typically, the workflow is an on-air processing workflow which transcodes the media, 
optionally trims the clip and alters audio for compliance. Then, it delivers the media to 
an on-air server and notifies an automation system. For more details, see the 
TrafficManager User’s Guide.

Dublist Portal

Dublist Portal is a client Windows program provided as part of a TrafficManager license. 
Dublist Portal enables customers who are performing advertisement processing to 
define, manage, and process dublists as part of their automated TrafficManager 
workflows.

Edit Decision List

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a target 
clip. The list entries specify the start and stop of the clip, and Vantage supports list 
entries from multiple media files. Vantage operators use Vantage Workflow Portal 
(VWP) to create EDLs.

Edit Service

The Edit Service executes the Conform action, Chronicle action, and the Compose 
action.

Examine action

An Examine action uses the Analysis Service to evaluate the video and audio of a media 
file to measure certain characteristics, such as audio loudness, or to detect 
characteristics, such as the presence and size of curtains. You can configure it to publish 
metadata or variables containing the results of analysis.

Exist action

An Exist action uses the Catalog Service, and allows you to determine if a binder of a 
given name (or name fragment) is present in a specified catalog.
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Faspex Delivery action

A Faspex Delivery action, which is executed by the Aspera Service, is used to deliver files 
to Aspera faspex servers. Upon delivery, recipients are notified and can download the 
package.

Flip action

A Flip action is executed by the Transcode Service, and implements the specified codec, 
which is used to transcode decoded digital baseband media into another media 
encoding format. The Telestream Media Transcode and Analysis engine performs the 
transcode on behalf of Vantage. The Flip action has an Export command, which allows 
you to save the configured Flip action as an XML file, for use in SDK applications.

Forward action

A Forward action, which is implemented in every service, forwards a binder and all 
current variables to another workflow, starting a new job with the target workflow. A 
Forward action may be added to the end of a workflow, and requires that the target 
workflow have a Receive action as its first action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create comprehensive, intelligent run-time switching 
workflows consisting of smaller workflows used as building blocks.

See Receive action.

Gather action

A Gather action is implemented by the Staging Service, and collects one or more files 
from a specified server and directory (and optionally, its subfolders), and brings them 
into the workflow as attachments. Use of a file matching pattern allows you to select 
only certain types of files.

hot folder

A hot folder is a directory on a server that has been identified as a directory for storing 
media to be processed by a workflow in Vantage. When the workflow monitor identifies 
new media in this folder, it is submitted for processing.

Identify action

An Identify action uses the Analysis Service to determine certain properties of a media 
file, such as codec type, video bit rate, or file size. This information can then be 
published as a metadata labels or variables.

Inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that 
facilitate the setup and configuration of a given action. Inspectors are unique to each 
action—for example, configuring a Watch action is very different than configuring a 
Flip action.

IPTV Flip action

The IPTV Flip action is included with the Cable / IPTV version of TrafficManager. IPTV Flip 
actions are executed by the IPTV VOD Transcode Service which can optionally run on a 
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Lightspeed server for GPU-enhanced x264 encoding and video processing. The IPTV 
Flip action and Cable Transcode Service supports the features required to handle 
varying IPTV, set-top box and cable encoding requirements, and ancillary metadata 
specific to cable ad splicing and cable/IPTV set-top box environments. Transcoding is 
performed by the Telestream Media Transcode and Analysis engine on behalf of 
Vantage.

IPTV VOD Transcode Service

The IPTV VOD Transcode Service is the Vantage component that executes the IPTV Flip 
action. This service (which can optionally run on a Lightspeed server for H264 encoding 
and video processing), supports the features required to handle varying IPTV, set-top 
box and cable encoding requirements, and ancillary metadata specific to cable ad 
splicing and cable/IPTV set-top box environments. Transcoding is performed by the 
Telestream Media Transcode and Analysis engine on behalf of Vantage.

job

A job is each execution of a Vantage workflow. Jobs have a state (separate from action 
states), and jobs are comprised of actions that are executing. Jobs, like actions, may be 
in-process or they may be complete.

As a job executes, each action may be performed by any service (on any computer) in 
the Vantage domain that is capable of performing it. The capability of a service to 
perform a specific job depends on its current operating state, its workload, and its 
suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by 
selecting the workflow in the Workflow Designer panel and displaying the Job Status 
tab. Alternatively, all in-process and failed jobs within a Vantage Domain may be 
viewed in the Status details panel of the Management Console.

Job Profile action

Use the Job Profile action (which is executed by the Agility Service) to submit jobs to 
Agility for processing; definition of the job is provided directly in Vantage by 
configuring the action.

Job XML action

Use the Job XML action (which is executed by the Agility Service) to submit jobs to 
Agility for processing; definition of the job is provided in an XML file.

job routing

See qualification rule and run on rules.

job state

A job state is the current condition of a job. Keyword values are Start | Pause | Success | 
Fail | In Process.

Job Status Views Web Application

The Vantage Job Status Views Web Application is installed on a Vantage Web server and 
enables you to view real-time information about jobs in the domain from anywhere on 
your network with a Web browser.
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label

A label or metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, Author, ISCI 
code or Ad-ID and other metadata values; this set of metadata is collectively called a 
Spot metadata label. Metadata labels are stored in binders with the associated media 
and attachment files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you 
can create and modify labels for your use using the Management Console (Workflow 
Design Items > Metadata Labels).

license

A Vantage license is stored in the Vantage domain database and enables one or more 
Vantage features within a Vantage domain. Licenses are delivered as XML files and 
imported into the database and activated via the Vantage Management Console.

Lightspeed Server

A Vantage Lightspeed Server is a 1RU, GPU-enabled, multi-core CPU server used to host 
Vantage services and accelerate video processing and x264 transcoding. Lightspeed 
Server accelerates compute-intensive image processing, including scaling, 
deinterlacing, frame rate conversion, motion vector calculation, and other tasks that 
require computation and analysis to modify or create new video frames. 

Management Console

The Management Console enables Vantage system administrators to effectively 
configure Vantage domains, and scale domains across multiple servers to meet their 
operating requirements and perform effectively in their environment.

MediaInfo action

The MediaInfo action, which is executed by the Analysis Service, performs 2 tasks, based 
on its analysis of the media file and its streams:

- Creates variables from properties, using the MediaInfo API

- Creates a report of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

media nickname

A media nickname is an alias or alternate name that is assigned to a media file during 
Vantage workflow execution. When a media file is submitted to a workflow, the actual 
file name and location is stored in a Vantage binder along with a media nickname as 
defined in the workflow. Within the workflow, all references to a file are by media 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See attachment nickname and nickname.
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MediaMate action

A MediaMate action uses the MediaMate Service to enable Vantage workflows to utilize 
and interact with the Subtitling capabilities of Screen MediaMate. Each subtitling 
option provides different capabilities that relate to the subtitle process.

Note: The MediaMate action is only supported on 64-bit Windows Server 2008.

MediaMate Service

The MediaMate Service implements the MediaMate Screen software for Vantage, and 
provides two-way communication between workflows (and the MediaMate action) 
utilizing the MediaMate Screen software itself.

Message action

A Message action is implemented in the Communicate Service and enables you to 
generate and transmit an electronic Message—an email, for example. A Vantage 
administrator must configure Vantage to use an SMTP server (Vantage Management 
Console: Settings & Options > Email) before email can be utilized.

Metadata Service

The Metadata Service is the Vantage component that executes the actions relating to 
the transformation of metadata between labels, variables, and XML files: Populate 
action, and Transform action.

Monitor Service

The Monitor Service is the Vantage component that executes Watch actions and 
Associate actions, both relating to the discovery of files and starting jobs.

Move action

A Move action is executed by the Transport Service, and is used to move a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination, then deleting the source.

Move actions can be executed on any action state.

Multiscreen Flip action

Multiscreen Flip actions are an optional, licensed feature. Multiscreen Flip actions are 
executed by the Multiscreen Service, which is used to perform adaptive bit-rate 
encoding and simultaneous packaging of decoded digital baseband media into 
multiple bit-rate variants of H.264 video and containers in adaptive rate streaming 
formats, including Adobe HDS, Apple HLS, Microsoft HSS, and players the support 
MPEG DASH. Transcoding is performed by the Telestream Media Transcode and 
Analysis engine on behalf of Vantage. You can configure the Multiscreen action to 
perform transcoding on a standard Vantage server or on a Lightspeed server. 

nickname

A nickname is an alias or alternate name that is assigned to a media or attachment file 
during Vantage workflow execution. When a media or attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
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nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only allow 
the use of certain nickname types. For example, a Flip action only allows media file 
nicknames to be used as the inputs and outputs. However, other actions (such as the 
Move and Copy actions) operate on any type of file and allow the use of any nickname.

See attachment nickname and media nickname.

Notify action

A Notify action is implemented in the Communicate Service, and is an action which 
saves job information to a file, or which interfaces with an external system. You can 
configure a Notify action to produce an XML file, and you can also use it to invoke a 
Web Service. 

In TrafficManager applications, this action is useful to notify automation systems that a 
commercial has been processed and is available for air. For example, a Notify action can 
create text or CSV dublists and provide them to automation systems that are capable of 
processing dublists in that format. 

origin action

An origin action is a specific type of action, which must be used to start a workflow. A 
workflow without an origin action as its first action is not properly designed, and 
cannot be activated. The origin actions include the Watch action and Receive action, as 
well as the Catch action and Dublist action, (optional TrafficManager actions).

Original nickname

The media nickname Original is a reserved nickname that is typically assigned to media 
files in a workflow by the origin action.

See media nickname.

Pipeline

Pipeline is a network-based video capture and playout device for moving SD & HD SDI 
video & audio in and out of MacOS X and Windows file-based workflows, with a wide 
variety of industry-standard encoders.

Populate action

A Populate action uses the Metadata Service to read and write metadata labels. During 
ingest, metadata labels can be added to ingested media and generally include trim 
information, audio levels, file properties, and commercial metadata. The metadata 
labels can then be reviewed and modified by operators using Workflow Portal. At any 
stage of a workflow, Vantage can extract information from labels using the Populate 
action, allowing Vantage for example to use trim points during a transcode, or audio 
level information when creating the final broadcast asset.

Process MMF action

A Process MMF action (which is executed by the Agility Service) processes an 
attachment as an MMF file and generates variables from it.
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QC action

A QC action, which is executed by the Analysis Service, enables you to perform analysis 
on media using a variety of analysis tools, and optionally, produce a report of the 
analysis. The QC action is similar to the Analyze action, with additional features in 
addition to generating variables for each property.

In each tool, you can test various properties for True/False, min/max values, allowable 
values, or ranges, and then set pass/fail and other variables based on the results of the 
analysis. You can use these variables in downstream actions.

qualification rule

A qualification rule influences or controls the routing and execution of actions among 
Vantage services of the same type in a distributed Vantage domain. Qualification rules 
can be used to ensure that jobs are routed to services that are best suited for the task. 
Vantage uses values contained in variables to determine the suitability of a given 
service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any actual 
machine analysis. As a result, it is up to the system administrator to correctly set up 
variables and qualification rules, and apply variables to the appropriate actions to 
ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: 
Services.

See also run on rules.

Receive action

A Receive action is an optional, licensed feature; an origin action which is implemented 
in every service. Receive actions are designed to receive files from other systems: 
workflows, SDK-based applications, and Workflow Portal, for example. Files can be 
automatically submitted from a previous workflow using the Forward action.

See Forward action.

Register action

A Register action uses the Catalog Service to add the binder created by each job to a 
Vantage catalog. Register actions can be executed on any action state.

See also Vantage catalog.

Report action

A Report action, which is executed by the Analysis Service, generates a list of variables 
and their values and saves them in a file format specified by you.

resource cost

A resource cost is an integer value, implemented in the Vantage Management Console 
on each action type to specify a relative computer resource consumption value in 
relation to all other action types. This value enables Vantage to maximize resources and 
optimize transactions, so that you can tune your Vantage system for the highest 
possible throughput on your particular hardware.
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retry rules

Retry rules are rules that you can specify on certain actions, to re-execute actions that 
fail primarily due to platform access and network latency problems. The retry rules you 
set on a given action override the default retry rules established in the Management 
Console.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have 
the characteristics that enable them to execute this action. Rules are set up by 
specifying variables which have been bound to a given Vantage service and values set. 
After configuration, the action can test each rule by comparing its run time value to the 
value in the service’s copy and determine if there is a match before attempting to 
execute it. 

See also qualification rule.

Sdk Service

The Sdk Service is the Vantage component which enables integration with third-party 
or custom-developed client programs, for submitting jobs, tracking status, etc.

Signiant Delivery action

A Signiant Delivery action, which is executed by the Signiant Service, is used to deliver 
files to servers controlled by Signiant file transfer products.

Signiant Service

The Signiant Service is the Vantage component which enables integration with third-
party or custom-developed client programs, for submitting jobs, tracking status, etc.

The Signiant Service implements the Signiant file transfer product for Vantage, and 
provides two-way communication between workflows (and the Signiant Delivery 
action) utilizing the Signiant software itself.

Staging Service

The Staging Service is the Vantage component which executes Archive actions and 
Gather actions.

service

See Vantage services.

Synchronize action

A Synchronize action is a connector action, for the sole purpose of uncluttering 
workflow connectors. In workflows where there is a many-to-many relationship (for 
example, 6 Flip actions connecting to 6 Deploy actions, which connect to 6 Deletes), 
instead of drawing connection between them all, you simply connect them to a 
common Synchronize action. There is no Inspector for the Synchronize action, because 
no configuration is required.

Traffic Service

The Traffic Service is the Vantage component which executes the Catch action and 
Dublist action.
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TrafficManager

TrafficManager is an optional, licensed feature which enables automated advertisement 
and syndicated media processing from catch server to automat ion systems and on-air 
servers, serving both the broadcast and cable industry. It includes the Catch action for 
catch servers and the Dublist action for dublist management. 

transcode

Transcode means the process of decoding media in one format (MPEG2, for example) 
down to digital baseband and then encoding it in another media format (MPEG4, for 
example). 

Transcode Service

The Transcode Service is the Vantage component that executes the Flip action—
transforming media from one format to another. 

Transform action

A Transform action uses the Metadata Service to transform metadata between XML files 
(attachments) and labels. XSL style sheets are used to perform these transformations; 
style sheets can be managed in the Vantage Management Console: Workflow Design 
Items > Style Sheets.

Transport Service

The Transport Service is the Vantage component that executes the actions relating to 
file operations: Move action, Delete action, Copy action, and Deploy action.

Vantage array

A Vantage array is a domain whose software components are distributed among 
multiple computers for durability and scalability, instead of installed and operating on 
a single computer (often referred to as a distributed domain). A typical array has the 
Vantage domain database installed on a dedicated server, and all Vantage services 
installed on another computer, and additional Transcode services each installed on 
other computers for high-performance, parallel transcoding.

Vantage catalog

Formal name for catalog. See catalog.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all 
workflows, actions, jobs, binders, licenses, and configuration information for a Vantage 
domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage 
services, jobs, binders, and configuration settings, all known to and interacting with 
each other, stored in a database. This collection constitutes a Vantage domain. Vantage 
domains may exist on a single computer or they may be distributed across many 
computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the 
Vantage domain database.
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Multiple Vantage domains may exist on a network, but they are independent entities 
that do not communicate with each other. They are not bound together and do not 
share resources or work. The purpose of storing an entire domain in a database is to 
provide an easy way to create and manage the domain and to provide access to all the 
details about each resource in the domain to any other resource that needs it.

Vantage EDL nickname

The nickname Vantage EDL is a reserved nickname that is typically assigned to media 
files that are created in catalog ingest workflows, to identify the ingest files of an Edit 
Decision List in Workflow Portal, during Stitch and Trim operations.

See media nickname.

Vantage folder address

A Vantage folder address is an alias to a local or remote file folder. You can create and 
manage Vantage folder addresses in the Vantage Folder Address Book dialog, in Copy 
and Move actions in Vantage Workflow Designer, and in the Vantage Management 
Console.

After you create a Vantage folder address, you can specify the destination directory in 
any workflow simply by selecting the Vantage folder address. Changes to a Vantage 
folder address—such as updating an IP address or a password—immediately affect all 
workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution are 
not automatically deleted from Vantage folders according to job expiration settings. 

Vantage Proxy nickname

The media nickname Vantage Proxy is a reserved nickname that may be assigned to 
media files encoded in H.264 and AAC audio as QuickTime movies, or H.264 or x.264 
media files with AAC audio encoded with the Final Cut / Avid QuickTime encoder, 
which enables previewing with the media viewers provided in Vantage programs such 
as Workflow Designer, Workflow Portal, and the Vantage Management Console.

See media nickname.

Vantage services

The term Vantage services refers to the collection of Windows services in a Vantage 
domain, which are responsible for executing all of the actions in a workflow as it 
executes.

Vantage store

A Vantage store is a directory on a Windows file system that stores temporary files. 
Stores are managed by the Vantage domain for the purpose of centralizing large 
directories for reading and writing files. Unlike a Vantage folder, temporary files placed 
in a Vantage store are deleted when the binder is deleted. Vantage stores are generally 
used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Storage. Services 
that create temporary files, such as the Transcode Service, can be configured to use 
specific stores.
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Vantage Thumbnail nickname

The media nickname Vantage Thumbnail is a reserved nickname that is typically 
assigned to output media files that are created to display thumbnail images instead of 
binder names in Vantage programs such as VWP.

See media nickname.

Vantage Transcode

Vantage Transcode is a Web application which allows users to quickly and easily build 
straight-line transcoding workflows in a browser, based on a Watch > Transcode > 
Deliver template. Vantage Transcode runs under Microsoft IIS. 

variable

In Vantage, a variable is a container for temporary job information—a symbolic name 
(or identifier) which contains some known or unknown quantity or element of 
information; a value. You use the variable name to reference the current value; this 
separation of name and content allows the name to be used independently of the 
exact information it represents. The variable can be bound to a value (that is, you can 
set a variable to a given value) during run time, and the value of the variable may 
change during the course of workflow execution. 

A variable identifies temporary job metadata. Variables have a name (such as Number of 
Audio Channels), a type (such as Integer Number) and a default value (such as 50). 
Variables values can be set inside a job in a variety of ways: through analysis, through 
metadata population, in the Watch and Associate actions, as a property of an action, or 
by a service as it executes an action.

Variables are used by Vantage services and actions to control workflow execution. The 
majority of parameters in Vantage can be bound (or attached) to variables, allowing the 
workflow to dynamically update on a job-by-job basis. 

For example, a variable may be assigned a value by an Analysis action to determine 
how many lines of black are at the top of a video frame; a crop filter later in the 
workflow can bind to that variable, ensuring that every crop in every job is appropriate 
to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a 
FibreRequired=TRUE variable must pass this condition to a service which evaluates the 
condition to determine if it can successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items > 
Variables) or in Vantage Workflow Designer, and assigned for use in workflows and 
services.

VidChecker action

A VidChecker action is an optional, licensed feature in Vantage. It uses the VidChecker 
Service to enable Vantage workflows to utilize and interact with various QC tests 
provided by the VidChecker software.

VidChecker Service

The VidChecker Service implements the VidChecker QC software for Vantage, and 
provides two-way communication between workflows (and the VidChecker action 
actions) utilizing the VidChecker software itself.
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Watch action

A Watch action is an origin action; it uses the Monitor Service to regularly poll a target 
location (a directory, for example) on a device or file system (FTP, Windows network 
folder, etc.) to discover new files.

When a new file is discovered, the Watch action submits a job for the workflow which it 
is part of, for processing the file—typically, a media file.

Upload Portal Web App

The Upload Portal is a Web application that runs in most popular browsers and presents 
a simple interface to allow remote users to quickly and easily upload media and other 
files and metadata to your Vantage system.

Web Dashboard

The Web Dashboard option displays important domain information from anywhere on 
your network in a Web browser. The Web Dashboard is installed on the IIS server on 
your Vantage domain database server. 

workflow

A workflow in Vantage is a set of actions designed to perform an automated process. 
Vantage workflows are created using the Vantage Workflow Designer by adding and 
configuring actions and connecting them together. Workflows are stored in the 
Vantage domain database, and executed by Vantage services.

Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit 
workflows, activate and deactivate workflows, monitor job status, and review and 
delete jobs that have completed.

Workflow Portal

Workflow Portal is a client program that features a customizable set of functionality to 
support various operator-related tasks: selecting media and submitting jobs, updating 
variables and metadata, forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when Vantage 
administrators construct the user interface and functionality they want for a given task, 
then save it. When operators launch VWP, they select the configuration appropriate to 
the task at hand, and VWP dynamically implements the appropriate user interface from 
the configuration file.

Workflow Portal Web App

The Workflow Portal Web app is a limited implementation of Workflow Portal, for use in 
a Web browser over a network or Internet connection.
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Message action, requires email 
configuration 179

metadata label 374
metadata labels

adding 218
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deleting 220
displaying category names 220
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exporting 221
finding workflows with a specific 

label 221
for ingest workflows 289
importing 221
managing 214, 247
overview 215
parameters 218

sorting 220
viewing with VMC 217
VWP controls 294

Metadata Service 375
Microsoft SQL Server

2008 Standard
installing for distributed 

domain 84, 121
Client Access License 65
configuration 85, 122
ports used 57
Vantage SQL instance 67, 68

Microsoft SQL Server 2008 Express
guidelines for using 61

Microsoft SQL Server 2008 Standard
guidelines for using 61

mirror database. See database mirroring
MMX 46, 47
Monitor Service 375
monitoring

3rd Party Devices view 342
Array Statistics view 346
Service Statistics view 344
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MPEG disclaimers 5
MPEG2, 32-core limitation 47
Multiscreen Flip action 375
Multiscreen license 24
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N
network requirements 55
nickname 375
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See attachment nicknames
See media nicknames

notices, legal, generally 3
Notify action 376

O
operating system requirements

Vantage client programs 50
Vantage services 51
Vantage Web Applications 49

origin action 376
Original media nickname 211
Original, nickname 376

P
page size configuration, Dashboard 353
paging the job list, Dashboard 353
parameters, metadata labels 218
password

changing with Dashboard 331
changing with VMC 165
default 329
logging into Dashboard 329
logging into VMC 136
SMTP server 180
SQL database 170
SQL database default 122
SQL database, logging in 135

patches, installing 110
path specifications, Vantage storage 151
Performance Primitives 67
Pipeline 376
Plug-in Versions utility 196
Populate action 376
ports

Agility, configuring 189
See also HTTP ports
See also TCP ports
See also UDP ports
SMTP, configuring 180
used by Vantage 55
Vantage services, configuring 171

Post Producer 38
post-installation procedures 92
Process MMF action 376
processor, minimum requirements 46, 47
programs, in Vantage, generally 29

Q
QC action 377
qualification rule 377
qualification rules

adding to a service 175
overview 174
removing from a service 176

queue status display 349
QuickTime

installing 81, 88, 112
requirements 53

R
RAM, minimum requirements 46
Receive action 377
Refresh button 342
refreshing the configuration list 303
Register action 377
Report action 377
resource cost 377
restore domain database 92
restoring a domain

overview 197
procedure 199

Retry rules 378
retry settings, configuring for an 

action 234
Run on rules 378
run status display 349

S
Safari 5, recommended for 

Dashboard 326
saving a configuration 302
Sdk Service 378
Server Health chart 339
server maintenance mode

controlling with Dashboard 341
controlling with VMC 169

server. See Vantage server
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Service Metrics History, resetting 169
service. See Vantage service
session limit, Vantage service 167, 171
session-based load balancing 177
SFTP, port used 57
shares, accessing in other Windows 

domains 181
Signiant agent 186
Signiant Delivery action 378
Signiant Service 378
SMTP port, specifying 180
SMTP server

hostname configuration 180
IP address configuration 180
password 180
username 180

SQL database
default value 85

SQL. See Microsoft SQL Server
SSE 46, 47
SSE2 46, 47
Staging Service 378
storage. See Vantage storage
store

adding 153
adding to a service 172
aliases for 97
assigning to service 172
block size configuration 156
configuring a service to use 172
configuring the local store 93
deleting 157
deleting from a service 172
duplicating 156
exporting 157
finding related workflows 155
importing 157
modifying 154
online and offline 155
overview 150
viewing files in 153

style sheets
adding 230
deleting 231
displaying 230
exporting 231

importing 231
managing 229
overview 229
renaming 230

Synchronize action 378

T
target resource usage 171
TCP ports

used by Vantage 55
Vantage service, configuration 171
Vantage Web Applications 99

tech support, data collecting for 191
Telestream

contacting 7
Telestream, Inc, contacting

International distributor support 21
product guide comments 21
sales and marketing 21
technical support 21
Vantage Technical Support 21

Third Party Devices view 342
time synchronization guidelines 60
tip messages 139
tool tips 140
tours 304
trademark notices 3
Traffic Service 378
TrafficManager 38, 379
Transcode 379
Transcode Edition 24
Transcode Pro Connect 25
Transcode Pro Edition 24
Transcode Service 379
Transform action 379
Transport Service 379
troubleshooting

license installation 102
Vantage Web Applications install 100

U
UDP ports used 55
uninstalling

all Vantage server software 361
client software on a workstation 363
subsystems not removed 77, 362
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upgrading Vantage to 4.0 76
Upload Portal Web app 382
user

See also Vantage user
Vantage Windows account 59

User Account Control Admin Approval 
Mode, affect on installers 52

user management, enabling and 
disabling 163

username
default Vantage user 329
logging into Dashboard 329
logging into SQL database 135
logging into VMC 136
SMTP server, configuring 180
SQL database default 122
SQL database, configuring 170

utilities, diagnostics 144

V
Vantage

.Net Framework requirements 54
activating the license offline 102
downloading installation software 66
port requirements 55
Workflow Portal Web application. See 

Workflow Portal
Vantage 4.0, upgrading from previous 

version 76
Vantage administrator

email address for notifications 180
Vantage Analysis license 25
Vantage array 379

installing 83
Vantage Array license 40
Vantage catalog 368
Vantage client programs

installing 107
operating system requirements 50
updating 107

Vantage Dashboard 358
action

error details 358
filters 354
priority, changing 359
restarting 359

deleting jobs 358

display components 330
domain

changing 332
status 334

header pane 330
job

error details 358
filters 354
restarting 358
stopping 358

license status display 336
logging in 328
logging out 331
menu pane 331
overview 325
password, changing 331
patch status 337
release status 337
server status 338
sorting lists 331
starting 327
time filter 335
version information 332
welcome page 333

Vantage demo mode 69
Vantage domain 379

all-in-one
installation 80

back up
overview 197
procedure 198

connection settings 135
identifying

with Dashboard 330
with VMC 137

name 135
overview 134
renaming 200
restore

overview 197
procedure 199

selecting
with Dashboard 328, 332
with VMC 134, 138

status display in Dashboard 334
Vantage domain database 379

configuration guidelines 61
dedicated server
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requirements 63

installer 67
installing 83
moving to another database 117
overview 134
password 170
See also Microsoft SQL Server
username 170

Vantage editions, generally 24
Vantage EDL media nickname 211
Vantage EDL, nickname 380
Vantage folder

adding 159
block size configuration 161
deleting 161
duplicating 162
exporting 162
finding related workflows 161
importing 162
managing 158
modifying 160
overview 150

Vantage folder address 380
Vantage Job Status Views

access control 271
All Workflows View, enabling and 

disabling 268
creating a view 269, 312, 320
deleting a view 187, 270, 313, 320
display columns, selecting 271, 314, 

321
duplicating a view 269, 313, 320
exporting views 188, 274, 317
importing views 188, 274, 317
introduction 267
jobs, selecting for a view 270
public access 273, 315
renaming a view 269, 313, 320
user access 273, 315
view configuration panel, 

displaying 268, 312, 319
view list refresh 274, 316
workflow, selecting for a view 270, 

316
Vantage Job Status Views Web 

Application 373
Vantage Lightspeed server

adding to an existing domain 126
Vantage Management Console

File menu 141
Help menu 141
installing 107
introduction 31
Options menu 141
overview 133
starting 134
workspace 138

Vantage Monitor chart 349
Vantage Multiscreen license 24
Vantage patches, installing 110
Vantage programs, generally 29
Vantage Proxy media nickname 211
Vantage Proxy, nickname 380
Vantage server

installation 112
maintenance mode, controlling with

Dashboard 341
VMC 169

non-dedicated, performance tips 64
renaming 201
requirements 46
status display in Dashboard 338
uninstall all components 361

Vantage service
adding 89, 168
configuring 170
health chart in Dashboard 350
HTTP port 171
installing 112
limits 171
log file settings 171
log on ID 128
logon properties 90, 129
maintenance mode, controlling with

Dashboard 350
VMC 169

managing
with Dashboard 343
with VMC 165

metrics history
clearing 351
resetting 169

moving to another domain 128
operating system requirements 51
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qualification rules
adding 175
overview 174
removing 176

queue status display 349
removing 168
run status display in Dashboard 349
session limit 167, 171
statistics view, Dashboard 344
status display, Dashboard 343
store

adding 172
configuring 172
deleting 172

target resource usage 171
TCP port 171
timeout 171
variables

adding 173
deleting 173
overview 172

VMC setup tab options 170
Vantage services, generally 380
Vantage Setup installer 67
Vantage storage

managing 152
overview 150
path specifications 151
See also stores
See also Vantage folders

Vantage store 380
Vantage Thumbnail media nickname 211
Vantage Thumbnail, nickname 381
Vantage Transcode 35, 381
Vantage Transcode Edition 24
Vantage Transcode Pro Connect 25
Vantage Transcode Pro Edition 24
Vantage user

adding 164
exporting 165
importing 165
Job Status Views, access 273, 315
managing 163
password entry for Dashboard 329
password entry for VMC 136
removing 165
user management

disabling 163

enabling 163
username entry for Dashboard 329
username entry for VMC 136
VWP access 300

Vantage user default 329
Vantage user password

changing with Dashboard 331
changing with VMC 165

Vantage Web Applications
installation troubleshooting 100
installer 68
installing 94
operating system requirements 49
upgrading 115

Vantage Web Apps 109
Vantage Web Transcode UI 35
Vantage Windows user account 59
Vantage Workflow Designer 382

installing 107
setting grid dimensions 208
uninstalling

from a workstation 363
Vantage Workflow Portal 302, 303, 304

alias support for Web client 97
binder

deletion control 289
filtering control 291
view controls 292

catalog access control 286
configurations

creating 280
editing 280
ingest workflow 281
managing 279
network file access 281, 284
overview 278

EDL storage control 300
forward to workflows control 298
licensing

machine-based 276
overview 276
user-based 276

licensing requirements 38
media list display control 288
metadata label controls 294
overview 275
sessions

resetting 277
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viewing 277
user access control 300
variable controls 297

VANTAGE, SQL instance name 67, 68
variable 381
variables

adding 226
deleting 227
duplicating 227
exporting 228
finding related workflows 228
importing 228
managing 225
modifying 227
overview 225
using in services 172
viewing 226
VWP controls 297

version
Vantage Dashboard 332
Vantage programs 140

VidChecker action 381
VidChecker Service 381
VMC. See Vantage Management Console

W
warning messages 139
warranty 6
Warranty and Disclaimers 6
Watch action 382
Web

Workflow Portal application. See Work-
flow Portal

Web Applications, installing 94
Web Applications. See Vantage Web Ap-

plications
Web Apps 109
Web Dashboard 382
Web Transcode UI 94
Windows 7, Vantage client support 50
Windows authentication guidelines 58
Windows Firewall, recommendations 50
Windows Installer 4.5 51
Windows Installer 5.0 51
Windows Server 2003

64-bit processor recommended 46, 47

Vantage client support 50
Vantage service support 51

Windows Server 2008
64-bit processor recommended 46, 47
Computer Browser Service 

requirement 52
requirements 51
Vantage client support 50
Vantage service support 51
Web Applications support 49

Windows services log on ID 90
Windows Vista, Vantage client support 50
Windows XP Pro

Vantage client support 50
workflow 382
workflow categories

managing 208
Workflow Portal 382

described, generally
Workflow Portal Web app 382
workflows

asset requirements for ingest 289
exporting 206
finding

containing a metadata label 221
containing a variable 228

importing 206
managing with VMC 205
opening in VWD from VMC 205
refreshing the VMC list 207
related to a store 155
viewing active workflows 253
VMC management overview 204

workstation, uninstalling Vantage 
software 363
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